
 Undo Command
Use the Undo command or the Undo button on the toolbar to reverse the last change to a page. You can undo 
the last 30 actions.

Undo button
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Redo Command
Use the Redo command or the Redo button on the toolbar to reverse the effect of the last Undo command. You 
can redo up to 30 actions. 

Redo button
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Select All Command
Use the Select All command to select all items on the page. Use this command to copy or delete the entire 
contents of a page.
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Clear Command 
Use the Clear command to delete the selected items from the page without placing them on the clipboard. The 
FrontPage Editor may reformat your page after some deletions. For example, it renumbers a list if one or more 
elements are deleted from it.
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Find Command 
Use the Find command to search for specified text. The Find command can be case-sensitive and can match 
whole words only or any text.

Dialog Box Options 

Find What
Enter the text to find.

Match Whole Word Only
Finds text only if it matches a whole word.

Match Case
Finds text only if it matches the text to find in capitalization.

Direction
Specify Up to search from the insertion point to the beginning of the document or Down to search from the 
insertion point to the end of the document.

Find Next
Once a successful match has been found, click this button to repeat the search.

Cancel
Click Cancel to exit the Find command. 
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Replace Command
Use the Replace command to search for specified text and replace it with other specified text. You provide text to
find and text for replacement in the Replace dialog box.

The Replace command can be case-sensitive and can replace whole words only or it can replace any text. You 
can replace all instances of the text in a single operation, or you can repeatedly find the text to replace, then 
replace it.

Dialog Box Options 

Find What
Enter the text to find.

Replace With
Enter the replacement text.

Match Whole Word Only
Find text only if it matches a whole word.

Match Case
Finds text only if it matches the text to find in capitalization.

Find Next
Once a successful match has been found, click this button to repeat the search without replacing the currently 
found text.

Replace
Replaces the currently found text and finds the next match.

Replace All
Replaces the currently found text and continues replacing matches until all matches have been replaced.

Cancel
Click Cancel to exit the Replace command. This does not undo all replacements that have occurred.
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Bookmark Command
Use the Bookmark command to create a bookmark. You can assign a bookmark to any selected text, including 
special characters and text that is linked. When you create a bookmark, you assign it a name. This name is used 
to identify the bookmark as the target of a hyperlink.

When Format Marks is selected, the FrontPage Editor displays bookmarks as text with a blue dashed underline.

Dialog Box Options

Bookmark Name
Type the name of the new bookmark. This should be a term or a short phrase.

Other Bookmarks on This Page
Lists all bookmarks on the page.

Clear
Click Clear to clear the bookmark and close the dialog box.

Goto
Click Goto to scroll the view to the selected bookmark.
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Unlink Command 
Use the Unlink command to delete a text hyperlink. Unlink does not delete the characters to which the hyperlink 
is applied, but only removes the hyperlink itself. 

If you select a subset of the characters to which the hyperlink is applied, Unlink will only remove the hyperlink 
from the selected characters. If you choose Unlink with the insertion point on the hyperlink, but with no 
characters selected, Unlink will delete the entire hyperlink.
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Close Command 
Use the Close command to close the active page. If you have edited the page since opening it, you are prompted
to save changes. If the page was opened from the current FrontPage web, it is saved to the FrontPage web. If 
the page was opened from a file, it is saved to the file.

If the page is new, the FrontPage Editor displays the Save As dialog box.
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Page Setup Command 
Use the Page Setup command to set the header, footer, and margins for the active page. You enter the print 
setup information in the Print Page Setup dialog box. 

Page Setup does not change system-wide printing defaults. However, the values that you enter do apply to all 
pages printed from the FrontPage Editor, not just the active page.

Dialog Box Options 

Header 
Type the header to appear at the top of the printed page. The default value &T is replaced by the page title.

Footer
Type the footer to appear at the bottom of the printed page. The default value &P is replaced by the word "Page" 
followed by the page number. 

Note      The header, footer, and margins that you specify will apply to all the pages you print, not just the active 
page.

Margins

Left

Enter the left margin, in inches.

Right

Enter the right margin, in inches.

Top

Enter the top margin, in inches.

Bottom

Enter the bottom margin, in inches.

Options
Click Options to open the Print Setup dialog box for your printer. Use this dialog box to select page orientation, 
paper size, and other options available for your printer driver.
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Print Preview Command 
Use the Print Preview command to view how the page will appear when you print it. Form fields do not appear in 
the preview or on the printed page.

Note      The view of the page in the Print Preview window is not the same as the view of the page from a Web 
browser. The Print Preview Command automatically paginates your pages and assigns them page numbers. 
Web browsers do not paginate HTML pages and do not assign them page numbers.
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Exit Command
Use the Exit command to end a session in the FrontPage Editor. Before exiting, the FrontPage Editor prompts 
you to save any changes to pages.



Send Command
Use the Send command to send a copy of the active page to an electronic mail recipient. This feature is 
particularly useful in authoring environments where new FrontPage web pages require editorial review before 
being published on the World Wide Web. By using the Send command, your FrontPage web page drafts can be 
sent to other authors or editors on the network for review.

To use the Send feature, you need Microsoft Exchange (or other mail system compatible with the Messaging 
Application Programming Interface (MAPI).
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Recent File Command
The FrontPage Editor keeps a numbered list of the four pages most recently opened from files. This list is 
displayed at the end of the File menu. To open a page that was opened recently, select it from this list of files or 
type its number.
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Recent File Command
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Remove Formatting Command
Use the Remove Formatting command to return the formatting of the selected text on the current page to the 
default, which is based on the paragraph style.
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Microsoft FrontPage Help Command
Use the Microsoft FrontPage Help command to display online Help for this Microsoft application.



Microsoft on the Web Command
Use the Microsoft on the Web command to go to the Microsoft FrontPage World Wide Web site.



Symbol Command 
The Symbol command displays the Symbol dialog box. Select a special character from this dialog box to insert it 
at the insertion point.

To select a character for insertion, click it. Use the arrow keys to change selections.

Dialog Box Options

Insert
Click Insert to insert the currently selected character. You can also insert a character by double-clicking it.

Close
Click Close to close the Symbol dialog box.
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One-Line Text Box Command 
Use the One-Line Text Box command to insert a one-line text box field at the insertion point. A one-line text box 
field accepts one line of information from a user. 

To create a new form containing a one-line text box field, insert the text box field outside of any currently defined 
forms.

You can also insert a one-line text box field using the One-Line Text Box button on the forms toolbar.

One-Line Text Box 
button
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Check Box Command 
Use the Check Box command to insert a check box field at the insertion point. Use a series of check boxes to 
present a list of items, one or more of which can be selected.

To create a new form containing a check box, insert the check box outside of any currently defined forms.

You can also insert a check box field using the Check Box button on the forms toolbar.

Check Box 
button
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Scrolling Text Box Command 
Use the Scrolling Text Box command to insert a scrolling text box field at the insertion point. A scrolling text box 
field accepts multi-line text entries, such as user comments and suggestions. 

To create a new form containing a scrolling text box field, insert the scrolling text box outside of any currently 
defined forms.

You can also insert a scrolling text box field using the Scrolling Text Box button on the forms toolbar.

Scrolling Text Box 
button
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Radio Button Command 
Use the Radio Button command to insert a radio button field at the insertion point. Use a series of radio buttons 
with the same name in a form to present a list of items, only one of which can be selected at a time.

To create a new form containing a radio button, insert the radio button outside of any currently defined forms.

You can also insert a radio button field using the Radio Button button on the forms toolbar.

Radio Button
 button
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Drop-Down Menu Command 
Use the Drop-Down Menu command to insert a drop-down menu field at the insertion point. A drop-down menu 
field presents a list of items one or more of which can be selected.

To create a new form containing a menu form field, insert the menu field outside of any currently defined forms.

You can also insert a Drop-Down Menu field using the Drop-Down Menu button on the forms toolbar.

Drop-Down Menu
 button
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Bold Text Command
Use the Bold Text command to apply the strong text character style to the selected text.

Note      Some Web browsers ignore the strong character style when displaying text; others may use a different 
method of strengthening text, such as changing point size.
You select the Bold Text command using the Bold Text button on the format toolbar.

Bold Text button
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Italic Text Command
Use the Italic Text command to apply the emphasis character style to the selected text. 

Note      Some Web browsers ignore the emphasis character style when displaying text; others may use a 
different method of emphasizing text, such as underlining it.
You select the Italic Text command using the Italic Text button on the format toolbar.

Italic Text button
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Underline Text Command
Use the Underline Text command to apply the underline character style to the selected text.

Note      Some Web browsers ignore the underline character attribute when displaying text; others may use a 
different method of emphasizing text, such as italicizing it. 
You select the Underline Text command using the Underline Text button on the format toolbar.

Underline Text 
button
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Select Hotspot Command
Use the Select Hotspot command to select a hotspot in an image for editing, cutting, or copying.

You select the Select Hotspot command using the Select Hotspot button on the image toolbar.

Select 
Hotspot 
button
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Text Color Command
Use the Text Color command to change the color of text. Choose Text Color by clicking the Text Color button on 
the format toolbar.

Text Color 
button

You select the new text color in the Color dialog box. 
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Stop Command 
Use the Stop command to stop following a hyperlink. If you stop following a hyperlink after a new page is opened
but before all of the images have appeared, the remaining images appear as the broken painting icon:

To stop following a hyperlink, click the Stop button on the standard toolbar.

Stop 
button
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Back Command
The FrontPage Editor maintains an internal history-list of pages that you displayed, either by opening pages, 
creating new pages, or following hyperlinks. Use the Back command to display the previously displayed page. 

You can also go back to a page by clicking the Back button on the standard toolbar:

Back button
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Forward Command
The FrontPage Editor maintains an internal history-list of pages that you displayed, either by opening pages, 
creating new pages, or following hyperlinks. Use the Forward command to display the next page in the list. You 
cannot use the Forward command until you have used the Back command at least once. 

You can also go forward to a page by clicking the Forward button on the standard toolbar:

Forward button
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Thesaurus Command
Use the Thesaurus command to display the Thesaurus dialog box, which lists alternatives for the selected word. 
You can look up specific meanings of the selected word and choose to replace it with a synonym.

Dialog Box Options

Looked up
Displays the selected word.

Meanings
Displays a list of possible meanings. Select a meaning from the list to display the proposed synonyms for the 
word.

Replace with Synonym
Choose from the list of proposed synonyms.

Replace
Click the Replace button to change the selected text on the active page with the synonym shown in the Replace 
With Synonym field.

Look Up
Click the Look Up button to display synonyms for the currently selected meaning.
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Format Toolbar Command 
Use the Format Toolbar command to display or hide the FrontPage Editor's formatting toolbar. The formatting 
toolbar contains commands that reformat selected paragraphs or text. When this command has a check mark 
next to it, the toolbar is displayed.
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Forms Toolbar Command 
Use the Forms Toolbar command to display or hide the FrontPage Editor's forms toolbar. The forms toolbar 
contains commands that insert fields into a form. When this command has a check mark next to it, the toolbar is 
displayed.
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Status Bar Command
Use the Status Bar command to display or hide the status bar. When the Status Bar command has a check mark 
next to it, the status bar is displayed.

{button Related Procedures,JI(`frontpg.HLP',`Content_Workplace')}



Refresh Command
Use the Refresh command to refresh the display of the current page in the FrontPage Editor or revert to the last-
saved version of the current page. If the current page has not been saved when the Refresh command is 
selected, the FrontPage Editor will prompt you to save your changes.
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Cascade Command 
Use the Cascade command to arrange all open pages in overlapping windows.
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Tile Command 
Use the Tile command to resize all open FrontPage Editor windows so that they do not overlap.
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Arrange Icons Command 
Use the Arrange Icons command to arrange the icons of minimized pages at the bottom of the FrontPage Editor 
window.
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Edit URL Dialog Box
Use the Edit URL dialog box to change the path of the file you are importing. 

Dialog Box Option

Folder Location within Your FrontPage Web
Type the path of the folder in which the imported files will be placed.
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Configure Editors Tab
Options Dialog Box
Use the Configure Editors tab to associate an editor with a file type. Enter the file type (as represented by the 
filename extension), the name of the editor, and the path to the editor's executable file. For example, in the 
Configure Editors tab, the FrontPage Editor is listed as the editor for an HTM or HTML files with the following 
information: HTM and HTML as the file type, FrontPage Editor as the name of the editor, and C:\Program Files\
Microsoft FrontPage\bin\fpeditor.exe as the path.

Once you have associated an editor with a type of file, you can open files with that file's associated extension 
using the FrontPage Explorer Open Command. The associated editor will be opened automatically. If you try to 
open a file with a file type for which there is no entry in the list, the operating-system association will be used to 
launch the file.

Dialog Box Options

Type
The type of file to associate with an editor. The type of file is the file extension for the format of the file you want 
to edit. For example, for the file my_doc.txt, the type of file is TXT. If you use a . (dot), then an association for files
which have no extension is created. When you select an editor, both the Type and Editor fields are selected. 

Editor
The name of the editor, and the path of the editor's executable file. When you select an editor, both the Type and 
Editor fields are selected.

Add
Select this option to add an editor. In the Add Editor Association dialog box, specify the file type, editor's name, 
and path of the executable file for that editor.

Modify
Select this option to modify the information for an existing editor. In the Modify Editor Association dialog box, 
change the editor's name and path of the executable file for that editor.

Remove
Select the Type and Editor you want to remove, then click Remove to remove an editor from the list of available 
editors.
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Add Editor Association Dialog Box
Use the Add Editor Association dialog box to add an editor to the Configure Editors dialog box.

Dialog Box Options

File Type
Enter the type of file to be associated. The file type is the file extension for the format of the file you want to edit. 
For example, for the file my_doc.txt, the type of file is TXT.

Editor Name
Enter the name of the editor that will be automatically opened when you open a file of this type, for example, Text
Editor.

Command
Type the path of the executable file for the editor you are adding.

Browse
Select this option to open the Browse dialog box to select the editor’s executable file.
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Modify Editor Association Dialog Box
Use the Modify Editor Association dialog box to modify the information of an existing editor.

Dialog Box Options

File Type
Enter the type of file to be associated. The file type is the file extension for the format of the file you want to edit. 
For example, for the file my_doc.txt, the type of file is TXT.

Editor Name
Enter the name of the editor, for example, Text Editor.

Command
Type the path the executable file for the editor.

Browse
Select this option to open the Browse dialog box to select the editor’s executable file.
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Summary Tab
Properties Dialog Box
Use the Summary tab of the Properties dialog box to view the characteristics that identify the currently selected 
page.

Dialog Box Options

Created
The date of the page was created.

Created by
The name of the author who created the page.

Modified
The date of the last modification to the page.

Modified by
The name of the author who most recently modified the page.

Comments
Add notes about the page in this field.
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Delete FrontPage Web Command
Use this command to delete a FrontPage web. When you delete a FrontPage web, it cannot be recovered.

You need to be authorized as an administrator in the root FrontPage web to delete a FrontPage web. 
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Recent FrontPage Webs Command
The FrontPage Explorer keeps a numbered list of the four most recently opened FrontPage webs. This list is 
displayed at the end of the File Menu. To open a FrontPage web that was opened recently, select it from this list 
of files or type its number.
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Recent FrontPage Webs Command
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Exit Command
Use the Exit command to end a session in the FrontPage Explorer. If there is a current FrontPage web, 
FrontPage closes it.



New Folder Command
Use the New Folder command to create an empty folder within the current FrontPage web. This command is 
available only when in Folder view in the FrontPage Explorer.

When created, a new folder appears with a temporary name. Change the selected default name by typing a new 
name for the folder and pressing ENTER.
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Microsoft FrontPage Help Command
Use the Microsoft FrontPage Help command to display online Help for this Microsoft application.



Microsoft on the Web Command
Use the Microsoft on the Web command to go to the Microsoft FrontPage World Wide Web site.



Up One Level Command
Use the Up One Level command to open the folder that contains the currently selected folder.
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Repeated Hyperlinks Command 
Use the Repeated Hyperlinks command to display or hide multiple hyperlinks from one page to another page. By 
default, if a page has multiple hyperlinks to another page, the FrontPage Explorer only shows you one hyperlink; 
when you display repeated hyperlinks, you see all the hyperlinks to another page. When the Repeated 
Hyperlinks command has a check mark next to it, the repeated hyperlinks are displayed in the Hyperlink View. 

You can also display repeated hyperlinks by clicking the Repeated Hyperlinks button on the FrontPage Explorer 
toolbar.

Repeated 
Hyperlinks 
button
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Refresh Command 
Use the Refresh command to update the display of all views for the FrontPage web in which you are working. 
Because more than one person may be working on a FrontPage web at one time, refreshing your web ensures 
that the hyperlinks in your page are as up-to-date as possible. 
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Hyperlinks to Images Command 
Use the Hyperlinks to Images command to display or hide all hyperlinks to images in a FrontPage web. When the
Hyperlinks to Images command has a check mark next to it, hyperlinks to images are displayed in the Hyperlink 
View. When a page has a hyperlink to an image, an icon displays next to the page:

Image 
icon

You can also display hyperlinks to images by clicking the Hyperlinks to Images button on the FrontPage 
Explorer's toolbar.

Hyperlinks 
to Images 
button
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Change Password Command
Use the Change Password command to change a password. You must supply the current password before you 
can change it. You establish the new password in the Change Password dialog box.

Dialog Box Options

Old Password
Enter the current password.

New Password
Enter the new password. You can use alphanumeric characters and punctuation, but you cannot use spaces. 
FrontPage passwords are case-sensitive.

Confirm Password
Verify the new password by typing it again. If the confirmation field matches the entry in the New Password field, 
the password will be successfully changed.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Webs')}



Properties Command
Use the Properties command to view the properties of the currently selected folder or file. 

The Properties dialog box can have three tabs:

· Use the General tab to view the characteristics of the currently selected folder or file. When a folder is 
selected, properties such as number of files and folders within that folder are displayed. When a file is 
selected, properties such as type and size of the file are displayed. 

· Use the Summary tab to find out who created and last modified a file. In the Comments field, you can add 
notes about the file.

· Use the Errors tab to learn why FrontPage has flagged a file in the Hyperlink View with the Error icon. The 
Errors tab only appears when an error has occurred in a page.

Error 
icon:

The keyboard shortcut for Properties is ALT+ENTER.

{button Dialog Box,AL(`web properties DB tabs',0,`',`main')}
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Rename Command
Use the Rename command in the following views:

· Folders view and All Files view 
In these views, use the Rename command to change the name of a folder or file.

· Navigation view, 
In the Navigation pane, use the Rename command to change a page label. In the Files pane, use the 
Rename command to rename a file.
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Font Command 
Use the Font command to change the format of characters you select. You can apply any combination of 
attributes; however, some Web browsers may ignore certain attributes when displaying text.

The Insert Font dialog box has two tabs:

· Use the Font tab to select the font, and attributes such as size and color.
· Use the Special Styles tab to select special character styles such as blinking, color, superscript and subscript.

{button Dialog Box,AL(`fonts DB tabs',0,`',`main')}
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Push Button Command
Use the Push Button command to create a push button field at the insertion point. A push button field submits a 
form to its form handler or resets a form to its initial state. Because FrontPage automatically adds a Submit and 
Reset Push Button field to each new form, you only need to create a Push Button field if the default fields have 
been deleted.

To create a new form containing a push button field, insert the field outside of any currently defined forms.

You can also create a push button field using the Push Button button on the forms toolbar.

Push Button
button
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Image Form Field Command
Use the Image Form Field command to create an image form field at the insertion point. An image form field 
submits a form to its form handler. Image form fields are similar to a Push Button fields; however, image form 
fields cannot be used to reset a form.

After choosing this command, FrontPage displays the Insert Image Dialog Box where you select the image to 
insert in the form.
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Background Sound Command
Use the Background Sound command to include a sound file on the active page that will be activated and played 
back when a user browses to the page on the World Wide Web.

You can insert the following types of sound files on a page:

Wave Sound (WAV)

MIDI Sequencer (MIDI)

AIFF Sound (AIF, AIFC, AIFF)

AU Sound (AU, SND)

To change the properties of the background sound, choose Page Properties on the File Menu in the FrontPage 
Editor.

{button Dialog Box,AL(`open tabs',0,`',`main')}
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Increase Indent Command
Use the Increase Indent command to indent the current paragraph. You can also use the Increase Indent 
command to increase the nesting level of a numbered or bulleted list item. 

FrontPage supports an unlimited number of indentation levels. If you indent one or more list items that follow a 
list item, the indented items become a sub-list of the preceding list item. 

You select the Increase Indent command using the Increase Indent button on the format toolbar.

Increase Indent
button
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Decrease Indent Command
Use the Decrease Indent command to remove the indentation of a paragraph. You can also use the command to 
decrease the nesting level of a numbered or bulleted list item. When you decrease the indent of an indented list 
item, it becomes a member of the list that enclosed it when it was indented.

You select the Decrease Indent command using the Decrease Indent button on the format toolbar.

Decrease Indent
button

{button Related Procedures,JI(`frontpg.HLP',`Contents_Text')}



Increase Text Size Command
Use the Increase Text Size command to make text larger. Choose Increase Text Size by clicking the Increase 
Text Size button on the standard toolbar. 

Increase 
Text Size 
button

When you increase the size of text, FrontPage increases the HTML Font Size attribute of the text. The size of the
text is displayed in the Size field in the Font tab of the Font dialog box.

Note      The font size that is viewed in a Web browser may differ due to the Web browser’s settings.
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Decrease Text Size Command
Use the Decrease Text Size command to make text smaller. Choose Decrease Text Size by clicking the 
Decrease Text Size button on the standard toolbar. 

Decrease Text 
Size button

When you decrease the size of text, FrontPage decreases the HTML Font Size attribute of the text. The size of 
text is displayed in the Size field of the Font tab of the Font dialog box.

Note      The font size that is viewed in a Web browser may differ due to the Web browser’s settings.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Text')}



Numbered List Command
Use the Numbered List command to format the paragraph containing the insertion point as a numbered list 
paragraph. If the paragraph containing the insertion point is already a numbered list paragraph and your press 
the Numbered List button, FrontPage will reformat the paragraph by decreasing its indentation one level.

Numbered List 
button
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Align Left Command
Use the Align Left command to align the current paragraph, image, or table to the left margin of the page. The 
Align Left command also works for paragraphs, images, or tables within a table cell. You select the Align Left 
command using the Align Left button on the formatting toolbar.

Align Left 
button
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Align Right Command
Use the Align Right command to align the current paragraph, image, or table to the right margin of the page. The 
Align Right command also works for paragraphs, images, or tables within a table cell. You select the Align Right 
command using the Align Right button on the formatting toolbar.

Align Right 
button
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Center Command
Use the Center command to align the current paragraph, image, or table to the middle of the page. The Center 
command also works for paragraphs, images, or tables within a table cell. You select the Center command using 
the Center button on the formatting toolbar.

Center button
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Make Transparent Command 
Use the Make Transparent command to make a selected color in a GIF image transparent. A transparent color is 
replaced by the background color or background image of the page. This is useful when you insert an image that 
has its own background color ,and you want the background color or image of the page to become the 
background of the image you inserted.

An image can have only one transparent color. After you choose Make Transparent, the pointer becomes the 
Make Transparent pointer when you move it over the image.

To make a color transparent, place the tip of the Make Transparent pointer on the color and click. If the image 
already has a transparent color, selecting a new transparent color returns the existing transparent color to its 
normal color. Clicking on a transparent color makes the image non-transparent.

Choose the Make Transparent command by clicking the Make Transparent button on the image toolbar.

Make 
Transparent 
button

Make Transparent sets the Transparent field in the Image Properties dialog box. To make an image non-
transparent, turn off the Transparent field in the Image Properties dialog box, or click on the transparent color.

If you choose Make Transparent while a JPEG image is selected, the FrontPage Editor prompts you to convert 
the image to GIF format. If FrontPage converts the image, the number of colors in the image may be reduced 
and the image file will become larger.

Note      To change the background of a page, use the Background Image or Use Custom Background Color field 
in the Page Properties dialog box.
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Insert Table Command
Use the Insert Table command to create a table. Tables are used for laying out pages; inserting a table within a 
table gives you more control how page elements will be positioned on a page. You can also use tables to arrange
data systematically, such as timetable for a train.

You can create a table quickly by clicking the Insert Table button on the standard toolbar. Click and hold the 
button, then drag until FrontPage displays the number of rows and columns you want. Except for the number of 
rows and columns, when you use the Table button, FrontPage inserts a table with default properties.

Insert Table 
button

Dialog Box Options 

Size
Use the options in this section to control the size of the table.

Rows

Enter the number of rows you want the table to contain. The default number of rows for a table is two.

Columns

Enter the number of columns you want the table to contain. The default number of columns for a table is two.

Layout
Use the options in this section to control the layout of a table.

Alignment

From the drop-down list, indicate where you want the table positioned on the page. Currently, most Web 
browsers only support aligning a table left or right.

· Default
This is the position of the table when it is created.

· Left
Positions the table on the left side of the page.

· Right
Positions the table on the right side of the page.

· Center
Positions the table in the center of the page.

Border Size

Enter a size, in pixels, to add a border around a table. The default border size is one.

A border width of zero means that no table border will appear in a Web browser, although the FrontPage Editor 
displays dotted lines around cells when the Paragraph button on the standard toolbar is enabled. When you use 
a table for laying out a page, set the border size to zero so the table is invisible.

Note      To adjust the space around each cell in the table, use the Cell Padding field.

Cell Padding

Enter a number, in pixels, to set the space between the contents and inside edges of cells. You cannot set the 
cell padding for an individual cell. The default cell padding is one.

Cell Spacing

Enter a number, in pixels, to set a cell's spacing. Cell spacing determines how much space is placed between 
cells in a table. The default cell spacing is two.

Width



Specify Width

Check this box to specify a width for a table. If you do not specify a width, a Web browser will resize the table to 
fit the content in the table cells.

in Pixels

Select this option, then type the width of the table, in pixels.

in Percent

Select this option, then type a percentage for the width of the table in a Web browser’s window. For example, if 
you choose 50 percent, the table will span 50 percent of a Web browser’s window, regardless of how a user 
resizes the window. When you specify a percentage width for a table, the width of each cell in the table will be 
specified evenly. The default table width is 100 percent of the window. 

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Insert Rows or Columns Command
Use the Insert Rows or Columns command to add rows or columns to a table. When a row or column is selected 
before you use this command, the new row or column inherits the cell properties from the selected row or 
column, such as background color and vertical and horizontal alignment.

Dialog Box Options

Columns
Select this option to insert columns into the table.

Number of Columns
Enter the number of columns you want inserted in the table.

Left of Selection
Select this option to have the columns inserted to the left of the cell, row, or column.

Right of Selection
Select this option to have the columns inserted to the right of the cell, row, or column.

Rows
Select this option to insert rows into the table.

Number of Rows
Enter the number of rows you want inserted in the table.

Above Selection
Select this option to have the rows inserted above the cell, row, or column.

Below Selection
Select this option to have the rows inserted below the cell, row, or column.
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Split Cells Command
Use the Split Cells command to divide cells into columns or rows.

You can also split cells by clicking the Split Cells button on the table toolbar.

Split Cells 
button

Dialog Box Options 

Split into Columns
Select this option to split the cells into columns. The graphic in the dialog box shows how the split will occur.

Note      When you split a cell containing text into columns, the resulting empty cells are of default size.

Number of Columns
Enter the number of columns into which you want the cells split. If the number of columns or rows a cell spans is 
more than one, then that cell can only be split into columns or rows by the number of columns or rows the cell 
spans. This is enforced by the Split Cells dialog box. For example, if a cell spans three columns and one row, the
cell can be split into any number of rows, but only three columns. If more than one cell is selected, the FrontPage
Editor splits each selected cell individually.

Split into Rows
Select this option to split the cells into rows. The graphic in the dialog box shows how the split will occur.

Number of Rows
Enter the number of rows into which you want the cells split. If the number of columns or rows a cell spans is 
more than one, then that cell can only be split into columns or rows by the number of columns or rows the cell 
spans. This is enforced by the Split Cells dialog box. For example, if a cell spans one columns and two rows, the 
cell can be split into any number of columns, but only two rows. If more than one cell is selected, the FrontPage 
Editor splits each selected cell individually.
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Merge Cells Command
Use the Merge Cells command to combine the contents of selected cells into a single cell. You can merge cells 
horizontally or vertically.

This command is only available when two or more adjacent cells are selected, and the selected cells form a 
rectangle.
You can also merge cells by clicking the Merge Cells button on the table toolbar.

Merge Cells 
button
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Insert Cell Command
Use the Insert Cell command to insert one cell in a table. FrontPage inserts the cell without any cell attributes, 
such as height or width. Before inserting a cell, place the insertion point in a cell or select a cell, row, or column. 

This feature allows expert users to construct tables cell by cell.
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Insert Caption Command
Use the Insert Caption command to insert a table title or phrase that summarizes the contents of the table. You 
can insert a caption when the insertion point is in a cell, or when a cell, row, column, or table is selected. The 
caption is centered above the table by default.

You can change the attributes of selected characters with the Font command or character-attribute buttons on 
the format toolbar. You can apply any combination of attributes.

To move the caption to the bottom of the table, open the Caption Properties dialog box and select Bottom of 
Table.
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Select Cell Command
Use the Select Cell command to select the cell containing the insertion point. You can also select an cell by 
pressing ALT+CLICK in the cell. To select cells that are not adjacent to a selected cell, press ALT+SHIFT+CLICK.
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Select Row Command
Use the Select Row command to select the row containing the insertion point. You can also select a row by 
clicking its left border when the row-selection cursor is displayed.
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Select Column Command
Use the Select Column command to select the column containing the insertion point. You can also select a 
column by clicking its top border when the column-selection cursor is displayed.
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Select Table Command
Use the Select Table command to select a table. You can also select a table by moving the pointer to the 
selection bar and double-clicking the left mouse button.
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Table Properties Command
Use the Table Properties command to open the Table Properties dialog box where you can set or view the 
properties of a table, such as the table’s layout, size, or background color. When a table is selected, you can also
press ALT+ENTER to open the Table Properties dialog box.

{button Dialog Box,JI(`frontpg.HLP',`PE_IDD_TABLE_PROPERTIES')}
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Cell Properties Command
Use the Cell Properties command to open the Cell Properties dialog box where you can set or view the 
properties of a cell, such as the cell’s height and width. When a cell is selected, you can also press ALT+ENTER 
to open the Cell Properties dialog box.

{button Dialog Box,JI(`frontpg.HLP',`PE_IDD_CELL_PROPERTIES')}
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Caption Properties Command
Use the Caption Properties command to open the Caption Properties dialog box where you can set or view the 
properties of a caption, such as the caption’s position. When a table caption is selected, you can also press 
ALT+ENTER to open the Caption Properties dialog box.

{button Dialog Box,JI(`frontpg.HLP',`PE_IDD_CAPTION_PROPERTIES')}

{button Related Procedures,JI(`frontpg.HLP',`Content_Tables')}



Delete Cells Command
Use the Delete Cells command to delete selected cells, rows, or columns, from a table. 

You can also delete cells by clicking the Delete Cells button on the table toolbar.

Delete Cells 
button
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Distribute Rows Evenly Command
Use the Distribute Rows command to make all selected rows the same height. 

You can also distribute rows evenly by clicking the Distribute Rows Evenly button on the table toolbar.

Distribute 
Rows Evenly 
button
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Distribute Columns Evenly Command
Use the Distribute Columns command to make all selected columns the same width.

You can also distribute rows evenly by clicking the Distribute Rows Evenly button on the table toolbar.

Distribute Columns 
Evenly button
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absolute URL
The full Internet address of a page or other World Wide Web resource. The absolute URL includes a protocol, 
such as “http,” network location, and optional path and file name. For example, http://example.microsoft.com/ 
is an absolute URL. See also URL.



active hyperlink
A hyperlink that is currently selected in a Web browser. Some Web browsers indicate the active hyperlink by 
changing its color.



active page
The page currently being edited in the FrontPage Editor.



ActiveX control
A component that can be inserted in a page to provide functionality not directly available in HTML, such as 
animation sequences, credit-card transactions, or spreadsheet calculations. ActiveX controls can be 
implemented in a variety of programming languages from Microsoft and third parties.



address
An HTML paragraph style used to render URLs on a page or to supply signatures or other indications of 
authorship. Address paragraphs are usually displayed in italics and are sometimes indented. In Web browsers, 
an Internet address is also called a URL or a network location.



All Files View
The FrontPage Explorer view that displays all the files in a FrontPage web in a single list, along with information 
about each file, such as name, size, and file type. Views in the FrontPage Explorer provide different ways of 
looking at the information in your FrontPage web, so that you can effectively manage your site.



All Folders Pane
In the FrontPage Explorer's Folders view, the left portion of the screen, which shows all the folders and files in 
the current FrontPage web.



All Pages Pane
In the FrontPage Explorer's Hyperlinks view, the left portion of the screen, which shows all the pages in the 
current FrontPage web.



animated GIF
A file containing a series of GIF (Graphics Interchange Format) images that are displayed in rapid sequence by 
some Web browsers, giving an animated effect. See also GIF.



anonymous FTP
A file transfer (FTP) service in which any user can copy files by logging on with the name “anonymous.” See also 
FTP.



article
A single entry in a discussion group or newsgroup. An article can be a response to a previous article.



ascender
The part of a lowercase letter that rises above the main body of the letter.



ASCII
(American Standard Code for Information Interchange) The predominant method for encoding 7-bit characters on
a Personal Computer. HTML tags and URLs must be in ASCII.



ASP
(Active Server Page) A method for creating programs that run on a Web server, first available on the Microsoft 
Internet Information Server 3.0. See also IIS.



aspect ratio
The ratio of an image’s width to its height.



authentication database
A database on a server that matches user names to passwords.



background sound
A sound file that you associate with a page. When the page is displayed in a Web browser, the sound file plays or
repeats the number of times that you specify.



banner
An image, usually displayed at the top of each page in a Web site, containing text and design elements.



Banner Ad Manager
A FrontPage component that shows each of a series of designated images for a specified number of seconds, 
then transitions to the next image using any of several transition effects.



base URL
A URL that you can optionally assign to a page to convert relative URLs on that page into absolute URLs. A base
URL should end with a document name part, such as http://samples.microsoft.com/sample.htm, or a trailing 
slash, such as http://samples.microsoft.com/subdir/. See also absolute URL.



baseline
In text, the imaginary line draw along the bottom of the main body of the letters. The descenders descend below 
the baseline. In a table, the cell property that aligns the baseline of text in a cell with the baseline of the tallest 
text in the row.



basic authentication
An authentication protocol supported by Microsoft Internet Explorer. There is no encryption in this protocol.



bevel
A three-dimensional effect applied to the border of an image. The FrontPage Editor’s image toolbar contains a 
Bevel command.



BMP
The standard bitmap image format on Windows-compatible computers. Bitmap images can be saved for 
Windows or OS/2 systems and support 24-bit color.



bookmark
A named location on a page that can be the target of a hyperlink. A bookmark can be applied to a set of 
characters or it can exist on a page separately from any text. Bookmarks allow authors to link to a specific 
section of a target page. In a URL, a bookmark is preceded by a pound-sign character (#). Also called anchor.



broken hyperlink
In the FrontPage Explorer, a hyperlink that does not correctly point to a page or other Internet file. A broken 
hyperlink either indicates an incorrect URL or a missing page or file.



bulleted list
A paragraph style that creates a single list element, usually indicated by a bullet character. Also called an 
unordered list.



bulletin board
An electronic forum that hosts posted messages and articles related to a common subject.



cascading style sheet
An HTML syntax that gives authors precise control over the formatting of text in Web pages. Formatting 
information is stored in a Web site in style sheets, and can be applied to whole pages or parts of pages.



cell
The smallest component of a table. In a table, a row or column contains one or more cells.



cell padding
The space between the contents and inside edges of a table cell.



cell spacing
The amount of space between cells in a table. Cell spacing is the thickness, in pixels, of the walls of each cell.



CERN image map dispatcher
The program HTIMAGE.EXE, which handles server-side image maps in the Personal Web Server when the 
image map style is set to “CERN” in the FrontPage Explorer.



CGI
(Common Gateway Interface) A standard method of extending Web server functionality by executing programs or
scripts on a Web server in response to Web browser requests. A common use of CGI is in form processing, 
where the browser sends the form data to a CGI script on the server, and the script integrates the data with a 
database and sends back a results page as HTML.



change style dropdown
A dropdown list on the FrontPage Editor’s toolbar from which you can choose a format for the currently selected 
paragraphs or apply a style from a style sheet.



channel
A push technology that allows users to subscribe to a Web site to browse offline, automatically display updated 
pages on their screen savers, and download or receive notifications when pages in the Web site are modified. 
Channels are available only in browsers that support channel definitions, such as Microsoft Internet Explorer 
version 4.0.



Channel Definition Format (CDF) file
A file that enables users to access your FrontPage web as a channel in browsers that support channel 
definitions, such as Microsoft Internet Explorer version 4.0. The CDF file provides an index of resources available
on your channel and a recommended schedule for updating the channel on the user's computer. The FrontPage 
Channel Definition Wizard uses your input to create a CDF file that allows users to subscribe to your FrontPage 
web as a channel, a screen saver, or a desktop component, as well as receive e-mail notification when specific 
files change.



check box
A form field that can be chosen by clicking a box. When a box is selected, it is usually displayed with a check 
mark or X. Check boxes are usually grouped to represent a set of choices. Users can select more than one 
check box in a form. See also radio button.



child page
A page that is part of the navigation structure of a FrontPage web and that is linked to a parent page. A child 
page is accessed from its parent page by following a link from a navigation bar on the parent page. Web content 
on a child page often provides more detailed information related to the content on the parent page. See also 
navigation bar, peer pages.



child web
A named subdirectory of the root web that is a whole FrontPage web and is separate from the root web. Any 
number of child webs can be under the root web. Each child web can have many levels of subdirectories, making
up its content. Note that child webs only go to one level. FrontPage does not support creating child webs within 
child webs.



class selector
In a cascading style sheet style-definition (or style rule), a subset of a selector that controls whether the same 
selector can be used for slightly different styles in different situations. In FrontPage you can define or apply class 
selectors by clicking the Style button on the element's Properties dialog box, and then defining or applying the 
class selector in the Style dialog box.



client
On the Internet, a program that requests files or services from a server.



client-side image map
An image map that encodes the destination URL of each hotspot directly in a page. Client-side image maps do 
not require processing from a server to follow the hyperlinks on the image map, so they are more efficient. 
However, not all browsers support client-side image maps.



client-side program
On the Internet, a program that is run on a client computer rather than on a server computer. Client-side 
programs do not communicate over the Internet.



clip art
A collection of icons, buttons, and other useful image files, along with sound and video files that can be inserted 
into pages.



clipboard
A temporary storage area on a computer for cut or copied items.



column
In a table, a vertical collection of cells.



comment
Text that you can view in the FrontPage Editor but that will not be displayed by a Web browser. Comment text 
appears purple in the FrontPage Editor and retains the character-size and other attributes of the current 
paragraph style.



Confirmation Field
A FrontPage component that is replaced with the contents of a form field. It is useful on a form confirmation page,
where it can echo a user’s name or any other data entered into a field.



confirmation page
A page that is displayed in a Web browser after a form has been submitted by a user. The confirmation page 
usually displays the user’s name and other data from the form. You specify a form’s confirmation page in the form
handler’s dialog box.



Contents Pane
In the FrontPage Explorer's Folders view, the right portion of the screen, which shows the files contained in the 
folder selected in the All Folders pane.



converter
A program that converts a text file, or a portion of a text file, from one format to another. For example, FrontPage 
includes a Microsoft Word to HTML converter. See also filter.



crop
To reduce the size of an image by eliminating all portions outside of a resizable box that is dragged over the 
image. The FrontPage Editor’s image toolbar contains a Crop command.



current FrontPage web
The FrontPage web currently open in the FrontPage Explorer.



custom dictionary
A list of words not in the standard dictionary but that an author wants accepted by the spelling checker as correct.



Database Region Wizard
A FrontPage wizard that guides an author through creating a connection to a database, forming a database 
query, and associating a query with one or more form fields on a page. End users browsing the page can then 
query the database based on parameters they enter in the form.



default image hyperlink
In an image map, the hyperlink to follow when a user clicks in an area where there are no hotspots on the image.



definition
The HTML style of the second paragraph of a pair of paragraphs composing a definition list entry. The first 
paragraph in the pair is the term.



definition list
A list of alternating term and definition paragraphs. Definition lists are often used to implement dictionaries in 
FrontPage webs. See also term and definition.



descender
The part of a lowercase letter that descends below the main body of the letter; the part of a lowercase letter 
below the baseline of the letter.



Design-time control
An ActiveX control that is used while designing or editing a page. Design-time controls that are installed on the 
client computer are listed in the FrontPage Editor. See also ActiveX control.



desktop component
In a Web browser's desktop, a small screen region that displays summary or update information about a Web 
site which has been subscribed to as a channel. For example, a desktop component might display a stock ticker, 
a list of news stories, or a pop-up broadcast message. Desktop components are available only in browsers that 
support channel definitions, such as Microsoft Internet Explorer version 4.0.



Discussion Form Handler
A FrontPage form handler that allows users to participate in an online discussion. The Discussion Form Handler 
collects information from a form, formats it into an HTML page, and adds the page to a table of contents and to a 
text index. In addition, the Discussion Form Handler gathers information from the form and stores it in one of a 
selection of formats.



discussion group
A FrontPage web that supports interactive discussions by users. Users submit topics or responses by entering 
text in a form. Users can search the group using a search form or access articles using a table of contents.



discussion group folder
A folder in a FrontPage web containing all the articles in a discussion group. The name of a discussion group 
folder begins with an underscore character and is created automatically by FrontPage. Discussion group 
directories are not normally visible from the FrontPage Explorer. However, they can be searched by a FrontPage 
Search Form.



Distributed Password Authentication
Microsoft Distributed Password Authentication (DPA), which provides an advanced, distributed method of user 
authentication, allowing for single user logon. DPA support is provided by the Microsoft Membership System and 
is optimized for the needs of Internet service providers and online services.



drop-down menu field
A form field that presents a list of selections in drop-down menu style. A drop-down menu form field can be 
configured to permit the selection of many fields or a single field.



editor
An interactive program that can create and modify files of a particular type. For example, the FrontPage Editor is 
an HTML editor.



e-mail
(electronic mail) A service for sending messages over a computer network.



embedded files
Images, sounds, and video clips that have been inserted on a page in the FrontPage Editor from files or from the 
clipboard. You are prompted to save any embedded files when you save the active page.



embedded style sheet
A cascading style sheet that is embedded on a page. Styles in an embedded style sheet can be applied only to 
the page containing the style sheet, and will either extend or override styles defined in any external style sheet 
that is linked to the page.



emphasis text
The HTML character style used for mild emphasis. Certain Web browsers display emphasized text as italic.



EPS
(Encapsulated PostScript) An extension of the PostScript graphics file format developed by Adobe Systems. EPS
lets PostScript graphics files be incorporated into other documents. FrontPage supports importing EPS files.



Ethernet
A commonly used type of local area network (LAN).



executable folder
A folder in a FrontPage web from which scripts and executable programs can be run on a Web server. You can 
make a folder executable in the FrontPage Explorer. Web server administrators may prohibit the use of 
executable folders.



extended attribute
An HTML attribute not directly supported in FrontPage. In the FrontPage Editor, you can add extended attributes 
to most elements on the page.



external hyperlink
A hyperlink to any page or file that is outside the current FrontPage web.



external style sheet
A cascading style sheet in a file with a .css file extension. The .css file is comprised solely of style rules in 
valid .css syntax, without any surrounding HTML tags. By defining styles in one or more external style sheets and
linking them to pages in your web, you ensure consistency of appearance throughout those pages. If you change
a style in the external style sheet, the change will be reflected in all of the pages linked to that style sheet.



FAQ
(Frequently Asked Questions) A common type of document on the Internet that contains a list of questions and 
answers on a common theme. On the World Wide Web, questions are often hyperlinks to the answers.



file
A named collection of information that is stored on a computer. Also, an Internet protocol that refers to files on a 
disk or Local Area Network. You can create hyperlinks to files (file://) in the FrontPage Editor.



file server
A computer running on a network that stores files and provides access to them. Also called server.



file type
The format of a file, commonly indicated by its filename extension. Computer applications usually work on a 
limited set of file types.



Files Pane
In the FrontPage Explorer's Navigation view, the lower half of the screen, which displays a familiar Windows 
Explorer-like file and folder list of the current FrontPage web.

In the FrontPage Explorer's Folders view, the right portion of the screen, which displays the contents of the 
selected folder in the All Folders pane.



filter
A tool that converts an image or a file.



finger
An Internet program that displays information about the users currently logged on to a computer.



firewall
A method of protecting the files and programs on one network from users on another network. A firewall blocks 
unwanted access to a protected network while giving the protected network access to networks outside of the 
firewall. A company will typically install a firewall to give users access to the Internet while protecting their internal
information. FrontPage allows users to author FrontPage webs on the Internet even from within a protected 
network.



folder
A named storage area on a computer containing files and other folders.



Folders View
In the FrontPage Explorer, the view of a FrontPage web that shows how the content of the FrontPage web is 
organized. You can create, delete, copy, and move folders in the Folders view. Views in the FrontPage Explorer 
provide different ways of looking at the information in your FrontPage web, so that you can effectively manage 
your site.



form
A set of data-entry fields on a page that are processed on a server. The data is sent to the server when a user 
submits the form by clicking on a button or, in some cases, by clicking an image.



form field
A data-entry field on a page. A user supplies information in a field either by typing text or by selecting a field.



form handler
A program on a server that executes when a user submits a form. A FrontPage form is associated with a form 
handler in the Form Properties dialog box.



format toolbar
The FrontPage Editor toolbar containing commands that reformat selected paragraphs or text.



formatted text
A monospaced paragraph style in which all white space (such as tabs and spaces) is displayed by a Web 
browser. In other text styles, extra white space may be ignored by a Web browser.



forms toolbar
The FrontPage Editor toolbar containing commands for creating form fields.



frame
A named sub-window of a frames page. A frame appears in a Web browser as one of a number of window 
regions in which pages can be displayed. A frame may be scrollable and resizable, and may have a border. You 
display a page in a frame by creating a hyperlink to the page and specifying the frame as part of the hyperlink.



frames page
A page that subdivides a Web browser’s window into regions called frames that can independently display 
pages. See also frame.



Frames Page HTML View
The view in the FrontPage Editor that shows the HTML of the frames page currently being displayed. See also 
frames page.



FrontPage component
A built-in FrontPage object that is evaluated and executed when an author saves the page or, in some cases, 
when a user browses to the page. Most FrontPage components generate HTML. FrontPage components include 
Search Forms, which provide full text-searching capability in a FrontPage web, Popup Menus, which create 
popup menus on a page, and Save Results Form Handlers, which gather information from a form and store it in a
file or send it to an e-mail address. See also WebBot component.



FrontPage component cursor
In the FrontPage Editor, the robot-shaped cursor that is displayed when you move the mouse pointer over an 
area of a page containing a FrontPage component. See also FrontPage component.



FrontPage Editor
The FrontPage tool for creating, editing, and testing Web pages.



FrontPage Explorer
The FrontPage tool for creating, viewing, modifying, and administering FrontPage webs.



FrontPage Server Extensions
A set of programs and scripts that support FrontPage authoring and extend the functionality of a Web server. The
FrontPage Server Extensions are available for the Microsoft Internet Information Server and other popular 
Windows and UNIX Web servers. If you are not sure if your Web server is supported, visit 
http://www.microsoft.com/frontpage/



FrontPage web
A home page and its associated pages, images, documents, multimedia, and other files stored on a Web server 
or on a computer’s hard drive. A FrontPage web also contains files that support FrontPage functionality and that 
allow a web to be opened, copied, edited, and administered in the FrontPage Explorer.



FrontPage web name
The name of a FrontPage web. A FrontPage web name corresponds to a folder name on a Web server and is 
subject to the length, character restrictions, and case sensitivity of that server.



FrontPage web structure
The set of relationships among the pages in a FrontPage web as defined in the FrontPage Explorer’s Navigation 
view. A well-defined structure gives a user a sense of position in a FrontPage web. When a navigation bar is 
inserted on a page that is part of a FrontPage web’s structure, FrontPage automatically creates hyperlinks to the 
pages that are below that page in the structure (child pages), above that page in the structure (parent pages) and
equal to that page in the structure (peer pages). See also navigation bar, Navigation Pane, Navigation View.



FrontPage web title
A descriptive name for a FrontPage web. The FrontPage web title is displayed in the title bar of the FrontPage 
Explorer window when the FrontPage web is open. A FrontPage web title must start with a letter and can have a 
maximum of 31 characters.



FTP
(File Transfer Protocol) The Internet service that transfers files from one computer to another, over standard 
phone lines. You can create ftp hyperlinks (ftp://) in the FrontPage Editor.



GIF
(Graphics Interchange Format) A graphical file format commonly used to display indexed-color images on the 
World Wide Web. GIF is a compressed format, designed to minimize file transfer time over standard phone lines. 
See also interlaced GIF.



gopher
The Internet protocol where files are displayed in a hierarchical menu and are retrieved based on user input. You 
can create gopher hyperlinks (gopher://) in the FrontPage Editor.



heading
A paragraph style that is displayed in a large, bold typeface. The size of a heading is related to its level: Heading 
1 is the largest, Heading 2, the next largest, and so on. Use headings to name pages and parts of pages.



hidden field
A form field that is invisible to a user but supplies data to a form handler. Each hidden field is implemented as a 
name-value pair. When a form is submitted by a user, its hidden fields are passed to the form-handler along with 
name-value pairs for each visible form field.



hidden folder
A folder in a FrontPage web that has a name beginning with an underscore character, as in _hidden. By default, 
pages and files in hidden folders cannot be viewed in a Web browser.



home page
The starting point for a Web site. It is the page that is retrieved and displayed by default when a user visits the 
Web site. The default home-page name for a server depends on the server’s configuration. On many Web 
servers it is index.htm or default.htm. Some Web servers support multiple home pages.



horizontal line
A horizontal graphic element on a Web page often used to separate sections of the page.



hotspot
A graphically defined area in an image that contains a hyperlink. An image with hotspots is called an image map. 
In Web browsers, hotspots are invisible. Users can tell that a hotspot is present by the changing appearance of 
the pointer.



hover button
An animated button on a Web page that is activated when the mouse pointer is moved over the button or when 
the button is clicked.



HTIMAGE.EXE
The CERN image map dispatcher. This program handles server-side image maps when the image map style is 
set to “CERN.”



HTML
(Hypertext Markup Language). The standard language for describing the contents and appearance of pages on 
the World Wide Web. The FrontPage Page Editor reads and writes HTML files. Knowledge of the HTML 
language is not required to use FrontPage.



HTML attribute
A name-value pair used within an HTML tag to assign additional properties to an object being defined. FrontPage
assigns some attributes automatically when you create an object such as a paragraph or image map. You can 
assign other attributes by editing the Properties dialog box.



HTML character encoding
A standard table which associates a numeric index with each character in a character set. The table is used 
when you create a Web page for use in a specific language. Also called code page.



HTML Markup
A FrontPage component that is replaced with any arbitrary text you supply. This text is substituted for the 
FrontPage component when the page is saved to the server as HTML. Use HTML Markup to insert non-standard
HTML commands on a page.



HTML tag
A symbol used in HTML to identify a page element’s type, format, and appearance. The FrontPage Editor 
automatically creates HTML tags to represent each element on a page.



HTML View
The view in the FrontPage Editor that displays a page’s HTML. You can directly edit a page’s HTML in this view.



HTTP
(HyperText Transport Protocol) The Internet protocol that allows World Wide Web browsers to retrieve 
information from servers.



hyperlink
A pointer from text or from an image map to a page or other type of file on the World Wide Web. On Web pages, 
hyperlinks are the primary way to navigate between pages and among Web sites.



Hyperlink Status View
A view in the FrontPage Explorer that graphically shows the status of the hyperlinks in your FrontPage web. The 
list includes both internal and external hyperlinks, and graphically indicates whether the hyperlinks have been 
verified or whether they are broken. Views in the FrontPage Explorer provide different ways of looking at the 
information in your FrontPage web, so that you can effectively manage your site.



Hyperlinks Pane
In the FrontPage Explorer's Hyperlinks view, the right portion of the screen, which shows the hyperlinks to the 
selected page and from the selected page in the All Pages pane.



Hyperlinks View
A view in the FrontPage Explorer that graphically shows the hyperlinks among pages and other files in your 
FrontPage web along with the hyperlinks from your FrontPage web to other World Wide Web sites. Views in the 
FrontPage Explorer provide different ways of looking at the information in your FrontPage web, so that you can 
effectively manage your site.



hypertext
Originally, any textual information on a computer containing jumps to other information. The hypertext jumps are 
called hyperlinks. On Web pages hypertext is the primary way to navigate between pages and among Web sites.
Hypertext on Web pages has been expanded to include hyperlinks from text and hyperlinks from image maps.



ID selector
In a cascading style sheet style-definition (or style rule), a selector that is used to define a style for an individual 
page element, usually as an inline style. In FrontPage you can define or apply ID selectors by clicking the Style 
button on the element's Properties dialog box, and then defining or applying the ID selector in the Style dialog 
box.



IIS
(Internet Information Server) Microsoft's high-performance, secure, and extensible Internet server based on 
Windows NT Server. IIS supports the World Wide Web, FTP, and gopher.



image
A picture or graphics file that can be inserted on a Web page and displayed in a Web browser. FrontPage lets 
you import images in the following formats: GIF, JPEG (standard and progressive), BMP (Windows and OS/2), 
TIFF, TGA, RAS, EPS, PCX, and WMF. Imported images are converted to GIF format (for images containing up 
to 256 colors) or JPEG format (for images containing over 256 colors) when the page is saved to the current 
FrontPage web.



image alignment
In FrontPage, the specification of how images and text are aligned with each other on a page. You specify image 
alignment in the FrontPage Editor.



image bullet
Images used as the bullet characters in a bulleted list. The FrontPage Editor supports image bullets.



image form field
A form field that displays an image in a form. By clicking the image, a user either submits or clears the form.



image map
An image containing one or more invisible regions, called hotspots, which are assigned hyperlinks. Typically, an 
image map gives users visual cues about the information made available by clicking each part of the image. For 
example, a geographical map could be made into an image map by assigning hotspots to each region of interest 
on the map.



image toolbar
The FrontPage Editor toolbar that contains commands to modify or enhance images. You also use the image 
toolbar to create image hotspots. See also hotspot.



IMAGEMAP.EXE
The NCSA image map dispatcher. This program handles server-side image maps when the image map style is 
set to “NCSA.”



Include Page component
A FrontPage component that is replaced with the contents of another page in the FrontPage web. This lets you 
update parts of many pages in one step.



initial page
The page that is initially displayed in a frame when a user browses to a frames page containing the frame. In the 
FrontPage Editor you can assign the initial page to a frame. See also frames page.



inline image
An image that is embedded in a line of text rather than in its own window. In FrontPage, images are inline by 
default.



inline style
A method of applying cascading style sheet properties and values to an element on a page, such as a table, 
image, or ActiveX control. You can use this method even if the page is not linked to an external style sheet or 
does not contain an embedded style sheet. In FrontPage, you can create and apply an inline style by clicking the 
Style button on the element's Properties dialog box, and then setting the inline style properties on the Style 
dialog box.



interlaced GIF
A GIF image that is gradually displayed in a Web browser, showing increasingly detailed versions of the entire 
image until all of the data has finished downloading. See also GIF.



internal hyperlink
A hyperlink to any page or file that is part of the current FrontPage web.



internal web
A World Wide Web site created within an organization and accessible only to members of that organization on an
intranet.



Internet
The global computer network, composed of thousands of Wide Area Networks (WANs) and Local Area Networks 
(LANs) that uses TCP/IP to provide world-wide communications to homes, schools, businesses, and 
governments. The World Wide Web runs on the Internet.



Internet Explorer
The Microsoft Web browser for Windows 95, Windows NT, and Macintosh. When Internet Explorer is installed, 
FrontPage offers additional functionality, such as dynamic page and themes preview from within the FrontPage 
Editor. Internet Explorer version 3.0 offers ActiveX, Java, and plug-in support. Internet Explorer version 4.0 adds 
support for cascading style sheets, Dynamic HTML, and the Channel Definition Format (CDF).



Internet Information Server
(IIS) Microsoft's high-performance, secure, and extensible Internet server based on Windows NT Server. IIS 
supports the World Wide Web, FTP, and gopher.



intranet
A computer network that is internal to an organization and supports Internet applications, especially the World 
Wide Web. Most intranets are configured so that their users can access the entire Internet without allowing users
of the Internet access to the computers on the intranet. See also firewall.



IP
(Internet Protocol) Internet software that divides data into packets for transmission over the Internet. Computers 
must run IP to communicate across the Internet. See also TCP.



IP address
(Internet Protocol address) The standard way of identifying a computer that is connected to the Internet, much 
the way a telephone number identifies a telephone on a telephone network. The IP address is four numbers 
separated by periods, and each number is less than 256, for example, 192.200.44.69. Your Web server 
administrator or Internet Service Provider will assign your computer an IP address.



IP address mask
(Internet Protocol address mask) A range of IP addresses defined so only computers with IP addresses within the
range are allowed access to an Internet service. To mask a portion of the IP address, replace it with the asterisk 
wild card character (*). For example, 192.44.*.* represents every computer on the Internet with an IP address 
beginning with 192.44.



ISAPI
(Internet Server Application Programming Interface) A Web server application-development interface, developed 
by Process Software and Microsoft Corporation, that can be used in place of CGI.



Java
A general-purpose programming language created by Sun Microsystems. Java can be used to create Java 
applets. A Java program is downloaded from the Web server and interpreted by a program running on the 
computer running the Web browser.



Java applet
A short program written in Java that is attached to a Web page and executed by the computer on which the Web 
browser is installed.



JavaScript
A cross-platform, World Wide Web scripting language developed by Netscape Communications. JavaScript code
is inserted directly into an HTML page.



JPEG
(Joint Photographic Expert Group) A graphical file format used to display high-resolution color images on the 
World Wide Web. JPEG images apply a user-specified compression scheme that can significantly reduce the 
large file sizes usually associated with photo-realistic color images. A higher level of compression results in lower
image quality, whereas a lower level of compression results in higher image quality. See also progressive JPEG.



LAN
(Local Area Network) A computer network technology designed to connect computers separated by a short 
distance. A LAN can be connected to the Internet and can also be configured as an intranet.



line break
A special character that forces a new line on a page without creating a new paragraph.



list
A group of paragraphs similarly formatted to indicate membership in a set or in a sequence of steps. In the 
FrontPage Editor you can create numbered lists or bulleted lists, menus, directories, or definitions.



mailto
The Internet protocol used to send electronic mail. You can create e-mail hyperlinks in the FrontPage Editor.



marquee
A region on a page that displays a horizontally scrolling text message.



menu list
A list of short paragraph entries formatted with little white space between them.



meta tag
An HTML tag that must appear in the <head> portion of the page. Meta tags supply information about a page but
do not affect its appearance. A standard meta tag, “generator,” is used to indicate the type of editor that created 
the HTML page.



Microsoft Image Composer
A powerful image editing application integrated with FrontPage that lets you create original artwork or modify 
existing images.



MIME type
(Multipurpose Internet Mail Extensions type) A method used by Web browsers to associate files of a certain type 
with applications that display files of that type.



multi-hosting
The ability of a Web server to support more than one Internet address and more than one home page. Also 
called multi-homing.



name-value pair
The name of a form field and the value of the field at the time the form is submitted. Each field in a form can have
one or more name-value pairs, and the form itself can have one or more name-value pairs.



navigation bar
A graphical or textual page element that incorporates navigation hyperlinks to pages that are part of a FrontPage 
web’s structure. You design the FrontPage web’s structure in the FrontPage Explorer’s Navigation view. See also
FrontPage web structure, Navigation View.



Navigation Pane
In the FrontPage Explorer's Navigation view, the upper half of the screen, which shows the structure of your 
FrontPage web in a graphical representation.



Navigation View
The FrontPage Explorer view that is used to create, display, print, and change the navigation structure of a 
FrontPage web. The Navigation view includes a folder-like view, from which you can drag-and-drop pages into 
your site structure. Views in the FrontPage Explorer provide different ways of looking at the information in your 
FrontPage web, so that you can effectively manage your site.



NCSA image map dispatcher
The program IMAGEMAP.EXE, which handles server-side image maps when the image map style is “NCSA” and
you are using the FrontPage Personal Web Server.



nested frames page
A frames page containing another frames page inside one of its frames. See also frames page, frame.



nested list
A list that is contained within a member of another list. Nesting is indicated by indentation in most Web browsers. 
When you create one list element within another list element in FrontPage, the new list element is automatically 
nested.



network location
In a URL, a unique name that identifies an Internet server. A network location has two or more parts, separated 
by periods, as in my.network.location. Also called host name and Internet address.



news
The Internet protocol for retrieving files from an Internet newsgroup. You can create news hyperlinks (news://) in 
the FrontPage Editor.



No Frames View
The page view in the FrontPage Editor that displays the alternate HTML of a frames page. This is the HTML for 
Web browsers that do not support frames pages to display.



normal text
The default paragraph style of the FrontPage Editor, intended for use in text paragraphs.



Normal view
The default WYSIWYG page view of the FrontPage Editor that displays a page as it would appear in a Web 
browser.



NSAPI
(Netscape Server Application Programming Interface) A Web server application development interface, 
developed by Netscape Communications Corporation.



NTLM
(NT LanMan) The Windows NT Challenge/Response authentication protocol. This protocol uses encryption for 
secure transmission of passwords.



numbered list
The HTML paragraph style that presents an ordered list of items.



OLE
(Object Linking and Embedding) An object system created by Microsoft. OLE lets an author invoke different 
editor components to create a compound document.



one-line text box
A labeled, single-line form field in which users can type text.



page
A single document on a Web site written in HTML language. You can use the FrontPage Editor to create and 
modify pages without having to learn HTML.



page template
A pre-designed but generic Web page you can use to create new custom pages. Some of FrontPage’s page 
templates provide typical page content, while others provide common page layouts.



page title
A text string identifying a page. The page title is displayed in the FrontPage Explorer and is used by many 
FrontPage Editor and FrontPage Explorer commands.



paragraph style
In the FrontPage Editor, the paragraph style specifies the type of font to use in a paragraph, the font’s size, and 
other attributes related to text on a page. Paragraph style also specifies whether to use bullets and numbering 
and controls indentation and line spacing.



parent page
A page in a FrontPage web that is part of the navigation structure of a FrontPage web and is linked to one or 
more pages called child pages. A child page is accessed from its parent page by following a link from a 
navigation bar on the parent page. See also navigation bar, peer pages.



password
A string of characters that allows a user access to an Internet service, if the service requires it.



path
The portion of a URL that identifies the folders containing a file. For example, in the URL 
http://example.microsoft.com/hello/world/greetings.htm, the path is /hello/world/.



PCT
(Personal Communications Technology) An enhanced version of Secure Socket Layer. See also Secure Socket 
Layer.



PCX
A graphical file format that compresses its image data with RLE-type compression, used by early versions of 
Windows Paintbrush. FrontPage can import PCX files.



peer pages
A set of pages that are part of the navigational structure of a FrontPage web and share a common parent page. 
See also FrontPage web structure.



plug-in
One of a set of software modules that integrate into Web browsers to offer a range of interactive and multimedia 
capabilities.



port
One of the network input/output channels of a computer running TCP/IP. On the World Wide Web, port usually 
refers to the port number a server is running on. A single computer can have many Web servers running on it, but
only one server can be running on each port. The default port for Web servers is 80.



PPP
(Point to Point Protocol) An Internet standard for transmitting data over serial links between computers.



progressive JPEG
An enhancement to the JPEG image format specification that allows an image to be gradually displayed in a 
Web browser, showing increasingly detailed versions of the entire image until all of the data has finished 
downloading. While this is similar to interlaced GIF images, progressive JPEG images can retain the high quality 
of 24-bit color and offer the same efficient compression as standard JPEG. See also JPEG.



properties
The characteristics of an item in a FrontPage web, such as the title and URL of a FrontPage web or the name 
and initial value of a form field. You can also specify properties for page elements such as tables, images, and 
scrolling marquees.



protocol
A method of accessing a document or service over the Internet, such as File Transfer Protocol (FTP) or 
Hypertext Transfer Protocol (HTTP). Also called type.



proxy server
An Internet server that acts as a firewall, mediating traffic between a protected network and the Internet. See also
firewall.



publish
The process of making your FrontPage web public on the World Wide Web or an intranet. You publish your 
FrontPage web using the FrontPage Explorer.



push button
A form field that lets a user submit a form or reset a form to its initial state.



radio button
A form field that presents a user with a selection that can be chosen by clicking on a button. Radio buttons are 
presented in a list, one of which is selected by default. Selecting a new member of the list deselects the currently 
selected item. See also check box.



RAS
The Raster image file format developed by Sun Microsystems.



registered user
A user of a Web site whose name and password has been recorded within the Web site. In a FrontPage web, 
you can register users with a FrontPage Registration Form Handler.



Registration Form Handler
A FrontPage form handler that allows users to automatically register themselves for access to a service 
implemented as a World Wide Web site. The Registration Form Handler adds the user to the service’s 
authentication database, then gathers optional information from the form and stores it in one of many supported 
formats.



relative URL
The Internet address of a page or other World Wide Web resource relative to the Internet address of the current 
page. A relative URL gives the path from the current page to the destination page or resource. A relative URL can
include a protocol. For example, the relative URL doc/sample.htm refers to the page sample.htm in the folder 
doc, below the current folder.



resample
The changing of the pixel dimensions (and therefore file size) of an image. An image can be resampled down (its 
number of pixels is decreased) or resampled up (its number of pixels is increased). When you resample an 
image down, pixel information is deleted from the image. When you resample an image up, new pixel information
is created based on the color values of the existing pixels. Resampling and image down and then resampling it 
up to the original resolution will cause the quality of the image to deteriorate. The FrontPage Editor includes a 
Resample command.



root web
The FrontPage web that is provided by a Web server by default. To access the root web, you supply the URL of 
the server without specifying a page name or sub-web. FrontPage is installed with a root web named <Root 
web> or Personal Web. All FrontPage sub-webs are contained by the root web. See also sub-web.



row
In a table, a horizontal collection of cells.



RTF
(Rich Text Format) A method of encoding text formatting and document structure using the ASCII character set. 
By convention, RTF files have an .rtf filename extension. You can open RTF files in the FrontPage Editor and 
have them converted to HTML.



Save Results Form Handler
A FrontPage form handler that gathers information from a form and stores it in one of a selection of formats or 
sends the information to an e-mail address. When a user submits the form, the Save Results Form Handler 
appends the form information to a file on the server in a specified format.



Scheduled Image
A FrontPage component that is replaced on the page by an image during a specified time period. When the time 
period has expired, the image is no longer displayed. This is useful for displaying graphical information that has a
limited lifetime, such as the announcement of a new product or service.



Scheduled Include Page component
A FrontPage component that is replaced with the contents of a file in a FrontPage web during a specified time 
period. When the time period has expired, the contents of the file are no longer displayed. This is useful for 
displaying textual information that has a limited lifetime.



script
A type of computer code than can be directly executed by a program that understands the language in which the 
script is written. Scripts do not need to be compiled to be run.



scrolling text box
A labeled, multiple-line form field in which users can type one or more lines of text.



Search Form
A FrontPage component that creates a form that provides full text-searching capability in your FrontPage web 
when the FrontPage web is browsed. When a user submits a form containing words to locate, the Search Form 
returns a list of hyperlinks to the pages in your FrontPage web containing matches for the words.



Secure Socket Layer
(SSL) A low-level protocol that enables secure communications between a server and FrontPage or a Web 
browser.



selection bar
In the FrontPage Editor, an unmarked column along the left edge of body text that is used to select lines of text 
by clicking the left mouse button.



selector
In a cascading style sheet style-definition (or style rule), the HTML element linked to a particular set of style 
properties and values. For example, in the following style definition:

H1 { font-size: x-large; color: green }
the selector is H1.



server
A computer that offers services on a network. On the World Wide Web, a server is a computer that runs the Web 
server software which responds to HTTP protocol requests. Also called host.



server-side image map
An image map that passes the coordinates of the mouse pointer to a CGI handler routine on the server. Server-
side image maps require your server to compute the target URL of the hyperlink based on the mouse pointer 
coordinates.



server-side include
A feature provided by some Web servers that automatically inserts text onto pages when they are fetched by a 
Web browser.



SGML
An ISO (International Standards Organization) markup language for representing documents on computers. 
HTML is based on SGML concepts.



shared borders
Page regions reserved for content that you want to appear consistently throughout your pages. Shared borders 
usually contain navigation bars — hyperlinks to the other pages in the current FrontPage web. When you create 
a FrontPage web in the FrontPage Explorer’s Navigation view, shared borders and navigation bars are 
automatically created and updated, even when you add, move, or delete pages from the web’s structure.



size handle
The black rectangle displayed on a selected form field, image, or hotspot. When you select a size handle, the 
cursor becomes a bi-directional arrow. Click and drag a size handle to reshape a form field, image, or hotspot.



SLIP
(Serial Line Internet Protocol) An Internet standard for transmitting data over serial links between computers.



special character
A character not included in the standard 7-bit ASCII character set, such as the copyright mark (©). In FrontPage, 
you can add special characters using the FrontPage Editor.



standard toolbar
The FrontPage Editor toolbar containing the most commonly used menu commands.



status bar
The area at the bottom of the FrontPage Editor or FrontPage Explorer that displays information about the 
currently selected command or about an operation in progress.



strong text
The HTML character style used for strong emphasis. Certain browsers display this style as bold.



style
Styles are used in a webs to control the type of font, alignment and spacing of text, appearance of background 
pages, and other HTML attributes. A collection of styles is called a style sheet. See also cascading style sheet.



sub-web
A named subdirectory of the root web that is a complete FrontPage web. Each FrontPage sub-web can have 
independent administration, authoring and browsing permissions from the root web and other sub-webs. In 
addition, searches implemented through the FrontPage Search Form are limited to the sub-web, and FrontPage 
only manages hyperlinks within the sub-web. Any number of sub-webs can be created under the root web. 
FrontPage does not support creating sub-webs within sub-webs. However, each sub-web can have many levels 
of subdirectories, organizing its content. See also root web and FrontPage web.



Substitution component
A FrontPage component that is replaced by the value of a selected page or web variable.



table
One or more rows of cells on a page used to organize the layout of a page or arrange data systematically. In 
FrontPage, you can place anything in a table cell, including text, images, and forms.



Table of Contents
A FrontPage component that creates an outline of your FrontPage web, with hyperlinks to each page. The Table 
of Contents updates this outline each time a FrontPage web’s contents change.



table toolbar
The FrontPage Editor toolbar that contains commands for creating and modifying tables.



tag selection
In the FrontPage Editor, a method of selecting a group of paragraphs and other objects on a page. Use tag 
selection to select the members of a list, an entire form, or a FrontPage component. To tag select a set of 
objects, move the cursor to the left of the objects until the cursor becomes the tag selection cursor (an arrow 
pointing to the upper-right), and then double-click.



target frame
The name of a frame in which to display the target page of a hyperlink. Typically, a hyperlink from one frame of a 
frames page will supply as its target frame another frame of the frames page.



task
An item associated with a FrontPage web representing one action you need to perform to complete a FrontPage 
web. Some tasks are automatically generated by FrontPage wizards. You can also add your own tasks. Tasks 
are displayed in the FrontPage Explorer’s Tasks view.



Tasks View
The FrontPage Explorer view that maintains a list of the tasks required to complete a FrontPage web. Views in 
the FrontPage Explorer provide different ways of looking at the information in your FrontPage web, so that you 
can effectively manage your site.



TCP
(Transmission Control Protocol) Internet networking software that controls the transmission of packets of data 
over the Internet. Among its tasks, TCP checks for lost packets, puts the data from multiple packets into the 
correct order, and requests that missing or damaged packets be resent. Computers must run TCP to 
communicate with Web servers.



template
A set of pre-designed formats for text and images on which new pages and new FrontPage webs can be based. 
After a page or web is created using a template, you can customize the page or web.



term
The first of a pair of paragraphs formatted as a definition list entry. The second paragraph is the definition.



TGA
(TARGA) A photo-realistic image format designed for systems with a Truevision display adapter.



theme
A theme applies professionally designed, graphical page elements to the pages in a FrontPage web. FrontPage 
offers a gallery of over 50 themes that consist of similar design elements for bullets, fonts, images, navigation 
bars, and other page elements. When applied, a theme gives pages and navigation bars in a FrontPage web an 
attractive and consistent appearance. You apply a theme in the FrontPage Explorer's Themes view.



Themes View
The FrontPage Explorer view that lets you add graphic page elements, such as bullets and backgrounds, to your 
FrontPage web. You can choose from a gallery of available FrontPage themes and apply them to all pages in the
current FrontPage web to give your site a consistent, professional appearance and navigation structure. You can 
also enable, disable, or override theme formatting for individual pages in the FrontPage Editor.



thumbnail
A small version of an image on a Web page, usually containing a hyperlink to a full-size version of the image.



TIFF
(Tagged Image File Format) A high-resolution, tag-based image format. TIFF is used for the universal 
interchange of digital images.



Timestamp
A FrontPage component that is replaced by the date and time a page was last edited or updated.



Toolbar
The FrontPage Explorer toolbar containing the most commonly used menu commands.



transition effect
One of a set of page-display effects, such as Dissolve and Fade To Black, that are available in some Web 
browsers. Transition effects can be configured to occur when a user visits or leaves a page. You can apply a 
transition effect to a page using the FrontPage Editor.



TWAIN
Developed by a consortium of imaging hardware and software manufacturers, TWAIN is a cross-platform 
interface for acquiring electronic images captured by TWAIN-compliant scanners, digital cameras, and still-frame 
video capture boards.



typewriter font
The text style that emulates fixed pitch (monospaced) typewritten text. Typewriter font is useful for computer 
code examples and for presenting sample input from a user.



UNIX
A multi-user, multitasking operating system that exists in various forms and implementations, typically used on 
proprietary computer workstations. Many Web servers run on UNIX systems.



URL
(Uniform Resource Locator) A string that supplies the Internet address of a Web site or resource on the World 
Wide Web, along with the protocol by which the site or resource is accessed. The most common URL type is 
“http,” which gives the Internet address of a Web page. Some other URL types are “gopher,” which gives the 
Internet address of a Gopher directory, and “ftp,” which gives the network location of an FTP resource.



variable
Information about a FrontPage web or page that can be displayed by FrontPage form handlers or FrontPage 
Substitution components when a page is browsed. FrontPage includes standard web and page variables. 
Authors can define new variables in the FrontPage Explorer.



VBScript
Microsoft Visual Basic Scripting Edition, a subset of the Microsoft Visual Basic programming system. Microsoft 
Internet Explorer version 3.0 and higher, along with other Web browsers, can read VBScript programs embedded
in HTML pages. VBScript programs can be executed either on the Web server, or on the computer on which the 
Web browser is installed. In the FrontPage Editor, you can insert and edit VBScript code.



veronica
An automated Internet search service available through gopher. See also gopher.



video clip
A short video sequence that can be embedded into a Web page. Video clips can be inserted into FrontPage 
using ActiveX Controls, VBScript, Java applets, or plug-ins.



Views bar
The vertical bar at the left of the FrontPage Explorer window. The buttons on the Views bar let you switch to 
different views of your FrontPage web, such as Folders view or Hyperlinks view. Views in the FrontPage Explorer
provide different ways of looking at the information in your FrontPage web, so that you can effectively manage 
your site.



virtual server
One of multiple Web sites running on the same server, each with a unique domain name and IP address. A Web 
server that supports virtual servers is called a multi-hosting Web server.



visited hyperlink
A hyperlink on a page that has been activated. Visited hyperlinks are usually displayed in a unique color by a 
browser.



Visual SourceSafe
A document source-control system developed by Microsoft. FrontPage integrates with Visual SourceSafe if both 
applications are installed on the same computer.



WAIS
(Wide Area Information Service) Supports searching over the Internet.



WAN
(Wide Area Network) A computer network that spans a long distance and uses specialized computers to connect 
smaller networks.



washout
An image editing effect available in the FrontPage Editor. Applying the Washout tool to an image file creates a 
low-resolution, high-contrast version of the image. A washed-out image can be used as a watermarked 
background on your pages, without the need to make manual resolution, color, and contrast adjustments in an 
image editing program.



watermark
An image that appears on the backgrounds of pages in a Web site to decorate and identify the pages, but which 
does not scroll as the page scrolls. Not all Web browsers support watermarks.



Web browser
A client application that fetches and displays Web pages and other World Wide Web resources to the user. 
FrontPage includes Microsoft Internet Explorer, a popular Web browser.



WebBot component
A dynamic object on a page that is evaluated and executed when an author saves the page or, in some cases, 
when a user browses to the page. Most WebBot components generate HTML. Many built-in FrontPage 
components, such as Search Forms, Banner Ad Manager, and Save Results Form Handlers, are implemented as
WebBot components. The FrontPage Software Developer’s Kit (SDK) contains instructions for adding custom 
WebBot components to the FrontPage Editor.



Wizard
A FrontPage program that creates FrontPage webs and pages based on interaction with an author.



WMF
(Windows Meta File) A vector graphics format for Windows-compatible computers used mostly for word 
processing clip art.



World Wide Web
The graphical Internet hypertext service that uses the HTTP protocol to retrieve Web pages and other resources 
from Web servers. Pages on the World Wide Web usually contain hyperlinks to other pages, documents, and 
files.



WYSIWYG
(What You See Is What You Get). An editing interface in which a file being created is displayed as it will appear to
an end-user. The FrontPage Editor is a WYSIWYG editor.



Table Properties Dialog Box
Use the Table Properties dialog box to set and view properties of a table.

Dialog Box Options 

Layout
Use the options in this section to control the layout of a table.

Alignment

From the drop-down list, indicate where you want the table positioned on the page. Currently, most Web 
browsers only support aligning a table left or right.

· Default
This is the position of the table when it was created.

· Left
Positions the table on the left side of the page.

· Right
Positions the table on the right side of the page.

· Center
Positions the table in the center of the page.

Float

From the drop-down list, choose whether you want text to flow to the right of the table, left of the table, or not at 
all.

· Default
Does not allow text to flow around the table.

· Left
Positions the table against the left margin so that text can appear between the table and the right margin.

· Right
Positions the table against the right margin so that text can appear between the table and the left margin.

Border Size

Enter a number, in pixels, to add a border around a table. The default border size is one.

A border width of zero means that no table border will appear in a Web browser; however, the FrontPage Editor 
displays dotted lines around cells when border size is zero to show you the layout of the table. When you use a 
table for laying out a page, set the border size to zero so the table is invisible.

Note      To adjust the space around each cell in the table, use the Cell padding field.

Cell Padding

Enter a number, in pixels, to set the space between the contents and inside edges of cells. You can only set the 
cell padding for an entire table. The default cell padding is one.

Cell Spacing

Enter a number, in pixels, to set the spacing of the cells in a table. Cell spacing determines how much space is 
placed between all the cells in a table. You can only set the cell spacing for an entire table. The default cell 
spacing is two.

Custom Background
Use the options in this section to select a background image or color for the table.

Use Background Image

Select this option to choose a background image for a table. A table can have a different background image from 
the page containing it.



Browse

Click Browse to open the Select Background Image dialog box where you can select the table’s background 
image. 

Properties

Click Properties to open the Image Properties dialog box and edit the background image’s properties.

Background Color

Select a color from the drop-down list to be used for the background of the table. A table can have a different 
background color from the page containing it. To define a custom color, select Custom from the drop-down list. 
You can set a background image, a background color, or both.

Custom Colors
Use the options in this section to choose the colors used for the table border. You can specify two colors for a 
table border, which gives the border a three-dimensional look. Specify one color for a solid border.

Border

Select a color from the drop-down list to make the table border all one color. To define a custom color, select 
Custom from the drop-down list. When you only select a Light Border or Dark Border, the second color used for 
the border is the color selected in this field.

Light Border

Select a color from the drop-down list to be used as one of the table border colors and to produce a three-
dimensional effect. To define a custom color, select Custom from the drop-down list.

Dark Border

Select a color from the drop-down list to be used as one of the table border colors and to produce a three-
dimensional effect. To define a custom color, select Custom from the drop-down list.

Minimum Size
Use the option in this section to determine the minimum width of a table.

Specify Width

Check this box to specify a minimum width for a table. If you do not specify a width, a Web browser might resize 
the table and change how the contents of cells fit within the cells. To fix the appearance of a table on a page, 
specify a table width.

in Pixels

Select this option, then type the width of the table, in pixels. The table will not scale with the size of a Web 
browser’s window, regardless of how a user resizes the window.

in Percent

Select this option, then type a percentage for the width of the table in a Web browser’s window. For example, if 
you choose 50 percent, the table will span 50 percent of a Web browser’s window, regardless of how a user 
resizes the window. When you specify a percentage width for a table, the width of each cell in the table is the 
same. The default table width is 100 percent of the window. 

Specify Height

Check this box to specify a minimum height for a table. If you do not specify a height, a Web browser might 
resize the table and change how the contents of cells fit within the cells. To fix the appearance of a table on a 
page, specify a table height.

in Pixels

Select this option, then type the height of the table, in pixels. The table will not scale with the size of a Web 
browser’s window, regardless of how a user resizes the window.

in Percent



Select this option, then type a percentage for the height of the table in a Web browser’s window. For example, if 
you choose 50 percent, the table will span 50 percent of a Web browser’s window, regardless of how a user 
resizes the window. When you specify a percentage height for a table, the height of each cell in the table is the 
same. The default table height is 100 percent of the window. 

Apply
Click Apply to view any changes you made to a table's properties before you close this dialog box.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Cell Properties Dialog Box
Use the Cell Properties dialog box to set and view properties of a cell.

Dialog Box Options 

Layout
Use the options in this section to position the contents of a cell and create headings for a cell.

Horizontal Alignment

Select the horizontal alignment for the contents of a cell from the drop-down list:

· Default
This is the position of the cell when it was created.

· Left
Aligns the contents of a cell on the left side of the cell. Left is the default.

· Right
Aligns the contents of a cell on the right side of the cell.

· Center
Aligns the contents of a cell in the center of the cell.

Vertical Alignment

Select the vertical alignment for the contents of a cell from the drop-down list:

· Default
This is the position of the cell when it was created.

· Top
Aligns the contents of a cell at the top of the cell.

· Middle
Aligns the contents of a cell in the middle of the cell. Middle is the default.

· Baseline
Makes the baseline of text in a cell match that of the tallest text, including letters with ascenders, in the row 
containing the cell. 

· Bottom
Ends the contents of a cell at the bottom of the cell.

Header Cell

Select this option to make the text in a cell bold.

No Wrap

Select this option so Web browsers do not to wrap the text inside the cell. If this option is not selected, the text in 
the cell might be wrapped. 

Custom Background
Use the options in this section to select a background image or color for the cell.

Use Background Image

Select this option to choose a background image for the cell. A cell can have a different background image from a
table or page containing it. You can set a background image, a background color, or both.

Browse

Click Browse to open the Select Background Image dialog box where you can select the image you want for the 
cell's background. 

Properties



Click Properties to open the Image Properties dialog box and edit the background image’s properties.

Background Color

Select a color from the drop-down list to use as the background of the cell. Each cell can have a unique 
background color from the other cells.

Custom Colors
Use the options in this section to choose the colors used for the cell border. You can specify two colors for a cell 
border, which gives the cell border a three-dimensional look. Specify one color for a solid cell border. 

Border

Select a color from the drop list to make the cell border all one color. To define a custom color, select Custom. 

When you only select a Light Border or Dark Border, the second color used for the table border is the color 
selected in this field.

Light Border

Select a color from the drop-down list to use as the light border of a cell, producing more of a three-dimensional 
effect. To define a custom color, select Custom.

Dark Border

Select a color from the drop-down list to use as the dark border of a cell, producing more of a three-dimensional 
effect. To define a custom color, select Custom.

Minimum Size
Use the options in this section to determine the minimum width of a cell.

Specify Width

Check this box to specify a width for the contents of a cell. To achieve as consistent and predictable display of a 
table as possible, avoid specifying the width of a cell (or cells) to be larger than the width of a table.

in Pixels

Select this option, then type the width of the cell, in pixels.

in Percent

Select this option, then type a percentage for the width of the table. For example, if you choose 5 percent, the 
cell will span 5 percent of the table width. Your table might appear significantly different in FrontPage and a Web 
browser unless you set percentage widths for all cells in at least one row of the table.

Specify Height

Check this box to specify a height for the contents of a cell. To achieve as consistent and predictable display of a 
table as possible, avoid specifying the height of a cell (or cells) to be larger than the height of a table.

in Pixels

Select this option, then type the height of the cell, in pixels.

in Percent

Select this option, then type a percentage for the height of the table. For example, if you choose 5 percent, the 
cell will span 5 percent of the table height. Your table might appear significantly different in FrontPage and a Web
browser unless you set percentage heights for all cells in at least one row of the table.

Cell Span
Use the options in this section to change the size of a cell.

Number of Rows Spanned

Type a number to set the number of rows a cell should extend across.



Number of Columns Spanned

Type a number to set the number of columns a cell should extend across. 

Apply
Click Apply to view any changes you made to the cell's properties before you close this dialog box.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Caption Properties Dialog Box
Use the Caption Properties dialog box to set and view properties of a table's caption.

Dialog Box Options 

Top of Table
Select this option to place the caption at the top of the table.

Bottom of Table
Select this option to place the caption at the bottom of the table.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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To insert a table
Tables have columns and rows of cells that can contain text, images, forms, or other page elements. You can use
tables for laying out a page or to arrange data systematically.

To quickly create a table with the same number of cells in each row and column, using mostly default settings, 
follow the procedure below.

1 In the FrontPage Editor, move the insertion point where you want to create the table.
2 Click the Insert Table button on the standard toolbar, then drag until FrontPage displays the number of rows 

and columns you want.

To quickly create a table with irregular rows and columns, follow the procedure below.

1 In the FrontPage Editor, move the insertion point where you want to create the table.
2 On the Table menu, choose Draw Table or click the Draw Table button on the table toolbar.

3 To draw the outside border of the table, drag from the upper-left corner to the lower-right corner of the table.
4 To make cells, draw vertical and horizontal lines within the table.
5 Click the Eraser button on the table toolbar to remove any lines you do not want.

To set the properties of a table when you create it, follow the procedure below.

Note      Whenever you specify new table properties, they will appear as the new default the next time you insert a
table using the menu command or the toolbar button.
1 In the FrontPage Editor, move the insertion point where you want to create the table.
2 On the Table menu, choose Insert Table.
3 In the Rows field, specify the number of rows you want.
4 In the Columns field, specify the number of columns you want.
5 In the Alignment field, choose where you want the table positioned on the page.
6 In the Border Size field, enter how wide you want the border to be, in pixels.
7 To change the table's cell padding, enter a number in the Cell Padding field.
8 To change the table's cell spacing, enter a number in the Cell Spacing field.
9 To change the table's width, do one of the following:

· Select in Pixels, then type the width you want the table to be, in pixels.
· Select in Percent, then type a percentage of the width of the screen.

10 Click OK.
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To insert a row or column
After a table is created, you can insert rows and columns as needed.

To insert a row or column quickly, follow the procedure below.

1 In the FrontPage Editor, select a row or column. The same number of rows or columns selected will be 
inserted.

2 To insert a row above a selected row, click  on the table toolbar or choose Insert Rows on the shortcut 
menu.

To insert a column to the left of a selected column, click  on the table toolbar or choose Insert Columns on
the shortcut menu.

To have more control over where a row or column is inserted, you can use the Insert Rows or Columns 
command on Table menu.

1 In the FrontPage Editor, select a row or column.
2 On the Table menu, choose Insert Rows or Columns.
3 Choose Columns or Rows.
4 Enter the number of rows or columns you want to insert.
5 Enter the location where you want the rows or columns inserted.
6 Click OK.
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To add a table caption
You can add a title to a table to summarize its contents for a user.

1 In the FrontPage Editor, move the insertion point inside the table or select any part of the table.
2 On the Table menu, choose Insert Caption.

FrontPage inserts a caption above the first row of the table.
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To insert a cell
After a table is created, you can insert cells as needed. FrontPage inserts cells using the following rules:

· When the insertion point is in an empty cell, the cell is inserted to the left of the cell containing the insertion 
point.

· When the insertion point is in the first position of a cell containing text, image, or form, the cell is inserted to 
the left of the cell containing the insertion point.

· When the insertion point is at the right of any text, image, or form, the cell is inserted to the right of that text, 
image or form.

1 In the FrontPage Editor, move the insertion point to the cell or position in the cell based on the rules above.
2 On the Table menu, choose Insert Cell. 
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To merge cells
Note      This command is only available when two or more cells are selected, and the selected cells form a 
rectangle.
1 In the FrontPage Editor, select a row, column, or more than one cell.

2 Click  on the table toolbar or choose Merge Cells on the shortcut menu.
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To add a header cell
You can make the text in cells bold so that text can be used as a heading.

1 In the FrontPage Editor, move the insertion point inside a cell, then on the Table menu choose Cell 
Properties. You can also select a row, column, or cells.

2 Select the Header Cell option in the Layout section of the dialog box.
3 Click OK.
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To select a table or its parts
In the FrontPage Editor, you can select a table or its parts in more than one way. To delete a table or its parts, 
you must first select the table or the part you want to delete.

To select a cell

· Press ALT+CLICK in the cell. To select multiple cells, press SHIFT+CLICK. To select non-contiguous cells, press 
CONTROL+CLICK.

· Double-click the left cell padding when the  cursor is displayed.
· Place the insertion point in the cell, then on the Table menu choose Select Cell.

To select a row

· Move the pointer to the left of the row, then click the left border of the row when the  cursor is displayed. 
To select multiple rows, drag the mouse over the rows.

· Place the insertion point in the row, then on the Table menu choose Select Row.
To select a column

· Move the pointer to the top of the column, then click the top border of the column when the  cursor is 
displayed. To select multiple columns, drag the mouse over the columns.

· Place the insertion point in the column, then on the Table menu choose Select Column.
To select a table

· Move the pointer to the selection bar, then double-click.
· Place the insertion point in a cell, then on the Table menu choose Select Table.

To select a table caption

· Move the pointer to the to the left of the table caption, then click when the  cursor is displayed.
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To split cells
You can split cells into columns or rows.

1 In the FrontPage Editor, move the insertion point inside the cell you want to split or select a any group of cells.

2 Click  on the table toolbar or choose Split Cells on the shortcut menu.
3 Select Split into Columns or Split into Rows.
4 In the Number of Columns or Number or Rows field, enter the number of columns or rows into which you 
want the cells split.
5 Click OK.
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To edit a table caption
You can edit a table caption after it has been inserted.

· In the FrontPage Editor, move the insertion point in the caption where you want to make the change, then 
enter the new information.
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To change the layout of a table
You can change the layout of a table by opening the Table Properties dialog box and changing the following 
options:

· Alignment
· Border size
· Cell padding
· Cell spacing

1 In the FrontPage Editor, move the insertion point inside the table, then on the Table or shortcut menu choose 
Table Properties.

2 In the Alignment field, select the alignment you want from the drop-down list.
3 In the Float field, choose whether you want text to flow around the left or right of the table. When you choose 

Default, the text does not flow around the table.
4 In the Border Size field, enter how wide you want the border to be, in pixels.
5 In the Cell Padding field, enter how much space you want between the contents and inside edges of cells, in 

pixels.
6 In the Cell Spacing field, enter how much space you want between the cells in the table, in pixels.
7 Click OK.

{button Related Procedures,JI(`frontpg.hlp>main',`Content_Tables')}



To change the color of table borders
A table border can be one color or two colors. When you use two colors, the table border has a three-
dimensional appearance.

1 In the FrontPage Editor, move the insertion point inside the table for which you want to set border colors.
2 On the Table or shortcut menu, choose Table Properties.
3 Do one of the following:

· To have the border be one color, select a color from the Border drop-down list. To define a custom color, 
select Custom from the drop-down list.

· To have a two-color border (creating more of a three-dimensional effect), select colors from the Light 
Border and Dark Border drop-down lists. Custom colors can be defined by selecting Custom from the drop 
down lists.

Note      When you only select a Light Border or a Dark Border, the second color used for the table border is 
the color selected from the Normal drop-down list.

4 Click OK.
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To resize a table
You can quickly resize a table by dragging the bottom or right border to the height or width you want.

In the Table Properties dialog box, you can also resize a table by specifying width, height, or both; size can be in 
pixels or percent of window size. If a table is sized in pixels, its size remains constant regardless of the size of 
the window in which it displays. A table sized in percent changes depending on the size of the window in which it 
displays.

If a table does not have a width specified, Web browsers size the table to fit the content in the table cells.

1 In the FrontPage Editor, move the insertion point inside the table you want to resize.
2 On the Table or shortcut menu, choose Table Properties.
3 To specify width:

· Select Specify Width.
· Enter a number for the width.
· Select In Pixels or In Percent.

4 To specify height:
· Select Specify Height.
· Enter a number for the height.
· Select In Pixels or In Percent.

5 Click OK.
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To change the background color of table
A table can have a different background color from a page. 

1 In the FrontPage Editor, move the insertion point inside the table for which you want a background color.
2 On the Table menu, choose Select Table.

3 Click  on the table toolbar.
4 In the Color dialog box, select a color. Click Define Custom Colors to define a custom color.
5 Click OK.
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To change the layout of a cell
You can change the layout of a cell by opening the Cell Properties dialog box and changing the following options:

· Horizontal Alignment
· Vertical Alignment
· Header Cell
· No Wrap

1 In the FrontPage Editor, move the insertion point inside the table, then on the Table menu choose Cell 
Properties.

2 In the Horizontal Alignment field, select the alignment you want for the contents of the cell from the drop-down
list.

3 In the Vertical Alignment field, select the alignment you want for the contents of the cell from the drop-down 
list.

4 To make text in cells bold so the cells can be used as headings, select Header Cell.
5 Select No Wrap so the text inside cells is not wrapped by a Web browser.
6 Click OK.
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To change the background color of one or more cells
A cell can have a different background color from a table or a page. 

1 In the FrontPage Editor, select the cells for which you want a background color.

2 Click  on the table toolbar.
3 In the Color dialog box, select a color. Click Define Custom Colors to define a custom color.
4 Click OK.
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To change the color of cell borders
A cell border can be one color or two colors. When you use two colors, the cell border has a three-dimensional 
appearance.

1 In the FrontPage Editor, move the insertion point inside the cell for which you want to set border colors. Make 
sure the size of the border has been specified in the Table Properties dialog box.

2 On the Table or shortcut menu, choose Cell Properties.
3 Do one of the following:

· To have the border be one color, select a color from the Border drop-down list. To define a custom color, 
select Custom from this drop-down list.

· To have a two-color border (creating more of a dimensional effect) select colors from the Light Border and 
Dark Border drop-down lists. Custom colors can be defined by selecting Custom from the drop down lists.

Note      When you only select a Light Border or a Dark Border, the second color used for the cell border is the 
color selected from the Normal drop-down list.

4 Click OK.
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To change cell spanning
1 In the FrontPage Editor, move the insertion point in a cell or select a row or column,, then on the Table menu 

choose Cell Properties.
2 In the Number of Rows Spanned field, enter the number of rows you want the cells to span.
3 In the Number of Columns Spanned field, enter the number of columns you want the cells to span.
3 Click OK.
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To delete a table or its parts
In the FrontPage Editor, you can delete a table or its parts in more than one way. To delete a table or its parts, 
you must first select the table or the part you want to delete.

To delete a cell

1 In the FrontPage Editor, select the cell you want to delete.

2 Click  on the table toolbar.

To delete a row

1 In the FrontPage Editor, select the row you want to delete. To select multiple rows, drag the mouse.

2 Click  on the table toolbar.

To delete a column

1 In the FrontPage Editor, select the column you want to delete. To select multiple columns, drag the mouse.

2 Click  on the table toolbar.

To delete a table

1 In the FrontPage Editor, select the table you want to delete.
2 Press DELETE.

To delete a table caption

1 In the FrontPage Editor, move the pointer to the to the left of the table caption, then double-click the caption to
select it.

2 Press DELETE.
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Insert Rows Command
Use the Insert Rows command on the table toolbar to insert a row. By default, the new rows are inserted before 
(above) the current selection. As many rows as you select will be inserted. The new rows inherit the cell 
properties from the selected row, such as background color and vertical and horizontal alignment. To have more 
control over where a row is inserted, choose Insert Rows or Columns on the Table menu.

Insert Rows 
button
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Insert Columns Command
Use the Insert Columns command on the table toolbar to insert a column. By default, the new columns are 
inserted before (to the left) of the current selection. As many columns as you select will be inserted. The new 
columns inherit the cell properties from the selected column, such as background color and vertical and 
horizontal alignment. To have more control over where a column is inserted, choose Insert Rows or Columns 
on the Table menu.

Insert Columns 
button
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Background Color Command
Use the Background Color command on the table toolbar to set the background color for a cell or selected cells, 
row, column, or table. 

Note      A cell’s background color will override a table or page’s a background color. A table’s background color 
will override a page’s background color.

Background 
Color button
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To create a form
In the FrontPage Editor, you can create a new form anywhere on a page outside of an existing form.

· At the insertion point, create any form field. On the Insert menu, select Form Field and select the type of field
that you want.
FrontPage creates a new form containing the field that you selected and two Push Button fields, one for 
submitting the form and one for resetting it. If the field you created was a Push Button field, FrontPage does 
not add the additional fields.
New forms are assigned the FrontPage default form handler.
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To add a field to a form
1 In the FrontPage Editor, click in the form where you want to place the field.

Note      To create a new line in the form, press ENTER.
2 At the insertion point, create the form field. Use the Form Field command on the Insert menu or select the 

field from the forms toolbar.
3 To add accompanying text, click before or after the field and type directly into the form.
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To change a form’s handler
1 In the FrontPage Editor, right-click anywhere in the form.

2 From the shortcut menu, select Form Properties.
3 Do one of the following:

· To select the default form handler, click Send to and type a filename, e-mail address, or both.
· To select an advanced form handler, click Send to other and choose the form handler from the drop-down 

list.
4 To configure the form handler, click Options, edit the appropriate tabs, and click OK.
5 Click OK to close the Form Properties dialog box.
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To e-mail a form’s contents
You can configure the default form handler to send the contents of a form to an e-mail address.

1 Right-click anywhere in the form and choose Form Properties from the shortcut menu.
2 In the Form Properties dialog box, make sure that Send to is selected.
3 In the E-Mail Address field, type the e-mail address.

When a user submits the form, its contents will be sent to this address. E-mail must be available on the Web 
server machine for this option to work.

4 Click OK.
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To create a user-registration form
You create a user-registration form to register users for a FrontPage web. By default, all FrontPage webs on a 
Web server have the same permissions for users as the root FrontPage web. When you create a FrontPage web
that will require users to register before using it, you must open the FrontPage web and specify that it does not 
inherit its permissions from the root web but instead has its own set of permissions. 

1 In the FrontPage Explorer, open the FrontPage web for which you are registering users.
2 On the Tools menu, select Permissions.
3 In the Settings tab, select Use Unique Permissions for this Web, and click Apply.
4 In the Users tab, select Only Registered Users Have Browse Access, and click OK.
5 Open the root web on the Web server that contains the FrontPage web that requires user registration. (It is 

not necessary to save the currently opened web.)
6 From the root web, open the FrontPage Editor by clicking Show FrontPage Editor button.

7 On the FrontPage Editor’s File menu select New.
8 In the New Page dialog box, select User Registration, and click OK.

The FrontPage Editor creates a new page containing a user registration form and explanatory text. You can 
copy the form to any page in the root FrontPage web or leave it on the current page and edit the text. The 
form is labeled "Form Submission" by default. You can change its label. 
The user registration form also supplies a page that confirms the user’s user name.

9 Right-click anywhere in the user registration form.
10 From the shortcut menu, select Form Properties.
11 In the Form Properties dialog box, select Options.
12 In the Web Name field of the Registration tab of the Settings For Registration Form Handler dialog box, enter 

the name of the FrontPage web for which you are registering users and click OK.
Make sure that the registration form is accessible to users of the root web. For example, move it to the home 
page of the root web or create a hyperlink from the home page to the page containing the registration form.
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To create a discussion group
A discussion group is a FrontPage web. that supports interactive discussions of topics by users. Users submit 
topics by entering text in a form, they search the group using a search form, and they access articles using a 
table of contents.

To create a discussion group:

1 On the FrontPage Explorer’s File menu, select New and choose FrontPage Web.
2 In the New FrontPage Web dialog box, select Discussion Web Wizard and click OK.
3 In the Discussion Web Wizard dialog box, enter the Web server and FrontPage web name of your discussion 

group, and click OK.
4 If you are prompted for your name and password, enter them and click OK.
5 In the Discussion Web Wizard, select the main features of your discussion and click Next.

· A Table of Contents contains hyperlinks to the discussion topics.
· A Search Form lets users search the discussion topics for a word or phrase.
· Threaded Replies allow users the choice of either creating new top-level topics for discussions or replying 

to topics in current discussions.
·  A Confirmation Page displays a confirmation of an entry in a discussion to a user.

6 Enter a descriptive title for the discussion and click Next.
On any panel of the Discussion Web Wizard, you can click Finish to create the FrontPage discussion web 
using defaults for any settings you did not modify.

7 Select the fields you want on the input form and click Next.
The user uses the input form to submit topics to the discussion.

8 Select whether or not users will be required to register for the FrontPage discussion web and click Next.
If you select to register users, the Discussion Web Wizard will create a registration form and open it in the 
FrontPage Editor. Insert the registration form in your root FrontPage web to make it available to users.

9 Select the sort order for the table of contents and click Next.
10 Specify whether or not you want the table of contents to replace your home page and click Next.
11 Select the settings for the Search form and click Next.
12 Select color settings for all pages in the discussion web and click Next.
13 Select a frameset (if applicable) in which to display the discussion group and click Next.
14 Click Finish to accept your selections.
15 In the FrontPage Editor, open the pages created by the Discussion Web Wizard and customize them as 

needed.
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To create a one-line text box field
Use a one-line text box to accept one line of information from a user.

When a form containing a one-line text box field is submitted in a Web browser, the name and the contents of the
text box field are sent to the form handler.

1 In the FrontPage Editor, on the Insert menu, choose Form Field and select One-Line Text Box, or on the 
forms toolbar click the One-line Text Box button:

The one-line text box field is created at the insertion point. If the insertion point is inside a form, the one-line 
text box field is added to the form. To create a new form containing a one-line text box field, insert a one-line 
text box field outside of any currently defined forms.

2 Type the label of the field directly into the form.
Note      The FrontPage Editor creates one-line text box fields with default properties. Double-click the field to 
open its properties dialog box and edit any of its properties.
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To create a password field
A password field is a one-line text box. When a user types a password into the field, most Web browsers display 
the password back to the user as asterisks, to protect the confidentiality of the text.

When a form containing a password field is submitted in a Web browser, the name and the contents of the text-
box field are sent to the form handler of the form.

1 In the FrontPage Editor, choose Form Field on the Insert menu and select One-Line Text Box, or on the 
forms toolbar, click the One-line Text Box button:

The one-line text box field is created at the insertion point.
2 Click the one-line text box to select it.
3 On the Edit menu, choose Form Field Properties.
4 In the Password Field field, click Yes.
5 Click OK.
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To create a scrolling text box field
Use a scrolling text box to accept multiple lines of information from a user.

When a form containing a scrolling text box field is submitted in a Web browser, the name and the contents of the
field are sent to the form handler.

1 In the FrontPage Editor, on the Insert menu, choose Form Field and select Scrolling Text Box, or on the 
forms toolbar, click the Scrolling Text Box button:

The scrolling text box field is created at the insertion point. If the insertion point is inside a form, the scrolling 
text box field is added to the form. To create a new form containing a scrolling text box field, insert the 
scrolling text box field outside of any currently defined forms.

2 Type the label of the field directly into the form.
Note      The FrontPage Editor creates scrolling text box fields with default properties. Double-click the field to 
open its properties dialog box and edit any of its properties.
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To validate a text box field
You can set field validation rules for one-line text box and scrolling text boxes using the same method.

1 Double-click the text box field to open its properties dialog box.
2 Click Validate.
3 In the Data Type field, choose the type of data you want to allow in the field:

· No Constraints
· Text
· Integer
· Number

4 If you limited the use of the field to Text, click Letters to indicate that the field can contain alphabetic 
characters.

5 If you limited the use of the field to Text, click Digits to indicate that the field can contain numeric characters.
6 If you limited the use of the field to Text, click Whitespace to indicate that the field can contain white space 

(spaces, tabs, carriage returns, and line feeds).
7 If you limited the use of the field to Text, click Other and type in other permissible characters, such as commas

and hyphens to indicate that the field can contain these characters.
8 If you limited the use of the field to Integer or Number, you can specify a grouping character to use in the 

number or Integer by selecting it in the Grouping field:
· None indicates that no punctuation is permissible as in 123456789
· Period indicates that the period character is permissible, as in 123.456.789
· Comma indicates that the comma character is permissible, as in 123,456,789

9 If you limited the use of the field to Number, you can specify a punctuation character to use as a decimal point
by selecting it in the Decimal field:
· Period indicates that the period character is permissible for the decimal point, as in 123,456.789
· Comma indicates that the comma character is permissible for the decimal point, as in 123.456,789
Note that you cannot use the same character as both the decimal point and the grouping character.

10 For any data type, you can specify a minimum data length in the Min Length field of the Data Length section.
11 For any data type, you can specify a maximum data length in the Max Length field of the Data Length 

section.
12 For any data type, you can specify that data is required in the field by clicking Required in the Data Length 

section.
13 For any data type, you can specify a data value limit by clicking Field Must Be and choosing one of the 

following limits:
· Less than
· Greater than
· Less than or equal to
· Greater than or equal to
· Equal to
· Not equal to
and then typing a value in the Value field on the same line.
The validation rule will use numerical comparisons if the data type is Number or Integer and alphabetical order
comparisons if the data type is Text or No Constraints.

14 If you supplied a first data value limit by clicking Field Must Be, you can supply a second limit by clicking And
Must Be. Enter the second row of data value rules in the same way you entered the first row.

15 To supply a name to use when referring to the field in warning messages, type the name in the Display 
Name field.
By default, validation warning messages identify the field by its name, as entered in the Name field of the 
field’s properties dialog box. Often, the label that the user sees, which is typed directly into the form, does not 
match the field’s internal name. You use Display Name to specify the name that should be used to refer to a 
field in validation warning messages.
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To create a check box field
Use a series of check boxes to present a list of items, one or more of which can be selected by a user. 

When a form containing check boxes is submitted in a Web browser, the name of each selected check box, 
along with the value assigned to it, is sent to the form handler.

1 In the FrontPage Editor, on the Insert menu, choose Form Field and select Check Box, or on the forms 
toolbar, click the Check Box button:

The check box field is created at the insertion point. If the insertion point is inside a form, the check box field is
added to the form. To create a new form containing a check box field, insert a check box field outside of any 
currently defined forms.

2 Type the label of the field directly into the form.
Note      The FrontPage Editor creates check box fields with default properties. For example, check box fields 
are not selected by default. Double-click the field to open its properties dialog box and edit any of its 
properties.
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To create a radio button field
Use a series of radio buttons with the same name to present a list of items to a user, only one of which can be 
selected at a time.

When a form containing a set of radio buttons is submitted in a Web browser, the group name and the value 
assigned to the selected button is sent to the form handler.

1 In the FrontPage Editor, choose Insert: Form Field: Radio Button, or on the Forms toolbar, click the Radio 
Button button:

The radio button field is created at the insertion point. If the insertion point is inside a form, the radio button 
field is added to the form. To create a new form containing a radio button field, insert the field outside of any 
currently defined forms.

2 Type the label of the field directly into the form.
Note      The FrontPage Editor creates radio button fields with default properties. The first radio button you 
create in a form is given the group name "R1" and is selected by default. Each subsequent radio button that 
you create is given the group name of the radio button that immediately precedes it in the form. If no radio 
button precedes a new button, it is given the group name of the radio button that immediately follows it in the 
form. Double-click a radio button field to open its properties dialog box and edit any of its properties. To create
a set of radio buttons, repeat steps 1-2, using the same group name for each radio button.
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To validate a group of radio button fields
In the FrontPage Editor you can design a set of radio buttons that are all initially not selected. You can set a 
validation rule on the group of radio buttons (as identified by their group name) that specifies whether or not a 
user must choose one of the radio buttons in the group. If you set the validation rule for any radio button in the 
group, it applies to all radio buttons in the group.

1 Double-click any radio button field in the group to open the Radio Button Properties dialog box.
2 Click Validate.
3 To specify that a user must check one of the radio buttons in the group, click Data Required.
4 To supply a name to use when referring to the group of radio buttons in warning messages, type the name in 

the Display Name field.
By default, validation warning messages identify a field by its name, as entered in the Group Name field of the
Radio Button Properties dialog box. Often, the label that the user sees, which is typed directly into the form, 
does not match the field’s internal name. You can specify the name that should be used to refer to the field in 
validation warning messages. 
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To create a drop-down menu
Use a drop-down menu to present a list of items one or more of which can be selected from a menu or a scrolling
list. You can configure the drop-down menu to allow only one selection or many selections.

When a form containing a drop-down menu is submitted in a Web browser, the name of the form, followed by a 
list of names of the selected choices, is sent to the form handler.

The drop-down menu is created at the insertion point. If the insertion point is inside a form, the drop-down menu 
is added to the form. To create a new form containing a drop-down menu, insert a drop-down menu outside of 
any currently defined forms.

1 In the FrontPage Editor, choose Form Field on the Insert menu and select Drop-Down Menu, or on the 
forms toolbar, click the Drop-Down Menu button:

2 Click the drop-down menu field to select it, and on the Edit menu choose Form Field Properties.
3 In the Name field enter a name for the drop-down menu.

Note      The name you assign is not displayed on the form. To label a field, you type the label directly in the 
page.

4 For each menu choice that you want to add to the menu, select Add, and do the following in the Add Choice 
dialog box:
· In the Choice field, enter the name of the choice.
· To specify a value for the menu choice, click Specify Value and enter an optional value to send to the form 

handler If you specify a value, it replaces the name of the menu choice in the field's name-value pair.
· In the Initial State field, indicate the initial state of the menu choice: Selected or Not Selected.
· Click OK.
The menu items are displayed in the order in which you created them.

5 To modify the menu, do any of the following:
· To remove a selected choice, click Remove.
· To modify a selected choice, click Modify and edit the Modify Choice dialog box.
· To move a selected choice up in the menu, click Move Up.
· To move a selected choice down in the menu, click Move Down

6 In the Allow Multiple Selections field, select Yes to allow more than one menu item to be selected at a time. 
Select No to permit only one selection at a time.

7 In the Height field, set the height of the menu. Based on your selection, the menu will be displayed as follows: 
· If Height is greater than 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a 

scrollable list with full-height scroll arrows.
· If Height is greater than 1 and Allow Multiple Selections is No, most Web browsers display the menu as a 

scrollable list.
· If Height is 1 and Allow Multiple Selections is No, most Web browsers display the menu as a drop-down 

list.
· If Height is 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a scrollable list 

with half-height scroll arrows. This type of menu may be difficult to use.
8 Click OK.
9 Type the label of the menu into the form.
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To validate a drop-down menu field
There are two sets of validation rules for drop-down menu fields. One set applies to fields that allow multiple 
selections and the other set applies to fields that allow zero or one selection.

1 Double-click the drop-down menu field to open the Drop-Down Menu Properties dialog box.
2 Click Validate.

If you configured the drop-down menu field to allow multiple selections, you can set a validation rule that 
specifies either a minimum or maximum number of choices or both.

3 To specify a minimum number of choices, type the number in the Minimum Items field.
4 To specify a maximum number of choices, type the number in the Maximum Items field.
5 To require at least one item to be selected, click Data Required.
6 To prohibit users from selecting the first item in the drop-down menu, click Disallow First Item.

A common trick in drop-down menus is to make the first choice an instruction, not an actual choice. You can 
set a validation rule for either single or multiple-choice drop-down menu fields that prohibits a user from 
selecting the first item on the menu. 

7 To supply a name to use when referring to the field in warning messages, type the name in the Display Name 
field.
By default, validation warning messages identify the field by its name, as entered in the Name field of the 
Drop Down Menu Properties dialog box. Often, the label that the user sees, which is typed directly into the 
form, does not match the field’s internal name. You can specify the name that should be used to refer to the 
field in validation warning messages. 
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To create a push button field
Use a push button field to let users submit or reset a form. When a form is submitted, its data is passed to a form
handler. 

You can insert more than one push button on a single form. If you do this, assign each push button a distinct 
name. When the form is submitted in a Web browser, the name of the selected button, along with its label, is 
passed to the form handler of the form as a name-value pair.

1 In the FrontPage Editor, choose Form Field on the Insert menu and select Push Button, or on the forms 
toolbar click the Push Button button.

The push button field is created at the insertion point. If the insertion point is inside a form, the push button 
field is added to the form. If the insertion point is outside a form, a new form is created when you insert the 
push button field.

2 To label the push button on the page, type a label next to the push button in the form.
Note      The FrontPage Editor creates push button fields with default properties. Double-click the field to open 
its properties dialog box and edit any of its properties.
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To copy a form field
1 In the FrontPage Editor, click the field to be copied.
2 On the Edit menu, choose Copy.
3 Click where you want to paste a copy of the field.
4 On the Edit menu, choose Paste.
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Color Dialog Box
The color dialog box contains controls that let you select and create custom colors.

Dialog Box Options

Basic Colors
The Basic Colors grid displays up to 48 colors. The actual number of colors displayed is determined by your 
computer’s graphics adapter and display driver.

Custom Colors
You can create up to 16 custom colors. Each custom color is displayed in the Custom Colors grid.

Define Custom Colors
You can define custom colors using one of the following methods:

· Specify red, green, and blue values using the Red, Green and Blue edit fields, by entering a number between 
0-255.

· Specify hue, saturation, and luminosity values using the Hue, Saturation, and Luminosity edit fields, by 
specifying a number between 0-255.

· To set hue and saturation values, click and drag the mouse across the color spectrum field at the upper right 
of the dialog box. To set the luminosity value, move the triangle up or down in the vertical color bar to the right 
of the color spectrum field.

Color/Solid
This field displays the dithered and solid colors that correspond to your selection.

Add to Custom Colors
When you are satisfied with your choice of custom colors, click Add to Custom Colors to display the new color in 
the selected rectangle.
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Save As Template Dialog Box
Use the Save As Template dialog box to create the required folder, file name, and page title for a page    template.
A template folder can only contain one template file. All page templates are stored in the \Microsoft FrontPage\
Pages folder. The templates you create appear in the list of available templates in the New Page dialog box 
alongside the templates included with FrontPage.

If the template includes an image from your file system, and you modify that image for the template, the Save 
Embedded Files dialog box is displayed. This dialog box gives you the option of saving each changed image to 
the same folder as the page or to a different folder that you specify.

To replace an existing template with the page you created, accept the title and name displayed in the Save As 
Template dialog box or click Browse to select another title and name in the Templates dialog box.

Dialog Box Options

Title
Enter a page title for the template. This title appears in the Template or Wizard field in the New Page dialog box. 
The title of the template or page on which you based the new page is displayed in this field when the dialog box 
opens.

Name
Enter a name for the template's folder and file name. The name of the template or page on which you based the 
new page is displayed in this field when the dialog box opens.

Description
Describe the template you are creating. The description of the template on which you based the new page is 
displayed in this field when the dialog box opens.

Browse
Choose Browse to select the title and name of an existing template from the Templates dialog box. 
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Templates Dialog Box
Use the Templates dialog box to select the title and name of the existing template you want to change.

Dialog Box Options

Title
The page title of the template.

Name
The name of the template's folder and file name.
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Cut Command
Use the Cut command to remove selected items from the page and move them to the clipboard, replacing the 
clipboard's current contents. You can cut any items on the page, such as text, images, bookmarks, forms, or 
FrontPage components. If you then paste the contents of the clipboard into another application, only the text is 
pasted. If you paste into another FrontPage Editor window, all formatting, FrontPage components, forms, and 
other FrontPage page elements are pasted.

The FrontPage Editor may reformat your page after you cut items. For example, it will renumber a list when 
elements are cut from it.

When you cut text, its character attributes, such as bold and underlined, are retained on the clipboard. If the 
selection includes a paragraph break, the paragraph style of the paragraph is also retained.

You can also cut selected items by clicking the Cut button on the FrontPage Editor’s Standard toolbar.

Cut button
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Copy Command
Use the Copy command to copy selected items from the page and place them on the clipboard, replacing the 
clipboard's current contents. You can copy most selected items on the page, such as text, images, bookmarks, 
forms, or FrontPage components. If you then paste into another application, only the text is pasted. If you paste 
into another FrontPage Editor window, all formatting, FrontPage components, forms, and other FrontPage 
objects are pasted.

When you copy text, the character attributes, such as bold and underlined, are retained on the clipboard. If the 
selection includes a paragraph break, the paragraph style of the paragraph is also retained.

You can also copy selected items by clicking the Copy button on the FrontPage Editor’s Standard toolbar.

Copy button

{button Related Procedures,JI(`frontpg.HLP',`Contents_Text')}



Paste Command
Use the Paste command to place the contents of the clipboard at the insertion point. If there are currently 
selected items, they are overwritten.

When you paste text, some of its character attributes may be overridden. For example, when you paste text into 
a paragraph with a larger point-size, the pasted text is enlarged to match the size of the text in the paragraph.

If you paste a paragraph into another paragraph, the paragraph on the page is split into two paragraphs, and the 
pasted paragraph is inserted between those paragraphs. Pasting paragraphs may have other unintended effects,
such as renumbering lists.

You can paste the following types of images from the clipboard: GIF, JPEG, BMP (Windows and OS/2), TIFF, 
RAS, EPS, PCX, WMF, and TGA When you paste an image, it is automatically added to the FrontPage web 
when you save the page on which it is inserted. When you paste an image that is not in the GIF or JPEG format, 
it is first converted to the GIF format (for images with 256 or fewer colors) or the JPEG format (for images with 
more than 256 colors).

When you paste text from another application, FrontPage retains as much of the original formatting as 
possible ¾ this includes converting Microsoft Excel or Microsoft Word tables into HTML tables. To import entire 
files from other applications, use the Insert: File command in the FrontPage Editor; the files are automatically 
converted to HTML.

You can also paste from the clipboard by clicking the Paste button on the FrontPage Editor’s Standard toolbar.

Paste button
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Spelling Command
Use the Spelling command to check the spelling in the active page. In the Spelling dialog box, the command 
displays each misspelled word it finds. You can ignore the word, ignore all instances of the word, change the 
word, change all instances of the word, or add the word to your custom dictionary.

You can also run the Spelling command by clicking the Check Spelling button on the standard toolbar.

Check Spelling
 button

Note      The Spelling command does not check the spelling in a file that is included on the page by an Include 
Page component. To check the spelling in an included file, you must first open the file.

Dialog Box Options

Not in dictionary
Displays the misspelled word.

Change to
Displays a proposed correction. Type in this field to supply your own correction or pick a correction from the list of
Suggestions.

Suggestions
Lists possible corrections.

Ignore
Click Ignore to ignore the current word and continue.

Ignore All
Click Ignore All to ignore all instances of the current word and continue.

Change
Click Change to correct the current misspelled word using the text in the Change To field, then continue.

Change All
Click Change All to correct all instances of the current misspelled word using the text in the Change To field, then
continue.

Add
Click Add to leave the word unchanged and add it to the custom dictionary.

Cancel
Click Cancel to exit the spelling checker. This does not undo any corrections to the page or additions to the 
custom dictionary.
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Spelling Command
Use the Spelling command to check the spelling of the HTML    pages in the current FrontPage web. In the 
Spelling dialog box, you can choose whether you want to check spelling in all pages or only selected pages. You 
select pages for spell checking in the Folders View, the All Files View, and in the folders pane of the Navigation 
View.

After FrontPage checks spelling, the Dialog Box Options for Web Results displays to show the results of the 
spelling check and to give you the option of editing the pages with misspelled text.

You can also execute the Spelling command by clicking the Spelling button on the toolbar.

Cross File Spelling 
button

Dialog Box Options

All Pages
Select this option to have all pages in the current FrontPage web checked for spelling.

Selected Pages
Select this option to have only selected pages in the current FrontPage web checked for spelling.

Add a Task for Each Page With Misspellings
Select this option to add a task to the list in the Tasks View to correct pages with misspellings.

Cancel
Click Cancel to exit the spelling checker. This does not undo any corrections to a page.
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Find Command
Use the Find command to search for specified text in pages in the current FrontPage web.

After FrontPage finishes the search, the Dialog Box Options for Web Results displays to show the results of the 
search and to give you the option of editing those pages.

You can also execute the Find command by clicking the Find button on the toolbar.

Cross File Find 
button

Dialog Box Options 

Find What
Enter the text string FrontPage should search for.

Match Whole Word Only
Finds text only if it matches a whole word.

Match Case
Finds text only if it matches the capitalization of the search text in the Find What field.

All Pages
Select this option to search all pages in the current FrontPage web.

Selected Pages
Select this option to search only in selected pages in the current FrontPage web. Before beginning the search, 
select pages for searching in the Folders view or All Files view.

Cancel
Click Cancel to exit the Find command. 
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Replace Command
Use the Replace command to search for text and replace it with alternate text. You enter the text to be found and 
the text to replace it with in the Replace in FrontPage Web dialog box.

The Replace command can be case-sensitive, can replace whole words only, or can replace any text.

After FrontPage finishes the search, the Dialog Box Options for Web Results is displayed to show the results of 
the search and give you the option of editing those pages.

Dialog Box Options 

Find What
Enter the text string FrontPage should search for.

Replace With
Enter the replacement text.

Match Whole Word Only
Find text only if it matches a whole word.

Match Case
Finds text only if it matches the capitalization of the search text in the Find What field.

All Pages
Select this option to search all pages in the current FrontPage web.

Selected Pages
Select this option to search only selected HTML pages in the current FrontPage. Before beginning the search, 
select pages for searching in the Folder view or All Files view.

Cancel
Click Cancel to exit the Replace command. This does not undo any replacements that have already been made.
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To create a text hyperlink to a page or file in the current FrontPage web
1 In the FrontPage Editor, select text that will identify the hyperlink.
2 On the Insert menu choose Hyperlink, or click the Create or Edit Hyperlink button.

3 In the Create Hyperlink dialog box, click a page or file to make it the target of the hyperlink. To browse the 
contents of a folder, double-click it.

4 To link to a bookmark on the page you selected, type the name of the bookmark in the Bookmark field. You 
can create a hyperlink to a bookmark on an open page by first selecting the page and then choosing its 
bookmark from the list in the Create Hyperlink dialog box.

5 If you want the page that is the target of the hyperlink to appear in a frame in a frameset, select the frame in 
the Target Frame field.

6 Click OK.
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To create a text hyperlink to a new page
You can create a text hyperlink to a new page. FrontPage first creates the new page and then creates a hyperlink
to it.

1 In the FrontPage Editor, select text that will identify the hyperlink.
2 On the Insert menu choose Hyperlink, or click the Create or Edit Hyperlink button.

3 In the Create Hyperlink dialog box, if you want the page that is the target of the hyperlink to appear in a frame 
in a frameset, select the frame in the Target Frame field.

4 Click the New Page button.

5 In the Page tab of the New dialog box, select the template to use to create the new page.
6 To create the new page and add a task to the FrontPage Explorer’s Tasks view reminding you to finish the 

page later, click Just add web task.
7 Click OK.
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To create a text hyperlink to a page on the World Wide Web
1 In the FrontPage Editor, select text that will identify the hyperlink.
2 On the Insert menu choose Hyperlink, or click the Create or Edit Hyperlink button.

3 In the Create Hyperlink dialog box, click the World Wide Web button.

Your Web browser will be displayed.
4 In your Web browser, go to the page or file that you want to be the target of your hyperlink, and type ALT+TAB 

to return to the FrontPage Editor.
The location of the page you visited will be in the URL field.

5 If you want the page that is the target of the hyperlink to appear in a frame in a frameset, select the frame in 
the Target Frame field.

6 Click OK.
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To create a text hyperlink from the FrontPage Explorer
You can create a text hyperlink from an open page in the FrontPage Editor to another page in your FrontPage 
web using the FrontPage Explorer.

1 In the FrontPage Explorer, in the Folders, All Files, Navigation, or Hyperlinks view, select the page or file to 
which you want to create a hyperlink by clicking and holding the left mouse button.

2 Drag the page or file from the FrontPage Explorer to the FrontPage Editor.
If the FrontPage Editor is minimized, drag over the FrontPage Editor tile in the Windows task bar, pause for a 
moment, and the FrontPage Editor will be activated.

3 Move the pointer to the line at which you want to create the hyperlink and release the left mouse button.
FrontPage creates a hyperlink to the page or file.
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To follow a text hyperlink forward
· Hold down CTRL and click on the hyperlink, or click in the hyperlink and choose Follow Hyperlink from the 

shortcut menu.
The FrontPage Editor opens the target page for editing and makes it the active page. If the hyperlink points to a 
bookmark, the FrontPage Editor will scroll to that bookmark.

If the target page is not in the current FrontPage web, FrontPage opens a copy of the page. You can save the 
copy of the page, including all images and other objects on the page, to the current FrontPage web or to a file.
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To change a text hyperlink
1 In the FrontPage Editor, place the pointer anywhere in the text containing the hyperlink or select any part of 

the hyperlink.
2 To change the text of the hyperlink, edit it in place.
3 To change the target of the hyperlink, on the Edit menu choose Hyperlink, or click the Create or Edit 

Hyperlink button.

4 Edit the hyperlink in the Edit Hyperlink dialog box.
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To create a bookmark
1 In the FrontPage Editor, optionally select one or more characters of text.
2 On the Edit menu, choose Bookmark.
3 In the Bookmark Name field, enter the name of the bookmark, or accept the name that FrontPage suggests. 

You can include spaces in the bookmark name.
4 Click OK.
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To visit a bookmark
You can visit a bookmark on the current page without creating a hyperlink to it. You can visit a bookmark on 
another page if there is a hyperlink to that bookmark from the current page. 

1 To visit a bookmark on the current page, in the FrontPage Editor’s Edit menu, choose Bookmark.
2 In the Other Bookmarks on this Page field, select the bookmark to visit.
3 Click Goto.

The FrontPage Editor displays the page at the bookmark that you selected.
4 Close the Bookmark dialog box by clicking OK or Cancel.
To visit a bookmark on another page, in the FrontPage Editor, place the pointer anywhere in a hyperlink to a 
bookmark and choose Follow Hyperlink on the shortcut menu. The FrontPage Editor displays the new page at 
the bookmark. 

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Link_Bookmark')}



To check the status of hyperlinks
· On the FrontPage Explorer’s View menu, choose Hyperlink Status.

The Hyperlink Status view becomes active and the status of each hyperlink is displayed:
· OK indicates that the hyperlink is good.
· Broken indicates that the hyperlink is bad. 
· Unknown indicates that the hyperlink is external and has not been verified yet. To verify the hyperlink, 

select it, and choose Verify on the shortcut menu.
· Added task indicates that the hyperlink is either broken or has not been verified yet, and a related task has 

been added to the list in the Tasks view.
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To verify external hyperlinks
An external hyperlink is a hyperlink to a page or file outside the current FrontPage web. To verify external 
hyperlinks:

1 On the FrontPage Explorer’s View menu, choose Hyperlink Status.
2 To select a set of hyperlinks to verify, use CTRL+CLICK (for non-adjacent hyperlinks) or SHIFT+CLICK (for a 

range of hyperlinks).
3 On the FrontPage Explorer’s Tools menu, choose Verify Hyperlinks.
4 Click Verify Selected Hyperlinks or Verify All Hyperlinks.

Each hyperlink is verified in sequence. The status of each hyperlink is displayed in the Hyperlink Status view:
· OK indicates that the hyperlink has been checked and is good.
· Broken indicates that the hyperlink has been checked and is bad.
· Verifying indicates that the hyperlink is currently being verified.
· Added task indicates that the hyperlink is either broken or has not been checked yet, and a related task 

has been added to the list in the Tasks view.
5 To stop verifying hyperlinks, click the Stop button on the FrontPage Explorer’s toolbar. Then, to continue 

verifying hyperlinks, choose Verify Hyperlinks on the Tools menu and select Resume Verification.
Note      You can also check the status of internal hyperlinks, which are verified automatically, in the Hyperlink 
Status view.
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To insert an image from a file
When you insert an image from a file, the FrontPage Editor prompts you to import the image to your FrontPage 
web when you save the page.

You can insert the following types of images: GIF, JPEG (standard and progressive), BMP (Windows and OS/2), 
TIFF, TGA, RAS, EPS, PCX, and WMF.

When you insert an image that is not in the GIF or JPEG format, it is automatically converted to the GIF format 
(for images with 8 bits or less of color) or the JPEG format (for images with more than 8 bits of color).

1 In the FrontPage Editor, click the page where you want to insert the image.
2 On the Insert menu, choose Image.
3 In the Image dialog box, click the From File button.

4 In the Select File dialog box, use the Look In box and the box that lists files and folders to point to the file and 
folder where the image is stored. Choose a file type from the Files of Type drop-down field to list all the files of
that type. Select the image you want to insert, and then click OK.
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To insert an image from the current FrontPage web
You can insert the following types of images: GIF, JPEG (standard and progressive), BMP (Windows and OS/2), 
TIFF, TGA, RAS, EPS, PCX, and WMF.

When you insert an image that is not in the GIF or JPEG format, it is automatically converted to the GIF format 
(for images with 8 bits or less of color) or the JPEG format (for images with more than 8 bits of color).

1 In the FrontPage Editor, click the page where you want to insert the image.
2 On the Insert menu, choose Image.
3 In the Image dialog box, select an image to insert it. To browse the contents of a folder, double-click it.
4 Click OK.
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To insert an image from the World Wide Web
When you insert an image from the World Wide Web, the image is always retrieved from its specified location; 
you are not prompted to import the image to the current FrontPage web.

You can insert the following types of images: GIF, JPEG (standard and progressive), BMP (Windows and OS/2), 
TIFF, TGA, RAS, EPS, PCX, and WMF.

Note      If your computer is located behind a firewall, you must first specify your proxy server in the Proxies tab of
the FrontPage Explorer’s Options dialog box before you can insert images directly from the World Wide Web.

1 In the FrontPage Editor, place the insertion point on the page where you want to insert the image.
2 On the Insert menu, choose Image.
3 Click the World Wide Web button.

This opens your Web browser.
4 In your Web browser, type the exact location and name of the image that you want to insert (for example, 

http://www.microsoft.com/sample.gif), then press ENTER to display the image.
5 Return to the Image dialog box and click OK to insert the image.
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To import an image to a FrontPage web
When you import an image, you place a copy of it in your FrontPage web. To quickly import one or more images 
to the current FrontPage web, drag them from your desktop into the Folders, All Files, Navigation, or Hyperlinks 
view of the FrontPage Explorer. To import images to an import list, from which you can rename them and import 
them into the FrontPage web, do the following:

1 In the FrontPage Explorer, on the File menu, choose Import.
2 To add an image to the import list, click Add File. In the Add File to Import List dialog box, use the Look In box 

and the box that lists files and folders to point to the folder where the image is stored. Select the image, and 
click Open.
To add the entire contents of a folder to the import list, click Add Folder. In the Browse For Folder dialog box, 
locate and select the folder, and click OK.

3 To change the URL of any image before importing it, either to rename it or to change the image’s directory in 
the FrontPage web, click Edit URL to open the Edit URL dialog box.
In the File location within your FrontPage web field, type a URL relative to the root of the current FrontPage 
web. For example, if you type the URL images/picture.gif, the image will be saved in the folder images below 
the root folder of the current FrontPage web. After changing the URL, click OK.

4 To import the images and other files on the import list to the FrontPage web, click OK. While files are being 
imported, you can stop the process by clicking Stop.
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To create a circular hotspot
A hotspot is a region on an image that is a hyperlink.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Click the Circle button.

3 Point inside the image.
The pointer becomes a pencil.

4 Point to the center of the circular hotspot you want to create.
5 Drag the circular hotspot until it is the size you want. 

When you release the mouse button, the Create Hyperlink dialog box opens.
6 In the Create Hyperlink dialog box, specify the target of the hyperlink.
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To create a rectangular hotspot
A hotspot is a region on an image that is a hyperlink.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Click the Rectangle button.

3 Point inside the image. 
The pointer becomes a pencil.

4 Point to the first corner of the rectangle you want to create, then click.
5 Drag the rectangle until it is the size you want. 

When you release the mouse button, the Create Hyperlink dialog box opens.
6 In the Create Hyperlink dialog box, specify the target of the hyperlink.
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To create a polygonal hotspot
A hotspot is a region on an image that is a hyperlink.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Click the Polygon button.

3 Point inside the image.
The pointer becomes a pencil.

4 Click where you want the first corner of the polygon to be, then click to place each corner of the polygon. 
5 Double-click to finish the polygon.

The Create Hyperlink dialog box opens.
6 In the Create Hyperlink dialog box, specify the target of the hyperlink.

{button Related Procedures,AL(`image link procedures',0,`',`main')}



To create a text hotspot
You can create a text hotspot on a GIF image.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Click the Text button on the Image toolbar.

A rectangular region appears on the image with a cursor in it.
3 Type the text you want.

You can type a single line of text only.
4 To wrap the text, resize the text region by clicking and dragging its resize handles. Move the region by clicking

and dragging any border.
5 Double-click an edge of the rectangle.

The Create Hyperlink dialog box opens.
6 In the Create Hyperlink dialog box, specify the target of the hyperlink.
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To select a hotspot
1 In the FrontPage Editor, click the image. 

The hotspots become visible.
2 Click a hotspot to select it or drag over a portion of the image to select more than one hotspot.
3 Use TAB and SHIFT+TAB to move between hotspots.
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To set an image's default hyperlink
An image's    default hyperlink is the target of a hyperlink for any area that does not have a hotspot.

1 Click the image to select it.
2 On the Edit menu, choose Image Properties.
3 In the General tab, enter the default hyperlink’s target as a URL in the Location field or click Browse to specify

the default hyperlink’s target in the Create Hyperlink dialog box.
4 After creating the hyperlink, click OK to close the Image Properties dialog box.
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To edit an image
· From the FrontPage Editor or Explorer, double-click an image to open it in its associated image-editing 

program.
· In the FrontPage Editor, select the image and use any of the image editing commands on the image toolbar.
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To add text to an image
1 In the FrontPage Editor, select an image.

The image toolbar automatically displays when you select an image.
2 Click the Text button on the image toolbar.

If the image is a JPEG image, the FrontPage Editor prompts you to convert the image to GIF format, because 
text is not supported on JPEG images. If FrontPage converts the image, the number of colors in the image 
may be reduced and the image file may become larger.

3 Type the text into the rectangular region that is displayed on the image.
4 Resize the text region by clicking and dragging its resize handles or move the region by clicking and dragging 

any border.
Adding text to an image does not change the image file in your FrontPage web.
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To insert clip art
FrontPage includes the Microsoft Clip Gallery, a tool for previewing and inserting clip art, pictures, sounds, video 
clips, and animations.

1 In the FrontPage Editor, click the page where you want to insert the clip art.
2 On the Insert menu, choose Clipart.

This opens the Microsoft Clip Gallery.
3 In the Clip Gallery select an image, picture, sound file, or video, and click Insert.
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To make a color in an image transparent 
Making a color in an image transparent lets the background of the page show through the image where that color
was. An image can have only one transparent color. If an image already has a transparent color, selecting a new 
transparent color returns the current transparent color to its original color.

1 In the FrontPage Editor, select an image.
The image toolbar automatically displays when you select an image.

2 Click the Make Transparent button. 

The pointer changes to the Make Transparent pointer.
3 In the image, click a color to make transparent.

If the image is a JPEG image, the FrontPage Editor prompts you to convert the image to GIF format, because 
transparency is not supported in JPEG images. If FrontPage converts the image, the number of colors in the 
image may be reduced and the image file may become larger.
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To crop an image
When you crop an image, you exclude all parts outside of a rectangular area.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Click the Crop button on the image toolbar.

FrontPage displays a cropping rectangle superimposed over the image.
3 Resize the cropping rectangle and press Enter.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Images')}



To resample an image
Resampling an image, changes the file size of the image to match the current size in which it is displayed. You 
can resample an image to a larger or smaller size.

1 In the FrontPage Editor, select the image.
The image toolbar automatically displays when you select an image.

2 Select one of the resizing handles and stretch or shrink the image.
3 Click the Resample button on the image toolbar.
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To convert an image to black and white
1 In the FrontPage Editor, select the image.

To convert the page  ’  s   background image you do not need to select it.
2 Click the Black and White button on the image toolbar.
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To rotate an image
1 In the FrontPage Editor, select the image.

To rotate the page  ’  s   background image you do not need to select it.
2 Do one of the following:

· To rotate an image 90 counter-clockwise, click Rotate Left on the image toolbar.

· To rotate an image 90 clockwise, click Rotate Right on the image toolbar.

· To turns an image upside-down, click Flip on the image toolbar.

· To reverse an image sideways, click Reverse on the image toolbar.
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To adjust an image’s contrast
1 In the FrontPage Editor, select the image.

To adjust the page  ’  s   background image you do not need to select it.
2 Do one of the following:

· To increase contrast, click More Contrast on the image toolbar.

· To decrease contrast, click Less Contrast on the image toolbar.

Continue using these buttons until the contrast is correct.
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To adjust an image’s brightness
1 In the FrontPage Editor, select the image.

To adjust the page  ’  s   background image you do not need to select it.
2 Do one of the following:

· To increase brightness, click More Brightness on the image toolbar.

· To decrease brightness, click Less Brightness on the image toolbar.

Continue using these buttons until the brightness is correct.
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To washout an image
Washing out an images reduces its brightness and contrast. This is especially useful for page -background 
image.

1 In the FrontPage Editor, select the image.
To washout the page’s background image you do not need to select it.

2 Click the Washout button on the image toolbar.
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To add a beveled edge to an image
A beveled edge slants the border of an image, producing a three-dimensional effect.

1 In the FrontPage Editor, select the image.
To bevel the page  ’  s   background image you do not need to select it.

2 Click the Bevel button on the image toolbar.
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To reset an image
If you do not like the results of one or more image-editing commands, you can undo them. This undoes all 
image-editing commands that have been applied to the image since the last time it was saved or, for a new 
image, since it was inserted on the page.

1 In the FrontPage Editor, select the image.
To reset the page’s background image you do not need to select it.

2 Click the Restore button on the image toolbar.
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To create a thumbnail image
A thumbnail image is a small version of an image on a page. that contains a hyperlink to a full-size version of the 
same image.

1 In the FrontPage Editor, select the image.
2 On the Tools menu, choose AutoThumbnail.

FrontPage creates the thumbnail image, inserts it in place of the larger image, and creates a hyperlink to the 
full-sized image from the thumbnail image.
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About Microsoft FrontPage Editor Command
Use the About Microsoft FrontPage Editor command to view the version number, product identification number, 
and other information about your copy of the FrontPage Editor.

Dialog Box Option

System Info
Click System Info to open the Microsoft System Information where you can get information about your computer-
system’s configuration.



About Microsoft FrontPage Explorer Command
Use the About Microsoft FrontPage Explorer command to view the version number, product identification number,
and other information about your copy of the FrontPage Explorer.

Dialog Box Option

Network Test
Click Network Test to open the FrontPage TCP/IP Test dialog box. Click Start Test to have FrontPage check if 
you have a compliant TCP/IP stack and determine your host name and IP address.

System Info
Click System Info to open the Microsoft System Information where you can get information about your computer-
system’s configuration.



Marquee Command
Use the Marquee command to insert a region for animated text on the active page. Marquees are useful for 
drawing the user's attention to a line of text, such as a headline or an important announcement.

A marquee will be inserted at the insertion point on the page after the properties have been set in the Marquee 
Properties dialog box. To view the text movement of the marquee as it will appear when the page is browsed on 
the World Wide Web, choose Preview in Browser on the File menu in the FrontPage Explorer.

Note      Some Web browsers cannot display marquees. A normal line of text will be substituted in place of the 
marquee.

Dialog Box Options

Text
Enter the text that is to be animated with a marquee. If text was selected on the active page when you chose the 
Marquee command, it will be display it in the Text field.

To change the font’s properties, select the marquee and use the format toolbar to customize the font.

Direction
Choose the direction in which the animated marquee text will move.

Left

This option causes marquee text to move from the right to the left window border.

Right

This option causes marquee text to move from the left to the right window border.

Movement Speed
Choose the speed at which the marquee text will move.

Delay

This option specifies the delay, in milliseconds, before the marquee text will begin to move.

Amount

This option specifies the amount of movement, in pixels, by which the marquee text will move.

Behavior
Choose the type of motion that will be used to animate the marquee text.

Scroll

Similar to a stock ticker, this option causes the marquee text to continuously scroll across the screen, in the 
direction you specify.

Slide

This option causes marquee text to slide into view from the starting direction to the opposite window border. 
When the end of the defined marquee region is reached, the marquee text remains on the screen.

Alternate

This option causes marquee text to alternate back and forth, from the starting direction to the opposite window 
border. The marquee text remains on the screen at all times.

Align With Text
Choose this option to specify how the marquee region should be aligned with normal text.

Top



This options aligns marquee text with the top of normal text.

Middle

This options aligns marquee text with the middle of normal text.

Bottom

This options aligns marquee text with the bottom of normal text.

Size
By default, the dimensions of the marquee region are determined by the size of its text. You can override this 
default by specifying the exact height and width of a marquee.

Specify Width

This option lets you specify the exact width of the rectangular region that the marquee will occupy on the screen. 
The value you enter can be specified in pixels or in a percentage. Specifying pixels will define the marquee width 
precisely, whereas specifying a percentage will cause the exact width of the marquee to be dependent on the 
size of the user's Web browser window and screen resolution.

Note      If you choose a background color in the Marquee Properties dialog box, you will be able to see the exact 
size and shape of the marquee region.

Specify Height

This option lets you specify the exact height of the rectangular region that the marquee will occupy on the screen.
The value you enter can be specified in pixels or in a percentage. Specifying pixels will define the marquee 
height precisely, whereas specifying a percentage will cause the exact height of the marquee to be dependent on
the size of the user's Web browser window and screen resolution.

Note      If you choose a background color in the Marquee Properties dialog box, you will be able to see the exact 
size and shape of the marquee region.

Repeat
Choose a repeat option if you want the behavior of the marquee text to repeat the specified scrolling, sliding, or 
alternating effect.

Continuously

Select this option if you want the marquee text to keep repeating its specified behavior for as long as the page is 
displayed in the user's Web browser window.

Times

Select this option if you want the marquee text to repeat its specified behavior a specific number of times while 
the page is displayed in the user's Web browser window. The default setting is 1, which means that the behavior 
will occur only once and without repetition.

Background Color
Choosing a background color fills the defined marquee region with the specified color. This is useful for visually 
defining the region of the marquee, as well as for offsetting the marquee text from the rest of the page.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Delete Command
Use the Delete command to delete a selected page, file, folder, or task while you are in the FrontPage Explorer. If
there are hyperlinks to that page, they will be broken. When you delete a page, file, folder or task, it cannot be 
recovered.

You can also delete items by clicking the Delete button on the toolbar.

Delete button
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Cut Command
Use the Cut command in the following FrontPage Explorer views:

· Folders View or All Files view 
In these views, use the Cut command when you want to relocate selected files or folders. When the icons of 
the selected items are dimmed, use the Paste command to place the files or folders in the target folder.

· Navigation view 
In this view, use the Cut command when you want to relocate a selected page in the view. If a page has child 
pages and you cut the parent page., all the pages (parent and child) will be cut. Use the Paste command to 
place the cut page(s) where you want them in the view.

If you cut a selected file and paste it in another Windows application, only the absolute URL of the file is pasted 
— not the contents of the file.

You can also cut items by clicking the Cut button on the toolbar.

Cut button
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Copy Command
Use the Copy command in the following FrontPage Explorer views:

· Folders view 
In this view, use the Copy command when you want to copy selected files or folders to a different folder. Use 
the Paste command to place the files or folders in the target folder.

· All Files view
In this view, use the Copy command when you want to copy selected files to the root folder of the FrontPage 
web. Use the Paste command to place the files in the root folder of the web.

· Navigation view 
In the Navigation pane of this view, use the Copy command when you want to copy a selected page in the 
view. If a page has child pages and you copy the parent page., all the pages (parent and child) will be copied. 
Use the Paste command to place the copied page(s) where you want them in the view.
In the Files pane of this view, use the Copy command when you want to copy selected files or folders to a 
different folder. Use the Paste command to place the files or folders in the target folder. 

· Hyperlinks view 
In this view, use the Copy command to copy a page that you want to paste to another view.

· Tasks view
In this view, if you copy a selected page from another view and paste it into the Task view, FrontPage creates 
a new task linked to that page.
If you copy a selected file and paste it in another Windows application, only the absolute URL of the file is 
pasted — not the contents of the file.

You can also copy items by clicking the Copy button on the toolbar.

Copy button
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Paste Command
Use the Paste command in the following FrontPage Explorer views:

· Folders vew 
In these views, use the Paste command to place cut or copied files or folders in the selected target folder. If 
the file has hyperlinks, they will be preserved.

· All Files view 
In this view, use the Paste command to place cut or copied files in the current root folder. If the file has 
hyperlinks, they will be preserved.

· Navigation view
In the Navigation pane of this view, use the Paste command to place cut or copied pages where you want 
them in the view.
In the Files pane of this view, use the Paste command to place the files or folders in the target folder. 

· Tasks view
In this view, use the Paste command to create a new task linked to a page that you copied from another view.

If you cut a selected file and paste it in another Windows application, only the absolute URL of the file is pasted 
— not the contents of the file.

You can also paste items by clicking the Paste button on the toolbar.

Paste button
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Hyperlinks Command
Use the Hyperlinks command to switch to the Hyperlinks view. When the Hyperlinks command has a dot next to 
it, the Hyperlinks view is active.

The Hyperlinks view graphically displays hyperlinks to pages and from pages, other files in your FrontPage web, 
and all hyperlinks from your FrontPage web to other sites on the World Wide Web.

You can also switch to the Hyperlinks view by clicking the Hyperlinks button on the Views bar.

Hyperlinks 
button
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Folders Command
Use the Folders command to switch to the Folders view. When the Folders command has a dot next to it, the 
Folders view is active.

The Folders view is a Windows Explorer-like representation of a FrontPage web that shows the web contents, 
organized by folders and files. You can drag-and-drop to create, delete, copy, and move folders and files.

You can also switch to the Folders view by clicking the Folders button on the Views bar.

Folders 
button
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Task History Command
Use the Task History command when in Tasks view to show or hide completed tasks in your task list. When the 
Task History command has a dot next to it, tasks that you have marked as completed are included in the task list.
When the Task History command is unchecked, tasks that you have marked as completed will be hidden from 
the task list after you switch to another view on the Views bar.

{button Related Procedures,JI(`frontpg.HLP',`Content_Workplace')}



All Files Command
Use the All Files command to switch to the All Files view. When the All Files command has a dot next to it, the All 
Files view is active.

The All Files view displays all the files in your FrontPage web in a list, which provides information such as the file 
names, sizes, types, and modification dates.

You can also switch to the All Files view by clicking the All Files button on the Views bar.

All Files 
button
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Navigation Command
Use the Navigation command to switch to the Navigation view. When the Navigation command has a dot next to 
it, the Navigation view is active.

In the Navigation view, you create, display, and print the structure of a FrontPage web. The Navigation view is 
particularly useful for designing the layout of a new web site, because by using drag and drop, you can quickly 
decide the structure of your web. 

You can also switch to the Navigation view by clicking the Navigation button on the Views bar.

Navigation 
button

{button Related Procedures,JI(`frontpg.HLP',`Content_Workplace')}



Hyperlink Status Command
Use the Hyperlink Status command to switch to the Hyperlink Status view. When the Hyperlink Status command 
has a dot next to it, the Hyperlink Status view is active.

The Hyperlink Status view identifies the status of the hyperlinks in your FrontPage web. The list includes both 
internal and external hyperlinks and graphically indicates whether the hyperlinks have been verified or whether 
they are broken.

You can also switch to the Hyperlink Status view by clicking the Hyperlink Status button on the Views bar.

Hyperlink Status 
button
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Themes Command
Use the Themes command to switch to the Themes view. When the Themes command has a dot next to it, the 
Themes view is active.

The Themes view lets you add graphic page elements, such as bullets and backgrounds, to your FrontPage web.
You can choose from a gallery of available FrontPage themes, and then apply them to specific pages. You can 
apply a theme to an entire FrontPage web to give your site a consistent, professional appearance and navigation
structure.

You can also switch to the Themes view by clicking the Themes button on the Views bar.

Themes 
button
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Tasks Command
Use the Tasks command to switch to the Tasks view. When the Tasks command has a dot next to it, the Tasks 
view is active.

The Tasks view helps you create and track a list of tasks to be performed in your FrontPage web. You can create 
new tasks, assign them to specific pages, and track their progress and completion status. Use this view to 
display the status of outstanding web tasks before you publish your FrontPage web.

You can also switch to the Tasks view by clicking the Tasks button on the Views bar.

Tasks 
button
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Show FrontPage Editor Command 
Use the Show FrontPage Editor command to open the FrontPage Editor. If the FrontPage Editor is already open, 
this command brings the FrontPage Editor to the front of the desktop.

You can also go to the FrontPage Editor by clicking the FrontPage Editor button on the toolbar, or by double-
clicking the page you want to open in Folders View, All Files view, or Navigation view.

Show 
FrontPage 
Editor 
button
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Show Image Editor
Use the Show Image Editor command to open the default image editor for GIF files. To open the default image 
editor to edit a specific GIF image on a page, double-click that image in the FrontPage Editor.

To specify a default image editor, in the FrontPage Explorer choose Options on the Tools menu, then click the 
Configure Editors tab. In the Configure Editors tab, click Add and enter GIF in the File Type field, the name of the 
editor (for example, Image Composer) in the Editor Name field, and in the Command field, where the executable 
file for that editor is located on your local drive or network. Click Browse to find the executable file's location.

You can also open the default image editor by clicking the Show Image Editor button on the toolbar.

Show Image Editor
button
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Undo Command
Use the Undo command while In Navigation view to reverse the last action you performed.

You can also undo actions by clicking the Undo button on the toolbar.

Undo button
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Redo Command
Use the Redo command while in Navigation view to redo the last action that was undone using the Undo 
command.

You can also redo actions by clicking the Redo button on the toolbar.

Redo button
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Do Task Command
Use the Do Task command while in Tasks view to perform the selected task. This command is available only if 
the task is linked to a page or file.

· If the task is linked to a page, the FrontPage Explorer opens the page in the FrontPage Editor.
· If the task is linked to an image or other type of file, the FrontPage Explorer opens the file in the default editor 

for that type of file.
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Mark Task Complete Command
Use the Mark Task Complete command while in Tasks view to mark the selected task as completed. The task 
status will change to Completed and display a green light.

If the Show Task History command on the View menu is selected, the task will be hidden after you switch to 
another view (such as Folders view) on the Views bar.
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Draw Table Command
Use the Draw Table command to create a table. Tables are used for laying out pages; inserting a table within a 
table gives you more control how page elements will be positioned on a page. You can also use tables to arrange
data systematically, such as a timetable for a train.

Using the Draw Table command, you can easily create any type of table, even one that contains cells of different 
heights or a varying number of columns per row, just by drawing them with the pen.

First, define the outside border of the entire table by dragging from the upper-left corner to the lower-right corner 
of the table, then draw the column and row lines inside.

You can draw a table quickly by clicking the Draw Table button on the table toolbar.

Draw Table 
button
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Erase Command
To remove a cell border from a table, click the Erase button on the table toolbar, and then click and drag the 
eraser along the border. The FrontPage Editor erases the border and merges the adjacent cells.

Erase button
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Align Top Command
Use the Align Top command to align the contents of a table cell to the top of that cell. This command works with 
any group of selected cells.

Align Top 
button
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Center Vertically Command
Use the Center Vertically command to center the contents of a table cell between the top and bottom of that cell. 
This command works with any group of selected cells.

Center Vertically 
button
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Align Bottom Command
Use the Align Bottom command to align the contents of a table cell to the bottom of that cell. This command 
works with any group of selected cells.

Align Bottom 
button
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Show FrontPage Explorer Command
Use the Show FrontPage Explorer command to open the FrontPage Explorer. If the FrontPage Explorer is 
already open, this command brings the FrontPage Explorer to the front of the desktop.

You can also go to the FrontPage Explorer by clicking the FrontPage Explorer button on the standard toolbar.

FrontPage Explorer
button
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Show Image Editor Command
Use the Show Image Editor command to open the default image editor for GIF files. To open the default image 
editor to edit a specific GIF image on a page, double-click that image in the FrontPage Editor.

To specify a default image editor, in the FrontPage Explorer choose Options on the Tools menu, then click the 
Configure Editors tab.

You can also open the default image editor by clicking the Show Image Editor button on the standard toolbar.

Show Image Editor
button
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Table Toolbar Command
Use the Table Toolbar command to display or hide the FrontPage Editor's table toolbar. The table toolbar 
contains commands that let you draw and erase tables, insert rows and columns, and control the alignment of 
table elements. When this command has a check mark next to it, the toolbar is displayed.
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Format Marks Command
Use the Format Marks command while in Normal view to show or hide page elements, such as line breaks, 
paragraph marks, bookmarks, and form outlines, as well as the FrontPage placeholder icons for unknown HTML 
tags and script. When the Format Marks command has a check mark next to it, format marks are displayed.

You can also change between showing and hiding format marks by clicking the Show/Hide Formats button on the
standard toolbar.

Show / Hide Formats 
button
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New Page Command
Use the New Page command to add a new page to the current FrontPage web in the following FrontPage 
Explorer views:

· Folders view,
In this view, FrontPage creates a new, blank page with a placeholder file name (such as normal.htm) in the 
current folder. The placeholder file name is automatically selected so that you can type a new name for the 
page.

· All Files view, 
In this view, FrontPage creates a new, blank page with a placeholder file name (such as normal.htm) in the 
root folder. The placeholder file name is automatically selected so that you can type a new name for the page.

· Navigation view, 
In this view, you can create a new page at a specific location in your structure, or you can create a new page 
in the files list without specifying a location in your structure.
To create a new child page select the page beneath which you want to add a page, and then click New Page 
on the toolbar. FrontPage creates the new child page beneath the parent page you selected. To create a new 
top page, click anywhere in the background of the Navigation pane, then click New Page on the toolbar.
To create a new page without specifying a location in your structure, click anywhere on the background of the 
window, then click New Page. FrontPage creates the new page in the files list at the bottom of the window, but
doesn't add it to the structure.

You can quickly create a new page by clicking the New Page button on the toolbar.

New Page 
button
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New Task Command
Use the New Task command to add a new task to your task list in Tasks view. If you select a page in another 
view before clicking New Task, the task will be linked to that page.

In Tasks view, you can quickly create a new task by clicking the New Task button on the toolbar.

New Task 
button
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Export Command 
Use the Export command when in Folders view to copy the selected file from your FrontPage web to a local file 
system. Select the file to export, then in the Export Selected As dialog box, specify the file name and destination 
of the file to be exported.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Webs')}



Import Command
Use the Import command to copy files and folders into your FrontPage web.

Selecting Import with no FrontPage web open starts the Import Web Wizard. This wizard guides you through 
creating a new FrontPage web from a folder on your file system or local network, from another FrontPage web, 
or from an external site on the World Wide Web. 

Note The following dialog box options are only available when you choose the Import command with a 
FrontPage web open.

The Import File To FrontPage Web dialog box maintains an import list. You build the list by adding files and 
folders from your file system or local network. You can import the entire list at any time. The import list is cleared 
when you close the FrontPage web.

Dialog Box Options

File
The name and path of a file on the import list. 

URL
The intended location of the file in your FrontPage web after it is imported.

Add File
Click Add File to browse your file system or local network for files to add to the import list.

Add Folder
Click Add Folder to browse your file system or local network for folders to add to the import list. When you add a 
folder, the URL of each file in the folder includes the folder name and the names of any sub-folders. When you 
import the files, FrontPage will create the folders in the FrontPage web.

From Web
Click From Web to create a new FrontPage web from existing files on a computer or from an existing web site. 
When you click From Web, the Import Web Wizard opens to guide you through the process of creating the 
FrontPage web.

Edit URL
Click Edit URL to open the Edit URL dialog box, in which you can change the file’s intended location in your 
FrontPage web.

Note      To import pages and files to a hidden directory that a user may not be able to view from a Web browser, 
save the pages and files to the special FrontPage web directory _private. This is useful for storing pages that 
you want to include in other pages but do not want users to view directly.

Remove
Select this option to remove the selected files from the import list.

OK/Stop
Click OK when you're ready to add the files on the import list to your FrontPage web. While the files are being 
imported, the OK button becomes a Stop button. Click Stop to stop importing files.

Close
Click Close to close the Import File To FrontPage Web dialog box. Files will remain on the import list until you 
close the FrontPage web.
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New FrontPage Web Command
Use the New FrontPage Web command to create a new FrontPage web. In the New FrontPage Web dialog box, 
you can choose to create a new one page web; create a new FrontPage web by importing files from an existing 
web on your local disk, or from an external site on the World Wide Web; or create a new FrontPage web using a 
template or wizard.

You must be authorized as an administrator in the root web to create a new FrontPage web. If you have not yet 
entered your administrator name and password, the Name and Password Required Dialog Box opens. 
FrontPage creates a new FrontPage web after you enter your name and password.

Dialog Box Options

One Page Web
Select this option to create a new FrontPage web that contains one blank page.

Import an Existing Web
Select this option to create a new FrontPage web by importing files from an existing web on your local disk or an 
external site on the World Wide Web.

From Wizard or Template
This list box shows the wizards and templates you can use to create your new FrontPage web, such as the 
Discussion Web wizard. Click a wizard or template to display a brief description of it below the list box.

Choose a Title for Your FrontPage Web
Type the title of your new FrontPage web. When you start FrontPage, this is the title you'll see in the list of 
existing FrontPage webs that you can open.

FrontPage determines the location for your new web based on the address of the server on which you most 
recently created a web, and the specified web title, then displays that location below the Web Title field. The 
location that is displayed is what you will type in a Web browser to view the web you are creating.

Change
Click Change if you want to specify a different location for your new web — for example, on another local server 
— and then choose another server in the Change Location dialog box.

OK
Click OK when you are ready to create the new web. If you selected a wizard, the wizard will start.
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Text Command
Use the Text command to create a text label on an image. This is useful for creating graphical page banners, 
applying captions to images, and labeling image map hotspots  and buttons.

To create a new text label, select the image on which you want to place text and click the Text button. A resizable 
text box appears on the current image. Type text directly into the text box, and then change the font, size, style, 
and alignment of the text by selecting it and applying any combination of formatting options using the commands 
on the FrontPage Editor’s format toolbar.

By default, text regions are pre-formatted in black 12-point Arial Bold, centered within the text box.

Note      All text formatting is applied to the entire region of the text label. You cannot apply mixed formatting to 
partial text selections within the same text box. However, you can apply multiple text labels over the same image.
You can move the text label over the current image by clicking the image and then dragging the border of the text
box to a new location.

You select the Text command using the Text button on the image toolbar.

Text button
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Crop Command
Use the Crop command to select part of an image and discard the rest.

To crop an image, select the image and click the Crop button. A resizable selection box appears over the image. 
Resize the selection as needed and then move it over the part of the image you want to keep. Click the Crop 
button a second time — or press the ENTER key — to finish cropping the image.

Note      Cropping will permanently alter the appearance of your image. You may want to keep a saved copy of 
the original image for backup purposes.
You select the Crop command using the Crop button on the image toolbar.

Crop button
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Washout Command
Use the Washout command to create a faint, low-contrast version of the current image. This is useful for creating 
background images for pages and tables.

To apply the Washout effect to an image on the current page, select the image and click the Washout button.

To apply the Washout effect to the background image on the current page, click the Washout button when no 
images are selected.

Note      Applying the Washout effect will permanently alter the quality and appearance of your image. You may 
want to keep a saved copy of the original image for backup purposes.
You select the Washout command using the Washout button on the image toolbar.

Washout 
button
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Black and White Command
Use the Black and White command to convert an image from color to black and white. This is useful for creating 
grayscale versions or thumbnails of color images. Grayscale images take less time to download than color 
images.

To convert an image from color to black and white, select the image and click the Black & White button.

To convert the background image on the current page from color to black and white, click the Black and White 
button when no images are selected.

You select the Black and White command using the Black and White button on the image toolbar.

Black and 
White 
button
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Reset Command
Use the Reset command to restore an image to its saved version. This is useful for reverting to the original 
appearance of an image before image effects were applied.

To reset an image, select the image and click the Reset button.

To reset the background image on the current page, click the Reset button when no images are selected.

You select the Reset command using the Reset button on the image toolbar.

Reset 
button
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Rotate Left Command
Use the Rotate Left command to rotate the current image 90 degrees counter-clockwise. This is useful for 
correcting the placement of scanned images.

To rotate an image to the left, select the image and click the Rotate Left button.

To rotate the background image on the current page to the left, click the Rotate Left button when no images are 
selected.

You select the Rotate Left command using the Rotate Left button on the image toolbar.

Rotate Left 
button
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Rotate Right Command
Use the Rotate Right command to rotate the current image 90 degrees clockwise. This is useful for correcting the
placement of scanned images.

To rotate an image to the right, select the image and click the Rotate Right button.

To rotate the background image on the current page to the right, click the Rotate Right button when no images 
are selected.

You select the Rotate Right command using the Rotate Right button on the image toolbar.

Rotate Right
button
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Reverse Command
Use the Reverse command to horizontally flip an image. This is useful for creating symmetrical image banners in 
a page header.

To reverse an image, select the image and click the Reverse button.

To reverse the background image on the current page, click the Reverse button when no images are selected.

You select the Reverse command using the Reverse button on the image toolbar.

Reverse 
button
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Flip Command
Use the Flip command to vertically reverse an image. This is useful for creating symmetrical image banners in a 
page header.

To flip an image, select the image and click the Flip button.

To flip the background image on the current page, click the Flip button when no images are selected.

You select the Flip command using the Flip button on the image toolbar.

Flip button
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More Contrast Command
Use the More Contrast command to increase the contrast between the lightest and darkest parts of the current 
image. This is useful for adjusting the display intensity of an image.

To apply more contrast to an image, select the image and click the More Contrast button. If necessary, click the 
button repeatedly until the image reaches the level of contrast you want.

To apply more contrast to the background image on the current page, click the More Contrast button when no 
images are selected.

Note      Changing image contrast will permanently alter the appearance of your image. You may want to keep a 
saved copy of the original image for backup purposes.
You select the More Contrast command using the More Contrast button on the image toolbar.

More 
Contrast 
button
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Less Contrast Command
Use the Less Contrast command to decrease the contrast between the lightest and darkest parts of the current 
image. This is useful for adjusting the display intensity of an image.

To apply less contrast to an image, select the image and click the Less Contrast button. If necessary, click the 
button repeatedly until the image reaches the level of contrast you want.

To apply less contrast to the background image on the current page, click the Less Contrast button when no 
images are selected.

Note      Changing image contrast will permanently alter the appearance of your image. You may want to keep a 
saved copy of the original image for backup purposes.
You select the Less Contrast command using the Less Contrast button on the image toolbar.

Less 
Contrast 
button
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More Brightness Command
Use the More Brightness command to increase the lightness in an image. This is useful for adjusting the display 
intensity of an image.

To apply more brightness to an image, select the image and click the More Brightness button. If necessary, click 
the button repeatedly until the image reaches the level of brightness you want.

To apply more brightness to the background image on the current page, click the More Brightness button when 
no images are selected.

Note      Changing image brightness will permanently alter the appearance of your image. You may want to keep 
a saved copy of the original image for backup purposes.
You select the More Brightness command using the More Brightness button on the image toolbar.

More 
Brightness 
button
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Less Brightness Command
Use the Less Brightness command to decrease the lightness in an image. This is useful for adjusting the display 
intensity of an image.

To apply less brightness to an image, select the image and click the Less Brightness button. If necessary, click 
the button repeatedly until the image reaches the level of brightness you want.

To apply less brightness to the background image on the current page, click the Less Brightness button when no 
images are selected.

Note      Changing image brightness will permanently alter the appearance of your image. You may want to keep 
a saved copy of the original image for backup purposes.
You select the Less Brightness command using the Less Brightness button on the image toolbar.

Less 
Brightness 
button
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Bevel Command
Use the Bevel command to create a bevel effect around the border of the current image. This is useful for 
creating three-dimensional buttons from images.

To apply a bevel effect to an image, select the image and click the Bevel button.

To apply a bevel effect to the background image on the current page, click the Bevel button when no images are 
selected.

You select the Bevel command using the Bevel button on the image toolbar.

Bevel button
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Resample Command
Use the Resample command to resample an image. This is useful for optimizing the resolution and file size of an 
image after it has been resized on the page.

To resample an image, select the image and click the Resample button.

Note      Resampling an image will permanently alter the quality and appearance of your image. You may want to 
keep a saved copy of the original image for backup purposes.
You select the Resample command using the Resample button on the image toolbar.

Resample 
button
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Preview in Browser Command
Use the Preview in Browser command to view the active page in a Web browser. In the Preview in Browser 
dialog box, you can add the names of Web browsers you would like to use. FrontPage detects whether you have 
a Web browser installed on your computer and automatically adds its name to the dialog box.

If you preview a page that does not come from a Web server, some FrontPage components requiring a Web 
server (such as the Table of Contents and the Search Form components) will not work.

You can also preview the active page in a Web browser by clicking the Preview in Browser button on the 
standard toolbar.

Preview in Browser 
button

Dialog Box Options

Browser
Select the installed Web browser you want to use.

Add
Click Add to open the Add Browser dialog box where you can add additional Web browsers to the list of available
Web browsers.

Edit
Select a Web browser, then click Edit to open the Edit Browser dialog box where you can change information 
about a Web browser you have added. You cannot edit information about a Web browser that FrontPage has 
detected and added to the Preview in Browser dialog box automatically.

Delete
Select a Web browser, then click Delete to remove a Web browser you have added. You cannot remove a Web 
browser that FrontPage has detected and added to the Preview in Browser dialog box automatically.

Window Size
Select the window size for the browser.

Automatically Save Page
Select this option to save the page before displaying it in a Web browser.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Pages')}



Open Command
Use the Open command to retrieve a page from the current FrontPage web or from a file in your file system. You 
select the file to be opened in the Open dialog box. The FrontPage Editor opens the page in a new window.

You can open files of many popular types, and the FrontPage Editor converts them to HTML. The FrontPage 
Editor supports the following file types:

· HTML files and documents (*.htm, *.html, *.htx, *.asp)
· Rich Text Format (*.rtf)
· Text files (*.txt)
· Hypertext templates (*.htt)
· Microsoft Word 97 (*.doc)
· Microsoft Word 6.0/95 (*.doc)
· Microsoft Word 2.x (*.doc)
· Microsoft Excel (*.xls, *.xlw)
· Microsoft Works 3.0 (*.wps)
· Microsoft Works 4.0 (*.wps)
· WordPerfect 6.x (*.wpd, *.doc)

The FrontPage Editor preserves hyperlinks in Microsoft Office documents. Images in files are converted to the 
GIF image format.

You can also open files in the FrontPage Editor by clicking the Open button on the standard toolbar.

Open 
button

If the file you open has an HTML tag that FrontPage does not recognize, FrontPage preserves it as HTML 
Markup.

If you open a text file, the FrontPage Editor displays the Convert Text Dialog Box. This dialog box presents 
options for converting the text.
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Horizontal Line Command 
Use the Horizontal Line command to insert a horizontal line at the insertion point on the active page. After you 
insert a horizontal line, select it and press ALT+ENTER to view or set its properties in the Horizontal Line 
Properties dialog box.

If the current FrontPage web has a theme applied, all horizontal lines you insert will inherit their appearance and 
properties from the applied theme.
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Line Break Command
Use the Line Break command to insert a line break at the insertion point on the active page.

Note      Many Web browsers do not display empty paragraphs but do display line breaks as white space.

Dialog Box Options

Normal Line Break
Forces a line break. If an image is at the left or right margin, does not clear it.

Clear Left Margin
Forces a line break. If an image is at the left margin, moves the next line down until the left margin is cleared.

Clear Right Margin
Forces a line break. If an image is at the right margin, moves the next line down until the right margin is cleared.

Clear Both Margins
Forces a line break. If an image is at either or both margins, moves the next line down until both margins are 
cleared.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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General Tab
Properties Dialog Box
Use the General tab of the Properties dialog box to view the characteristics of the selected page or folder.

Dialog Box Options

Name
The file or folder name.

Title
The title of the selected page or file. The title is displayed in the FrontPage Explorer and is used by many 
FrontPage Editor and FrontPage Explorer commands. If you selected a folder, the title field does not appear on 
this tab.

If the selected page is an HTML page, you cannot edit the title in this box. To change the title of an HTML page, 
click OK to close this dialog, then open the page in the FrontPage Editor. On the File menu, choose Page 
Properties, and rename the page in the Title field.

If the selected page is not an HTML file, you can edit the title in this box.

Type
The type of file, such as HTML, folder, text, image, sound, or movie.

Size
The page’s or file’s size. If you selected a folder, the size field does not appear on this tab.

Location
The full URL of the page or file.

Contains
(Folders Only) The number of files and folders contained in the current folder.

Allow Scripts or Programs to be Run
(Folders Only) Select this check box to allow the folder to contain executable scripts or programs. This option 
only appears when you are using the Microsoft Personal Web Server version 4.0 or later.

Allow Files to be Browsed
(Folders Only) Select this check box to allow files to be opened in a Web browser.
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To customize a one-line text box field
You can customize a one-line text box field by opening the Form Field Properties dialog box and changing the 
following options:

· Name 
· Initial Value
· Width in Characters

1 In the FrontPage Editor, click the one-line text box to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Name field, type the name that you want associated with the field.

The name you assign is not displayed on the form, it is used by a form handler to identify the field.
4 In the Initial Value field, type the text you want to display in the field when the page is first displayed in a Web 

browser.
5 In the Width in Characters field, type the number of characters for the new width.

You can also change the width of the field using its size handles.
6 Click OK.
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To customize a scrolling text box field
You can customize a scrolling text box field by opening the Form Field Properties dialog box and changing the 
following options:

· Name 
· Initial Value
· Width in Characters
· Number of Lines

1 In the FrontPage Editor, click the scrolling text box to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Name field, type the name that you want associated with the field.

The name you assign is not displayed on the form, it is used by a form handler to identify the field.
4 In the Initial Value field, type the text you want to display in the field when the page is first displayed in a Web 

browser.
5 In the Width in Characters field, type the new width, measured in characters.

You can also change the width of the field using its size handles.
6 In the Number of Lines field, type the new height, measured in lines.
7 Click OK.
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To customize a check box field
You can customize a check box field by opening the Form Field Properties dialog box and changing the following
options:

· Name 
· Value
· Initial State

1 In the FrontPage Editor, click the check box to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Name field, type the name that you want associated with the field or group of check box fields.

The name you assign is not displayed on the form, it is used by a form handler to identify the field.
4 In the Value field, enter a value to associate with the field.
5 In the Initial State field, choose whether you want the check box to be checked or not checked when it is first 

displayed in a Web browser.
6 Click OK.
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To customize a radio button field
You can customize a radio button field by opening the Form Field Properties dialog box and changing the 
following options:

· Group Name 
· Value
· Initial State

1 In the FrontPage Editor, click the radio button to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Group Name field, type the name that you want associated with the group of radio button fields.

The name you assign is not displayed on the form, it is used by a form handler to identify the field.
4 In the Value field, enter a value to associate with the field.
5 In the Initial State field, choose whether you want the radio button to be selected or not selected when it is first

displayed in a Web browser.
Only one radio button in the same group can be selected at a time.

6 Click OK.
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To remove a choice from a drop-down menu
1 In the FrontPage Editor, click the drop-down menu to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 Click the menu choice that you want to remove.
4 Click Remove.
5 Click OK.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Fields')}



To modify a choice in a drop-down menu
1 In the FrontPage Editor, click the drop-down menu to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 Click the menu choice that you want to modify.
4 Click Modify.
5 To change the name of the menu choice, enter a name In the Choice field.
6 To change the value sent to the form handler, enter a value in the Specify Value field.
7 To change the initial state of the menu choice, in the Initial State group box, choose whether you want the 

menu choice to be selected or not selected when it is first displayed in a Web browser.
8 Click OK.
9 To move the menu choice to a different position in the menu, do the following:

· To move the choice up in the menu, click Move Up.
· To move the choice down in the menu, click Move Down.

10 Click OK.
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To move a choice in a drop-down menu
1 In the FrontPage Editor, click the drop-down menu to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 Click the menu choice that you want to move.
4 Do the following:

· To move the choice up in the menu, click Move Up.
· To move the choice down in the menu, click Move Down.

5 Click OK.
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To change the height of a drop-down menu
1 In the FrontPage Editor, click the drop-down menu to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Height field, set the height of the menu. Based on your selection, the menu will be displayed as follows: 

· If Height is greater than 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a 
scrollable list with full-height scroll arrows.

· If Height is greater than 1 and Allow Multiple Selections is No, most Web browsers display the menu as a 
scrollable list.

· If Height is 1 and Allow Multiple Selections is No, most Web browsers display the menu as a drop-down 
list.

· If Height is 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a scrollable list 
with half-height scroll arrows. This type of menu may be difficult to use.

4 Click OK.
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To create an image field
Create an image form field to use as the Submit button that you usually see on a form or to build a custom 
image-map utility. 

An image form field submits a form to a form handler when a user clicks the image. When a form is submitted by 
clicking an image field, FrontPage passes the x and y coordinates of the pointer (using the image's coordinate 
system) to the form handler. FrontPage's form handler’s do not use the coordinate information. However, you can
create a custom form handler that processes the form based on the coordinates passed to it.

An image form field is inserted at the insertion point. If the insertion point is inside a form, the image form field is 
added to the form. To create a new form containing an image form field, insert the field outside of any currently 
defined forms.

1 In the FrontPage Editor, on the Insert menu, choose Form Field, then Image.
2 Choose an image to insert by doing one of the following:

· If the image is in the current FrontPage web, select the image you want to insert. To browse the contents of
a folder, double click it. Click OK.

· If the image is in a file, click the File button . In the Image dialog box use the Look In box and the box 
that lists files and folders to point to the file and folder where the image is stored. Choose a file type from 
the Files of Type drop-down field to list all the files of that type. Select the image you want to insert, then 
click Open. Click OK.

· If the image is on the World Wide Web, click the World Wide Web button . In your Web browser, surf to
the image that you want to insert, then return to the Image dialog box. Click OK.

Note      The FrontPage Editor creates image fields with default properties. For example, the default name for 
the first image field in a form is I1. To open the image field's properties dialog box and edit any of its 
properties, double-click the image form field.

3 To label the image field on the page, type a label next to the image in the form.
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To add a hidden field
A hidden field is not visible to the user but supplies data to the form handler. Each hidden field is implemented as 
a name-value pair. When the form is submitted, all of its hidden fields are passed to the form handler along with 
name-value pairs from each field in the form.

1 In the FrontPage Editor, right-click within the form and select Form Properties from the shortcut menu.
2 In the Form Properties dialog box, click Advanced.
3 In the Advanced Form Properties dialog box, click Add.
4 In the Name/Value Pair dialog box, add the name of the hidden field in the Name field.
5 Enter a value to be associated with the name in the Value field. The value can be any text.
6 Click OK to close the Name/Value Pair dialog box.
7 Click OK to close the Advanced Properties dialog box.
8 Click OK to close the Form Properties dialog box.
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To delete a form field
1 In the FrontPage Editor, select the form field.
2 To delete the selected text, press DELETE.

To cut the selected form field, on the Edit or shortcut menu, choose Cut or click the Cut button:
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To add a choice to a drop-down menu
1 In the FrontPage Editor, click the drop-down menu to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 For each menu choice that you want to add to the menu, click Add, then do the following in the Add Choice 

dialog box:
· In the Choice field, enter the name of the menu choice.
· To specify a value for the menu choice, click Specify Value and enter an value to send to the form handler. 

If you specify a value, it replaces the name of the menu choice in the field's name-value pair.
· In the Initial State field, choose whether you want the menu choice to be selected or not selected when it is

first displayed in a Web browser.
· Click OK.
The menu items are displayed in the order in which you created them.

4 To modify the menu, do any of the following:
· To remove a selected choice, click Remove.
· To modify a selected choice, click Modify and edit the Modify Choice dialog box.
· To move a selected choice up in the menu, click Move Up.
· To move a selected choice down in the menu, click Move Down

5 In the Allow Multiple Selections field, select Yes to allow more than one menu item to be selected at a time. 
Select No to permit only one selection at a time.

6 In the Height field, set the height of the menu. Based on your selection, the menu will be displayed as follows: 
· If Height is greater than 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a 

scrollable list with full-height scroll arrows.
· If Height is greater than 1 and Allow Multiple Selections is No, most Web browsers display the menu as a 

scrollable list.
· If Height is 1 and Allow Multiple Selections is No, most Web browsers display the menu as a drop-down 

list.
· If Height is 1 and Allow Multiple Selections is Yes, most Web browsers display the menu as a scrollable list 

with half-height scroll arrows. This type of menu may be difficult to use.
7 Click OK.
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To change a hidden field
1 In the FrontPage Editor, right-click within the form and select Form Properties from the shortcut menu.
2 In the Form Properties dialog box, click Advanced.
3 In the Advanced Form Properties dialog box, click Modify.
4 In the Name/Value Pair dialog box, change the name in the Name field.
5 Change a value to be associated with the name in the Value field. The value can be any text.
6 Click OK to close the Name/Value Pair dialog box.
7 Click OK to close the Advanced Properties dialog box.
8 Click OK to close the Form Properties dialog box.
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To remove a hidden field
1 In the FrontPage Editor, right-click within the form and select Form Properties from the shortcut menu.
2 In the Form Properties dialog box, click Advanced.
3 In the Advanced Form Properties dialog box, select the hidden field you want to remove, then click Remove.
4 Click OK to close the Advanced Properties dialog box.
5 Click OK to close the Form Properties dialog box.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Fields')}



To customize a push button field
You can customize a push button field by opening the Form Field Properties dialog box and changing the 
following options:

· Name 
· Value/Label
· Button type

1 In the FrontPage Editor, click the push button to select it.
2 On the Edit or shortcut menu, choose Form Field Properties.
3 In the Name field, type the name that you want associated with the push button field.

The name you assign is not displayed on the form, it is used by a form handler to identify the field.
4 In the Value/Label field, enter a value(or label) to associate with the field.
5 In the Button type field, select the type of push button.
6 Click OK.
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To create an image hyperlink to a page or file in the current FrontPage web
You can create an image hyperlink to a page or file in the current FrontPage web.

1 In the FrontPage Editor, click the image to activate the image toolbar.
2 To create a hotspot, do one of the following:

· To create a rectangular hotspot, click the Rectangle button: 

· To create a circular hotspot, click the Circle button: 

· To create a polygonal hotspot, click the Polygon button: 

The Create Hyperlink dialog box opens.
3 In the Create Hyperlink dialog box, click a page or file to make it the target of the hyperlink. To browse the 

contents of a folder, double-click it.
4 To link to a bookmark on the page you selected, type the name of the bookmark in the Bookmark field. You 

can create a hyperlink to a bookmark on an open page by first selecting the page and then choosing its 
bookmark from the list in the Create Hyperlink dialog box.

5 If you want the page that is the target of the hyperlink to appear in a frame in a frames page select the frame 
in the Target Frame field.

6 Click OK.
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To create an image hyperlink to a page on the World Wide Web
You can create an image hyperlink to a page on the World Wide Web.

1 In the FrontPage Editor, click on the image to activate the image toolbar.
2 To create a hotspot, do one of the following:

· To create a rectangular hotspot, click the Rectangle button:

· To create a circular hotspot, click the Circle button:

· To create a polygonal hotspot, click the Polygon button:

The Create Hyperlink dialog box opens.
3 In the Create Hyperlink dialog box, click the World Wide Web button.

Your Web browser will be displayed.
4 In your Web browser, go to the page or file that you want to be the target of your hyperlink, and type ALT+TAB 

to return to the FrontPage Editor.
The location of the page you visited will be in the URL field.

5 If you want the page that is the target of the hyperlink to appear in a frame in a frames page select the frame 
in the Target Frame field.

6 Click OK.
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To create an image hyperlink to a new page
You can create an image hyperlink to a new page. FrontPage first creates the new page and then creates a 
hyperlink to it.

1 In the FrontPage Editor, click on the image to activate the image toolbar.
2 To create a hotspot, do one of the following:

· To create a rectangular hotspot, click the Rectangle button:

· To create a circular hotspot, click the Circle button:

· To create a polygonal hotspot, click the Polygon button:

The Create Hyperlink dialog box opens.
3 In the Create Hyperlink dialog box, if you want the page that is the target of the hyperlink to appear in a frame 

in a frames page select the frame in the Target Frame field.
4 Click the New Page button.

5 In the Page tab of the New dialog box, select the template or wizard to use to create the new page.
6 To create the new page and add a task to the FrontPage Explorer’s Tasks view reminding you to finish the 

page later, click Just add web task.
7 Click OK.
8 If the page is based on a wizard, follow the wizard’s instructions to finish creating the page.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Link_Bookmark')}



To follow an image hyperlink forward
· In the FrontPage Editor, select the hotspot in the image that contains the hyperlink. CTRL+Click the hotspot or 

on the Go menu, choose Follow Hyperlink.
The FrontPage Editor opens the target page for editing and makes it the active page. If the hyperlink points to a 
bookmark, the FrontPage Editor will scroll to that bookmark.

If the target page is not in the current FrontPage web, FrontPage opens a copy of the page. You can save the 
copy of the page, including all image and other elements on the page, to the current FrontPage web or to a file.
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To change an image hyperlink
1 In the FrontPage Editor, select the hotspot in the image that contains the hyperlink.
2 On the Edit menu, choose Hyperlink or click the Create or Edit Hyperlink button.

3 Edit the hyperlink in the Edit Hyperlink dialog box.
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To follow a hyperlink backward
After following a hyperlink from one page to another page or to a bookmark, you can follow the hyperlink 
backward to the first page. When you do this, the FrontPage Editor scrolls the page to display the source of any 
hyperlinks on the page.

· In the FrontPage Editor, click the Back button: 
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To delete a bookmark
1 In the FrontPage Editor, do one of the following:

· Place the pointer anywhere in the text containing the bookmark.
· Select any part of the bookmark.

2 On the Edit menu, choose Bookmark.
3 Click Clear.
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To create a hyperlink to a bookmark
You can create a hyperlink to a bookmark in an open page, a page in the current FrontPage web, or a page on 
the World Wide Web.

1 In the FrontPage Editor, on the Insert menu, choose Hyperlink.
2 In the Create Hyperlink dialog box, do one of the following:

· To link to a bookmark on a currently opened page, select the bookmark name from the Bookmark drop-
down list.

· To link to a bookmark in the current FrontPage web, enter the bookmark name in the Bookmark field.
· To link to a bookmark on the World Wide Web, enter the bookmark name in the Bookmark field. 

Note      If you browse to a URL with a bookmark in your Web browser, then switch back to the Create 
Hyperlink dialog box, the bookmark will be retained.

3 Click OK.
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To delete a text hyperlink
1 In the FrontPage Editor, place the insertion point on the hyperlink.

To delete part of text hyperlink, select the characters from which you want to delete the hyperlink.
2 On the Edit menu, choose Unlink.

The FrontPage Editor deletes the hyperlink, but not the text associated with the hyperlink.
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To delete an image hyperlink
1 In the FrontPage Editor, select the hotspot that contains the hyperlink.
2 Press DELETE.
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To associate a file type with an editor
In the FrontPage Explorer, you can associate a file type with an editor. When you then choose to open a file of 
that type, it will be opened in the associated editor.

1 In the FrontPage Explorer, on the Tools menu, choose Options.
2 In the Configure Editors tab, click Add.
3 In the File Type field, specify the file-name extension for the file type, such as "TXT." To associate files that do 

not have an extension, type a period character.
4 In the Editor Name field, enter an identifying name for the editor.
5 In the Command field, enter the full path of the executable file for the editor. To browse the file system for the 

executable file, click Browse.
6 Click OK to close the Add Editor Association dialog box.
7 Click OK to close the Options dialog box.
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To open a file from the FrontPage Explorer
When you open a file in the FrontPage Explorer, it is opened in the editor that is associated with that file type.

· To open a file, do one of the following:
· Double-click the file.
· Select the file and choose Open on the Edit menu.
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To change the associated editor for a file type
In the FrontPage Explorer, you can change the associated editor for a file type. When you then choose to open a 
file of that type, it will be opened in the new associated editor.

1 In the FrontPage Explorer, on the Tools menu, choose Options.
2 In the Configure Editors tab, select a type/editor association, then click Modify.
3 In the Editor Name field, specify a new identifying name for the editor. 

Because you are associating a new editor for the current file type, you cannot modify the File Type field.
4 In the Editor Name field, enter an identifying name for the new editor.
5 In the Command field, modify the full path of the executable file for the new editor you are associating, then 

click OK.
To browse the file system for the executable file, click Browse.

6 Click OK to close the Modify Editor Association dialog box.
7 Click OK to close the Options dialog box.
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To remove the association between an editor and a file type
1 In the FrontPage Explorer, on the Tools menu, choose Options.
2 In the Configure Editors tab, select the type/editor association, then click Remove.
3 Click OK to close the Options dialog box.
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To open a text file from the FrontPage Editor
When you open a text (TXT) file in the FrontPage Editor, it converts the file to a new HTML page that you can 
add to the current FrontPage web.

1 In the FrontPage Editor, on the File menu, choose Open.
2 Click the File button to select the file from your local drive or network.
3 If you know the full path and file name of the text file, type it into the File Name field.

Choose Text Files in the Files of Type drop-down field. Use the Look In box and the box that lists files and 
folders to point to the file and folder where the text file is stored. Select the file you want and then click Open.

4 Select a text-conversion option and click OK.
· One Formatted Paragraph converts all the text to a single paragraph of formatted text with line breaks.
· Formatted Paragraphs converts each paragraph in the text file to formatted text.
· Normal Paragraphs converts each paragraph in the text file to normal text.
· Normal Paragraphs With Line Breaks converts each paragraph in the text file to normal text and preserves 

the line endings by inserting line breaks at the end of each line.
FrontPage converts the text file and opens it in a new page.
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To open an RTF file from the FrontPage Editor
When you open a Rich Text Format (RTF) file in the FrontPage Editor, it converts the file to a new HTML page 
that you can add to the current FrontPage web.

1 In the FrontPage Editor, on the File menu, choose Open.
2 Click the File button to select the file from your local drive or network.
3 If you know the full path and file name of the RTF file, type it into the File Name field.

Choose Rich Text Format in the Files of Type drop-down field. Use the Look In box and the box that lists files 
and folders to point to the file and folder where the RTF file is stored. Select the file you want and then click 
Open.
FrontPage converts the file and opens it in a new window.
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To open an HTML file from the FrontPage Editor
1 In the FrontPage Editor, on the File menu, choose Open.
2 Click the File button to select the file from your local drive or network.
3 If you know the full path and filename of the HTM or HTML file, type it in the File Name field.

Choose HTML Files in the Files of Type drop-down field. Use the Look In box and the box that lists files and 
folders to point to the file and folder where the file is stored. Select the file you want and then click Open.
FrontPage opens the file in a new window.
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To insert an HTML file
1 In the FrontPage Editor, on the Insert menu, choose File.
2 Choose HTML Files in the Files of Type drop-down field. Use the Look In box and the box that lists files and 

folders to point to the file and folder where the file is stored. Select the file you want and then click Open.
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To insert a text file
The FrontPage Editor converts text files to HTML before inserting them at the insertion point.

1 In the FrontPage Editor, on the Insert menu, choose File.
2 Choose Text Files in the Files of Type drop-down field. Use the Look In box and the box that lists files and 

folders to point to the file and folder where the text file is stored. Select the file you want and then click Open.
3 Select a text-conversion option and click OK.

· One Formatted Paragraph converts all the text to a single paragraph of formatted text with line breaks.
· Formatted Paragraphs converts each paragraph in the text file to formatted text.
· Normal Paragraphs converts each paragraph in the text file to normal text.
· Normal Paragraphs With Line Breaks converts each paragraph in the text file to normal text and preserves 

the line endings by inserting line breaks at the end of each line.
FrontPage converts the text file and inserts it on the active page.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Files')}



To insert an RTF file
The FrontPage Editor converts Rich Text Format (RTF) files to HTML before inserting them at the insertion point.

1 In the FrontPage Editor, on the Insert menu, choose File.
2 Choose Rich Text Format in the Files of Type drop-down field. Use the Look In box and the box that lists files 

and folders to point to the file and folder where the RTF file is stored. Select the file you want and then click 
Open.
FrontPage converts the rich text format file and inserts it on the active page.
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To rename a file
1 In the FrontPage Explorer, select the file in the Folders View or the All Files View.
2 On the Edit menu, choose Rename.
3 Type the new name, and then press ENTER.
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To move a file
1 In the FrontPage Explorer, select the file in the Folders View.

In the All Folders pane of the Folders View, locate the folder into which you want to move the file.
2 Drag the file into the folder.
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To move a hotspot
To change the area of an image that is a hotspot, you can move one or more selected hotspots in that image.

1 In the FrontPage Editor, click the image containing the hotspot you want to move.
2 Select the hotspot.

When the hotspot is selected, size handles display at each of its corners and sides.
3 To move the hotspot, do one of the following:

· Click the left mouse button and drag the hotspot to its new position. While clicking and dragging a hotspot, 
press ESC to return it to its original position.

· Use the arrow keys to change its position.
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To select an image
You need to select an image to cut, copy or paste the image using the clipboard.

· In the FrontPage Editor, click the image.
A selected image appears in reverse video.

Note      Selecting an image does not activate the image toolbar. To activate the image toolbar, click the image.
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To convert an image to JPEG format
Once you have inserted an image on a page, you can convert it to JPEG format.

1 In the FrontPage Editor, select the image to be converted.
2 On the Edit menu, choose Image Properties.
3 In the Image Properties dialog box, choose JPEG in the Type section.

Quality is an Integer in the range 1 - 100. As Quality increases, image compression decreases, making the 
image file larger, but image quality improves. As Quality decreases, compression increases, making the image
file smaller, but image quality degrades. The default Quality is 75.To change the quality of the JPEG image, 
change the value in the Quality field.
In the Progressive Passes option, select 0 (zero) to indicate normal JPEG format. If you specify a higher 
number of passes, the selected image will be converted to progressive JPEG format.

4 Click OK.
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To convert an image to GIF format
Once you have inserted an image on a page, you can convert it to GIF format.

1 In the FrontPage Editor, select the image to be converted.
2 On the Edit menu, choose Image Properties.
3 In the Image Properties dialog box, choose GIF in the Type options.

If you select Interlaced, the image will be converted to interlaced GIF format.
4 Click OK.
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To specify alternate text for an image
You can specify alternate text to display in place of the image when image-display is disabled or not available in 
the Web browser. Some Web browsers also display the alternate text while the image is loading.

1 In the FrontPage Editor, select the image.
2 On the Edit menu, choose Image Properties.
3 In the Alternate Representations area of the Image Properties dialog box, type the alternate text in the Text 

field.
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To specify an alternate low-resolution image
You can specify a low-resolution version of an image to be displayed while the final image is downloading from 
the Web server. This is most useful for image maps made up of large or high-resolution images. Users with slow 
Internet connections can proceed to click hotspots on the image map based on the low-resolution image, without 
having to wait for the high-resolution image to finish downloading.

1 In the FrontPage Editor, select the image.
2 On the Edit menu, choose Image Properties.
3 In the Alternate Representations area of the Image Properties dialog box, click Browse next to the Low-Res 

field and do one of the following:
· In the Select Alternate Image dialog box, select the low-resolution image file to be used, then click OK.
· Click the World Wide Web button to launch your default Web browser. Browse to the location of the low-

resolution image file on the World Wide Web, then switch back to FrontPage by pressing ALT+TAB.
· Click the File button to select the low-resolution image file from your local drive or network. If you know the 

full path and file name of the text file, type it into the File Name field.
4 Click OK to close the Image Properties dialog box.
Note      You must first create a low-resolution version of the image on your page before you can use it for 
alternate image representation. To create a low-resolution version of an image, open the image in an image 
editing program such as Microsoft Image Composer and reduce the color depth (number of colors) in the image. 
The fewer colors you specify for the low-resolution version of the image, the faster it will display in the Web 
browser. Since the low-resolution image is intended as a placeholder for the high-resolution image, you should 
not change the height and width dimensions of the image.
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To highlight hotspots
Highlighting hotspots is useful when the image makes it difficult to see the hotspot outlines that are 
superimposed on the image.

1 In the FrontPage Editor, click the image to activate the image toolbar.
2 To alternate between displaying the hotspots only and displaying the image and the hotspots, click the 

Highlight Hotspots button:
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To resize an image
To make an inserted image fit on the page, you can resize it by changing its height and width proportions.

1 In the FrontPage Editor, click the image to select it.
When an image is selected, size handles display at each of its corners and sides.

3 To resize the image, do one of the following:
· Click the left mouse button and drag a size handle. When the image is the size you want, release the 

mouse button. If you drag a corner handle, the image is resized proportionally and the aspect ratio of the 
image is preserved. If you drag a side handle, the image will be distorted.

· On the Edit menu, choose Image Properties. In the Appearance tab, select Specify Size in the Size 
section. You can adjust the image dimensions by pixels or a percentage. To proportionally change the 
image dimensions, select the Keep Aspect Ratio option before changing the Height and Width values. 
Keeping the image aspect ratio prevents image distortion.

Note      Changing the size of an image can deteriorate the quality and appearance of the image, even if it was 
resized proportionally. To resample an image after resizing it, click the resized image to select it and then click 
the Resample button on the image toolbar.
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To format text
1 In the FrontPage Editor, select the text, then on the Format menu, choose Font.
2 Use the Font dialog box as follows:

· Specify basic font information, such as text size, font, and color, in the Font tab.
· Specify specific HTML character tags, such as Definition <dfn> or Citation <cite>, in the Special Styles

tab.
· Specify a vertical position, such as Superscript or Subscript, in the Special Styles tab.

3 To apply the styles you selected, click OK.
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To align a paragraph
In the FrontPage Editor:

· Click the Align Left button to align the current paragraph at the left margin of the page: 

· Click the Align Right button to align the current paragraph at the right margin of the page: 

· Click the Center button to align the current paragraph in the center of the page: 
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To change a paragraph's style
In the FrontPage Editor, do one of the following:

· To change to any available style, with the insertion point anywhere in the paragraph, pick the new style from 
the Change Style box.

· To quickly change to Bulleted List style, with the insertion point anywhere in the paragraph, click the Bulleted 
List button:

· To quickly change to Numbered List Style, with the insertion point anywhere in the paragraph, click the 
Numbered List button:
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To create a paragraph
In the FrontPage Editor, do one of the following:

· To create a new paragraph on a new page, start typing on the page. The FrontPage Editor applies the Normal
paragraph style by default.

· To create a new paragraph with the same style as the current paragraph, position the insertion point at the 
end of the current paragraph, then press ENTER.

· To divide the current paragraph, position the insertion point inside the paragraph, then press ENTER.
The FrontPage Editor creates a new paragraph in the same style, starting with the text to the right of the 
insertion point.
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To indent text
1 In the FrontPage Editor, select the text you want to indent.
2 Click the Increase Indent button:
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To outdent text
1 In the FrontPage Editor, select the text you want to outdent.
2 Click the Decrease Indent button:
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To cut or delete text
When you cut text it is removed from the page and copied to the clipboard. When you delete text, it is removed 
from the page, but it is not copied to the clipboard.

In the FrontPage Editor, do one of the following:

· To cut the selected text, click the Cut button:

· To delete the selected text, press DELETE.
· To delete the character before the insertion point, press BACKSPACE.
· To delete the character after the insertion point, press DELETE.
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To find text on a page
You can search for text on the current page. 

1 In the FrontPage Editor, on the Edit menu, choose Find.
2 Edit the Find dialog box as follows:

· To specify the text to find, enter it in the Find What field.
· To specify the direction to search from the insertion point, select Up or Down in the Direction field.
· To find text only if it matches a whole word, select Match Whole Word Only.
· To find text only if it matches the capitalization of the text to find, choose Match Case.
· To find the next match for the text, click Find Next.
· To cancel the Find command, click Cancel.
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To replace text on a page
You can replace text on the current page. 

1 In the FrontPage Editor, on the Edit menu, choose Replace.
2 Edit the Replace dialog box as follows:

· To specify the text to find, enter it in the Find What field.
· To specify the replacement text, enter it in the Replace With field.
· To find text only if it matches a whole word, select Match Whole Word Only.
· To find text only if it matches the capitalization of the text to find, select Match Case.
· To find the next match for the text, click Find Next.
· To replace the most recently found text with the replacement text, click Replace.
· To replace all instances of the text to find with the replacement text, click Replace All.
· To cancel the Replace command, click Cancel. 
Note      Canceling the command does not undo any replacements that have already occurred.
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To check spelling in a FrontPage web
If any pages are open in the FrontPage Editor, save them so the most current version of the FrontPage web is 
checked.

The Spelling command works on elements that can be edited in place on the page. For example, page titles 
added in the Page Properties dialog box, or buttons that have been added to the page by a FrontPage 
component, are not included in the Spelling command.

1 If you want to check the spelling of selected pages in your web, in the FrontPage Explorer, select those 
pages. You can select pages in any view except the Hyperlink Status view, the Themes view, or the Tasks 
view.

2 On the Tools menu, choose Spelling, or click the Cross File Spelling button on the toolbar:

The Spelling dialog box is displayed.
3 Specify the options in the Spelling dialog box as follows, then click Start:

· To check the spelling of all pages in your web, select the All Pages option.
· To check the spelling of the selected pages (if any), select the Selected Pages option.
· To add a task to the list in the Tasks view for each page in which misspelled text is found, select the Add A 

Task For Each Page With Misspellings check box.
1 The FrontPage Explorer scans the files for misspellings then displays the results as follows:

· If you selected the Add a Task For Each Page With Misspellings check box, the Check Spelling dialog box 
lists the number of tasks added to the Tasks view. To correct the misspellings, switch to the Tasks view, 
then double-click the task corresponding to the misspelling you want to correct. The FrontPage Editor 
opens the page linked to that task.

· If you did not select the Add a Task For Each Page With Misspellings check box, the Check Spelling dialog 
box lists each page that contains misspellings. To correct the misspellings, select the pages that you want 
to correct, then click Edit Page. The FrontPage Editor opens the selected pages.
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To check spelling on a page
You can check for spelling errors on the current page.

Note      The method described here does not check the spelling in a file that is included on the page by an 
Include Page component. To check the spelling in an included file, you must first open the file.
1 In the FrontPage Editor, on the Tools menu, choose Spelling, or click the Check Spelling button on the 

standard toolbar:

Starting at the beginning of the page, the Spelling command checks the spelling of each word on the page. 
When the command finds an unrecognized word, it displays the Spelling dialog box. The possible error is 
shown in the Not in Dictionary field.
If the unrecognized word resembles a word in the Spelling command's dictionary, FrontPage proposes a 
correction in the Change To field. The Suggestions field lists other possible corrections.

2 Use the Spelling dialog box as follows:
· To correct a spelling error, edit the Change To field or click one of the proposed corrections in the 

Suggestions field, then click Change.
The error is corrected and the next error is displayed.

· To correct all instances of a spelling error, edit the Change To field or click one of the proposed corrections 
in the Suggestions field, then click Change All.
All instances of the error are corrected and the next error is displayed.

· To ignore an unrecognized word, click Ignore.
· To ignore all instances of an unrecognized word, click Ignore All.
· To add the current word to your custom dictionary, click Add to Custom Dictionary.
· To cancel the Spelling command, choose Cancel. 
Note      Canceling the command does not undo any corrections to the page or additions to the custom 
dictionary that have already occurred.
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To insert a line break
1 In the FrontPage Editor, on the Insert menu, choose Line Break.
2 In the Break Properties dialog box, select the type of line break:

· To force a line break without clearing images in the left or right margin, choose Normal Line Break.
· To force a line break that clears images in the left margin, select Clear Left Margin.
· To force a line break that clears images in the right margin, select Clear Right Margin.
· To force a line break that clears images in both margins, select Clear Both Margins.
· To edit the cascading style sheet properties for the line break, click Style. Style-sheet formatting allows for 

precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes.
3 Click OK.
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To insert a special character
1 In the FrontPage Editor, on the Insert menu, choose Symbol.
2 To select a character for insertion, click it, or use the arrow keys to move through the available selections.
3 Click Insert to insert the currently selected character.

Note      You can also insert a character by double-clicking on it.
4 Click Close.
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To find text in a FrontPage web
If any pages are open in the FrontPage Editor, save them so the most current version of the FrontPage web is 
checked.

The Find command works on elements that can be edited in place on the page. For example, page titles added 
in the Page Properties dialog box, or buttons that have been added to the page by a FrontPage component, are 
not included in the Find command.

1 If you want to find text only in selected pages in your web, in the FrontPage Explorer, select those pages. You 
can select pages in any view except the Hyperlink Status view, the Themes view, or the Tasks view.

2 On the Tools menu, choose Find, or click the Cross File Find button on the toolbar:

The Find in FrontPage Web dialog box is displayed.
2 Edit the Find In FrontPage Web dialog box as follows:

· To find text in all of the pages in your web, select the All Pages option.
· To find text only in selected pages (if any), select the Selected Pages option.
· To specify the text to find, enter it in the Find What field.
· To find text only if it matches a whole word, select Match Whole Word Only.
· To find text only if it matches the capitalization of the text to find, choose Match Case.

4 Click OK.
FrontPage lists the results of the search in the Find Occurrences dialog box.

5 To add a task to the list in the Tasks view for each page containing the search text, select the page, then click 
Add Task.

6 To edit the pages containing the search text, select the page, then click Edit Page. The FrontPage Editor 
opens the selected pages.
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To replace text in a FrontPage web
If any pages are open in the FrontPage Editor, save them so the most current version of the FrontPage web is 
checked.

The Replace command works on elements that can be edited in place on the page. For example, page titles 
added in the Page Properties dialog box, or buttons that have been added to the page by a FrontPage 
component, are not included in the Replace command.

1 If you want to replace text only in selected pages in your web, in the FrontPage Explorer, select those pages. 
You can select pages in any view except the Hyperlink Status view, the Themes view, or the Tasks view.

2 On the Tools menu, choose Replace.
2 Edit the Replace In FrontPage Web dialog box as follows:

· To replace text in all of the pages in your web, select the All Pages option.
· To replace text only in selected pages (if any), select the Selected Pages option.
· To specify the text to find, enter it in the Find What field.
· To specify the replacement text, enter it in the Replace With field.
· To find text only if it matches a whole word, select Match Whole Word Only.
· To find text only if it matches the capitalization of the text to find, select Match Case.

4 Click OK. To cancel the Replace command, click Cancel. Canceling the command does not undo any 
replacements that have already occurred.
FrontPage lists the results of the search in the Find Occurrences dialog box.

5 To add a task to the list in the Tasks view for each page containing the search text, select the page, then click 
Add Task.

6 To edit the pages containing the search text, select the page, then click Edit Page. The FrontPage Editor 
opens the selected pages.
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Expand All Command
Use the Expand All command while in Navigation view to display your entire FrontPage web structure in the 
Navigation pane.

In the Navigation pane, a plus sign on a parent page indicates that there are child pages beneath which have 
been "collapsed," or hidden from the view. You can click any plus sign to expand the view and see all of the child 
pages beneath that parent page. If none of the pages in your structure contains a plus sign, the structure is 
already completely expanded, and the Expand All command will have no effect.
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Rotate Command
Use the Rotate command while in Navigation view to reorient the FrontPage web structure in the Navigation 
pane.

In the Navigation pane, your site structure is depicted in a hierarchical view, with your home page usually at the 
topmost or leftmost level in the structure. The Rotate command acts as a "toggle" that lets you switch between 
viewing your structure hierarchically from top to bottom, or from left to right.

You can also rotate the web structure by clicking the Rotate button on the toolbar.

Rotate 
button
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Size to Fit Command
Use the Size to Fit command while in Navigation view to display your entire FrontPage web structure in the 
Navigation pane without scrolling.

In the Navigation pane, your site structure is depicted in a hierarchical view from top to bottom or from left to 
right, with your home page usually at the topmost or leftmost level in the structure. When the Size to Fit 
command has a check mark next to it, the FrontPage Explorer automatically redraws your web structure to fit in 
the Navigation pane without scrolling. When the Size to Fit command is unchecked, the FrontPage Editor 
displays horizontal or vertical scroll bars in the Navigation pane if your site is too large to fit within the pane.

You can also toggle between these two modes by clicking the Size to Fit button on the toolbar. When the button 
appears "depressed," Size to Fit is active.

Size to Fit 
button
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To create a new folder
1 In the FrontPage Explorer, you can create a new folder in two of the views:

· In the All Folders pane of the Folders view, click the folder to which you want to add a new folder.
· In the Files pane of the Navigation view, click the folder to which you want to add a new folder. To add a 

new folder at the same level as the folders listed in the Files pane, click anywhere on the background of 
the Files pane to cancel the selection of any files or folders.

2 On the File menu, choose New, then select Folder.
The FrontPage Explorer creates a new folder, labeled "New Folder."

3 To change the folder name, type its label.
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To select pages
In the FrontPage Explorer, you can select pages as follows:

· In the Folders view, click the pages you want to select in the Files pane.
· In the All Files view, click the pages you want to select from the list of folders and files.
· In the Navigation view, you can select an individual page in the Navigation pane by clicking that page. You can

select one or more pages in the Files pane by clicking those pages.
· In the Hyperlinks view, you can select an individual page in the All Pages pane or the Hyperlinks pane by 

clicking that page.
· In the Hyperlink Status view, you can select one or more pages that contain hyperlinks by clicking those 

pages in the hyperlink status list.
· In the Tasks view, you can select one or more pages that are linked to tasks by clicking those pages in the 

task list.
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To preview a printed page
In the FrontPage Editor, you can view how a page will look before you print it.

Note      The view of the page in the Print Preview window is not the same as the view of the page from a Web 
browser. When you preview the printing of pages, the pages are paginated and assigned page numbers. Web 
browsers do not paginate or assign numbers.
1 On the File menu, choose Print Preview.
2 When you have finished previewing the page, click Close.
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To preview the printing of a web structure
In the FrontPage Explorer's Navigation view, you can view how a web structure will look before you print it.

1 On the File menu, choose Print Preview.
2 When you have finished previewing the printed structure, click Close.
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To print a page
In the FrontPage Editor, you can print the active page to a printer or to a file. Hyperlinks and images are printed 
as they look in the FrontPage Editor's normal view.

1 On the File menu, choose Print, or click the Print button on the standard toolbar:

2 In the Print Range section, select the range of pages you want to print.
3 In the Copies section, select the number of copies you want to print.
4 If you want to collate copies and your printer supports collating, click Collate.
5 If you want to print to a file, select the Print to File check box.
6 Click OK.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



To view the properties of page elements
In the FrontPage Editor, properties are the characteristics of page elements, such as the title and URL of a page 
or the name and initial value of a form field. You can also specify properties for page elements such as tables, 
images, and scrolling marquees.

1 To view the properties of a page element, in the FrontPage Editor, select the element.
2 Right-click to display the shortcut menu, then click Properties.
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To test your network connection
1 In the FrontPage Explorer, on the Help menu, choose About Microsoft FrontPage Explorer.
2 In the About FrontPage Explorer dialog box, click Network Test.
3 In the FrontPage TCP/IP Test dialog box, click Start Test. The TCP/IP Test utility tests your WinSock protocol, 

IP address, TCP/IP stack, host name, and other network parameters.
4 Click Exit to close the TCP/IP Test dialog box.
5 Click OK to close the About FrontPage Explorer dialog box.
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To delete pages from the current FrontPage web
In the FrontPage Explorer, you can delete pages from the current FrontPage web as follows:

· In the Folders view, right-click the pages you want to delete in the Files pane, and then on the shortcut menu, 
click Delete. The Confirm Delete dialog box appears, allowing you one last chance to confirm or cancel the 
deletion.

· In the All Files view, right-click the pages you want to delete from the list of folders and files, and then on the 
shortcut menu, click Delete. The Confirm Delete dialog box appears, allowing you one last chance to confirm 
or cancel the deletion.

· In the Navigation view:
· To remove a page from the Navigation pane, or to delete it from the web, right-click that page, and then on 

the shortcut menu, click Delete. The Delete Page dialog box appears. You can choose to remove the page 
from the structure in the Navigation pane only (without deleting the page from the FrontPage web), or you 
can delete the page from both the structure and the FrontPage web.

· To delete one or more pages in the Files pane, right-click the pages you want to delete, and then on the 
shortcut menu, click Delete. The Confirm Delete dialog box appears, allowing you one last chance to 
confirm or cancel the deletion.

· In the Hyperlinks view, right-click the page that you want to delete in the All Pages pane or the Hyperlinks 
pane, and then on the shortcut menu, click Delete. The Confirm Delete dialog box appears, allowing you one 
last chance to confirm or cancel the deletion.
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To hide a page from Web browsers
It is sometimes useful to store a page in your FrontPage web in a hidden folder that cannot be accessed by a 
Web browser. This is useful for saving style pages, or pages that you want to include in other pages but that you 
do not want users to view directly. Every FrontPage web contains a /_private folder expressly for this purpose.

· In the Files pane of the FrontPage Explorer's Folders view, select the page or pages that you want to hide, 
and then drag them into the /_private folder.
The FrontPage Explorer automatically fixes any hyperlinks to and from the pages to reflect the new location.

Tip      To help you organize your hidden pages, you can also create folders within the /_private folder, such as 
/_private/myfolder. Folders and files within the /_private folder are inaccessible by a Web browser.
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To insert a marquee
A marquee is a region on a page that displays a horizontally scrolling text message.

1 In the FrontPage Editor, place the insertion point on a blank line of text, or select the text that you want to 
display in the marquee.

2 On the Insert menu, point to Active Elements, then click Marquee.
The Marquee Properties dialog box is displayed.

3 In the Text box, enter the line of text that the marquee should display. If you selected text on the page in step 
one, the Text box contains the selected text.

4 Adjust the values for direction, movement speed, behavior, alignment, size, repetitions, and background color.
5 Click OK.

To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To change a marquee's direction
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 For Direction, choose either Right or Left.

The Direction option controls which way the marquee text will initially scroll, slide, or alternate.
4 Click OK.

To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To change a marquee's speed
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 For Movement Speed, adjust the Delay, in milliseconds, and the Amount of movement, in pixels.

The larger the Delay, the slower your marquee will move. The larger the Amount, the faster your marquee will 
move, because it will move in larger increments of pixels.

4 Click OK.
To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To change a marquee's size
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 For Size, adjust the dimensions of the marquee with the Specify Width and Specify Height options.

Select In Pixels to specify exact width and height measurements. Select In Percent to specify the proportional 
width or height of the window. For example, if you choose 50 percent, the marquee will span 50 percent of the
window, regardless of how you resize the window.

4 Click OK.
To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To change a marquee's background color
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 In the Background Color box, choose the color you want displayed behind the moving text in the marquee.

Note      By choosing Custom in the Background box, you can display the Color dialog box, which allows you 
to create and use custom colors as the marquee background.

4 Click OK.
To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To align a marquee with text
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 For Align With Text, specify how you want to align the marquee region relative to adjacent text on the same 

line.
4 Click OK.

To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To change the number of times a marquee repeats
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.
3 For Repeat, specify the number of times you want the marquee to repeat. If you want the marquee to repeat 

continuously, select the Continuously check box.
4 Click OK.
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To change a marquee's behavior
1 In the FrontPage Editor, click the marquee to select it.
2 On the Edit menu, choose Marquee Properties.

The Marquee Properties dialog box is displayed.
3 For Behavior, choose the movement behavior for the marquee:

· Similar to a stock ticker, the Scroll option causes the marquee text to continuously scroll across the screen,
in the direction you specify.

· The Slide option causes marquee text to slide into view from the starting direction to the opposite window 
border. When the end of the defined marquee region is reached, the marquee text remains on the screen.

· The Alternate option causes marquee text to alternate back and forth from the starting direction to the 
opposite window border. The marquee text remains on the screen at all times.

4 Click OK.
To preview the marquee as it will appear when the page is browsed on the World Wide Web, on the File 
menu, choose Preview in Browser.
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To specify the margins of a page
The FrontPage Editor lets you specify the margins of the active page.

1 Right-click on the background of the page to display the shortcut menu, and then click Page Properties.
The Page Properties dialog box is displayed.

2 Click the Margins tab, and then click Specify Top Margin to set a margin from the top of the page. Type the 
height of the margin, in pixels.

3 Click Specify Left Margin to set a margin from the left side of the page, and then type the width of the margin, 
in pixels.

4 Click OK to close the Page Properties dialog box.
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To send a copy of the active page through electronic mail
To use the Send feature of the FrontPage Editor, you must have installed Microsoft Exchange, Microsoft Outlook,
or another mail system compatible with the Messaging Application Programming Interface (MAPI).

1 On the File menu, choose Send.
FrontPage starts your email editor, and then opens a new message with the active page attached.

2 In the new message window, type a subject header and the message text to introduce the FrontPage 
attachment.

3 Enter the e-mail recipients.
4 Send the message.

A copy of the active page will be sent to the specified e-mail recipient.
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Print Preview Command
Use the Print Preview command when in Navigation view to preview the printing of the web structure displayed in
the Navigation pane.
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Print Navigation View Command
Use the Print Navigation View command when in Navigation view to print the web structure displayed in the 
Navigation pane. 

Tip      You can preview how your structure will look before you print it using the Print Preview command on this 
menu.
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Open FrontPage Web Command
Use the Open FrontPage Web command to open an existing FrontPage web. In the Open FrontPage Web dialog
box, select or type the Web server name or the file location of the FrontPage web you want to open, and then list 
the FrontPage webs on that server or in that folder.

You must be authorized as an administrator or author to open a FrontPage web. If you have not yet entered your 
name and password, the Name and Password Required Dialog Box opens.

Note      If end-user access has been restricted in the root web, a name and password are required to list and 
open FrontPage webs.
The FrontPage Explorer can open only one FrontPage web at a time; however, the same FrontPage web can be 
opened by another user running the FrontPage Explorer on a different computer.

You can also open a FrontPage web by clicking the Open FrontPage Web button on the toolbar.

Open 
FrontPage 
Web button

Dialog Box Options

Select a Web Server or Disk Location
Select a Web server from the list or type in the Web server’s network location. If the FrontPage web is not on a 
Web server, select a folder from the list or type the full path and folder name.

Note      If you specify a folder that does not contain a FrontPage web, you are asked if you want to convert the 
folder to a FrontPage web.

List Webs
Click this button after choosing a Web server or folder to see the available FrontPage webs on that server or in 
that folder.

Secure Connection Required (SSL)
Select this check box if you are opening a FrontPage web on a secure port of a Web server that supports Secure
Sockets Layer (SSL). All URLs to pages on a secure Web start with https:// (instead of http://) to indicate the 
secure link. 

When you open a FrontPage web for the first time, you must select this option if you are using FrontPage with a 
secure Web server. If you do not select this option and you are using FrontPage with a secure Web server, you 
will receive a message that access has been denied.

FrontPage Webs Found at Location
Select the FrontPage web you want to open from the list of FrontPage web titles. The FrontPage webs that are 
displayed are on the currently selected Web server or in the currently selected folder. 
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Web Settings Command 
Use the Web Settings command to get information about the current FrontPage web.

The FrontPage Web Settings dialog box has five tabs:

· Use the Parameters tab to create, modify, or remove variable in a FrontPage web. You can insert the value of 
a variable using the Substitution component, or you can create variables to add comments or data to your 
FrontPage web that are hidden from users browsing your site.

· Use the Configuration tab to find information about the current FrontPage web, such as the web title, web 
name, server, and the version of the FrontPage Server Extensions installed on your computer.

· Use the Advanced tab to set advanced features of the current FrontPage web, such as client-side image 
maps, the language for validating scripts, the use of hidden directories, and other advanced web configuration
settings.

· Use the Language tab to set the default language and HTML encoding for the current FrontPage web.
· Use the Navigation tab to change the text labels on navigation bars.
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Options Command
Use the Options command to set FrontPage Explorer options.

The Options dialog box has three tabs:

· Use the General tab to specify general settings, such as showing or hiding the Getting Started dialog box, the 
toolbar and the status bar, or enabling warnings before applying a theme or when the text index is out-of-date.

· Use the Proxies tab to register the name of a proxy server, or to disable the proxy server for local intranet 
addresses.

· Use the Configure Editors tab to associate an editor with a file type.
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New Task Dialog Box
Use this dialog box to add a new task to the list of tasks in Tasks View.

Dialog Box Options

Task Name
Type the name of the task.

Assign To
Type the author assigned to the task.

Created By
Shows the name of the author who created the task as well as the date and time the task was created.

Modified By
Shows the name of the author who most recently modified the task.

Completed
Shows the completion status of the task.

Linked To
Shows the page or image linked to the task. When you add a task from the FrontPage Editor, it is linked to the 
active page. When you add a task from the Folders, All Files, Navigation, Hyperlinks, or Hyperlink Status view, 
the task is linked to the page, file, or image selected in that view.

Description
Type the description of the task.

Priority
Choose the priority for this task: High, Medium, or Low.
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Change Location Dialog Box
Use this dialog box to specify a different location for your new FrontPage web from the location suggested in the 
New FrontPage Web dialog box.

Dialog Box Options

Location
The list shows the servers recently used by FrontPage.

· Select the server for your new FrontPage web. If the server you want isn't on the list, replace the suggested 
server name by typing the name of the server you want to use. For example, if the location is 
"localhost/myweb" (where "localhost" is the server name suggested by the FrontPage Explorer and "myweb" 
is the name you gave the new web), and you want to place "myweb" on a server named "myserver," edit the 
location to read "myserver/myweb."

· If you want to add your new web to the current FrontPage web, select (Add to Current Web).

Secure Connection Required (SSL)
Select this check box if you are creating a FrontPage web on a secure port of a Web server that supports Secure
Sockets Layer (SSL). All URLs to pages on a secure Web start with https:// (instead of http://) to indicate the 
secure link.

If you are using FrontPage with a secure Web server, you must select this check box. If you do not select this 
check box and you are using FrontPage with a secure Web server, you will receive a message that access has 
been denied.
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Parameters Tab
FrontPage Web Settings Dialog Box
Use the Parameters tab to create, modify, or remove variables in a FrontPage web. You can insert the value of a 
variable using the Substitution component, or you can create variables to add comments or data to your 
FrontPage web that are hidden from users browsing your site.

For example, you might want to create a variable to display your fax number. In this dialog box, you could name 
the variable Faxnumber and type a value such as 206-555-1234.

Now when you create a new page in the FrontPage Editor, you insert a Substitution component and assign it the 
variable called Faxnumber. FrontPage automatically inserts your fax number when the page is saved. If your 
area code changes next year, you can modify the value of the Faxnumber variable in this dialog box, and the 
change will automatically be updated in all occurrences in your web pages.

You can also use this dialog box to add comments or data to your web that are hidden from users browsing your 
site. For example, you might create a Name/Value pair of state=draft to notify authors that a draft of the 
FrontPage web is being written.

Dialog Box Options

Name
The name of the variable or comment. When you select a variable from this list, both the Name and Value fields 
are selected.

Value
The value that is associated with the name of the variable or comment. When you select a variable from this list, 
both the Name and Value fields are selected.

Add
Click Add to add a variable. In the Add Name and Value dialog box, specify the name and value of the variable.

Modify
Click Modify to modify the selected variable. In the Modify Name and Value dialog box, change the name and 
value of the variable.

Remove
Click Remove to remove the selected variable.

Apply
Click Apply to apply any changes you have made.
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Configuration Tab
FrontPage Web Settings Dialog Box
Use the Configuration tab of the Web Settings dialog box to view information about the current FrontPage web 
and server.

Dialog Box Options

Web Name
The name of the current FrontPage web. You can rename the current FrontPage web if you are authorized as an 
administrator in the root web. To rename the web, type in a new web name.

A web name corresponds to a directory name on a Web server and is subject to the length, character restrictions,
and case sensitivity of that server.

Note      If this field is read-only, renaming webs is unavailable for your type of server.

Web Title
The web title. To rename the title of a web, type in a new web title.

Source Control Project
If you have a server that supports Microsoft Visual SourceSafe version 5.0 and your FrontPage web is stored on 
that server, you can set up a SourceSafe project for the FrontPage web.

Enter the name of the Visual SourceSafe project to which you want to assign your web. The project name must 
begin with $/, for example $/Name. If the project does not exist, FrontPage will create a project for you. 
FrontPage will not create sub-projects. 

Web Server
The URL of the Web server.

FrontPage Server Extensions Version
The version of the set of programs installed on you server that manage FrontPage features.

Server Version
The name and version number of your server software.

IP Address
The IP address of your server.

Proxy Server
This is URL of the proxy server, if any.

Apply
Click Apply to apply any changes you made to your web title or web name.
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Advanced Tab
FrontPage Web Settings Dialog Box
Use the Advanced tab of the Web Settings dialog box to set advanced features for the current FrontPage web.

Dialog Box Options

Image Maps
Use the Image Maps section to configure FrontPage to generate image maps for a specific server type, and to 
generate client-side image maps.

Style

Select the server image-map style: FrontPage, NCSA, CERN, Netscape, or <None>. If you select <None> 
FrontPage will not generate HTML to support server-side image map processing.

Prefix

The server-relative URL of the server-side handler for the selected image-map style. If style is FrontPage, server-
side image maps are handled automatically. For other styles, accept the displayed default or provide the name 
and location of a handler.

Generate client-side image maps

Select this check box to instruct FrontPage to generate HTML that supports client-side image maps. You can 
configure FrontPage to generate both client-side and server-side HTML by clicking this field and selecting a 
server-side image map style.

Language
Use this section to select the scripting language for the scripts that are automatically generated to enforce any 
data validation settings you apply to form fields.

The language that you can use to enforce the validation of form fields are:

VBScript

Microsoft Visual Basic Script is a web-scripting language derived from the popular Microsoft Visual Basic 
language. It is supported in Microsoft Internet Explorer version 3.0 and higher.

JavaScript

JavaScript is Netscape Communication Corporation's brand name for the built-in scripting language in Navigator 
(also known as LiveScript). Microsoft Internet Explorer version 3.0 and higher supports the same language with 
its Jscript interpreter.

None

Select this option only if you have no scripts in your web.

Show documents in hidden directories
Select this to configure the FrontPage Explorer to display documents in hidden directories. If a web contains a 
discussion group, select this option to view the accumulated topic files in the FrontPage web.

Recalculate Status
The information in this section is generated by the FrontPage Explorer.

Included Page Dependencies Are Out Of Date

This field is selected if an Include Page component is out-of-date on any page in the FrontPage web. 

Text Index is Out Of Date

This field is selected if FrontPage has a text index that is out-of-date.



Apply
Click Apply to apply any changes you made to your web title or web name.
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Language Tab
FrontPage Web Settings Dialog Box
Use the Language tab to change the default FrontPage web language or HTML coding.

Default Web Language
This setting is used by the FrontPage Server Extensions to decide the language that should be used to return 
error messages from the Web server back to the Web browser. If you are creating web pages in another 
language, change this setting so that any error messages from the web server will match the content in your web
pages.

Default HTML Encoding
If you want the pages you are creating to be saved in a different character set from the default character set for 
your computer, select the character set from the list. Any new pages created in the FrontPage web will be saved 
in this encoding by default. You can still save pages using other encodings, but to do that you need to set the 
HTML encoding option in the General tab of the Page Properties dialog box on the File menu in the FrontPage 
Editor.
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General Tab
Options Dialog Box
Use the General tab to specify general settings, such as showing or hiding the Getting Started dialog box, the 
toolbar and the status bar, or enabling warnings before applying a theme or when the text index is out-of-date.

Dialog Box Options

Show Getting Started Dialog
When this check box is selected, the FrontPage Explorer displays the Getting Started dialog box when you start 
FrontPage, open, close, or delete a FrontPage web. By default, this option is selected.

If the check box is not selected, the Open FrontPage Web dialog box and the last web opened in the FrontPage 
Explorer are displayed.

Show Toolbar
Select this check box to display the toolbar, which contains buttons for the most commonly used commands, 
such as Open FrontPage Web, Copy, and Paste.

Show Status Bar
Select this check box to display the status bar, which shows information about a selected command or option.

Warn When Included FrontPage Components are Out Of Date
When this check box is selected, the FrontPage Explorer displays a message box to tell you that the allotted time
for displaying an Include Page component, Scheduled Image component, or Scheduled Include Page component
has expired in the current FrontPage web. By default, this check box is clear.

Warn When Text Index is Out of Date
When this check box is selected, the FrontPage Explorer displays a message telling you that the text index in 
FrontPage is out-of-date, then asks you if you want to recalculate the text index. For example, if you delete a 
page from your FrontPage web, you are warned that the text index is out-of-date so you can remove all 
references to that page from the text index.

Warn Before Permanently Applying Themes
When this check box is selected, the FrontPage Explorer displays a warning message whenever you choose to 
apply a theme in Themes View. By default, this check box is selected.
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Proxies Tab
Options Dialog Box
Use the Proxies tab to register the name of a proxy server, if your local network uses one. This command also 
lets you register all hosts that are inside your firewall.

For example, the proxy server will be used:

· When you use the FrontPage Editor's Follow Hyperlink command to link to a page outside of the firewall.
· When you use the FrontPage Editor's Open command to open a page outside of the firewall.
· When you use the FrontPage Explorer to open a hyperlink external to a FrontPage web.

Dialog Box Options

HTTP Proxy
Type the name of the proxy server and port (for example, my.proxy.server:2001.)

List of Hosts Without Proxy
Type the names and port numbers of servers that you want to use that are inside the firewall. Use a comma to 
separate the entries in the list.

Do Not Use Proxy Server for Local (Intranet) Addresses
Select this check box to allow only addresses that are fully qualified domain names (that is, the addresses have 
one or more periods in them) to go through a proxy server.
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To repair a broken hyperlink
Note By default, only broken internal hyperlinks and all external hyperlinks are displayed in the Hyperlinks Status
view. To show all internal hyperlinks, choose Show All Hyperlinks on the View menu.
1 Click a broken hyperlink to select it for repair.
2 On the shortcut menu, choose Edit Hyperlink.
3 In the Replace Hyperlink With field, enter the correct URL for the hyperlink.

For external hyperlinks, click Browse to open your Web browser and surf to the web site for the correct URL. 
Click ALT+TAB to return to the FrontPage Explorer. The correct URL will be added to the Replace Hyperlink 
With field.

4 Select one of the following options:
· To repair the broken hyperlink in all pages in the current FrontPage web, choose Change In All Pages.
· To repair the broken hyperlink in set of selected pages, choose Change in Selected Pages.

5 Click Replace.
The status of the hyperlink changes to Unknown if the hyperlink is external to the web, and if the hyperlink is 
to a file in the current FrontPage web, the status changes to OK.
Note      To ensure that the hyperlink is good, verify all hyperlinks again by clicking Verify on the shortcut 
menu.
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To recalculate hyperlinks
You recalculate hyperlinks to update the FrontPage Explorer's display of the current FrontPage web. In a multi-
authoring environment, this will let you view recent changes made to the FrontPage web by other authors. 
Recalculating hyperlinks also updates the text index maintained by the FrontPage Explorer. 

· In any view in the FrontPage Explorer, on the Tools menu, choose Recalculate Hyperlinks.
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To select a hyperlink
You select a text or image    hyperlink to follow, change, or delete it.

To select a text hyperlink

· In the FrontPage Editor, do one of the following:
· Place the pointer anywhere in the text containing the hyperlink.
· Select any part of the hyperlink.
· Double-click the hyperlink to select the entire hyperlink.

To select an image map hyperlink

· In the FrontPage Editor, click the hotspot in the image.

To select an image that is a hyperlink

· In the FrontPage Editor, select the entire image.
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To select hyperlink color
You can select the color of all hyperlinks on a page. When the page is viewed in a Web browser, all hyperlinks 
that have not been selected during the time period a Web browser lets you specify, will be displayed in this color. 

Note      The Background command on the Format menu is unavailable if there is a theme applied to the page. 
When using themes the colors of hyperlinks are set automatically.
1 In the FrontPage Editor, on the Format menu, choose Background.

The current color of hyperlinks in a page is displayed in the Hyperlink option.
2 To change the hyperlink color, select a color from the Hyperlink drop-down list or select Custom to define a 

custom color.
3 Click OK.
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To select visited hyperlink color
You can select the color of all visited hyperlinks in a page. When the page is viewed in a Web browser, all visited 
hyperlinks that have not been selected during the time period the Web browser lets you specify, will be displayed 
in this color.

Note      The Background command on the Format menu is unavailable if there is a theme applied to the page. 
When using themes the colors of hyperlinks are set automatically.
1 In the FrontPage Editor, on the Format menu, choose Background.

The current color of visited hyperlinks in a page is displayed in the Visited Hyperlink option.
2 To change the visited hyperlink-color, select a color from the Visited Hyperlink drop-down list or select Custom

to define a custom color.
3 Click OK.
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To select active hyperlink color
You can select the color of all active hyperlinks in a page. When the page is viewed in a Web browser, all visited 
hyperlinks that have not been selected during the time period the Web browser lets you specify, will be displayed 
in this color.

Note      The Background command on the Format menu is unavailable if there is a theme applied to the page. 
When using themes the colors of hyperlinks are set automatically.
1 In the FrontPage Editor, on the Format menu, choose Background.

The current color of active hyperlinks in a page is displayed in the Active Hyperlink option.
2 To change the active hyperlink-color, select a color from the Active Hyperlink drop-down list or select Custom 

to define a custom color.
3 Click OK.
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To verify hyperlinks
A critical part of managing a web site is verifying all the hyperlinks — both internal and external — contained in 
the site. The FrontPage Explorer verifies both internal and external hyperlinks and gives you a report on the 
status of the hyperlinks.

After Hyperlinks have been verified, they keep their status until the FrontPage web is closed or until they are 
verified again while the web is still open.

· In the Hyperlink Status view in the FrontPage Editor, choose Verify Hyperlinks on the Tools menu. To stop 
verifying hyperlinks, click Stop.
After a hyperlink is verified, it can have one the following statuses:

, when the URL of the hyperlink is incorrect.
, when the URL of the hyperlink is correct.
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Add/ Choice Dialog Box
Modify Choice Dialog Box
Use the Add Choice dialog box to add or modify a drop-down menu field choice. 

Dialog Box Options

Choice
Enter the name of the menu choice.

Specify Value
By default, the value submitted to a form handler for this menu choice will be the same as the name of the menu 
choice. If you want to specify a different value to associate with this choice, click Specify Value and enter the new
value.

Initial State
Choose whether you want the menu choice to be selected or not selected when it is first displayed in a Web 
browser.
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Convert Text Dialog Box
The Convert Text dialog box is displayed by the Open command when you want to open a text file and by the File
command when you want to insert a text file. The dialog box presents options for converting the text to 
FrontPage Editor paragraph styles.

Dialog Box Options 

One formatted paragraph
Converts the text to a single paragraph of formatted text, with line breaks.

Formatted paragraphs
Converts each paragraph in the text file to formatted text.

Normal paragraphs
Converts each paragraph in the text file to normal text.

Normal paragraphs with line breaks
Converts each paragraph in the text file to normal text and preserves the line endings by inserting line breaks at 
the end of each line.

{button Related Procedures,AL(`file page procedures',0,`',`main')}



Comment Dialog Box
Use the Comment dialog box to insert a comment in a page. Comments are invisible from Web browsers, so you 
can leave them in your page even after you publish the web on the World Wide Web. 

Dialog Box Options

Comment
Enter the text to appear on your page, in a single paragraph.

Note      The text will wrap when you reach the end of a line. Press ENTER or click OK to accept your edits. To 
cancel your edits, click Cancel.
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Text Properties Dialog Box
Use the Text Properties dialog box to view and set the properties of a one-line text box.

Dialog Box Options

Name
Type the name that you want associated with the field. When the form is submitted, the name is sent to a form 
handler as part of the of the name-value pair that identifies the field. The name of the text box field is not 
displayed on the page. Type a name on the page if you want the form field to have a name.

Initial value
Enter the characters to appear in the field when the page is first displayed in a Web browser.

Width in characters
Ender the width you want the text box field to be, in characters. You can also change the width of a text box using
its size handles.

Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Password field
To use this text box field as a password field, select Yes. Select no if you do not want the field to be a password 
field. To protect a password, most Web browsers display the password field as a row of asterisks.

Validate
Click Validate to open the Text Box Validation Dialog Box. Use this dialog box to restrict what a user can enter in 
the text box.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Check Box Properties Dialog Box
Use the Check Box Properties dialog box to view and set the properties of a check box.

Dialog Box Options

Name
Type the name that you want associated with the check box field. When the form is submitted, the name is sent 
to a form handler as part of the of the name-value pair that identifies the field. The names of check boxes do not 
need to be unique. The name of the text box field is not displayed on the page. Type a name on the page if you 
want the form field to have a name.

Value
The value associated with this field.

Initial state
Choose whether you want the check box to be checked or not checked when it is first displayed in a Web 
browser.

Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers.

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Scrolling Text Box Dialog Box
Use the Scrolling Text Box Properties dialog box to view and set the properties of a scrolling text box.

Dialog Box Options

Name
The name associated with this scrolling text box field. When the form is submitted, the name is sent to a form 
handler as part of the of the name-value pair that identifies the field. The name of the text box field is not 
displayed on the page. Type a name on the page if you want the form field to have a name.

Initial value
Enter the characters to appear in the field when the page is first displayed in a Web browser.

Width in characters
Ender the width you want the text box field to be, in characters. You can also change the width of a scrolling text 
box using its size handles.

Number of lines
The height of the scrolling text box field, in number of lines of text. You can also change the height of a text box 
using its size handles.

Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Radio Button Properties Dialog Box
Use the Radio Button Properties dialog box to view and set the properties of a radio button.

Dialog Box Options

Group Name
The name associated with the radio button field. FrontPage creates a default group name for you when the field 
is inserted on the page. When the form is submitted, the name is sent to a form handler as part of the of the 
name-value pair that identifies the field. The name of the radio button field is not displayed on the page. Type a 
name on the page if you want the form field to have a name.

To create a set of radio buttons on a form so that only one can be selected, give all the buttons in the set the 
same group name.

Value
The value associated with the button. Assign each radio button a unique value. When the form is submitted, the 
value of the single selected button is sent to the form handler along with the name associated with the set of 
buttons.

Initial State
Choose whether you want the radio button to be selected or not selected when it is first displayed in a Web 
browser. Only one radio button in the same group can be selected at a time.

Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Validate
Click Validate to open the Radio Button Validation Dialog Box. Use this dialog box to require a user to choose an 
option from a group of options by selecting a radio button.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Drop-Down Menu Properties Dialog Box
Use the Drop-Down Menu Properties dialog box to view and set the properties of a drop-down menu field,

Dialog Box Options

Name
The name associated with the drop-down menu field. When the form is submitted, the name of the drop-down 
menu field, followed by a list of each selected menu choice, is sent to the form handler as the name-value pair of 
this field.

Choice
Lists the names of the menu choices associated with this drop-down menu. Selected choices are sent to the form
handler. To add a choice, click Add, which opens the Add Choice Dialog Box.

Selected
Choose whether you want the menu choice on the current row to be selected or not selected when it is first 
displayed in a Web browser. Set the initial state of the menu choice in the Add Choice Dialog Box.

Value
The value of the menu choice on the current row. If you supply a value, the value is sent to the form handler 
when the form is submitted instead of the name of the menu choice. Set a value in the Add Choice Dialog Box.

Add
Click Add to add a menu choice to the bottom of the list. You name the choice and set its initial state and value in 
the Add Choice Dialog Box. 

Modify
Click Modify to modify the currently selected menu choice using the Add Choice Dialog Box.

Remove
Click Remove to remove the currently selected choice from the menu.

Move Up
Click Move Up to move the currently selected choice up in the menu.

Move Down
Click Move Down to move the currently selected choice down in the menu.

Height
Click Height to set the height of the menu. The height of a drop-down menu field controls how the menu appears:

· If the menu allows only 1 selection and the height is 1, most Web browsers display the menu as a drop-down 
list.

· If the menu allows only 1 selection and the height is larger than 1, most Web browsers display the menu as a 
scrollable list.

· If the menu allows more than 1 selection and the height is 1, most Web browsers display the menu as a 
scrollable list with half-height scroll arrows. This combination of settings makes it difficult to use the menu.

· If the menu allows more than 1 selection and the height is larger than 1, most Web browsers display the menu
as a scrollable list with full-height scroll arrows.

Allow multiple selections
Select Yes to allow more than one menu item to be selected at a time. Select No to permit only one selection at a
time.



Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Validate
Click Validate to open the Drop-Down Menu Validation Dialog Box. Use this dialog box to require a user to 
choose an one of more options from a drop-down menu.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Push Button Properties Dialog Box
Use the Push Button Properties dialog box to view and set the properties of a push button.

Dialog Box Options

Name
The name associated with this push button field. When the form is submitted, the name is sent to a form handler 
as part of the of the name-value pair that identifies the field. Naming a push button is useful if you create more 
than one push button on a single form, and want to process the form based on which button was selected.

Value/Label
The label of the push button. If you supply a label, it replaces the default label on the push button. 

If you provide a label and a name, the label is sent to the form handler as the value portion of the field's name-
value pair.

Button type
Select the type of push button. Select Submit to use the button to submit the form; when you select Submit, the 
default label is Submit. Select Reset to use the button to reset the form to its initial state; when you select Reset, 
the default label is Reset. Select Normal if you want to insert a generic button to which you can assign a script; 
when you select Normal, the default label is Button.

Tab order
Enter a value in this field to control the order in which a user can move from field to field within a form using the 
TAB key. 

Only Internet Explorer 4.0 or later supports Tab Order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

Enter a number 1 through 999 to establish the order to use for navigating between fields in a form. If two fields 
share the same number, the field defined earlier on the page will come first. Enter -1 to remove the control from 
the tab order.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.

Form
Click Form to edit the Form Properties Dialog Box for the form containing this field.

{button Related Procedures,AL(`field form procedures',0,`',`main')}



Image Form Field Properties Dialog Box
Use the Image Form Field Properties dialog box to view and set the properties of an image form field.

Dialog Box Options

Name
Type the name that you want associated with the field. When the form is submitted, the name is sent to a form 
handler as part of the of the name-value pair that identifies the field. 

Image Properties
Click the Image Properties button to open the Image Properties dialog box where you can view and change the 
properties of the image you inserted.

Form
Click Form to edit the Form Properties Dialog Box for the form containing this field.

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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Image Toolbar Command 
Use the Image Toolbar command to display or hide the FrontPage Editor's image toolbar. The image toolbar 
contains commands that operate on images. When this command has a check mark next to it, the toolbar is 
displayed.
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Standard Toolbar Command
Use the Standard Toolbar command to display or hide the standard FrontPage Editor toolbar. The standard 
toolbar contains the most commonly used Edit and File menu commands; commands for inserting FrontPage 
components, tables, and images; and other commands such as creating and editing hyperlinks. When this 
command has a check mark next to it, the toolbar is displayed.
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Advanced Toolbar Command
Use the Advanced Toolbar command to display or hide the FrontPage Editor’s advanced toolbar. The advanced 
toolbar contains commands that insert custom HTML tags, ActiveX controls, Java applets, plug-ins, VBScript, or 
JavaScript on a page. When the Advanced Toolbar command has a check mark next to it, the toolbar is 
displayed.
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To create a new page
1 In the FrontPage Editor, on the File menu, choose New.

The New dialog box is displayed.
2 On the Page tab, select a template or wizard on which to base the new page.

When you select a template or wizard from the list, a thumbnail sketch of that template or output from that 
wizard, is displayed in the Preview area.

3 Click OK.
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To create a template page
In the FrontPage Editor, you can save a page as a template. After you have saved the template, it will be 
displayed along with the standard FrontPage page templates in the Page tab of the New dialog box.

1 On the File menu, choose Save As.
2 Click As Template.
3 In the Save As Template dialog box, type a page title for the template in the Title field, a name for the page in 

the Name field, and a brief description of the template in the Description field.
The page title and the description will be displayed when the user selects that template in the Page tab of the 
New dialog box.

4 Click OK.
If you applied a theme before saving the page as a template, the template will apply the theme as follows:

· If you applied the theme to the original page by choosing the Use Theme From Current Web option, when you
create a new page from the template, the new page will automatically apply the theme (if any) from the current
FrontPage web.
For example, if the original page applied the "Canvas" theme from its web, and you use the resulting template 
to create a new page in a new web which uses the "Safari" theme, the new page will automatically apply the 
"Safari" theme instead of "Canvas."

· If you applied the theme to the original page by choosing the Use Selected Theme option, when you create a 
new page from the template, the new page will apply the same theme as the original page.
For example, if the original page applied the "Canvas" theme to that page only, and you use the resulting 
template to create a new page in a new web which uses the "Safari" theme, the new page will apply the 
"Canvas" theme instead of "Safari." You can still apply the Safari theme to the new page using the Theme 
command on the Format menu.
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To apply one page's background style and colors to another page
You can display a page using the same background style and colors as another page in your FrontPage web. 
The page will use the background image, background color, and all hyperlink and text colors from the page that 
you specify.

Note      This feature is disabled if a theme has been applied to the current page.
1 In the FrontPage Editor, open the page that you want to display using another page's background style and 

colors.
2 On the Format menu, choose Background.
3 Select Get Background and Colors from Page.
4 Click Browse, and then in the Current Web dialog box, select the page containing the background style and 

colors that you want to use on the current page.
5 Click OK.
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To add a horizontal line
1 In the FrontPage Editor, move the insertion point where you want the horizontal line added.

Note      If the insertion point is at or near the end of a line, the horizontal line is added on the next line.
2 On the Insert menu, choose Horizontal Line.

The FrontPage Editor inserts a horizontal line. If a theme has been applied to the current page, the FrontPage
Editor inserts a horizontal line based on that theme.
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To preview a page in a Web browser
If you have installed Microsoft Internet Explorer version 3.0 or higher on your computer, you can quickly preview 
the current page in the FrontPage Editor by clicking the Preview tab.

If you have not installed Microsoft Internet Explorer version 3.0 or higher on your computer, the FrontPage Editor 
will not display a Preview tab. Instead, use the following procedure:

1 On the File menu, choose Preview in Browser.
The Preview in Browser dialog box is displayed.

2 Select a Web browser from the Browser list.
3 To change the size of your Web browser's window, choose a Window Size.
4 Click Preview.
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To add a Web browser to the preview list
In the FrontPage Editor, the Preview in Browser dialog box displays a list of Web browsers called the preview list.
If the browser you want to use isn't on the preview list, you can add it using the following procedure. You must 
have a page open to use the Preview in Browser command.

1 On the File menu, choose Preview in Browser.
The Preview in Browser dialog box is displayed.

2 Click Add.
The Add Browser dialog box is displayed.

3 In the Name box, type the name of the Web browser as you want it to appear in the preview list of the Preview
in Browser dialog box.

4 In the Command box, type the name and path of the Web browser’s executable file, or click Browse to find the
file in your file system or local network.

5 Click OK to close the Add Browser dialog box.
The Preview in Browser dialog box is displayed with the new browser added to the list.

6 Click Close to close the Preview in Browser dialog box.
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To set the preview window size
In the FrontPage Editor, the Preview in Browser dialog box lets you specify the size of a Web browser window 
when you are previewing a page. You must have a page open to use the Preview in Browser command.

1 On the File menu, choose Preview in Browser.
The Preview in Browser dialog box is displayed.

2 In the Window Size section, select an option for the Web browser’s window size. This size is used for all Web 
browsers in the preview list.

3 Click Close to close the Preview in Browser dialog box.
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To change the appearance of a horizontal line
In the FrontPage Editor, move the pointer over the horizontal line and double-click it. This displays the Horizontal 
Line Properties dialog box.

Note      If a theme has been applied to the page, you can change only the alignment of the line.
· In the Width area, choose whether to specify the width of the horizontal line as a percent of the window's 

width, or as a fixed number of pixels, and then type the appropriate value. If you specify a Width option of 
Percent of window and a value of 100, the line will occupy the entire width of the window.

· In the Height area, type the height of the line, in pixels.
· In the Alignment area, choose whether to align the line with the left margin, center the line, or align the line 

with the right margin. If the Width options are set to 100 percent of window, the Alignment option has no effect.
· In the Color box, select the color you want from the list. If you select a color, the line will be solid, and you 

cannot apply shading.
· Select the Solid Line check box if you want the line to appear solid. Clear the check box if you want the line to 

appear shaded. If you select a Color, the line will be solid, and you cannot apply shading.
· To edit the cascading style sheet properties for the horizontal line, click Style. Style-sheet formatting allows for

precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes.
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To resize a cell
You can quickly resize a cell by dragging the borders of a cell to the height or width you want.

In the Cell Properties dialog box, you can also resize a cell by specifying width, height, or both; size can be in 
pixels or percent of window size. If a table is sized in pixels, its size remains constant regardless of the size of 
the window in which it displays. A table sized in percent changes depending on the size of the window in which it 
displays.

1 In the FrontPage Editor, move the insertion point inside the cell you want to resize.
2 On the Table menu, choose Cell Properties.
3 To specify width, in the Minimum Size section:

· Select the Specify Width check box.
· Type a value for the width of the selected cell.
· Select In Pixels or In Percent.

4 To specify height, in the Minimum Size section:
· Select the Specify Height check box.
· Type a value for the height of the selected cell.
· Select In Pixels or In Percent.

5 Click OK.
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To convert existing text to a table
Before following this procedure, indicate where you want to divide text into columns and rows by adding 
separator characters to your text. For instance, use commas to divide columns, and use paragraph marks to 
mark the ends of rows.

Tip      Because HTML does not directly support tab characters, it is recommended that you use commas or other 
characters to separate columns.
1 Select the text you want to convert to a table.
2 On the Table menu, choose Convert Text To Table.

The Convert Text to Table dialog box is displayed.
3 In the Separate Text At area, select the character you used to separate columns, such as commas, and then 

click OK.
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To convert a table to text
When you convert a table to text, FrontPage separates each table cell into a paragraph.

1 Select the table that you want to convert to text.
2 On the Table menu, choose Convert Table To Text.
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To distribute rows and columns evenly
If you have a table of varying row heights and column widths, you can use the Distribute Rows Evenly and 
Distribute Columns Evenly commands to equalize the width or height of the selected rows or columns.

1 Select the rows or columns that you want to make the same height or width.
2 On the Table menu, choose Distribute Rows Evenly or Distribute Columns Evenly, or click the Distribute 

Rows Evenly or Distribute Columns Evenly buttons on the table toolbar:

 Distribute Rows Evenly button

 Distribute Columns Evenly button
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To add a task from the FrontPage Explorer
Use this procedure to add a new task to the current FrontPage web. The task is then added to the list in Tasks 
View.

1 To add a task linked to a specific page, image, or other file, select the page, image, or file in Folders View, All 
Files View, Navigation View or Hyperlinks View, and then on the shortcut menu, choose Add Task.
To add a task that is not linked to a specific page, image, or file, click the Tasks button on the Views bar to 
switch to Tasks View, and then click the New Task button on the toolbar:

The New Task dialog box is displayed.
2 In the Task Name box, type the name of the task.
3 In the Assigned To box, type the name of the person responsible for completing the task.
4 In the Description box, type the description of the task.
5 In the Priority area, select the priority for this task.

If you selected a page, image, or file to link to the task, the Linked To field displays the name of that page, 
image, or file.

6 Click OK.
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To add a task from the FrontPage Editor
Use this procedure to add a new task linked to the active page. The task is then added to the list in the 
FrontPage Explorer's Tasks View.

1 On the Edit menu, choose Add Task. If you have not yet saved the active page, you will be prompted to do 
so before continuing.
The New Task dialog box is displayed.

2 In the Task Name box, type the name of the task.
3 In the Assigned To box, type the name of the person responsible for completing the task.
4 In the Description box, type the description of the task.
5 In the Priority area, select the priority for this task.

The Linked To field displays the name of the active page to which this task is linked.
6 Click OK.
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To modify a task
1 In the FrontPage Explorer, click the Tasks button on the Views bar to switch to Tasks View.
2 Select the task that you want to modify, and then on the shortcut menu, choose Edit Task.

The Task Details dialog box is displayed.
3 Move the insertion point to the field you want to modify, then type the new information.
4 Click OK.
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To show completed tasks
· In the FrontPage Explorer, on the View menu, choose the Task History command.
When the Task History command has a check mark next to it, tasks that you have marked as completed are 
included in the list in Tasks view. When the Task History command is unchecked, tasks that you have marked as 
completed will be hidden from the task list after you switch to another view on the Views bar.
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To view task history
· In the FrontPage Explorer, on the View menu, choose the Task History command.
When the Task History command has a check mark next to it, tasks that you have marked as completed are 
included in the list in Tasks view. When the Task History command is unchecked, tasks that you have marked as 
completed will be hidden from the task list after you switch to another view on the Views bar.
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To mark a task completed
1 In the FrontPage Explorer, click the Tasks button on the Views bar to switch to Tasks View.
2 Select the task that you want to mark as completed, and then on the shortcut menu, choose Mark Complete.

The task status changes to Completed and shows a green light.
4 Click OK.

To show completed tasks, on the View menu, choose the Task History command.
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To delete a task
1 In the FrontPage Explorer, click the Tasks button on the Views bar to switch to Tasks View.
2 Select the task that you want to delete, and then on the shortcut menu, choose Delete.

The Confirm Delete dialog box is displayed.
4 Click Yes to delete the task.
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To do a task
To do a task, that task must be linked to a page, image, or other file.

1 In the FrontPage Explorer, click the Tasks button on the Views bar to switch to Tasks View.
2 Select the task that you want to do, and then on the shortcut menu, choose Do Task.

· If the task is linked to a page, the FrontPage Editor opens that page.
· If the task is linked to an image or file, FrontPage opens the image or file using the editor associated with 

that type of image or file.
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Follow Hyperlink Command
Use the Follow Hyperlink command to follow the selected hyperlink to its destination.

· If the hyperlink leads to a bookmark on the current page, the FrontPage Editor scrolls the window to that point.
· If the hyperlink leads to another page in the current FrontPage web, the FrontPage Editor opens that page.
· If the hyperlink leads to a page on the World Wide Web, the FrontPage Editor downloads that page and opens

it to allow editing.
Following a hyperlink may take a long time. If the hyperlink is to a server that is not responding, it may never 
succeed. You can cancel the Follow Hyperlink command using the Stop button on the standard toolbar:

You can also follow a hyperlink by pressing CTRL and then clicking the hyperlink. When you press CTRL over a 
hyperlink, the pointer changes to a hand.
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Mail Command
Note      This command is available only if you have installed Microsoft Internet Explorer version 4.0 or higher and
an Internet Mail editor on your computer.
Use the Mail command to open your Internet Mail service for reading or sending electronic mail.
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News Command
Note      This command is available only if you have installed Microsoft Internet Explorer version 4.0 or higher and
an Internet News service on your computer.
Use the News command to open your Internet News service.
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Contacts Command
Note      This command is available only if you have installed Microsoft Internet Explorer version 4.0 or higher and
a Contact Manager application on your computer.
Use the Contacts command to open your Contact Manager for viewing or updating your address book.
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Horizontal Line Properties Dialog Box
Use the Horizontal Line dialog box to set and view the properties of a horizontal line.

Note      If a theme has been applied to the page, you can change only the alignment of the line.

Dialog Box Options

Width
Use this area to choose whether to specify the width of the horizontal line as a percent of the window's width, or 
as a fixed number of pixels. If you specify a Width option of Percent of Window and a value of 100, the line will 
occupy the entire width of the window.

Percent of window

Select this option, then type a percentage of the width of the window. 

Pixels

Select this option, then type the line's width, in pixels.

Height
Use this section to set the height of the line, in pixels.

Pixels

Type the line's height, in pixels.

Alignment
Use this area to choose whether to align the line with the left margin, center the line, or align the line with the 
right margin. If the Width options are set to 100 percent of window, the Alignment option has no effect.

Left

Select this option to begin the line at the left margin of the page.

Center

Select this option to center the line on the page.

Right

Select this option to align the line with the right margin.

Color
Select the color you want from the list, or click Custom to define a custom color. If you select a color, the line will 
be solid, and you cannot apply shading.

Solid Line
Select this check box if you want the line to appear solid. Clear the check box if you want the line to appear 
shaded. If you select a Color, the line will be solid, and you cannot apply shading.

Style
Click this button to edit the cascading style sheet properties for the horizontal line. Style-sheet formatting allows 
for precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Text Box Validation Dialog Box
Use the Text Box Validation dialog box to set field validation rules for one-line text box and scrolling text box form
fields.

Dialog Box Options

Display Name
By default, validation warning messages identify the field by its name, as entered in the Name field of the field’s 
properties dialog box. Often, the label that the user sees, which is typed directly into the form, does not match the
field’s internal name. Use the Display Name field to specify the name that should be used to refer to the field in 
validation warning messages.

Data Type
Choose the type of data to which you want to limit the field:

· No Constraints
· Text
· Integer
· Number

Text Format
This section contains settings for fields that can only contain text.

Letters

Select this check box to allow the field to contain alphabetic characters.

Digits

Select this check box to allow the field to contain numeric characters.

Whitespace

Select this check box to allow the field to contain white space, including spaces, tabs, carriage returns, and line 
feeds.

Other

Select this check box and type other permissible characters, such as commas or hyphens, to allow the field to 
contain those characters.

Numeric Format
This section contains settings for fields that can only contain integers or numbers.

Grouping

Select a grouping punctuation-character to use in the number or integer:

· None indicates that no punctuation is permissible as in 123456789
· Comma indicates that the comma character is permissible, as in 123,456,789
· Period indicates that the period character is permissible, as in 123.456.789

Decimal

If you limited the use of the field to Number, you can specify a punctuation character to use as a decimal point:

· Comma indicates that the comma character is permissible for the decimal point, as in 123.456,789
· Period indicates that the period character is permissible for the decimal point, as in 123,456.789
Note      You cannot use the same character as both the decimal point and the grouping character.

Data Length



This section contains data length settings for any data type.

Required

Select this check box to specify that data is required in the field.

Min Length

Select this check box to specify a minimum data length.

Max Length

Select this check box to specify a maximum data length.

Data Value
This section contains data value settings for any data type.

Field Must Be

Select this check box to specify a data value limit, and then choose one of the following limits:

· Less Than
· Greater Than
· Less Than Or Equal To
· Greater Than Or Equal To
· Equal To
· Not Equal To

Value

Type a value to complete the data-value limit. The data-value limit will use numerical comparisons if the data type
is Number or Integer and alphabetical order comparisons if the data type is Text or No Constraints.

For example, if the data type in Integer, and Field Must Be is Greater Than, typing 100 in Value specifies that the 
field must contain a value greater than 100.

And Must Be

Select this check box to specify a second data-value limit by clicking Field Must Be and choosing one of the 
following limits:

· Less Than
· Greater Than
· Less Than Or Equal To
· Greater Than Or Equal To
· Equal To
· Not Equal To

Value

Type in a second value to complete the data value limit.
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Radio Button Validation Dialog Box
Use the Radio Button Validation dialog box to set field validation rules for radio button form fields.

Dialog Box Options

Display Name
By default, validation warning messages identify the field by its name, as entered in the Name field of the field’s 
properties dialog box. Often, the label that the user sees, which is typed directly into the form, does not match the
field’s internal name. Use the Display Name field to specify the name that should be used to refer to the field in 
validation warning messages.

Data Required
Select this check box to specify that a user must select one of the radio buttons in the group. 
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Drop-Down Menu Validation Dialog Box
Use the Drop-Down Menu Validation dialog box to set field validation rules for drop-down menu form fields.

Dialog Box Options 

Display Name
By default, validation warning messages identify the field by its name, as entered in the Name field of the field’s 
properties dialog box. Often, the label that the user sees, which is typed directly into the form, does not match the
field’s internal name. Use the Display Name field to specify the name that should be used to refer to the field in 
validation warning messages.

Data Required
Select this check box to require the user to select at least one item in the drop-down menu.

Minimum Items
If you configured the drop-down menu field to allow multiple selections, you can specify a minimum number of 
choices that the user must select.

Maximum Items
If you configured the drop-down menu field to allow multiple selections, you can specify a maximum number of 
choices that the user can select.

Disallow First Item
A common trick in drop-down menus is to make the first menu item an instruction to users on how to use the rest 
of the menu. To prohibit users from selecting the first item in the drop-down menu, click Disallow First Item.
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Font Tab
Font Dialog Box
Use the Font tab to apply character formatting to the selected text.

Dialog Box Options

Font
Choose the name of the Font to apply to selected text.

Font Style
Choose the style of the font to apply to selected text.

Size
Choose the font size to apply to selected text.

Effects
Choose special formatting to apply to selected text.

Color
Select a color from the drop-down list, or choose Custom to create a custom color.

Sample
This area displays a preview of what the selected text will look like with character formatting applied.

Style
Click this button to edit the cascading style sheet properties for the selected text. Style-sheet formatting allows 
for precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Special Styles Tab
Font Dialog Box
Use the Special Styles tab to apply special character styles to the selected text.

Special character styles may not display as expected in the FrontPage Editor. However, because these styles 
may be found in pages that you open or insert in your current FrontPage web, they are included in the Special 
Styles tab. You should use regular styles when creating new text.

Dialog Box Options

Citation (<cite>)
Select this check box to format the selected text as the name of a manual, section, or book.

Sample (<samp>)
Select this check box to format the selected text as a sequence of literal characters, similar to a typewriter font.

Definition (<dfn>)
Select this check box to format the selected text as a definition, typically in italics.

Blink (<blnk>)
Select this check box to format the selected text as blinking text.

Note      Some Web browsers do not display blinking text.

Code (<code>)
Select this check box to format the selected text as a code sample, similar to a typewriter font.

Variable (<var>)
Select this check box to format the selected text as a variable name, typically in italics.

Bold (<b>)
Select this check box to format the selected text as bold text.

Note      Some Web browsers may substitute the Strong attribute for bolded text.

Italic (<i>)
Select this check box to format the selected text as italicized text.

Note      Some Web browsers may substitute the Emphasis attribute for italicized text.

Keyboard (<kbd>)
Select this check box to format the selected text as text that will be typed by the user, similar to a typewriter font.

Vertical Position
Select Superscript or Subscript formatting for the selected text. The default setting is Normal.

By
If you selected a vertical position of Superscript or Subscript, select the number of points by which the selected 
text should be raised or lowered.

Sample
This area displays a preview of what selected text will look like with the Special Styles applied.

Style
Click this button to edit the cascading style sheet properties for the selected text. Style-sheet formatting allows 
for precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 



Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Other Tab
Bullets and Numbering Dialog Box
List [Item] Properties Dialog Box

Use the Other tab to view or change the style of the selected list. To display this tab, you must position the 
insertion point in existing text that has already been formatted as a list.

Dialog Box Options

List Style
Displays a list of available list styles. If this dialog box was opened from within an existing list in the active page, 
the currently applied style is highlighted. To change the format of the currently selected list, choose another list 
format.

Compact Layout
The Compact Layout option is valid only with the Definition List style. Select this check box to indicate to a Web 
browser that it should use reduced interim line spacing.

Enable Collapsible Outlines
Microsoft Internet Explorer version 4.0 allows users browsing your Web site to collapse or expand an outline list. 
Select this check box to enable collapsible outlines for Web browsers that support Dynamic HTML.

Style
Click this button to edit the cascading style sheet properties for the selected list. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Plain Bullets Tab
Bullets and Numbering Dialog Box
List [Item] Properties Dialog Box

Use the Plain Bullets tab to change or apply a traditional bulleted list style. If a theme has been applied to the 
page, this tab is not available.

Dialog Box Options

Plain Bullets examples
This area displays examples of the available styles for traditional bulleted lists. If this dialog box was opened from
within an existing list on the active page, the currently applied style is highlighted. Click the bulleted list style that 
you want to apply to the new or existing list.

Enable Collapsible Outlines
Microsoft Internet Explorer version 4.0 allows users browsing your Web site to collapse or expand an outline list. 
Select this check box to enable collapsible outlines for Web browsers that support Dynamic HTML.

Style
Click this button to edit the cascading style sheet properties for the selected list. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Numbers Tab
Bullets and Numbering Dialog Box
List [Item] Properties Dialog Box

Use the Numbers tab to change or apply a numbered list style.

Dialog Box Options

Numbered List examples
This area displays examples of the available styles for numbered lists. If this dialog box was opened from within 
an existing list on the active page, the currently applied style is highlighted. Click the numbered list style that you 
want to apply to the new or existing list.

Start At
Changes the starting number of the list.

Enable Collapsible Outlines
Microsoft Internet Explorer version 4.0 allows users browsing your Web site to collapse or expand an outline list. 
Select this check box to enable collapsible outlines for Web browsers that support Dynamic HTML.

Style
Click this button to edit the cascading style sheet properties for the selected list. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Page Properties Command
Use the Page Properties command to specify properties of the active page, such as background images and 
sounds, margins, and language settings for HTML encoding. If a theme has been applied to the page, many of 
these properties are set by the theme. This dialog box contains the following tabs:

· Use the General tab to specify properties such as a page title, target frame, and background sound.
· Use the Background tab to specify properties such as the background image, background color, and color for 

hyperlinks. If a theme has been applied to a page, this tab is not available.
· Use the Margins tab to specify the top and left page margins.
· Use the Custom tab to add, remove, or modify system variables and user variables.
· Use the Language tab to specify the language for HTML encoding when saving or loading a page.

{button Dialog Box,AL(`page properties tabs',0,`',`main')}
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File Command
Use the File command to insert the contents of a file at the insertion point. If the file is not an HTML file, the 
FrontPage Editor converts it to HTML. You can insert many types of files, including Microsoft Word, Microsoft 
Excel, WordPerfect, and WordStar. You select the file to insert using the Select File dialog box. 

· If you change the contents of the file after inserting it, you must insert it again to update it.
· If you try to insert a file with a filename extension that FrontPage does not recognize, or if the contents of the 

file do not appear to match the type indicated by the filename extension, the FrontPage Editor displays the 
Open File As dialog box. In this dialog box, you can indicate whether the file should be inserted in HTML, RTF,
or text format.

· If you are inserting a text file, the FrontPage Editor displays the Convert Text dialog box with options for 
converting the text.
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Hyperlinks Inside Page Command 
In the FrontPage Explorer's Hyperlinks View, use the Hyperlinks Inside Page command to show or hide the 
hyperlinks that a page has to itself. When you create a page, you can insert a hyperlink to that page so a user 
can quickly go to topics on that page; hyperlinks can be to the top of a page (using the URL) or to a bookmark. 
When the Hyperlinks Inside Page command has a check mark next to it, the Hyperlinks View shows hyperlinks 
that a page has to itself.

You can also display hyperlinks inside a page by clicking the Hyperlinks Inside Page button on the FrontPage 
Explorer toolbar.

Hyperlinks 
Inside 
Page 
button

{button Related Procedures,JI(`frontpg.HLP',`Contents_Link_Bookmark')} 



Open Command
Use the Open command in the FrontPage Explorer's Folders View, All Files View, Navigation View, or Hyperlinks 
View to open the selected pages or files.

· If you selected pages, the FrontPage Editor opens those pages.
· If you selected files, such as images or ASCII text, the Open command opens the files in the editor that has 

been associated with the file type in the Configure Editors tab in the Options dialog box.
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Open With Command
Use the Open With command in the FrontPage Explorer's Folders View, All Files View, Navigation View, or 
Hyperlinks View to open the selected pages or files using an editor that you choose from the list in the Open With
Editor dialog box.

Tip      If the type of the files you are opening are already associated with an editor, you can open the files more 
quickly using the FrontPage Explorer's Open Command.

Dialog Box Option

Editor
This list includes the FrontPage Editor and any editors that you have associated with file types using the 
Configure Editors tab in the Options dialog box. The list shows the name of each editor and the path to each 
editor's executable file.

Select an editor from this list, and then click OK to open the selected pages or files using that editor.
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Page Tab
New Dialog Box
Use the Page tab to create a new page from a template or wizard.

Dialog Box Options

[Page]
Shows the templates and wizards you can use to create a new page. If you select a template or wizard from the 
list, the Preview area displays a thumbnail image of that template or wizard.

Use the buttons to the right of the list to display large icons, or to view the list with small icons.

Description
Displays a brief description of the selected template or wizard.

Preview
Displays a thumbnail image of the selected template or wizard.

Options

Open in Current Frame

Select this check box to create a new page in the current frame in a frames page that is open in the FrontPage 
Editor. If you are not currently editing a frames page, this option is not available.

Just Add Web Task

Select this check box to create a new page and a new task linked to that page. Instead of opening the new page 
in the FrontPage Editor, FrontPage creates the new page, adds it to the current FrontPage web, then adds a task
to the list in the FrontPage Explorer's Tasks View.
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Frames Tab
New Dialog Box
Use the Frames tab to create a new frames page.

Dialog Box Options

[Frames]
Shows the types of frames pages you can create. If you select a frames page from the list, the Preview area 
displays a thumbnail image of that page.

Use the buttons to the right of the list to display large icons, or to view the list with small icons.

Description
Displays a brief description of the selected frames page.

Preview
Displays a thumbnail image of the selected frames page.

Note      Even though some frames pages, such as Footer and Footnotes, may look very similar when displayed 
in the Preview area, each frames page's target frame and hyperlinks are unique.

Options

Open in Current Frame

Select this check box to create a new frames page in the current frame in a frames page that is open in the 
FrontPage Editor. If you are not currently editing a frames page, this option is not available.

Just Add Web Task

Select this check box to create a new frames page and a new task linked to that page. Instead of opening the 
new frames page in the FrontPage Editor, FrontPage creates the new frames page, adds it to the current 
FrontPage web, then adds a task to the list in the FrontPage Explorer's Tasks View.
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Image Bullets Tab
Bullets and Numbering Dialog Box
List [Item] Properties Dialog Box

Use the Image Bullets tab to view the bulleted list style from the applied theme (if any), or to specify a different 
image to use as a bullet.

Dialog Box Options

Image Bullets example
If a theme has been applied to the page, this area displays an example of the bulleted list style from that theme.

If an image bullet has already been specified for the selected list, this area displays an example of the bulleted 
list style using that image bullet.

If no theme has been applied to the page, and no image bullet has yet been specified, this area displays gray 
placeholder squares to indicate bullets.

Image
Use this section to specify whether to use the image bullets from the applied theme (if any), or to specify a 
different image to use as a bullet.

Use Images From Current Theme

Select this option to use the bulleted list style from the theme that has been applied to this page (if any).

Specify Image

Select this option to choose a different image to use as an image bullet. You can choose an image from your 
computer, from your local network, or from the World Wide Web.

If you know the path and name of the image file, type it in the box. If you do not know the path and name, click 
Browse.

If a theme has been applied to the page, the image bullet you specify here will replace the bullets from the 
theme.

Browse

Click Browse to display the Select Image dialog box to locate the image you want to use as an image bullet. You 
can choose an image from your computer, from your local network, or from the World Wide Web.

Enable Collapsible Outlines
Microsoft Internet Explorer version 4.0 allows users browsing your Web site to collapse or expand an outline list. 
Select this check box to enable collapsible outlines for Web browsers that support Dynamic HTML.

Style
Click this button to edit the cascading style sheet properties for the selected list. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Bullets and Numbering Command
Use the Bullets and Numbering command to apply formatting to a list on the active page.

The dialog box may contain up to four tabs:

· Use the Image Bullets tab to view the bulleted list style from the applied theme (if any), or, for theme or non-
theme pages, to specify an image to use as a bullet.

· Use the Plain Bullets tab to display four traditional bulleted list styles. Click the image of the style you want to 
apply. If a theme has been applied to the page, this tab is not displayed.

· Use the Numbers tab to display six numbered list styles. Click the image of the style you want to apply. You 
can also change the starting number of the first numbered list item.

· Use the Other tab to view or apply a List Style, such as a definition list or menu list. Some Web browsers may 
ignore certain styles when displaying text. If you selected text that is not formatted as a list, this tab is not 
displayed.
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Convert Text to Table Command
Use the Convert Text to Table command to convert selected text to a table. Before using this command, indicate 
where you want to divide text into columns and rows by adding separator characters to your text. For instance, 
use commas to divide columns, and use paragraph marks to mark the ends of rows.

Tip      Because HTML does not directly support tab characters, it is recommended that you use commas or other 
characters to separate columns.

Dialog Box Options

Paragraphs
Select this option to create a one-column table with a row for each paragraph mark in the selected text.

Tabs
Select this option if you used tab characters to separate columns in the selected text. You should note that, 
because HTML does not directly support tab characters, the results may be unpredictable.

Commas
Select this option if you used commas to separate columns in the selected text.

Other
Select this option if you used another character — such as an exclamation point — to separate columns in the 
selected text, and then type the character in the box to the right of Other.
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Convert Table to Text Command
Use the Convert Table to Text command to convert the selected table to text. The FrontPage Editor separates 
each table cell into a paragraph.
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New Command
Use the New command to display the New dialog box, which you can use to create a new page in a new 
FrontPage Editor window. Once you have created the new page, you can add it to the current FrontPage web 
using the Save command on the File menu.

The New dialog box contains two tabs:

· Use the Page tab to create a new page based on one of the listed templates or page Wizards.
· Use the Frames tab to create a new frames page.
You can quickly create a new blank page based on the Normal Page template by clicking the New button on the 
standard toolbar.

New button
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 To create a directory list
A directory list presents a sequence of short terms. The exact formatting of a directory list depends on the Web 
browser being used. Many Web browsers ignore the Directory List style.

1 In the FrontPage Editor, place the insertion point on the line the list is to begin on,    then on the Format 
toolbar, choose Directory List from the Change Style dropdown box.

2 Type the first list item, and then press ENTER to continue the list.
3 Press ENTER twice to end the list.
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To create a menu list
A menu list presents an unordered list of short entries. The exact formatting of the list depends on the Web 
browser being used. Many Web browsers ignore the Menu List style.

1 In the FrontPage Editor, place the insertion point on the line the list is to begin on, then on the Format toolbar, 
choose Menu List from the Change Style dropdown box.

2 Enter a list item, and then press ENTER to continue the list.
3 Press ENTER twice to end the list.
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To create a definition list
A definition list presents a term and its definition. Generally, a term is positioned flush left, and its definition is 
indented. The exact formatting of the list depends on the Web browser being used.

1 In the FrontPage Editor, place the insertion point on the line the list is to begin on.
2 Type the first term you want to define.
3 On the Format toolbar, choose Defined Term from the Change Style dropdown box, then press ENTER.

The FrontPage Editor will indent the new line and apply the Definition style.
4 Type the definition of the term.
5 To list and define additional terms, press ENTER and repeat Steps 2-4.
6 Press ENTER twice to end the definition list.
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To end a list
When you have finished typing list items in the FrontPage Editor, do one of the following to end the list:

· Press ENTER twice.
· Press CTRL+ENTER.
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To select a list
· In the FrontPage Editor, move the pointer to the selection bar next to the list you want to select, then double-

click to select the entire list.
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To delete a list item
1 In the FrontPage Editor, place the pointer over the number or bullet of the list item you want to delete, then 

double-click to select the entire item.
2 Press DELETE.

Definition lists, comprised of terms and definitions, are not preceded by a bullet or number; however, you can 
select and delete an entire term or definition using the same procedure.
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To insert a list item
· In the FrontPage Editor, position the insertion point at the beginning of the line where you want to insert 

another list item, then press ENTER. Type the item to be inserted on the new line.
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To create a nested list
1 In the FrontPage Editor, place the cursor at the end of the item in the primary list that precedes the line where 

you want the nested list to begin.
2 Press ENTER to create a new line.
3 Click the Increase Indent button on the Format toolbar.
4 Type the first list item to be added, then click the Numbered List or Bulleted List button on the Format toolbar 

to create the nested list.
5 Press ENTER for each additional line item you want to add to the secondary list.
6 To end both lists, place the cursor at the end of the last list item and press CTRL+ENTER.
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To insert a video clip
FrontPage has two methods for inserting a video clip on the active page. 

Note      If you have Microsoft Internet Explorer installed, you can immediately preview the video clip by selecting 
the Preview tab in the FrontPage Editor.

1 In the FrontPage Editor, on the Insert menu, choose Active Elements, and then Video.
2 In the Video dialog box, locate the video you want to insert from the current FrontPage web, the World Wide 

Web, or your file system. If you have Microsoft Office 97 installed, click Clip Art to insert a video clip from the 
Microsoft Clip Gallery.

3 Click OK.

You can insert a video clip from the Microsoft Clip Gallery when you have Microsoft Office 97 installed.

1 In the FrontPage Editor, on the Insert menu, choose Clip Art.
2 Click the Videos tab.
3 Select the video clip you want to insert by clicking its preview image.
4 Click Insert.

The video clip is inserted on the active page.
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To change the layout of an image
You can change the layout of an image by opening the Image Properties dialog box and changing the following 
options:

· Alignment
· Border Thickness
· Horizontal Spacing
· Vertical Spacing

1 In the FrontPage Editor, click the image on the page, then on the Edit or shortcut menu choose Image 
Properties.

2 In the Alignment field, select the alignment you want from the drop-down list.
3 In the Border Thickness field, enter how wide you want the border to be, in pixels.
4 In the Horizontal Spacing field, enter how much space you want from the left and right margins of the page, in 

pixels.
5 In the Vertical Spacing field, enter how much space you want from the top and bottom margins of the page, in 

pixels.
6 Click OK.
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To reverse an image horizontally
1 In the FrontPage Editor, click the image to select it.
2 On the image toolbar, click the Reverse button.

The image is reversed horizontally.
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To flip an image vertically
1 In the FrontPage Editor, click the image to select it.
2 On the image toolbar, click the Flip button.

The image is flipped vertically.
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Rectangle Command
Use the Rectangle command to create a rectangular hotspot on an image. To place the rectangle, click and drag 
across a region of the image.

After you have placed the rectangle, the FrontPage Editor displays the Create Hyperlink dialog box, where you 
select the target of the hyperlink. The target of a hyperlink can be a page, bookmark, image, or file in the current 
FrontPage web, on another Web server, or on the World Wide Web.

· To create a hyperlink to a currently open page or to a page or bookmark in the current FrontPage web, select 
the file from the file list and, if available, choose a bookmark from the Bookmark drop-down list.

· Click the World Wide Web button  to create a hyperlink to any page or other resource on the World Wide 
Web.

· Click the File button  to create a hyperlink to a file or resource on your local file system (recommended 
for intranets only).

· Click the E-Mail button  to specify an e-mail address as the target of the hyperlink.

· Click the New Page button  to create a new page in the current FrontPage web and make it the target 
of the hyperlink.

You select the Rectangle command using the Rectangle button on the image toolbar.

Rectangle 
button
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Circle Command 
Use the Circle command to create a circular hotspot on an image.

To create the circle, click in the image to define the center point and drag across a region of the image to define 
the radius.

After you have placed the circle, the FrontPage Editor displays the Create Hyperlink dialog box, where you select
the target of the hyperlink. The target of a hyperlink can be a page, bookmark, image, or file in the current 
FrontPage web, on another Web server, or on the World Wide Web.

· To create a hyperlink to a currently open page or to a page or bookmark in the current FrontPage web, select 
the file from the file list and, if available, choose a bookmark from the Bookmark drop-down list.

· Click the World Wide Web button  to create a hyperlink to any page or other resource on the World Wide 
Web.

· Click the File button  to create a hyperlink to a file or resource on your local file system (recommended 
for intranets only).

· Click the E-Mail button  to specify an e-mail address as the target of the hyperlink.

· Click the New Page button  to create a new page in the current FrontPage web and make it the target 
of the hyperlink.

You select the Circle command using the Circle button on the image toolbar.

Circle 
button
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Polygon Command 
Use the Polygon command to create a polygonal hotspot on an image.

To create the polygon, click in the image to define the first corner, drag to define the first edge, then repeatedly 
click and drag to define remaining edges and corners.

There are three ways to complete the shape of a polygon:

· Drag the edge to the starting corner.
· Double click from the current corner. The FrontPage Editor adds a final edge to complete the shape.
· Press ESC from the current edge. The FrontPage Editor adds a final corner and edge to complete the shape.
After you have defined the polygon, the FrontPage Editor displays the Create Hyperlink dialog box, where you 
select the target of the hyperlink. The target of a hyperlink can be a page, bookmark, image, or file in the current 
FrontPage web, on another Web server, or on the World Wide Web.

· To create a hyperlink to a currently open page or to a page or bookmark in the current FrontPage web, select 
the file from the file list and, if available, choose a bookmark from the Bookmark drop-down list.

· Click the World Wide Web button  to create a hyperlink to any page or other resource on the World Wide 
Web.

· Click the File button  to create a hyperlink to a file or resource on your local file system (recommended 
for intranets only).

· Click the E-Mail button  to specify an e-mail address as the target of the hyperlink.

· Click the New Page button  to create a new page in the current FrontPage web and make it the target 
of the hyperlink.

You select the Polygon command using the Polygon button on the image toolbar.

Polygon 
button
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Highlight Hotspots Command 
Use the Highlight Hotspots command to view the hotspots defined on an image without viewing the image. This 
is useful when image features make it difficult to see the hotspot outlines that are superimposed on the image.

This command changes between displaying the hotspots only and displaying the image and the hotspots. When 
you click outside of an image, the display always shows the image and its hotspots.

You select the Highlight Hotspots command using the Highlight Hotspots button on the image toolbar.

Highlight 
Hotspots button
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To undo an action
Up to 30 actions on a page can be undone.

· In the FrontPage Editor, choose Undo on the Edit menu or click the Undo button on the standard toolbar:
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To redo an action
Up to 30 actions on a page can be redone after they have been undone.

· In the FrontPage Editor, choose Redo on the Edit menu or click the Redo button on the standard toolbar:
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Paragraph Command
Use the Paragraph command to view or change the properties of the selected paragraph on the active page.

Dialog Box Options

Paragraph Format
Select a new paragraph style from the list.

Paragraph Alignment
Select the paragraph alignment style:

· Default - do not override the paragraph’s default alignment
· Left - align the current paragraph to the left margin of the page or table cell. 
· Right - align the current paragraph to the right margin of the page or table cell. 
· Center - align the current paragraph to the center of the page or table cell. 

Style
Click Style to open the Style dialog box where you can edit the cascading style-sheet properties for the selection.
Style-sheet formatting allows for precise control over spacing, alignment, fonts, and colors that is not possible 
with basic HTML attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; 
however, the formatting displayed in a Web browser depends on the Web browser used to display the page.
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To open a page from the FrontPage Explorer
· Do one of the following:

· Double-click the page in any of the following views: Folders, All Files, Navigation, or Hyperlinks.
· Select the page in any of the following views: Folders, All Files, Navigation, or Hyperlinks, then press 

ENTER.
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To open a page in the FrontPage Editor

1 Click the Open button .
2 In the Open dialog box, do one of the following:

· To open a page from the current FrontPage web, click a page. To browse the contents of a folder, double-
click it. After selecting the page, click OK.

· To open the page from your file system, click the File button , and choose a file in the Select File 
dialog box.

· To open a page from the World Wide Web, click the World Wide Web button . FrontPage starts your 
Web browser. Visit the page you want to open and return to FrontPage. The location of the page you visited is 
displayed in the Open dialog box’s URL field. Click OK to open the page.

3 Click OK.
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To save a page to a file
1 In the FrontPage Editor, choose Save As on the File menu.
2 Click the File button.

3 Use the Save In box and the box that lists files and folders to point to the folder where you want to store the 
page as a file.

4 Specify the file name.
5 Click Save. You are prompted to save any images, ActiveX controls, sound files, and other objects on the 

page to the folder containing the file.
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To save a page to the current FrontPage web
1 If the page was opened from the current web or from the World Wide Web, in the FrontPage Editor, choose 

Save on the File menu, or click the Save button. If the page was opened from a file, choose Save As on the 
File menu.

2 If you are saving the page to the FrontPage web for the first time, in the Title field, type a descriptive page title.
3 If you are saving the page to the FrontPage web for the first time, in the URL field, type a URL relative to the 

root of the currently open FrontPage web, or accept the URL that FrontPage supplies as a default. For 
example, if you type the URL folder2/sample.htm, the page will be saved in the folder folder2 below the root 
folder of the current FrontPage web.

4 Click OK.
5 If the page has been opened from a file or from the World Wide Web, you are prompted to save any images, 

ActiveX controls, sound files, and other objects on the page to the FrontPage web.
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To timestamp a page
1 In the FrontPage Editor, click the page where you want to insert the timestamp.
2 On the Insert menu, choose Timestamp.
3 In the Display field of the Timestamp Properties dialog box, choose which event the timestamp will record:

· Date This Page Was Last Edited
· Date This Page Was Last Automatically Updated

4 In the Date Format field, select the date format from the drop-down list. 
5 In the Time Format field, select the time format from the drop-down list. You must select either a date format, a

time format, or both.
6 Click OK.
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To create a table of contents
1 In the FrontPage Editor, click the page where you want to create a table of contents.
2 On the Insert menu, choose Table of Contents.
3 In the Page URL for Starting Point of Table field, type the relative URL of the page to list as the starting page 

in the table of contents.
If you do not know the relative URL of the page, click Browse to open the Current Web dialog box, then click 
the page that you want to use as the starting point of the table of contents.

4 In the Heading Size field, select the paragraph style for the caption of the table of contents.
5 To show each page once in the table of contents, click Show Each Page Only Once.
6 To display pages in your FrontPage web that are not the targets of hyperlinks, click Show Pages With No 

Incoming Hyperlinks.
Note      The starting point page is always displayed.

7 To specify that the table of contents should be recalculated whenever any page in the FrontPage web is 
edited, click Recompute Table of Contents When Any Other Page Is Edited.

8 Click OK.
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To include a page in another page
1 In the FrontPage Editor, click the page where you want to include the contents of another page.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Include Page and click OK.
4 In the Page URL to Include field, type the relative URL of the page to include. Click Browse and click a page 

or file in the Current Web dialog box to include it.
5 Click OK.
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To include an image in a page during a time period
1 In the FrontPage Editor, click the page where you want to include an image during a specified time period.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Scheduled Image and click OK.
4 In the Image to Include field, type the relative URL of the image to include it. Click Browse and in the Image 

dialog box, click an image to include it.
5 In the Starting Date and Time fields, specify the year, month, day, and time after which the image should be 

included.
6 In the Ending Date and Time fields, specify the year, month, day, and time after which the image should no 

longer be included.
7 In the Optional Image to Include Before or After the Given Dates field, type the relative URL of an image to 

include if the current date and time is not within the specified time period. Click Browse then click an image in 
the Image dialog box to include it.

8 Click OK.
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To include a page in another page during a time period
1 In the FrontPage Editor, click the page where you want to include the contents of another page during a 

specified time period.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Scheduled Include Page and click OK.
4 In the Page URL to Include field, type the relative URL of the page to include. Click Browse and in the Current

Web dialog box, click a page or file to include it.
5 In the Starting Date and Time fields, specify the year, month, day, and time after which the page should be 

included.
6 In the Ending Date and Time fields, specify the year, month, day, and time after which the page should no 

longer be included.
7 In the Optional Page URL to Include Before or After the Given Dates field, type the relative URL of a page to 

include if the date and time is outside of the specified time period. Click Browse then click a page or file in the 
Current Web dialog box to include it.

8 Click OK.
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To add comments to a page
A comment is text on a page that can be viewed in the FrontPage Editor but not from a Web browser. Comments 
are displayed in purple and retain the character-size and other attributes of the current paragraph style.

1 In the FrontPage Editor, click where you want the comment to be inserted.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Comment and click OK.
4 In the Comment dialog box, enter the comment, in a single paragraph. The text wraps when you reach the 

end of a line.
5 Click OK.
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To insert a variable
1 In the FrontPage Editor, click the page where you want to insert the variable.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Substitution and click OK.
4 In the Substitute With drop-down list, select a standard variable or one that an author has added to the 

FrontPage web.
5 Click OK. 

The variable is inserted and its value — which is set in the Parameters tab of the FrontPage web Settings 
dialog box — is displayed in the style of the paragraph containing it.
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To view explanations of errors on pages
When a FrontPage component is configured incorrectly, FrontPage flags the page containing the FrontPage 

component with an Error icon  in the All Pages pane of the Hyperlinks view in the FrontPage Explorer:

1 In the All Pages pane in the FrontPage Explorer, select the page with the error icon next to it.
2 On the Edit menu, choose Properties, then click the Errors tab.

In the Errors tab, a description of the error and how to correct it is displayed.
3 Click OK.
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To add a system meta-variable to a page
1 With a page open in the FrontPage Editor, on the File menu, choose Page Properties.
2 In the System Variables section in the Custom tab, click Add.
3 In the System Meta Variable dialog box, enter the name and value of the system variable.
4 Click OK to close the System Meta Variable dialog box.
5 Click OK to close the Page Properties dialog box.
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To add a user-defined meta-variable to a page
1 With a page open in the FrontPage Editor, on the File menu, choose Page Properties.
2 In the User Variables section in the Custom tab, click Add.
3 In the User Meta Variable dialog box, enter the name and value of the variable.
4 Click OK to close the User Meta Variable dialog box.
5 Click OK to close the Page Properties dialog box.
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To set a background color for a page
1 In the FrontPage Editor, on the Format menu, choose Background.
2 Select the Specify Background and Colors option.
3 In the Background field, select a color from the drop-down list. 

To define a custom color, select Custom.
4 Click OK.
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To set a background image for a page
1 In the FrontPage Editor, on the Format menu, choose Background.
2 Select the Specify Background and Colors option.
3 Select the Background Image option.
4 In the field below, enter the URL or file name of the background image you want to use. Click Browse to find 

the relative URL or file name.
5 Click OK.
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To associate a background sound with a page
1 With a page open in the FrontPage Editor, on the File menu, choose Page Properties.
2 In the Background Sound section in the General tab, enter the absolute URL of the sound file. Click Browse to

open the Background Sound dialog box where you can choose a file from the current FrontPage web, your file
system, the World Wide Web, or click Clip Art to choose a sound from the Microsoft Clip Gallery.

3 In the Loop field, enter the number of times to repeat the background sound. To play the sound continuously, 
select Forever.

4 Click OK.
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To change the number of times a background sound repeats
1 With a page open in the FrontPage Editor, on the File menu, choose Page Properties.
2 In the Background Sound section in the General tab, enter the number of times to repeat the background 

sound in the Loop field. To play the sound continuously, select Forever.
3 Click OK.
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To add a watermark image to a page
1 With a page open in the FrontPage Editor, on the File menu, choose Page Properties.
2 In the Background tab, select Specify Background and Colors.
3 Select Background Image and Watermark.
4 Click Browse to open the Select Background Image dialog box where you can choose an image to use as a 

watermark from the current FrontPage web, your file system, the World Wide Web, or click Clip Art to choose 
an image from the Microsoft Clip Gallery.

5 Click OK to close the Page Properties dialog box.
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To create a bulleted list
A bulleted list presents an unordered list of items. Generally, Web browsers render bulleted lists as paragraphs 
separated by blank space, prefixed by bullets.

1 In the FrontPage Editor, click the Bulleted List button on the Format toolbar.

2 Enter a list item, then press ENTER to continue the list.
3 Press ENTER twice to end the list.

Note      To reformat existing text as a bulleted list, select one or more paragraphs, then click the Bulleted List 
button.
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To create a numbered list
A numbered list presents an ordered list of items, such as steps in a procedure. Generally, Web browsers render 
numbered lists as paragraphs separated by blank space, prefixed by numbers.

1 In the FrontPage Editor, click the Numbered List button on the Format toolbar.

2 Enter a list item, then press ENTER to continue the list.
3 Press ENTER twice to end the list.

Note      To reformat existing text as a numbered list, select one or more paragraphs, then click the Numbered 
List button.
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To create a frames page
1 In the FrontPage Editor, choose New on the File menu.
2 In the New dialog box, in the Frames tab, select a frames page template.

The template is displayed in the Preview field, and a description of the template is displayed in the Description
field.

3 Click OK.
The frames page is created and opened.
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To specify the initial page of a frame
· If an initial page has not been set, click Set Initial Page directly in the frame, and then in the Create Hyperlink 

dialog box choose the page to use as the initial page. You can also click New Page directly in the frame to 
create a blank new page and set it as the initial page for the frame.

· If an initial page has been set for the active frame, choose Set Initial Page on the Frame menu, and then in 
the Create Hyperlink dialog box choose the page to use as the initial page.
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To open a page in a frame

Use this procedure to open a page in the selected frame on the active frames page in the FrontPage Editor.

1 On the File menu, choose Open.
2 In the Open dialog box, select the page or file that you want to open.
3 The Open in Current Frame check box is selected by default. If you do not want to open the page in the 

currently selected frame, clear this check box; the page will be opened in a new window in the FrontPage 
Editor.

4 Click OK.
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To create a hyperlink to display a page in another frame
1 In the FrontPage Editor, choose Hyperlink on the Insert menu.
2 In the Create Hyperlink dialog box, select the page or file that you want to link to.

FrontPage displays the current page’s default target frame in the Target Frame field of the Create Hyperlink 
dialog box.
Note      Steps 3 through 6 describe how you can change the target frame for a hyperlink. Go to step 7 if you 
want to use the page’s default target frame.

3 To change the target frame for the hyperlink, click the Modify button in the Create Hyperlink dialog box.

FrontPage displays the Target Frame dialog box.
4 The FrontPage Editor creates a “map” of the frames page that you can use to select a new target frame. This 

map is displayed in the Current Frames Page field. To assign the target frame of a hyperlink, click the frame in
this map.
When you click a frame, its name is displayed in the Target Setting field.

5 To make the target frame you selected the default target frame for the current page, click Make Default for 
Hyperlinks on This Page.

6 After selecting the target frame, click OK.
7 In the Create Hyperlink dialog box, click OK to create the hyperlink to the target frame.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Frames')}



To resize a frame
· Open the frames page in the FrontPage Editor and click and drag any frame border.
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To split a frame
· Open the frames page in the FrontPage Editor, hold down CTRL, and drag any frame border.
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To delete a frame
· In the FrontPage Editor, select the frame and on the Frame menu choose Delete Frame.
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To display frame borders
1 With a frames page open in the FrontPage Editor, choose Frames Page Properties on the Frame menu.
2 In the Frames tab of the Page Properties dialog box, click Show Borders.

Borders between frames will be shown when the frames page is displayed in a Web browser.
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To adjust the spacing between frames
1 With a frames page open in the FrontPage Editor, choose Frames Page Properties on the Frame menu.
2 In the Frames tab of the Page Properties dialog box, enter a value in the Frames Spacing field.

This specifies the amount of padding, in pixels, between frames when the frames page is displayed in a Web 
browser. The default for most Web browsers is 2 pixels.
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Using Themes
Overview

Applying Themes
To apply a theme to a FrontPage web

To apply a theme to a page

Changing Themes
To change the theme applied to a FrontPage web

To change the theme applied to a page

Removing Themes
To remove the theme applied to a FrontPage web

To remove the theme applied to a page



To assign shared borders to a page
1 On the FrontPage Editor’s Tools menu, choose Shared Borders.
2 In the Page Borders dialog box, click Set For This Page Only.
3 Select one or more of the shared borders: Top, Bottom, Left, and Right.
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To edit a shared border
1 In the FrontPage Editor, open any page with shared borders.
2 Click inside the shared border region. For example, to edit the Left shared border, click the left border of the 

page.
When you click in a shared border region, its outline becomes solid.

3 Make any edits in the shared border region.
4 Choose Save on the File menu.

Any edits you made to the page and to all shared borders on the page are saved.
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To insert a navigation bar on a page
1 In the FrontPage Editor, move the insertion point to where you want to place the navigation bar. To put a 

navigation bar in a shared border region, click inside that region.
2 On the Insert menu, choose Navigation Bar.

In the Navigation Bar Properties dialog box, configure the navigation bar.
3 Click OK to insert the navigation bar.
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Using Navigation Bars and Shared Borders
Overview

Using Navigation Bars
To insert a navigation bar on a page

To change the text of a button in a navigation bar

To modify a navigation bar

To change the position of navigation bar

To delete a navigation bar in the FrontPage Editor

Using Shared Borders
To assign shared borders to a FrontPage web

To assign shared borders to a page

To edit a shared border



Close FrontPage Web Command
Use the Close FrontPage Web command to close a FrontPage web. The FrontPage Explorer remains open after 
you close a FrontPage web. To close the FrontPage Explorer, cancel the Getting Started with Microsoft 
FrontPage dialog box, then from the File menu, choose Exit.

Note      If you close a Frontage web while a page from that web is open in the FrontPage Editor and needs to be 
saved, you are prompted to save the page to the web.
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To create a new line
· To start a new line of text without adding white space, press SHIFT+ENTER.

This inserts a line break. Because Web browsers do not add extra white space between lines separated by 
line breaks, your lines will be displayed more closely together.
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To apply a theme to a page
1 On the FrontPage Editor’s Format menu, choose Theme.
2 In the Choose Theme dialog box, click Use Selected Theme, and choose a theme from the list.
3 Select any of the following options:

· Click Vivid Colors to specify a bright set of colors for the theme.
· Click Active Graphics for a lively set of banners, buttons, bullets, and other graphical elements.
· Click Background Image for a textured page background. If this is not selected, the page background will 

be a basic color.
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Save Command
Use the Save Command to save the active page in HTML format. HTML files have an .htm file extension by 
default. On a frames page, the page in the active frame, indicated by a highlighted border, is considered the 
active page.

· If the page was opened from the current FrontPage web, or from your computer or your local network, the 
Save command saves the page without prompting you. If you have inserted any images, sounds, videos, and 
so on from files or from the clipboard, the Save command displays the Save Embedded Files Dialog Box. This
dialog box gives you the option of saving each new or replaced image, sound, video, and so on to the current 
FrontPage web.

· If the page has never been saved, the Save command displays the Save As dialog box. To save the page to a
hidden directory that a Web browser cannot access, save the file to the _private folder. This is useful for 
saving pages that you want to include in other pages but that you do not want users to browse to directly.

To save a page to different location or with a different name, use the Save As command.

You can also save a page by clicking the Save button on the standard toolbar.

Save button
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Save As Command
Use the Save As command to save a copy of the active page under a different name, to a different location on 
your computer or local network, or to a different FrontPage web. On a frames page, the page in the active frame, 
indicated by a highlighted border, is considered the active page.

You can also use the Save As command to save the active page as a template.

· To save the page to the current FrontPage web, in the Save As dialog box type a new name for the page in 
the URL box. If you have inserted any images, sounds, videos, and so on from files or from the clipboard, the 
Save As command displays the Save Embedded Files dialog box. 
Tip      To save the page to a hidden directory that a Web browser cannot access, save the file to the _private 
folder. This is useful for saving pages that you want to include in other pages but that you do not want users to
browse to directly.

· To save the page to a different location on your computer or local network, click the File button:

This displays the Save As File dialog box. If you have inserted any images, sounds, videos, and so on from files or 
from the clipboard, the Save As File command displays the Save Embedded Files dialog box. This dialog box gives 
you the option of saving each new or changed image, sound, video, and so on to the same folder as the page or to 
another folder that you specify.
· To save the page as a template, click As Template and type a title and name for the template in the Save as 

Template dialog box.

The FrontPage editor saves pages in HTML format. HTML files have an .htm file extension by default.
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Save All Command
Use the Save All Command to save all open pages. The Save All command saves each page in HTML format. 
HTML files have an .htm file extension by default.

· If the page was opened from the current FrontPage web, or from your computer or your local network, the 
Save All command saves the page without prompting you. If you have inserted any images, sounds, videos, 
and so on from files or from the clipboard, the Save All command displays the Save Embedded Files dialog 
box. This dialog box gives you the option of saving each new or changed image to the current FrontPage web.
Tip      To save the page to a hidden directory that a Web browser cannot access, save the file to the _private 
folder. This is useful for saving pages that you want to include in other pages but that you do not want users to
browse to directly.

· If the page is new, the Save All Command displays the Save As dialog box in which you provide the filename 
and path to save the page to the current FrontPage web. You can also use this dialog box to save the page to 
a different location on your computer or local network, or to save the page as a template.
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Custom Tab
Page Properties Dialog Box
The Custom tab displays meta tags (system variables and user-defined variables) that are associated with the 
active page.

Dialog Box Options

System Variables (HTTP-EQUIV)
This section lists the meta tags that use the HTTP-EQUIV attribute as the name portion of their name-value 
pairs. These meta tags supply special instructions to a Web browser, such as an expiration date or a display-
refresh value.

Name

The name of the meta tag.

Value

The value to associate with the tag.

Add

Click Add to add a new meta tag.

Modify

Click Modify to modify the currently selected meta tag.

Remove

Click Remove to remove the currently selected meta tag.

User Variables
This section lists user-defined meta tags.

Name

The name of the meta tag.

Value

The value associated with the tag.

Add

Click Add to add a new meta tag.

Modify

Click Modify to modify the currently selected meta tag.

Remove

Click Remove to remove the currently selected meta tag.
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General Tab
Page Properties Dialog Box
The General tab displays general properties of the active page.

Dialog Box Options

Location
The complete URL of the page. If the page was opened from a file, this field contains the full filename of the 
page, and has a “File://” prefix. If the page has not been saved, the URL will be “FrontPage:///Editor/New Page 
n.htm.”

Title
The page title, or friendly name of the new page. 

Base Location
The optional base URL of the page.

Default Target Frame
If you want all of the target pages of hyperlinks on the active page to be displayed in a different frame on a 
frames page, type the name of the default target frame, or click the Target Frame button:

If a hyperlink does not specify a different target frame, the target page of the hyperlink will be displayed in the 
default target frame.

Note      If a frame is supplied and no frames page is loaded when a hyperlink is followed, the browser may create
a new window in which to display the target page of the hyperlink.

Background Sound

Location

Type the name of a background sound file. Web browsers will play this sound file when the page is displayed. 
You can specify a file from the current FrontPage web or from your file system. If you specify a file from your file 
system, you will be prompted to save the file to the current FrontPage web when you save the page.

Browse

Click Browse to browse for the file in the current FrontPage web or in your file system.

Loop

Type the number of times to repeat playing the background sound.

Forever

Select this check box to play the background sound continuously while the page is displaying.

Style
Click this button to edit the cascading style sheet properties for the selected list. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Background Tab
Page Properties Dialog Box
The Background tab displays properties of the active page that affect the page’s appearance. If a theme has 
been applied to the page, these options are not available.

Dialog Box Options

Specify Background and Colors
This section contains fields that control the background color of the page.

Background Image

Select the Background Image check box to use an image as the page's background. The image will be tiled to 
form a background for the page.

Type the name of the image in the box beneath the Background Image check box, or click Browse to browse for 
the image. You can specify an image file from the current FrontPage web or from your file system. If you specify 
a file from your file system, you will be prompted to save the file to the current FrontPage web when you save the
page.

Watermark

Select the Watermark check box to display the image as a watermark.

Browse

Click Browse to browse for the file in the current FrontPage web or in your file system.

Properties

Click Properties to open the Image Properties dialog box and view or edit the properties of the background 
image. You can view properties of images in the current FrontPage web only.

Background

Specify a background color for the page by selecting a color from the drop-down list. To specify a custom color, 
click Custom, and then select the custom color in the Color dialog box.

Note      You can combine a background image with a background color. If the background image has a 
transparent color, the background color will show through the background image.

Text

Specify a text color for the page by selecting a color from the drop-down list. To specify a custom color, click 
Custom, and then select the custom color in the Color dialog box.

Hyperlink

Specify a hyperlink color for the page by selecting a color from the drop-down list. To specify a custom color, click
Custom, and then select the custom color in the Color dialog box.

Visited Hyperlink

Specify a visited hyperlink color for the page by selecting a color from the drop-down list. To specify a custom 
color, click Custom, and then select the custom color in the Color dialog box.

Active Hyperlink

Specify an active hyperlink color for the page by selecting a color from the drop-down list. To specify a custom 
color, click Custom, and then select the custom color in the Color dialog box.

Get Background and Colors From Page
To display the current page using the background style and colors of another page in your FrontPage web, type 
the relative URL of the other page in the box, or click Browse. The current page will use the background image, 
background color, and all hyperlink and text colors from the page that you specify.



Browse

Click Browse to browse for the page in the current FrontPage web or in your file system.
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Margins Tab
Page Properties Dialog Box
The Margins tab displays properties of the active page that control the page’s margins. If the active page uses 
shared borders, the margin settings are applied from the edge of the shared border (instead of the edge of the 
page).

Dialog Box Options

Specify Top Margin
Select this check box to specify a top margin for the page, and then type the top margin, in pixels.

Specify Left Margin
Select this check box to specify a left margin for the page, and then type the left margin, in pixels.
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Current Web Dialog Box
Change Folder Dialog Box
Use the Current Web dialog box (Change Folder dialog box) to browse the folders and files in the current 
FrontPage web or to choose a different folder in the current FrontPage web in which to save embedded files.

Dialog Box Options

Look in
This box initially lists the URL of the current FrontPage web. The area below this box lists all of the folders and 
files in that web. If you double-click a folder to explore it, this box lists the name of the current folder.

To choose a different folder to browse or in which to save embedded files, select that folder. The folder name is 
then displayed in the Look In box, and the contents of that folder are listed in the area below the box.

Up One Level
Click this button to change to a higher-level folder in the current FrontPage web. If the URL of the current web is 
displayed in the Look In box, this button is disabled.

New Folder
Click this button to create a new folder. If the URL of the current FrontPage web is displayed in the Look In box, 
this button creates a new top-level folder in the current web. If a folder name is displayed in the Look In dialog 
box, this button creates a subfolder within the listed folder.

List
Click this button to display a list of page or file names.

Details
Click this button to display a list of page or file names and their page titles.
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Hyperlink Command
Use the Hyperlink command to create or modify a hyperlink. You can create a hyperlink to any page or resource 
in the current FrontPage web, on your local intranet, or the World Wide Web.

You can also create or edit a hyperlink using the Create or Edit Hyperlink button on the standard toolbar:

Create or Edit Hyperlink
button

{button Related Procedures,JI(`frontpg.HLP',`Contents_Link_Bookmark')}



Language Tab
Page Properties Dialog Box
Use the Language tab to change the HTML character encoding for saving or loading the active page.

Dialog Box Options

Save

HTML Encoding for Saving This Page

If you want this page to be saved in a different character set from the default character set for the current 
FrontPage web or from the character set for your computer if no web is open, select the character set from the 
list.

Tip      If you want to remove the charset meta tag from the page, select <None>. The page will still be saved in 
the current character set.

Load

HTML Encoding for Loading This Page

If the text on this page does not display correctly after opening the page, select a different character set from the 
list. The page will be reloaded after you click OK.

Warning!      If this page displays correctly, changing the HTML encoding for loading and saving the page can 
corrupt the page's contents.
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AutoThumbnail Tab
Options Dialog Box
Use the AutoThumbnail tab to specify the default options that the FrontPage Editor should use when creating 
thumbnails of images using the AutoThumbnail command on the Tools menu.

Dialog Box Options

Set
Select an option from this list to specify a default size for creating thumbnail images, then specify the value in the
Pixels box.

For example, if you want the AutoThumbnail command to create thumbnails that are 75 pixels wide, select Width,
then type 75 in the Pixels box. The AutoThumbnail command will then create thumbnails that are 75 pixels wide 
and will size the height of the thumbnails accordingly to maintain the aspect ratios of the original images.

If you select Shortest Side and specify 75 pixels, the AutoThumbnail command will then create thumbnails where
the shortest side of any image, whether height or width, is sized to 75 pixels, and the other dimension is sized 
accordingly to maintain the aspect ratio.

Pixels
Type the size, in pixels, for the option selected in the Set box.

Border Thickness
Select this check box to create borders around thumbnail images, then specify the size of the border in the Pixels
box.

Pixels
Type the size, in pixels, for borders.

Beveled Edge
Select this check box to create bevels around the edges of thumbnail images.
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Default Font Tab
Options Dialog Box
Use the Default Font tab to specify the font used to display a language or character set when no font is specified 
for text.

Note      These settings apply only to displaying the page while authoring in the FrontPage Editor. They do not 
affect the HTML character encoding of the page when viewed by a user in a Web browser. To change the HTML 
character encoding for saving or loading the page, use the Language tab of the Page Properties dialog box.

Dialog Box Options

Language
Lists the available languages or character sets for HTML character encoding. Select a language or character set 
from the list, then specify the font options for that language or character set in the boxes below.

Default Proportional Font
Select the default proportional font for the language or character set selected in the list above. This list includes 
all of the proportional fonts installed on your computer.

Default Fixed-Width Font
Select the default fixed-width, or "typewriter" font, for the language or character set selected in the list above. 
This list includes all of the fixed-width fonts installed on your computer. If the selected language or character set 
does not support fixed-width fonts, this option is not available.
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Save Embedded Files Dialog Box
The Save Embedded Files dialog box is displayed when you save a page on which you have inserted images, 
sounds, videos, and so on. The Save Embedded Files dialog box lets you choose whether to save embedded 
files to the current FrontPage web, or, if no web is open in the FrontPage Explorer, to your file system.

· If you choose not to save an embedded file to the current web, the page will contain a hyperlink to that file's 
original location.

· If another file with the same name already exists in the specified folder, you can choose to overwrite the 
existing file, or not save the new file. If you choose not to save the new file, you can specify whether the 
hyperlink should point to the new file's location outside the current web, or to the existing duplicate file in the 
current web.

Dialog Box Options

Embedded Files to Save
This box lists the images, sounds, videos, or other files that have been inserted onto the page, but which have 
not yet been saved to the current FrontPage web.

Name

This column lists the name of each embedded file. If the file is an image, you can select the name to display a 
preview of the image in the Image Preview box. To rename the file, select the name and then click the Rename 
button.

Folder

This column lists the folders in which each embedded file will be saved, if the Action in the right-hand column is 
set to Save or Overwrite. To save a file in a different folder in the current FrontPage web, select the file and then 
click the Change Folder button.

Action

This column lists the action to be taken on each embedded file. To change the action to be taken on a file, select 
the file and then click the Set Action button:

· If the Action is set to Save, the file will be saved to the folder specified in the Folder column.
· If the Action is set to Don't Save, the file will not be saved to the current FrontPage web; instead, the page will 

contain a hyperlink to that file's original location.
· If a file with the same name already exists in the current web, and the Action is set to Overwrite, the existing 

file in the current web will be overwritten, and the page will contain a hyperlink to the new file.
· If a file with the same name already exists in the current web, and the Action is set to Use Existing, the page 

will contain a hyperlink to the existing file in the current web.

Image Preview
If you have selected an image in the Embedded Files to Save list, the Image Preview box displays a preview of 
that image.

Rename
Click this button to rename the selected file in the Embedded Files to Save list.

Change Folder
Click this button to specify a different folder in the current FrontPage web in which to save the selected file in the 
Embedded Files to Save list.

Set Action
Click this button to specify whether to save the selected file in the Embedded Files to Save list to the selected 
folder in the current FrontPage web.
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Frames Tab
Page Properties Dialog Box
Use the Frames tab to specify the borders and amount of space between frames on a frames page.

Dialog Box Options

Frame Spacing

Type the amount of padding to display between frames, in pixels, when the frames page is displayed in a Web 
browser.

Show Borders
Select this check box to display borders between frames when the frames page is displayed in a Web browser.
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Paste Special Command
Use the Paste Special command to paste text that you have cut or copied to the Clipboard into the active page in
a format you specify. This command displays the Convert Text dialog box, where you can specify whether to 
convert the text to one or more formatted paragraphs or to normal paragraphs with or without line breaks. The 
Paste Special command is not available if the Clipboard contains an image, sound, video, or other non-text file.
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Options Command
Use the Options command to set FrontPage Editor options.

The Options dialog box has two tabs:

· Use the AutoThumbnail tab to specify the default options that the FrontPage Editor should use when creating 
thumbnails of images. You can specify a default size and whether to use borders and bevels around the 
thumbnail.

· Use the Default Font tab to specify the font used to display a language or character set when no font is 
specified for text.
Note      The settings on the Default Font tab apply only to displaying the page while authoring in the 
FrontPage Editor. They do not affect the HTML character encoding of the page when viewed by a user in a 
Web browser. To change the HTML character encoding for saving or loading the page, use the Language tab 
of the Page Properties dialog box.
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AutoThumbnail Command
Use the AutoThumbnail command to create a thumbnail of the selected image. The FrontPage Editor creates the
thumbnail based on options, such as automatic sizing and whether to use borders and bevels around the 
thumbnail, specified in the AutoThumbnail tab of the Options dialog box.
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To rename a FrontPage web
A FrontPage web name corresponds to a directory name on a Web server or in your file system and is subject to 
the length, character restrictions, and case sensitivity of that Web server or file system. A FrontPage web title is 
displayed by some Web browsers when you surf to the FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Web Settings.
This displays the FrontPage Web Settings dialog box.

2 In the Configuration tab, type the new FrontPage web name in the Web Name field.
3 To change the title of the FrontPage web, type the new title in the Web Title field.
4 Click OK.
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To export a page or file from a FrontPage web
1 In the FrontPage Explorer's Folders View, All Files View, Navigation View, or Hyperlinks View, select the page 

or file that you want to export.
2 On the File menu, choose Export.
3 In the Export Selected As dialog box, use the Save In box and the box that lists files and folders to point to the

folder in your file system in which you want to store the page or file.
4 To change the file name, edit it in the File Name field.
5 Click Save to export the file.
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To change the title of a FrontPage web
A FrontPage web title is displayed by some Web browsers when you surf to the FrontPage web. You can change 
the web title for the current FrontPage web that is open in the FrontPage Explorer.

1 On the Tools menu, choose Web Settings.
2 In the Configuration tab, type the new FrontPage web title in the Web Title field.
3 Click OK.
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Check In Command
Use the Check In command to update Microsoft Visual SourceSafe with changes made to a checked-out file and 
unlock the Visual SourceSafe master copy. For more information about the Check In command and Visual 
SourceSafe, use the online Help system in Visual SourceSafe.

The Check In command is only available when you have version 5.0 of Visual SourceSafe properly configured to 
work with FrontPage.

Dialog Box Options

Files
The files you selected to check in are listed in the field.

Comments on Version
Add information about the changes made to the files you are checking in. If you are checking in more than one 
file at a time, the comments will apply to all the files.

Keep Files Checked Out
Select this option to keep the latest copy of the file checked out. If you do not want to keep a copy of the latest 
file checked out, do not select this option.
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Check Out Command
Use the Check Out command to check out one or more selected pages or files from the current project in 
Microsoft Visual SourceSafe. When you check out a page or file, other users are prevented from checking it out 
(also known as being locked out). For more information about the Check Out command and Visual SourceSafe, 
use online Help in Visual SourceSafe.

The Check Out command is only available when you have version 5.0 of Visual SourceSafe properly configured 
to work with FrontPage.
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Undo Check Out Command
Use the Undo Check Out command to cancel a Check Out operation, undoing all changes made to pages or files
in the current project in Microsoft Visual SourceSafe. For more information about the Undo Check Out command 
and Visual SourceSafe, use online Help in Visual SourceSafe.

The Undo Check Out command is only available when you have version 5.0 of Visual SourceSafe properly 
configured to work with FrontPage.
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FrontPage Component Command
Use the FrontPage Component command to insert a FrontPage component. You select a FrontPage component 
from the Insert FrontPage Component dialog box.

After you select a FrontPage component, the FrontPage Editor opens the component’s properties dialog box. 
Edit the properties dialog box and then click OK to insert the component.

Dialog Box Options

Select a component
Select a FrontPage component from the list:

· Comment
· Confirmation Field
· Hit Counter
· Include Page
· Insert HTML
· Page Banner
· Scheduled Image
· Scheduled Include Page
· Substitution component
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Timestamp Command
Use the Timestamp command to insert a timestamp on the active page. This command displays the Timestamp 
Properties dialog box. Edit the properties dialog box and then click OK to insert the timestamp.

Dialog Box Options

Display
Select one of the following display options:

· Date this Page Was Last Edited displays the date the page was last edited and saved to the Web server.
· Date this Page Was Last Automatically Updated displays the date the page was most recently updated. A 

page is updated when it is saved to the Web server, or when a change to another page that is included in the 
page causes the page’s HTML to be regenerated.

Date Format
Select a date format from the drop-down list, or select None to display the time only.

Time Format
Select a time format from the drop-down list, or select None to display the date only.
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Table of Contents Command
Use the Table of Contents command to insert a table of contents on the active page. This command displays the 
Table of Contents Properties dialog box. Edit the properties dialog box and then click OK to insert the table of 
contents.

Dialog Box Options

Page URL for Starting Point of Table
Supply the relative URL of the page at which to start the table of contents. For a table of contents that 
encompasses the entire FrontPage web, type or browse to the URL of the FrontPage web’s home page. 

Browse
Click this button to select a starting page from the current FrontPage web.

Heading Size
Select a heading style for the first entry in the table of contents. If you do not want a heading, select None.

Show each page only once
Select this check box if you want each page in your FrontPage web to appear only once in the table of contents. 
A page can appear more than once if it is pointed to by multiple hyperlinks in your FrontPage web.

Show pages with no incoming hyperlinks
Select this check box to include orphan pages in your table of contents. Orphan pages are pages that cannot be 
reached by following hyperlinks from the home page.

Recompute table of contents when any other page is edited
Select this check box to specify that the table of contents page should be recreated whenever any page in the 
current FrontPage web is edited. This can be a time-consuming process if the FrontPage web is large. If you do 
not select this check box, you can manually regenerate the table of contents by opening and saving the page 
containing the table of contents.
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Substitution Component Properties Dialog Box
Use the Substitution Component Properties Dialog Box to configure a Substitution component.

Dialog Box Options

Substitute with
This field lists all standard web, page, and user-defined variables. Select a variable from the drop-down list. The 
value of the variable will be displayed when users browse to the page.

The following standard variables are listed along with any user-defined variables that you have added to the web:

· Author is replaced by the name of the author who created the page.
· Modified By is replaced by the name of the author who most recently modified the page.
· Description is replaced by a description of the current page.
· Page URL is replaced by the location of the page in the current FrontPage web.
To add a new variable in the FrontPage Explorer: on the Tools menu, choose Web Settings, then choose the 
Parameters tab.
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Confirmation Field Properties Dialog Box
Use the Confirmation Field Properties dialog box to configure a Confirmation Field. You should insert a 
Confirmation Field only on a confirmation page.

Dialog Box Options

Name of Form Field to Confirm
Type the name of the field. When a user browsing your Web site submits a form that causes the confirmation 
page to be displayed, the confirmation field will be filled in with the contents of the named field.

If you are editing a confirmation page for a Registration Form Handler, you can type one of four special field 
names defined for Registration Form Handler confirmation pages:

· Registration-Username
The name of the user who is registering.

· Registration-Password
The password of the user who is registering.

· Registration-Error
A sentence or two describing an error condition for a user browsing this page.

· Validation-Error
A bulleted list of the errors produced when validating a form.
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Include Page Component Properties Dialog Box
Use the Include Page Component Properties dialog box to configure an Include Page component.

Dialog Box Options

Page URL to Include
Type or browse to the relative URL of the page to include.

Note      If you do not want users to be able to directly visit a page that you are including on other pages, move 
the page you are including in the _private folder.

Browse
Click Browse to select a page from the list of pages in the current FrontPage web.
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To change the HTML character encoding for saving or loading a page
Use this procedure to change the HTML character encoding for saving or loading the active page in the 
FrontPage Editor.

Warning!      If the active page is displaying correctly, changing the HTML encoding for saving or loading the page
can corrupt the page's contents.

1 On the File menu, choose Page Properties, and then click the Language tab.
2 If you want the active page to be saved in a different character set from the default character set for the 

current FrontPage web or from the character set for your computer if no web is open, select the character set 
in the HTML Encoding for Saving This Page box.

3 If the text on the active page is not displaying correctly, select a different character set from the HTML 
Encoding for Loading This Page box. The page will be reloaded after you click OK.

4 Click OK to close the Page Properties dialog box.
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To specify the default display font for a language or character set
Use this procedure to specify the default font used to display a language or character set on pages in the 
FrontPage Editor.

Note      This procedure applies only to displaying a page while authoring in the FrontPage Editor. It does not 
affect the HTML character encoding of the page when viewed by a user in a Web browser. To change the HTML 
character encoding for saving or loading a page, use the Language tab of the Page Properties dialog box.

1 On the Tools menu, choose Options, and then click the Default Font tab.
2 In the Language (Character Set) list, select the language or character set for which you want to specify a 

default display font.
3 In the Default Proportional Font box, choose a default proportional font for the selected language or character 

set. The list includes all of the proportional fonts installed on your computer.
4 In the Default Fixed-Width Font box, choose a default fixed-width, or "typewriter" font, for the selected 

language or character set. The list includes all of the fixed-width fonts installed on your computer. If the 
selected language or character set does not support fixed-width fonts, this option is not available.

5 Click OK to close the Options dialog box.
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Setting Language and Character Encoding
Overview

Setting Language and Character Encoding
To change the HTML character encoding for saving or loading a page

To specify the default display font for a language or character set



Scheduled Include Page Component Properties Dialog Box
Use the Scheduled Include Page Component Properties dialog box to configure a Scheduled Include Page 
component on the active page.

To ensure proper timing of the Scheduled Include Page component, make some change to your FrontPage web 
daily, such as incrementing the value of a variable.

Note      If you do not want users to be able to directly visit a page that you are including on other pages, move 
the page you are including to the _private folder in the current FrontPage web.

Dialog Box Options

Page URL to include
Type the relative URL of the page to include, or click Browse to select the page from the list of pages in the 
Current Web dialog box.

Browse
Click Browse to select the page to include from the current FrontPage web.

Starting Date and Time
Use this section to specify the starting date of the period during which the included page should be included on 
the active page.

Year

Select the year.

Month

Select the month.

Day

Select the day.

Time

Select the time.

Ending Date and Time
Use this section to specify the ending date of the period during which the included page should be included on 
the active page.

Year

Select the year.

Month

Select the month.

Day

Select the day.

Time

Select the time.

Optional Page URL to include before or after the given dates
If you want to include a page before or after the specified time period, type the relative URL of the page that you 
want to include or click Browse to select the page from the list of pages in the Current Web dialog box.

Browse



Click Browse to select the page to include from the current FrontPage web.
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Scheduled Image Properties Dialog Box
Use the Scheduled Image Properties dialog box to configure a Scheduled Image on the active page.

To ensure proper timing of the Scheduled Image, make some change to your FrontPage web daily, such as 
incrementing the value of a variable.

Dialog Box Options

Image to include
Type the relative URL of the image to include or click Browse to select the image from the current FrontPage 
web, from your local network, or from the World Wide Web.

Browse
Click Browse to select the image to include. You can include an image from the current FrontPage web, from 
your local network, or from the World Wide Web.

Note      If you schedule an image to include from the World Wide Web, you should use the Verify Hyperlinks 
command in the FrontPage Explorer regularly to verify that the hyperlink to the image has not changed during the
period of the include.

Starting Date and Time
Use this section to specify the starting date of the period during which the image should be included on the active
page.

Year

Select the year.

Month

Select the month.

Day

Select the day.

Time

Select the time.

Ending Date and Time
Use this section to specify the ending date of the period during which the image should be included on the active 
page.

Year

Select the year.

Month

Select the month.

Day

Select the day.

Time

Select the time.

Optional Image to include before or after the given dates
If you want to include an image before or after the specified time period, type the relative URL of the image that 
you want to include, or click Browse to select the image from the current FrontPage web, from your local 
network, or from the World Wide Web.



Browse
Click Browse to select the image to include from the current FrontPage web, from your local network or from the 
World Wide Web.
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Search Form Properties Tab
Search Form Properties Dialog Box
A Search Form lets users search for text in all the pages of your FrontPage web. The Search Form creates a 
form in which users type text to locate, and then displays a list of hyperlinks to pages containing the search text. 
The search string can include the Boolean keywords and, not, or, and parentheses.

Note      To protect pages from being found by users searching your Web site with the Search Form, move the 
pages the _private folder in the current FrontPage web. The Search Form does not search in this folder.

Dialog Box Options

Search Input Form
These fields control the appearance of the form.

Label for Input

Type the label for the one-line text box in which users specify the text to locate.

Width in Characters

Type the width, in characters, of the one-line text box field.

Label for "Start Search" button

Type the label for the push button field that starts the search.

Label for "Clear" button

Type the label for the push button field that clears any search text the user has typed in the one-line text box.
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Search Results Tab
Search Form Properties Dialog Box
A Search Form lets users search for text in all the pages of your FrontPage web. The Search Form creates a 
form in which users type text to locate, and then displays a list of hyperlinks to pages containing the search text. 
The search string can include the Boolean keywords and, not, or, and parentheses.

Note      To protect pages from being found by users searching your Web site with the Search Form, move the 
pages the _private folder in the current FrontPage web. The Search Form does not search in this folder.

Dialog Box Options

Search Results
These fields control the scope of the search and the formatting of the search results.

Word List to Search

Type the keyword All, or the name of a discussion group folder.

· Use the keyword All to allow users to search all the pages in this web that are not stored in hidden folders.
· If this web has a discussion group, type the name of the discussion group folder to allow users to search only 

entries in the discussion group.

Additional information to display in the search results list

Select any of the following check boxes to include additional information in the search results:

· Score indicates the closeness of the match.
· File Date indicates the date and time the document containing the match was most recently modified.
· File Size indicates the size of the document containing the match, in kilobytes.
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New Frames Page Command
Use the New Frames Page command to create a new frames page in a new FrontPage Editor window. The 
Frames tab of the New dialog box shows template frames pages you can create and then customize to meet 
your needs. The Preview area displays a preview of the selected template frames page.

Once you have created the new frames page, you can save it to the current FrontPage web using the Save 
command on the File menu. You can create a new template frames page from your page using the Save As 
command on the File menu.
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Split Frame Command
Use the Split Frame command to split the selected frame on the active frames page in the FrontPage Editor. This
displays the Split Frame dialog box, where you specify whether to split the frame horizontally or vertically to 
create two new frames.

After you split a frame, the new frames inherit the border properties of the original frame. The contents of the 
original frame appear in the left frame (if you split the original frame into columns) or in the top frame (if you split 
the frame into rows).

Dialog Box Options

Split Into Columns
Select this option to split the selected frame into two new frames of equal width.

Split Into Rows
Select this option to split the selected frame into two new frames of equal height.
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Delete Frame Command
Use the Delete Frame command to delete the selected frame on the active frames page in the FrontPage Editor. 
This command deletes only the frame from the frames page, not the page that was displayed in the frame. The 
adjacent frame expands accordingly to occupy the space left by the deleted frame. If the frames page contains 
only one frame, you cannot delete the last frame.

To delete a frames page, select the page in the FrontPage Explorer's Folders View, All Files View, or Navigation 
View, and then press the DEL key.
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Set Initial Page Command
Use the Set Initial Page command to specify the initial page that should occupy the selected frame when the 
frames page is first displayed in a Web browser. This command displays the Create Hyperlink dialog box, where 
you can select a page from the current FrontPage web, a page or file from your local network, a page from the 
World Wide Web, or create a new page.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Frames')}



Open Page in New Window Command
Use the Open Page in New Window command to open the active page of a frames page in a new window. The 
frames page remains open as well. You can edit the page in either window.

This command is useful if a page is displaying in a small frame in which it is difficult to view your edits.
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Save Page Command
Use the Save Page command to save the page displayed in the selected frame on the active frames page in the 
FrontPage Editor.

· If the page was opened from the current FrontPage web or from your computer or your local network, the 
Save command saves the page without prompting you. If you have inserted any images, sounds, videos, and 
so on from files or from the clipboard, the Save command displays the Save Embedded Files Dialog Box. This
dialog box gives you the option of saving each new or replaced image, sound, video, and so on to the current 
FrontPage web.

· If the page has never been saved, the Save command displays the Save As dialog box.
To save a page to different location or with a different name, use the Save Page As command.

Note      To save the frames page, use the Save command on the File menu.
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Save Page As Command
Use the Save Page As command to save the page displayed in the selected frame on the active frames page in 
the FrontPage Editor. Typically, you will use this command to save a new page that you created in the frame or to
save a copy of an existing page under a different name, to a different location on your computer or local network,
or to a different FrontPage web.

You can also use the Save As command to save the page as a template.

· To save the page to the current FrontPage web, in the Save As dialog box type a new name for the page in 
the URL box. If you have inserted any images, sounds, videos, and so on from files or from the clipboard, the 
Save As command displays the Save Embedded Files dialog box. 

· To save the page to a different location on your computer or local network, click the File button:

This displays the Save As File dialog box. If you have inserted any images, sounds, videos, and so on from files or 
from the clipboard, the Save As File command displays the Save Embedded Files dialog box. This dialog box gives 
you the option of saving each new or changed image, sound, video, and so on to the same folder as the page or to 
another folder that you specify.
· To save the page as a template, click As Template and type a title and name for the template in the Save as 

Template dialog box.

The FrontPage editor saves pages in HTML format. HTML files have an .htm file extension by default.

Note      To save the frames page, use the Save command on the File menu.
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Frame Properties Command
Use the Frame Properties command to display the Frame Properties dialog box for the selected frame on the 
active frames page in the FrontPage Editor. The Frames Properties dialog box lets you specify properties for the 
frame, such as the frame size, margins, and initial page to display.

Dialog Box Options

Name
This box lists the name of the frame, which is used throughout the FrontPage Editor to set the frame as the target
frame for a hyperlink or the default target for all the hyperlinks on a page. Initially this box displays the default 
name assigned to the frame by the FrontPage Editor.

Note      If you change the default name, be careful not to rename the frame to the same name as another frame 
in the current FrontPage web,

Options
Use the options in this section to specify whether to allow the frame to be resized or to display scrollbars when 
the page is displayed in a Web browser.

Resizable in Browser

Select this check box to allow users to resize the frame when the page is displayed in a Web browser. If this 
check box is cleared, the frame will display at the size specified in the Frame Size section.

Show Scrollbars

Select an option from the drop-down list to specify the use of scrollbars around the frame when displayed in a 
Web browser:

· If Needed - displays scrollbars if the contents of the frame are too large to be displayed without scrolling.
· Never - turns off scrollbars.
· Always - turns on scrollbars.

Frame Size
Use the options in this section to specify the size of the frame relative to other frames on the frames page. The 
specific options change depending on whether the frame belongs to a row or a column, relative to the other 
frames on the frames page.

Tip      You can also change the size of a frame by dragging the frame's borders in the Normal view of the 
FrontPage Editor.

Column Width/Height

If the selected frame belongs to a column that contains other frames of the same size above or below, these 
options are enabled. You can specify the frame's column width and height as follows:

· In values relative to the other frames in the same column. A value of one indicates frames of equal 
width/height. For example, if you change the height of the selected frame to 3, and then change the height of 
the frame below it to 2, the FrontPage Editor sizes the frames to 3/5 and 2/5 of the height of the column.

· As a percent of the size of the window when the frames page is displayed in a Web browser.
· In a fixed number of pixels.
If you change the column width for the selected frame, the change will be applied uniformly to all other frames in 
that column. The sizes of frames in other columns to the left or right of the selected frame will be adjusted 
accordingly.

Width/Row Height

If the selected frame belongs to a row that contains other frames of the same size to the left or right, these 
options are enabled. You can specify the frame's width and row height as follows:

· In values relative to the other frames in the same row. A value of one indicates frames of equal width/height. 
For example, if you change the width of the selected frame to 3, and then change the width of the frame to the
right to 2, the FrontPage Editor sizes the frames to 3/5 and 2/5 of the width of the column.



· As a percent of the size of the window when the frames page is displayed in a Web browser.
· In a fixed number of pixels.
If you change the row height for the selected frame, the change will be applied uniformly to all other frames in 
that row. The sizes of frames in other rows above or below the selected frame will be adjusted accordingly.

Margins
Use the options in this section to specify the size of margins inside the selected frame.

Width

Specify the width, in pixels, that the contents of the frame should be indented from the left and right frame 
borders.

Height

Specify the height, in pixels, that the contents of the frame should be indented from the top and bottom frame 
borders.

Initial Page
This box displays the URL of the initial page displayed in the frame when the frames page is first displayed in a 
browser. If no initial page has been set or to specify a different initial page, type the URL of that page or click 
Browse to select a new or different initial page.

Browse
Click this button to select a new or different initial page to display in the frame. This displays the Edit Hyperlink 
dialog box. You can specify an initial page from the current FrontPage web, from your local network, or from the 
World Wide Web.

Frames Page
Click this button to display the Frames tab of the Page Properties dialog box.

Style
Click this button to edit the cascading style sheet properties for the frame. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Name and Password Required Dialog Box
Use the Name and Password Required dialog box to gain access to a FrontPage web if you are not already 
logged in with the appropriate permission level.

Note      The legal characters and the case sensitivity that you can use for both the name and password depend 
on the Web server you are using.

Dialog Box Options

Name
Type your username.

Password
Type your password.
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Edit Hyperlink Dialog Box
Use the Edit Hyperlink dialog box to repair a broken hyperlink or to change a hyperlink and automatically update 
occurrences of that hyperlink in the current FrontPage web. You can repair or change the hyperlink in all pages in
which it is found or only in selected pages. You display this dialog box by double-clicking a hyperlink in the 
Hyperlink Status View of the FrontPage Explorer or by selecting the hyperlink and then clicking Edit Hyperlink on 
the shortcut menu.

Dialog Box Options

Hyperlink
Lists the URL of the page or file to which the selected hyperlink currently points.

In Page
Lists the name of the page that contains the selected hyperlink.

Edit Page
Click this button to open the page that contains the selected hyperlink in the FrontPage Editor.

Replace Hyperlink With
This box initially lists the URL of the selected hyperlink. To repair or change the hyperlink to point to another URL,
type the new URL in this box or click Browse to locate the new destination in your Web browser.

Browse
Click Browse to use your Web browser to locate the new destination to which the hyperlink should point.

Change in all pages
Select this option to replace all occurrences of the original hyperlink in the current web with the new hyperlink 
listed in the Replace Hyperlink With box. When you click Replace, the FrontPage Explorer will search all of the 
pages in the current web and replace each occurrence of the original hyperlink with the new hyperlink.

Change in selected pages
Select this option to replace the original hyperlink with the new hyperlink only on the pages selected in the box 
below. When you click Replace, the FrontPage Explorer will search only the selected pages and replace each 
occurrence of the original hyperlink with the new hyperlink.
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Hover Button Command
Use the Hover Button command to insert a hover button component on the active page in the FrontPage Editor. 
This command displays the Hover Button dialog box, where you specify options such as the button label, color, 
size, and effect.

Dialog Box Options

Button Text
Type the text to appear on top of the button.

Font
Click this button to display the Font dialog box, where you can specify the font characteristics for the button text.

Link To
To create a hyperlink from the hover button, type a URL, or click Browse to select a hyperlink target in the Select 
Hover Button URL dialog box.

Browse
Click this button to select a hyperlink target for the hover button. This displays the Select Hover Button URL 
dialog box, where you can choose a target from the current FrontPage web, from your local network, or from the 
World Wide Web. When you click OK to close the Select Hover Button URL dialog box, the Link To box displays 
the URL of the target to which you browsed.

Button Color
Select a color for the button. If you click Custom and select an image to use as a button, you do not need to 
select a button color.

Effect
Select a visual effect that will display when a user hovers over the button.

Width
Type the width of the button, in pixels. If you select an image for the hover button using the Custom dialog box, 
the width you type here should match the width of the image.

Background Color
Select a background color for the hover button. The background color of a hover button cannot be made 
transparent; however, you can match its background color to the page's background color.

Effect Color
Select a color for the effect selected in the Effect box. The effect color will appear over the button color.

Height
Type the height of the button, in pixels. If you select an image for the hover button using the Custom dialog box, 
the height you type here should match the height of the image.

Custom
Click this button to associate a sound file or image with the hover button. This displays the Custom dialog box, 
where you can specify whether to play a sound when a users clicks or hovers over the button. You can also 
specify whether to use an image as the button or whether to display an image when a user hovers over the 
button.
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Banner Ad Manager Command
Use the Banner Ad Manager command to insert a Banner Ad Manager component on the active page in the 
FrontPage Editor. This command displays the Banner Ad Manager dialog box, where you specify options such as
the size, transition effect, and images to display in the banner ad.

Dialog Box Options

Width
Type the width of the banner ad, in pixels. This value should correspond to the width of the widest image to be 
displayed in the banner ad.

Tip      The Banner Ad Manager works best with images that are approximately the same size. Otherwise, the 
images are centered in a window the size of the largest image, on a neutral background.

Height
Type the height of the banner ad, in pixels. This value should correspond to the height of the tallest image to be 
displayed in the banner ad.

Transition
Use the options in this section to specify the duration and transition effects for displaying images in the banner 
ad.

Effect

Select the type of transition effect to use when the banner ad manager switches the display from one image to 
the next or select None to display the images in sequence without any transition effect in between.

Show each image for (seconds)

Type the number of seconds that each image should display in the banner ad.

Link to
Type or browse to the URL to which the banner ad manager should point. If a user browsing the page clicks on 
the banner ad, the hyperlink will jump to the URL you specify here.

Browse
Click Browse to locate the URL to which the banner ad manager should point. 

Images to Display
This box lists the images to be displayed in the banner ad. The images will be displayed sequentially starting at 
the top of the list in an infinite loop.

· To add images to this list, click the Add button.
· To remove an image from this list, select the image, and then click the Remove button.
· To reorder the images in the list, select the image you want to move, and then click the Move Up or Move 

Down buttons.

Add
Click Add to add images to the list of images to be displayed in the banner ad, then select the images in the Add 
Image for Banner Ad dialog box. You can add images from the current FrontPage web, your local network or file 
system, the Microsoft Clip Art Gallery, or the World Wide Web.

Remove
Select an image from the list of images to display, then click Remove to remove the image from the list.

Move Up
Select an image from the list of images to display, then click Move Up to move the image one level higher in the 



list. Each time you click Move Up, the image will move up one level until it reaches the top of the list.

Move Down
Select an image from the list of images to display, then click Move Down to move the image one level lower in 
the list. Each time you click Move Down, the image will move down one level until it reaches the bottom of the 
list.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Pages')}



To delete a navigation bar in the FrontPage Editor
Use this procedure to delete a navigation bar on the active page in the FrontPage Editor. Navigation bars are 
created automatically when you create a FrontPage web using a wizard or by creating a navigational structure in 
the FrontPage Explorer's Navigation view.

· If you delete the navigation bar from a shared border region on the page, the navigation bar will also be 
deleted from all other pages in the current FrontPage web that use that shared border.

· If you delete a navigation bar from the body of a page that uses shared borders or from a page that does not 
use shared borders, the navigation bar will be deleted from that page only.

1 In the FrontPage Editor, select the navigation bar that you want to delete.
2 On the Edit menu, choose Cut or Clear, or press the DELETE key.
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To modify a navigation bar
Navigation bars are created automatically when you create a FrontPage web using a wizard or by creating a 
navigational structure in the FrontPage Explorer's Navigation View.

· To modify the text labels displayed on a navigation bar, edit the page titles in the FrontPage Explorer's 
Navigation View.

· To modify which pages a given navigation bar points to, open the page containing the navigation bar in the 
FrontPage Editor, double-click the navigation bar, then specify the pages to which the navigation bar should 
point in the Navigation Bar Properties dialog box.

· To modify the navigational structure of your Web site, use the FrontPage Explorer's Navigation View to add 
pages, delete pages, and reorganize the relationships between pages. The FrontPage Explorer will 
automatically update your navigation bars to reflect the new navigational structure.

· To modify the colors, fonts, and types of buttons on a navigation bar, select a different theme. If you select a 
different theme in the FrontPage Explorer's Themes View, the new theme will be applied to all navigation bars 
in the current web. If you select a different theme for the active page in the FrontPage Editor, the new theme 
will be applied to the navigation bar on that page only.

· To modify whether a navigation bar uses buttons or text, open the page containing the navigation bar in the 
FrontPage Editor, double-click the navigation bar, then specify whether to use buttons or text in the Navigation
Bar Properties dialog box.
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To change the position of a navigation bar
Use this procedure to change the orientation of a navigation bar on the active page in the FrontPage Editor. 
Navigation bars are created automatically when you create a FrontPage web using a wizard or by creating a 
navigational structure in the FrontPage Explorer's Navigation view.

· If you change the orientation of a navigation bar in a shared border region on the page, the orientation of the 
navigation bar will also be changed on all other pages in the current FrontPage web that use that shared 
border.

1 In the FrontPage Editor, select the navigation bar that you want to reposition.
2 To change the orientation of the navigation bar, double-click the navigation bar, then specify whether to use a 

horizontal or vertical orientation in the Navigation Bar Properties dialog box.
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Verify Hyperlinks Command
Use the Verify Hyperlinks command in the FrontPage Explorer to verify the internal hyperlinks and external 
hyperlinks in the current FrontPage web.

When you select Verify Hyperlinks, the FrontPage Explorer switches to the Hyperlink Status View, checks all 
internal and external hyperlinks, and then lists the status of each:

· OK indicates that the hyperlink has been checked and is good.
· Broken indicates that the hyperlink has been checked and is bad.
· Unknown indicates an external hyperlink that has not been checked yet.

The Verify Hyperlinks command does not initially verify external hyperlinks because verification can take a 
long time.

· Added task indicates that the hyperlink is either broken or has not been checked yet, and a related task has 
been added to the list in the Tasks view.

Initially, the Hyperlink Status View lists broken internal hyperlinks and all external hyperlinks, then displays the 
Verify Hyperlinks dialog box. To view the status of all hyperlinks, close the dialog box, and then select Show All 
Hyperlinks on the View menu.

The Verify Hyperlinks dialog box lets you verify all hyperlinks, or just the hyperlinks selected in the Hyperlink 
Status View. Once you start the process, you can stop it by clicking the Stop button on the toolbar:

Note      To ensure that the Verify Hyperlinks command checks the most current version of your FrontPage web, 
save any open pages in the FrontPage Editor before clicking Start.

Dialog Box Options

Verify All Hyperlinks
Select this option to verify all broken or unknown hyperlinks.

Resume Verification
Select this option if you started to verify hyperlinks, but stopped before completing the process. If you have not 
yet verified hyperlinks or if you have already completed verifying all hyperlinks, this option is not available.

Verify Selected Hyperlinks
Select this option to verify only the selected hyperlinks in the Hyperlink Status View.

Start
Click Verify to start the process. To stop the process before it completes, click the Stop button on the toolbar.
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General Tab
Image Properties Dialog Box
Use the General Tab of the Image Properties dialog box to set and view the general properties of an image.

Dialog Box Options

Image Source
This field displays the relative URL of the image, if the image is in the current FrontPage web; the absolute URL 
of the image, if the image is on a page in the World Wide Web; or the full file name of the image, if the image is in
a file. Images from files have the File prefix.

Browse
Click Browse to repair the path to a broken image or to select a different image from the current FrontPage web, 
from your local network, from the World Wide Web, or from the Microsoft Clip Gallery.

Edit
Click Edit to open the selected image in the editor for which the image is associated in the FrontPage Editor.

Type
This section contains options that specify the image type. When you insert an image that is not in the GIF or 
JPEG format, it is converted to GIF format (for images with 256 or less colors) or JPEG format (for images with 
more than 256 colors).

You can convert an image from GIF to JPEG or from JPEG to GIF by selecting a different type in this section.

GIF

Select GIF to save the image in GIF format.

Transparent: For GIF images only, the Transparent check box is selected if there is a transparent color assigned
to the image. You can assign a transparent color using the Make Transparent command on the FrontPage 
Editor's image toolbar. Clear the Transparent check box to make the image non-transparent and return the 
transparent color to its normal color.

Interlaced: For GIF images only, the Interlaced check box is selected if this is an interlaced GIF. You cannot 
create an interlaced GIF using the FrontPage Editor. However, you can insert an interlaced GIF onto the page.

JPEG

Select JPEG to save the image in JPEG format.

Quality: When you save the image in JPEG format, you specify the image quality. Quality is an integer in the 
range 1 - 99. As Quality increases, image compression decreases, making the image larger, but image quality 
improves. As Quality decreases, compression increases, making the image smaller, but image quality degrades. 
The default Quality is 75.

Progressive Passes: If the image is a progressive JPEG, specify the number of passes to make to resolve the 
image until it is finished downloading in a Web browser. If you specify zero, the JPEG will not be rendered 
progressively.

Alternative Representations
Use this section to specify the alternative representations of the image when viewed in a Web browser.

Low-Res

Specify a small image to display in place of the image. This small image is displayed by some Web browsers 
while the main image is being downloaded from the Web server. You can specify a small image from the current 
FrontPage web, from your local network, from the World Wide Web, or from the Microsoft Clip Gallery.

Browse



Click Browse to select a small image to use as the low-resolution alternative.

Text

Specify text to display in place of the image when image-display is disabled or not available in the Web browser. 
Some Web browsers also display the alternative text while the image is downloading.

Default Hyperlink
This section lets you specify the default hyperlink for the image. This is the target of a hyperlink from any area in 
the image not covered by a hotspot. You cannot set a default hyperlink for an image form field.

Location

Type the URL of the page to which the hyperlink should point, or click Browse to locate the page using the 
Create Hyperlink dialog box.

Browse

Click Browse to locate the page to which the hyperlink should point. You can choose a page from the current 
FrontPage web, from your local network, from the World Wide Web, or from the Microsoft Clip Gallery.

Target Frame

The Target Frame field lists the frame in which to display the page to which the hyperlink points. Note that if a 
frame is supplied and no frames page is loaded, the Web browser may create a new window in which to display 
the page to which the hyperlink points.

Type the name of the frame or click the Target Frame button:

Style
Click this button to edit the cascading style sheet properties for the image. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Appearance Tab
Image Properties Dialog Box
Use the Appearance Tab of the Image Properties dialog box to set and view the layout and size properties of an 
image.

Dialog Box Options

Layout
Use this section to align the image.

Alignment

Sets the type of alignment between the image and the text:

· Default aligns the image using the default settings of the Web browser. This is the same as the baseline 
option.

· left aligns the image in the left margin and wraps the text that follows the image down the image's right side.
· right aligns the image in the right margin and wraps the text that precedes the image down the image's left 

side.
· top aligns the top of the image with the surrounding text.
· texttop aligns the top of the image with the top of the tallest text in the line.
· middle aligns the middle of the image with the surrounding text.
· absmiddle aligns the image with the middle of the current line.
· baseline aligns the image with the baseline of the current line.
· bottom aligns the bottom of the image with the surrounding text.
· absbottom aligns the image with the bottom of the current line.
· center aligns the center of the image with the surrounding test.

Border Thickness

Sets a black border of the specified thickness around the image, in pixels.

Horizontal Spacing

Sets the horizontal spacing between the image and the nearest text or image on the current line, in pixels.

Vertical Spacing

Sets the vertical spacing between the image and the nearest text or image on the line above or below the current
line, in pixels.

Size
The options in this section control the width and height of the image.

Specify Size

Select this check box to specify the size of the image.

Width

Type a number for the width of the image, and then select whether the number represents pixels or a percentage
of the width of the window in a Web browser.

In Pixels

Type the width of the image, in pixels.

In Percent

Type a percentage of the width of the window in a Web browser. For example, if you choose 50 percent, the 
image will span 50 percent of the window, regardless of how a user resizes the window in a Web browser.



Height

Type the height of the image, and then select whether the number represents pixels or a percentage of the height
of the window in a Web browser.

In Pixels

Type the height of the image, in pixels.

In Percent

Type a percentage of the height of the window in a Web browser. For example, if you choose 50 percent, the 
image will span 50 percent of the height of the window, regardless of how a user resizes the window in a Web 
browser.

Keep Aspect Ratio

Select this check box to maintain the aspect ratio of the image if you changed the width or height. For example, if
you changed the width of the image to 100 pixels but did not specify a height, selecting this check box will ensure
that the image displays 100 pixels wide, and the height will size automatically to maintain the original aspect ratio
of the image.
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Video Tab
Image Properties Dialog Box
Use the Video Tab of the Image Properties dialog box to set and view the properties of a video.

Dialog Box Options

Video Source
This field displays the relative URL of the video, if the video is in the current FrontPage web; the absolute URL of 
the video, if the video is on a page in the World Wide Web; or the full file name of the video, if the video is in a 
file. Videos from files have the File prefix.

Browse
Click Browse to repair the path to a broken video, or to select a different video from the current FrontPage web, 
from your local network, from the World Wide Web, or from the Microsoft Clip Gallery.

Show Controls in Browser
Select this check box to display buttons in a Web browser for starting, stopping and replaying the video.

Repeat
The options in this section control the number of repetitions of the video and the time delays between repetitions.

Loop

Specify the number of times you want the video to repeat. If the Forever check box is selected, this box is not 
available.

Loop Delay

If the video is set to loop a number of times or forever, specify the delay between each playing of the video, in 
milliseconds. 

Forever

Select this check box if you want the video to play continuously. This overrides any settings in the Loop field.

Start
The options in this section control when the video will start playing.

On File Open

Select this check box to begin playing the video when the file is opened.

On Mouse Over

Select this check box to begin playing the video when a user moves the mouse over the video.
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To add a background image to a table
A table can have a different background image from a page. When you specify a background image, any 
selected color from the Background Color drop-down list could be overridden, unless the background image you 
choose has a color specified as transparent.

1 In the FrontPage Editor, move the insertion point inside the table to which you want to add a background 
image.

2 On the Table menu, choose Table Properties.
3 Select the Use Background Image check box, and then click Browse to open the Select Background Image 

dialog box:
· If the image is in the current FrontPage web, browse to the folder that contains the image, select the image

you want, and then click OK.
· If the image is in a file on your local network, click the File button:

This displays the Select File dialog box. Browse to the image you want from your local network, and then click OK.
· If the image is on the World Wide Web, click the World Wide Web button:

Your Web browser will be displayed. Browse to the image that you want, and then switch back to the FrontPage 
Editor. The location of the page you visited will be displayed n the URL field.

· If the image is clip art, click the Clip Art button to display the Microsoft Clip Gallery, and then select the 
image that you want.

4 If you want to specify properties for the image, such as transparency, click the Properties button, and then set 
properties in the Image Properties dialog box.

5 Click OK to close the Table Properties dialog box. The specified image is displayed as the table background.
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To add a background image to a cell
A cell can have a different background image from a table or page. When you specify a background image, any 
selected color from the Background Color drop-down list could be overridden, unless the background image you 
choose has a color specified as transparent.

1 In the FrontPage Editor, move the insertion point inside the cell to which you want to add a background image.
2 On the Table menu, choose Cell Properties.
3 Select the Use Background Image check box, and then click Browse to open the Select Background Image 

dialog box:
· If the image is in the current FrontPage web, browse to the folder that contains the image, select the image

you want, and then click OK.
· If the image is in a file on your local network, click the File button:

This displays the Select File dialog box. Browse to the image you want from your local network, and then click OK.
· If the image is on the World Wide Web, click the World Wide Web button:

Your Web browser will be displayed. Browse to the image that you want, and then switch back to the FrontPage 
Editor. The location of the page you visited will be displayed n the URL field.

· If the image is clip art, click the Clip Art button to display the Microsoft Clip Gallery, and then select the 
image that you want.

4 If you want to specify properties for the image, such as transparency, click the Properties button, and then set 
properties in the Image Properties dialog box.

5 Click OK to close the Cell Properties dialog box. The specified image is displayed as the cell background.
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To insert a table within a table
You can insert a table within a table.

1 In the FrontPage Editor, move the insertion point where you want the table inserted.
2 On the Table menu, choose Insert Table.
3 Specify the size, layout and width for the table, then click OK.
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To delete a FrontPage web
You can delete the current FrontPage web in the FrontPage Explorer. When you delete a FrontPage web, it 
cannot be recovered. You need to be authorized as an administrator in the root web in order to delete a 
FrontPage web.

1 On the FrontPage Explorer’s File menu, choose Delete FrontPage Web.
2 If necessary, enter your administrator name and password in the Name and Password Required dialog box, 

then click OK.
3 In the Confirm Delete dialog box, choose Yes.
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To open a FrontPage web
1 On the FrontPage Explorer’s File menu, choose Open FrontPage Web.
2 In the Getting Started dialog box, select Open an Existing FrontPage Web and choose the FrontPage web 

you want to open. Click More Webs if the web you want to open is not listed.
3 Click OK.
4 If you are prompted for your author name and password, enter them in the Name and Password Required 

dialog box, and click OK.
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To create a new FrontPage web
1 On the FrontPage Explorer’s File menu, point to New and choose FrontPage Web.
2 In the New FrontPage Web dialog box, select the type of FrontPage web you want to create. Choose one of 

the following:
· One Page Web creates a FrontPage web with a single page (the home page). Use this option to create a 

FrontPage web from scratch, with no generic or pre-existing content.
· Import an Existing Web will launch the Import Web Wizard, which is used to import an existing web into a 

new FrontPage web. This wizard will guide you through the process of importing an existing Web site.
· From Wizard or Template lists the Web Wizards and web templates you can choose from to create a new

FrontPage web with suggested content. To view a description of the individual FrontPage web wizards and 
templates, click the wizard or template you want to use. The description will appear just below the list box.

3 Enter a descriptive title for your new FrontPage web in the Choose a Title for Your FrontPage Web field.
4 Click OK.
5 If you are prompted for your administrator name and password, enter them in the Name and Password 

Required dialog box, and click OK.
Note      FrontPage will suggest a location for the new FrontPage web based on the currently selected Web 
server or folder. To choose a custom location, click Change in the New FrontPage Web dialog box to display the 
Change Location dialog box. In this dialog box, enter a new location for your FrontPage web and specify whether
a secure connection is required.
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To import files to a FrontPage web
When you import a file, you place a copy of the file in your FrontPage web. You can import any type of file that 
your operating system supports. To quickly import a file or a selection of files to the current FrontPage web, drag 
them into the FrontPage Explorer’s Folders View. To import files to an import list from which you can rename the 
files and later import them into the FrontPage web, do the following:

1 On the FrontPage Explorer’s File menu, choose Import.
In the Import File To FrontPage Web dialog box, you can add one or more files to the import list without 
importing them. The files remain on the list until you choose to import or remove them. Adding a folder to the 
import list will add all the files it contains (as well as those of its subfolders) to the import list.

2 To add a file to the import list, click Add File. In the Add File to Import List dialog box, point to the folder where 
the file you want to import is stored. Select the file, then click Open.

3 To add the entire contents of a folder to the import list, click Add Folder. In the Browse For Folder dialog box, 
locate and select the folder, then click OK.

4 To change the URL of any file before importing it (either to rename it or change the file's folder in the 
FrontPage web), click Edit URL to open the Edit URL dialog box. In the File Location Within Your FrontPage 
Web field, type a URL relative to the root of the current FrontPage web. For example, if you type the URL 
folder2/sample.htm, the page will be saved in folder2 below the root folder of the current FrontPage 
web. After changing the URL, click OK.

5 To save the import list and import the files in the list at a later time, click Close in the Import File to FrontPage 
Web dialog box. To start importing the files to the current FrontPage web, click OK.
While files are being imported, you can stop the process by clicking Stop.
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To copy the current FrontPage web
You can create a new FrontPage web by copying the current FrontPage web to another location.

1 On the FrontPage Explorer’s File menu, choose Publish FrontPage Web or click the Publish button on the 
FrontPage Explorer’s toolbar:

2 In the Publish FrontPage Web dialog box, specify the location to which you want to copy the current 
FrontPage web. You can choose from the drop-down list or enter a new location by typing directly into this 
field. To copy to a folder on your local file system, type in the full path and name of the folder. If you specify a 
folder that does not exist, FrontPage will offer to create it.

3 If you are copying the root web, select the Include Child Webs option to copy the other FrontPage webs on 
the same Web server or, if the root web is in a folder, to copy the other FrontPage webs in the same folder.

4 Click OK.
Note      If FrontPage detects that you are copying to a Web server that does not have the FrontPage Server 
Extensions installed, it will launch the Microsoft Web Publishing Wizard to copy your FrontPage web.
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To publish the current FrontPage web
1 On the FrontPage Explorer’s File menu, choose Publish FrontPage Web or click the Publish button on the 

FrontPage Explorer’s toolbar: 

2 In the Publish FrontPage Web dialog box, specify the location to which you want to publish the current 
FrontPage web. You can choose from the drop-down list or enter a new location by typing directly into this 
field. To publish to a folder on your local file system, type in the full path and name of the folder. If you specify 
a folder that does not exist, FrontPage will offer to create it.

3 If you are publishing the root web, select the Include Child Webs option to publish the other FrontPage webs 
on the same Web server or, if the root web is in a folder, to publish the other FrontPage webs in the same 
folder.

4 Click OK.
Note      If FrontPage detects that you are publishing to a Web server that does not have the FrontPage Server 
Extensions installed, it will launch the Microsoft Web Publishing Wizard to publish your FrontPage web.

{button Related Procedures,AL(`file web procedures',0,`',`main')}



To add pages to a FrontPage web
Do one of the following:

· In the FrontPage Explorer, switch to either the Folders View, the All Files View, or the Navigation View. On the 
File menu, point to New, then choose Page, or click the New Page button on the toolbar to create new pages:

· In the FrontPage Editor, create new pages and add them to the current FrontPage web using the Save 
command on the File menu.

· In the FrontPage Editor, open pages from the World Wide Web using the Open command on the File menu, 
then add them to the current FrontPage web using the Save command on the File menu.

· In the FrontPage Explorer, import pages or entire folders from your file system to the current FrontPage web 
using the Import command on the File menu.
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To add a variable to a FrontPage web
1 On the FrontPage Explorer’s Tools menu, choose Web Settings while the current FrontPage web is open.
2 In the FrontPage Web Settings dialog box, select the Parameters tab.
3 To add a variable, click Add.
4 Type in the Name and Value of the variable and click OK to close the Add Name and Value dialog box.
5 Click OK to close the FrontPage Web Settings dialog box.
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To delete a variable from a FrontPage web
1 On the FrontPage Explorer’s Tools menu, choose Web Settings while the current FrontPage web is open.
2 In the FrontPage Web Settings dialog box, select the Parameters tab.
3 Select the variable to be deleted, then click Remove.
4 Click OK to close the FrontPage Web Settings dialog box.
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To modify a variable in a FrontPage web
1 On the FrontPage Explorer’s Tools menu, choose Web Settings while the current FrontPage web is open.
2 In the FrontPage Web Settings dialog box, select the Parameters tab.
3 Select the variable to be changed, then click Modify.
4 Type in the new name and/or value of the variable and click OK to close the Modify Name and Value dialog 

box.
5 Click OK to close the FrontPage Web Settings dialog box.
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To copy a page to a FrontPage web
You can copy pages from a Web site to a FrontPage web, when permissible.

1 On the FrontPage Editor’s File menu, choose Open.
2 In the Open dialog box, do one of the following:

· Click the File button and locate the file you want to copy, then click OK. The page will open in the 
FrontPage Editor.

· Specify the Web server storing the file you want to copy, and then enter the URL of the file and click OK. 
The page will open in the FrontPage Editor.

· Click the World Wide Web button and browse to the URL of the page you want to copy to your FrontPage 
web, then return to the FrontPage Editor and click OK. The page will open in the FrontPage Editor.

3 On the File menu, choose Save As.
4 Enter a page title in the Title field.
5 Click OK.

You will be prompted to save any images, background sounds, or other page elements to the current 
FrontPage web.
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To create a new folder in a FrontPage web
1 In the FrontPage Explorer, switch to the Folders View by clicking the Folders button on the Views bar.

2 In the All Folders Pane, double-click the folder in which you want to create a new folder.
3 On the File menu, point to New, then choose Folder.
4 Type a name for the new folder.
5 Press ENTER.
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To show the Getting Started with Microsoft FrontPage Dialog Box
In the FrontPage Explorer, you can specify whether to display the Getting Started with Microsoft FrontPage 
dialog box when you start FrontPage, or when you open or close a FrontPage web.

1 On the Tools menu, choose Options, and then click the General tab.
2 Select the Show Getting Started Dialog check box.
3 Click OK.
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To edit a page's HTML
In the FrontPage Editor, you can edit HTML for the active page. The FrontPage Editor color-codes HTML syntax 
as you type.

· Click the HTML tab to switch to the FrontPage Editor's HTML View.
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To view HTML
In the FrontPage Editor, you can view and edit HTML for the active page. The FrontPage Editor color-codes 
HTML syntax as you type.

· Click the HTML tab to switch to the FrontPage Editor's HTML View.
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Viewing and Editing HTML
Overview

Viewing and Editing HTML
To edit a page's HTML

To view HTML



To undo an edit
In the FrontPage Editor, some changes may not be possible to undo. In these cases, the Undo command will not 
be available.

· On the Edit menu, choose Undo, or click the Undo button on the standard toolbar:
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To rename a form field
Use this procedure to rename a form field on the active page in the FrontPage Editor.

1 Select the form field, right-click to display the shortcut menu, and then click Form Field Properties.
This displays the properties dialog box for the form field.

2 In the Name field, type a new name for the form field, and then click OK to close the dialog box.
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Show All Hyperlinks Command
In the FrontPage Explorer's Hyperlink Status View, use the Show All Hyperlinks command to show or hide the 
status of hyperlinks in the current FrontPage web. When the Show All Hyperlinks command has a check mark 
next to it, the Hyperlink Status View shows the status of all hyperlinks. When the command is unchecked, the 
Hyperlink Status View shows the status of all external hyperlinks and only broken internal hyperlinks.
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Publish FrontPage Web Command
Use the Publish FrontPage Web command to publish your FrontPage web to a Web server or to copy your 
FrontPage web to a folder outside of a Web server.

If FrontPage detects that you are publishing to a Web server that does not have the FrontPage Server 
Extensions installed, it will launch the FrontPage Web Publishing Wizard to publish your FrontPage web.
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Form Properties Dialog Box
Use the Form Properties dialog box to specify what to do with the results of the selected form on the active page 
in the FrontPage Editor. You can send the results to a file in the current FrontPage web, the root web, or your file 
system. You can also send the results to an e-mail address, a FrontPage form handler, or a custom form handler 
that you create.

Note      All of the forms results options except Custom ISAPI, NSAPI, CGI or ASP Script require a server running 
the FrontPage Server Extensions.

Dialog Box Options

What to do with form results?
Use the options in this section to specify the action that FrontPage should take on the results of the form.

Send To

Select this option to send the form results using the default form handler to a file in the current FrontPage web, 
the root web, or your file system, or to an e-mail address.

File Name

Initially, this field displays the file that will contain the saved form information using the default form handler. This 
file is located in the _private folder of the current FrontPage web.

Note      Depending on your server, files in the _private folder may or may not be viewable by users browsing your
Web site. For server-specific information on how to create hidden folders that cannot be viewed by users, in 
FrontPage online Help, search for the keywords "hidden folders," and then choose the appropriate topic.

· To send the form results to a different file in the current web, type the relative URL of that file, or click Browse 
to locate the file.

· To send the form results to a file in the root web, you must use the special folder _vti_log in the root web. Type
a server-relative URL to a file in this folder, as in /_vti_log/myresults.txt.

· To send the form results to a file in your file system, type the complete path of the file, as in c:\my_results\
results.txt.

Browse

Click Browse to display the Current Web dialog box, where you can browse the folders in the current FrontPage 
web to select a file to which to send the form results.

E-mail Address

If you want to send the form results to an e-mail address, type that address here.

Send To Other

If you want to send the form results to a FrontPage or custom form handler, select this option, then select the 
form handler you want to use:

· Use the Custom ISAPI, NSAPI, CGI or ASP Script option to send the form results to a custom form handler 
that you have created using one of these methods.

· Use the Discussion Form Handler to save the form results from a discussion group.
· Use the Registration Form Handler to save form results that register users so that they can access a service 

on your Web site.

Options
Click the Options button to open a dialog box to configure the selected form handler.

Form Name
If you want to use a form name to refer to the form from a custom form handler, type that form name here.

Target Frame



The Target Frame field lists the frame in which to display the form results, such as a confirmation page. Note that
if a frame is supplied and no frames page is loaded, the Web browser may create a new window in which to 
display the form results.

Type the name of the frame or click the Target Frame button:

Advanced
Click the Advanced button to display the Advanced Form Properties dialog box, where you can create and modify
optional hidden fields.

For example, if you have multiple forms that use the same custom form handler, you might add a hidden field to 
each form identifying the form by a unique number or name. The hidden fields in the form results would then 
indicate from which form the results came.
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Advanced Form Properties Dialog Box
Use the Advanced Form Properties dialog box to create or modify optional hidden fields for the selected form 
handler.

For example, if you have multiple forms that use the same custom form handler, you might add a hidden field to 
each form identifying the form by a unique number or name. The hidden fields in the form results would then 
indicate from which form the results came.

Hidden Fields
Use this section to create and modify optional hidden fields. These fields are sent to the selected form handler as
name-value pairs when the form is submitted.

Name

Lists the name of each hidden field.

Value

Lists the value of the hidden field.

Add
Click Add to add a new hidden field. You add a field using the Name/Value Pair dialog box.

Modify
Click Modify to modify the selected hidden field. You modify a field using the Name/Value Pair dialog box.

Remove
Click Remove to remove the selected hidden field.
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File Results Tab
Options for Registration Form Handler Dialog Box
Options for Savings Results of Form Dialog Box
Use the File Results tab to configure how the default form handler or Registration Form Handler save form 
results to files.

Dialog Box Options

File Name
Supply the name of the file to contain the results and its location on the Web server. If the file does not exist, the 
default form handler or the Registration Form Handler will create the file the first time the form is submitted.

If you are configuring the default form handler, this field initially displays the file listed in the File Name field of the
Form Properties dialog box. This file is located in the _private folder of the current FrontPage web.

Note      Depending on your server, files in the _private folder may or may not be viewable by users browsing your
Web site. For server-specific information on how to create hidden folders that cannot be viewed by users, in 
FrontPage online Help, search for the keywords "hidden folders," and then choose the appropriate topic.

· To send the form results to a different file in the current web, type the relative URL of that file, or click Browse 
to locate the file.

· To send the form results to a file in the root web, you must use the special folder _vti_log in the root web. Type
a server-relative URL to a file in this folder, as in /_vti_log/myresults.txt.

· To send the form results to a file in your file system, type the complete path of the file, as in c:\my_results\
results.txt.

File Format
Select the format of the results file. You should note that text file formats always save faster than HTML file 
formats. The following formats are available:

HTML

HTML using normal text with line endings. This is the default format for the Registration Form Handler.

HTML definition list

HTML using a definition list to format name-value pairs.

HTML bulleted list

HTML using a bulleted list to format name-value pairs.

Formatted text within HTML

HTML using formatted text with line endings.

Formatted text

Text formatted for easy reading.

Text database using comma as a separator

Text with commas separating values. This format is recommended for use with a database, spreadsheet, or other
application. This is the default format for the default form handler.

Text database using tab as a separator

Text with tabs separating values. This format is recommended for use with a database, spreadsheet, or other 
application.

Text database using space as a separator

Text with space characters separating values. This format is recommended for use with a database, 



spreadsheet, or other application.

Include Field Names in Output
Select this check box to save both the name and the value of each form field. If you selected one of the file 
format options of text database using a separator character, the name of each field is saved only in the first line 
of the file so that it will appear as a column header if you import the data into a spreadsheet.

If this check box is not selected, only values are written to the file.

Latest Results At End
If you selected a File Format of HTML, select this check box to append form results to the bottom of the HTML 
file. The most recent form results will always be found at the bottom of the file. You cannot disable this option for 
text file formats.

Optional Second File
You can specify a second file to contain form results. This is useful if you want to format one results file for use as
input to a database or spreadsheet program and another results file for readability. If the specified results file 
does not exist, the default form handler or Registration Form Handler will create it the first time the form is 
submitted.

Refer to the preceding section for descriptions of the options in this section.
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Confirmation Page Tab
Options for Discussion Form Handler Dialog Box
Options for Registration Form Handler Dialog Box
Options for Savings Results of Form Dialog Box
Use the Confirmation Page tab to configure a confirmation page for the default form handler, Discussion Form 
Handler, or Registration Form Handler.

URL of Confirmation Page (Optional)
You can specify the relative URL or absolute URL of a confirmation page. If you do not specify a confirmation 
page, the selected form handler will create and maintain one automatically. If a confirmation page already exists 
in the current FrontPage web, you can click Browse to locate the page instead of typing a relative URL.

If you are supplying a confirmation page for a Registration Form Handler, you can use a Confirmation Field to 
insert one of three special attributes defined for Registration Form Handler confirmation pages:

· Registration-Username
The name of the user who is registering.

· Registration-Password
The password of the user who is registering.

· Registration-Error
A sentence or two describing an error condition at runtime.

Browse
Click Browse to select a confirmation page from the current FrontPage web.

URL of Validation Failure Page (Optional)
You can optionally specify the relative or absolute URL of a validation failure page. This is a page that displays if 
there is a field validation failure on any field in your form. If you do not specify a validation failure page, the 
selected form handler will create and maintain one automatically. If a validation failure page already exists in the 
current FrontPage web, you can click Browse to locate the page instead of typing a relative URL.

Browse
Click Browse to select a validation failure page from the current FrontPage web.
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Saved Fields Tab
Options for Registration Form Handler Dialog Box
Options for Savings Results of Form Dialog Box
Use the Saved Fields Tab to specify which form fields to save, and the order in which to save them, for the 
default form handler or Registration Form Handler. You can also specify additional information to save from the 
Web server, such as the user name or type of Web browser.

Dialog Box Options

Form Fields to Save
Specify by name which form fields should be written to the results file. Fields will be written in the order you 
specify here. Leave this field blank to write all form fields in the order in which they appear on the form. To select 
a subset of the fields, or to reorder the fields, create a list by typing each field name, one field name per line.

Additional Information to Save
Use the options in this area to select optional Web server data to write to the results file. These additional items 
are appended after the form fields. The following items are available:

Time

The time the form was used.

Date

The date the form was used.

Remote Computer Name

The name of the computer accessing the page.

User Name

The name of the user accessing the page.

Browser Type

The type of Web browser accessing the page.
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Options For Custom Form Handler Dialog Box
Use the Options for Custom Form Handler dialog box to configure a custom form handler.

Dialog Box Options

Action
Type the absolute URL of the form handler.

Method
Type the method of submitting information to the form handler, either Get or Post.

· The Get method encodes the form’s name-value pairs and assigns the information to a server variable called 
QUERY_STRING.

· The Post method passes the name-value pair directly to the form handler as input.

Encoding Type
The standard used to encode the form data that is passed to the form handler. Leave this field blank to use the 
default encoding method: application/x-www-form-urlencoded.

Style
Click this button to edit the cascading style sheet properties for the custom form handler. Style-sheet formatting 
allows for precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML 
attributes. Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting 
displayed in a Web browser depends on the Web browser used to display the page.
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Discussion Tab
Options for Discussion Form Handler Dialog Box
Use the Discussion tab to specify the general attributes of a discussion group using the Discussion Form 
Handler.

Dialog Box Options

Title
Type the name of the discussion group. This name will appear on pages containing articles.

Directory
Type the name of the directory in your FrontPage web containing the discussion group. Directory names must be
8 or less characters long and must begin with the underscore (_) character. By default, discussion group 
directories are not visible from the FrontPage Explorer. To view discussion group directories in the FrontPage 
Explorer, on the Tools menu, choose Web Settings, and then select the Show Documents in Hidden Directories 
check box on the Advanced tab.

Table of Contents Layout
Use this section to specify the fields to be added to the table of contents and viewed at runtime by participants in 
the discussion group.

Form Fields

Type the names of the form fields that will comprise the subject description in the table of contents. If you type 
more than one form field name, separate each using a space.

Time

Select this check box to insert the time the article was submitted.

Date

Select this check box to insert the date the article was submitted.

Remote Computer Name

Select this check box to insert the name of the computer from which the article was submitted.

User Name

Select this check box to insert the name of the author of the article.

Order Newest to Oldest

Select this check box to sort items in the order in which they were created.

Get Background and Colors from Page (Optional)
To display the pages containing discussion topics using the background style and colors of another page in your 
FrontPage web, type the URL of the other page, or click Browse to locate the page in the current FrontPage web.
The discussion topics will use the background image, background color, and all hyperlink and text colors from the
style page that you specify. If a theme has been applied to the Discussion Web, setting this option will have no 
effect, and the Web will continue to use the default background and colors of the applied theme.

Changing the value of this field will affect only the appearance of new articles posted to the discussion group.

Browse

Click Browse to select the style page from the current FrontPage web.
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Article Tab
Options for Discussion Form Handler Dialog Box
Use the Article Tab to specify the layout of each article in a discussion group using the Discussion Form Handler.

Dialog Box Options

URL of Header to Include
Type the relative URL or absolute URL of a page to include as the header of each article. If the page is located in
the current FrontPage web, you can click Browse to locate the page, instead of typing the relative URL.

Browse
Click Browse to select the header page from the current FrontPage web.

URL of Footer to Include
Use this field to specify the relative URL or absolute URL of a page to include as the footer of each article. If the 
page is located in the current FrontPage web, you can click Browse to locate the page, instead of typing the 
relative URL.

Browse
Click Browse to select the footer page from the current FrontPage web.

Additional Information to Include
Use the options in this section to specify any additional items to include on each article page.

Time

Select this check box to insert the time the article was submitted.

Date

Select this check box to insert the date the article was submitted.

Remote Computer Name

Select this check box to insert the name of the computer from which the article was submitted.

User Name

Select this check box to insert the name of the author of the article.
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Registration Tab
Options for Registration Form Handler Dialog Box
Use the Registration tab to configure the Registration Form Handler.

Dialog Box Options

FrontPage Web Name
Type the name of the FrontPage web the user can register for, starting at the root folder in your Web server.

User Name Fields
Type the names of the form fields that the Registration Form Handler should use to construct the user name. If 
you type more than one field name, separate each using a comma or space.

Password Field
Type the name of the form field in which the user will supply a password.

Password Confirmation Field
Type the name of the form field in which the user will confirm the password by repeating it.

Require Secure Password
Select this check box to require that the user enters a secure password. A secure password has 6 or more 
characters and does not partially match the user name.

URL of Registration Failure Page (Optional)
If you want to display a page containing a failure message when a user cannot be registered for the FrontPage 
web, type the relative or absolute URL of that page. If you do not specify a registration failure page, the 
Registration Form Handler will create and maintain one automatically. If a registration failure page already exists 
in the current FrontPage web, you can click Browse to locate the page instead of typing a relative URL.

Browse
Click Browse to locate a registration failure page in the current FrontPage web.
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Search Results Tab
Search Form Properties Dialog Box
A Search Form lets users search for text in all the pages of your FrontPage web. The Search Form creates a 
form in which users type text to locate, and then displays a list of hyperlinks to pages containing the search text. 
The search string can include the Boolean keywords and, not, or, and parentheses.

Note      To protect pages from being found by users searching your Web site with the Search Form, move the 
pages to a hidden folder. For server-specific information on how to create hidden folders that cannot be viewed 
by users, in FrontPage online Help, search for the keywords "hidden folders," and then choose the appropriate 
topic.

Dialog Box Options

Scope of Search
These fields control the scope of the search.

Entire Website

Choose this option to allow users to search all pages throughout your entire Web site that are not stored in 
hidden folders.

This FrontPage Web

Choose this option to allow users to search all pages in the current FrontPage web that are not stored in hidden 
folders.

Directory

Choose this option to allow users to search all pages in the specified folder. Type the name of the folder in the 
box. If this web has a discussion group, type the name of the discussion group folder to allow users to search 
only entries in the discussion group.

Maximum Records Per Page
Specify the maximum number of records to display per search results page.

Maximum Records Per Query
If you want to limit the number of records returned by a search, specify that number here.

Additional Information to Display in the Search Results List
This box displays a list of fields which can return results in the search results list. For each field that you want to 
return results in the search results list, select the check box to the left of that field.
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E-mail Results Tab
Options for Savings Results of Form Dialog Box
Use the E-mail Results tab to configure how the default form handler sends the results of a form to an e-mail 
address.

Dialog Box Options

E-mail Address to Receive Results
Type the e-mail address to which to send the form results.

E-mail Format
Select the format for the e-mail. The default format is formatted text, which ensures that the form results can be 
correctly interpreted by most e-mail programs, such as Microsoft Exchange.

HTML

HTML using normal text with line endings.

HTML definition list

HTML using a definition list to format name-value pairs.

HTML bulleted list

HTML using a bulleted list to format name-value pairs.

Formatted text within HTML

HTML using formatted text with line endings.

Formatted text

Text formatted for easy reading. This is the default format for e-mail.

Text database using comma as a separator

Text with commas separating values. This format is recommended for use with a database, spreadsheet, or other
application.

Text database using tab as a separator

Text with tabs separating values. This format is recommended for use with a database, spreadsheet, or other 
application.

Text database using space as a separator

Text with space characters separating values. This format is recommended for use with a database, 
spreadsheet, or other application.

Include Field Names
Select this check box to include the field names along with the field data.

E-mail Message Header
Use the options in this section to configure the Subject line and reply-to line of the e-mail.

Subject Line

Type the text that should appear in the Subject line of the e-mail that sends the form results; the default is Form 
Results. For example, if the form collects survey data, you might specify a Subject line of Survey Results.

If you want the Subject line to contain the results of a form field, select the Form Field Name check box, and then
type the name of the form field in the Subject Line box. For example, the form might contain a drop-down list that 
allows the user to select whether the data is a Complaint, Comment, or Inquiry. If you select the Form Field 



Name check box and type the name of the drop-down list form field in the Subject Line box, the Subject line of 
the e-mail will contain the user's selection from the drop-down field — in this example, Complaint, Comment, or 
Inquiry.

Form Field Name

Select this check box place the results of a form field in the Subject line of the e-mail, then type the form field 
name in the Subject Line box.

Reply-to Line

Type the name of the form field whose results you want to appear in the Reply-to line of the e-mail. Typically, this 
would be a form field that contains the user's e-mail address to which replies should be sent.

If you want to the Reply-to line of the e-mail to contain other text, clear the Form Field Name check box, and then
type the text in the Reply-to Line box.

Form Field Name

By default, this check box is selected so that you can type a form field name in the Reply-to Line box.

If you want the Reply-to line of the e-mail to contain text rather than the results of a form field, clear this check 
box, and then type the text in the Reply-to Line box.
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ActiveX Control Command
Use the ActiveX Control command or the Insert ActiveX Control button on the Advanced toolbar to insert an 
ActiveX control on the active page. For more detailed information about ActiveX controls, and to see a gallery of 
free controls that are available on the World Wide Web, visit http://www.microsoft.com/activeplatform/default.asp

Note      Some Web browsers cannot display ActiveX controls.
Insert ActiveX 
Control button

Dialog Box Options

Pick a Control
This field displays a list of the ActiveX controls installed on your computer. To insert a control, select it from this 
list. Some controls displayed in this list may be OCX controls that have not been fully upgraded to ActiveX 
protocols.

To specify an ActiveX control that has not yet been installed on your machine, type its class ID number directly 
into this field.

Properties
Click Properties to specify parameters for the ActiveX control, if necessary. If the ActiveX control is installed on 
your computer and supports local editing of properties, clicking Properties will open a properties editor that you 
use to configure the ActiveX control. The properties editor lists all of the ActiveX control’s properties and the 
current values of each property.

If the ActiveX control is not loaded on your computer, or if the control does not support local editing of properties, 
clicking Properties will open the Object Parameters dialog box. This dialog box is a simpler name/value editor. To
use the Object Parameters dialog box, you must know the names of each of the control’s properties along with 
valid data values for each property.

Name
If you want to use a custom or "friendly" name to refer to the ActiveX control within scripts on the active page, 
type that name here.

Layout
Use the fields in this section to specify the ActiveX control’s appearance and placement on the page.

Alignment

Sets the type of alignment between the ActiveX control and the surrounding text:

· default aligns the ActiveX control using the default settings of the Web browser. This is the same as the 
baseline option.

· left aligns the ActiveX control in the left margin and wraps the text that follows the ActiveX control down the 
control's right side.

· right aligns the ActiveX control in the right margin and wraps the text that precedes the ActiveX control down 
the control's left side.

· top aligns the top of the ActiveX control with the surrounding text.
· texttop aligns the top of the ActiveX control with the top of the tallest text in the line.
· middle aligns the middle of the ActiveX control with the surrounding text.
· absmiddle aligns the ActiveX control with the middle of the current line.
· baseline aligns the ActiveX control with the baseline of the current line.
· bottom aligns the bottom of the ActiveX control with the surrounding text.
· absbottom aligns the ActiveX control with the bottom of the current line.
· center aligns the center of the ActiveX control with the surrounding text. For most browsers, this is the same 

as selecting middle.



Border Thickness

Sets a black border of the specified thickness around the ActiveX control, in pixels.

Horizontal spacing

Sets the horizontal spacing between the ActiveX control and the nearest text or other object on the current line, in
pixels.

Vertical spacing

Sets the vertical spacing between the ActiveX control and the nearest text or other object on the line above or 
below the current line, in pixels.

Width

Type the width of the ActiveX control, in pixels.

Height

Type the height of the ActiveX control, in pixels.

Alternative Representation
Use this section to specify the alternative representations of the ActiveX control when viewed in a Web browser 
that does not support ActiveX.

HTML

Type HTML to display in place of the ActiveX control.

Network Location
Use this section to specify the network location of the ActiveX control and its data. If you specify this information, 
some Web browsers will automatically get the ActiveX control when the page is loaded.

Data Source

Some ActiveX controls take runtime parameters. For these controls, you can use this field to specify the URL or 
network location of the file containing the runtime parameters. Click Browse to browse the current FrontPage 
web, the World Wide Web, or your local network or file system for the file.

Code Source

You can use this field to specify the URL or network location that Web browsers should use to download the 
ActiveX control when the page is loaded, if the control is not on the user's computer. 

Style
Click this button to edit the cascading style sheet properties for the ActiveX control. Style-sheet formatting allows 
for precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Java Applet Command
Use the Java Applet command or the Insert Java Applet button on the Advanced toolbar to insert a Java applet 
on the active page.

Note      Some Web browsers cannot display and run Java applets.
Insert Java Applet 
button

Dialog Box Options

Applet Source
Type the name of the Java applet source file. Java applet source files usually have a CLASS filename extension, 
as in “hello.class”.

Applet Base URL
Type the URL of the folder containing the Java applet source file.

Message For Browsers Without Java Support
Use this field to type HTML to display in place of the Java applet. Web browsers that do not support Java applets
will display this HTML message.

Applet Parameters
Use this section to add parameter names and values for the Java applet. Because Java does not provide a 
mechanism for displaying what the parameters and values are for a given control, consult the documentation that
comes with the Java applet to learn the correct parameter names and the legal values for each parameter.

Name

Lists the names of the parameters you have added.

Value

Lists the value of each parameter.

Add

Click Add to add a parameter name/value pair.

Modify

Click Modify to edit the currently selected parameter name/value pair.

Remove

Click Remove to delete the currently selected parameter name/value pair.

Size
Use the fields in this section to control the size of the Java applet on the page.

Width

Type the width of the Java applet, in pixels.

Height

Type the height of the Java applet, in pixels.

Layout
Use the fields in this section to control the layout of the Java applet on the page.

Horizontal spacing



Sets the horizontal spacing between the Java applet and the nearest text or other object on the current line, in 
pixels.

Vertical spacing

Sets the vertical spacing between the Java applet and the nearest text or other object on the line above or below 
the current line, in pixels.

Alignment

Sets the type of alignment between the Java applet and the text:

· default aligns the Java applet using the default settings of the Web browser. This is the same as the baseline 
option.

· left aligns the Java applet in the left margin and wraps the text that follows the Java applet down the applet's 
right side.

· right aligns the Java applet in the right margin and wraps the text that precedes the Java applet down the 
applet's left side.

· top aligns the top of the Java applet with the surrounding text.
· texttop aligns the top of the Java applet with the top of the tallest text in the line.
· middle aligns the middle of the Java applet with the surrounding text.
· absmiddle aligns the Java applet with the middle of the current line.
· baseline aligns the Java applet with the baseline of the current line.
· bottom aligns the bottom of the Java applet with the surrounding text.
· absbottom aligns the Java applet with the bottom of the current line.
· center aligns the center of the Java applet with the surrounding text. For most browsers, this is the same as 

selecting middle.

Style
Click this button to edit the cascading style sheet properties for the Java applet. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Plug-In Command
Use the Plug-In command or the Insert Plug-In button on the Advanced toolbar to insert a plug-in on the active 
page.

Insert Plug-In 
button

Dialog Box Options

Data Source
Type the URL or file location of the plug-in or click Browse to browse the current FrontPage web, the World Wide 
Web, or your local network or file system.

Message For Browsers Without Plug-In Support
Use this field to type HTML to display in place of the plug-in. Web browsers that do not support plug-ins will 
display this HTML message.

Size
Use the fields in this section to control the size of the plug-in on the page.

Height

Type the height of the plug-in, in pixels.

Width

Type the width of the plug-in, in pixels.

Hide Plug-In
Select the Hide Plug-In check box if you do not want a visual representation of the plug-in to appear on the page.
For example, if the plug-in creates a sound, you may want it to be invisible on the page.

Layout
Use the fields in this section to control the layout of the plug-in on the page.

Alignment

Sets the type of alignment between the plug-in and the text:

· default aligns the plug-in using the default settings of the Web browser. This is the same as the baseline 
option.

· left aligns the plug-in in the left margin and wraps the text that follows the plug-in down the plug-in's right side.
· right aligns the plug-in in the right margin and wraps the text that precedes the plug-in down the plug-in's left 

side.
· top aligns the top of the plug-in with the surrounding text.
· texttop aligns the top of the plug-in with the top of the tallest text in the line.
· middle aligns the middle of the plug-in with the surrounding text.
· absmiddle aligns the plug-in with the middle of the current line.
· baseline aligns the plug-in with the baseline of the current line.
· bottom aligns the bottom of the plug-in with the surrounding text.
· absbottom aligns the plug-in with the bottom of the current line.
· center aligns the center of the plug-in with the surrounding text. For most browsers, this is the same as 

selecting middle.

Border Thickness

Sets a black border of the specified thickness around the plug-in, in pixels.



Horizontal spacing

Sets the horizontal spacing between the plug-in and the nearest text or other object on the current line, in pixels.

Vertical spacing

Sets the vertical spacing between the plug-in and the nearest text or other object on the line above or below the 
current line, in pixels.

Style
Click this button to edit the cascading style sheet properties for the plug-in. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.
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Script Command
Use the Script command or the Script button on the Advanced toolbar to insert a script, such as VBScript or 
JavaScript, into the active page.

Insert Script 
button

Usually scripts are run by a Web browser when a page opens, typically to display information produced by the 
script. You can add VBScript (Microsoft Visual Basic Scripting Edition) or JavaScript to your page using the 
options in the Script dialog box, or using the point-and-click interface of the Script Wizard.

In FrontPage you can write both inline scripts — scripts that are embedded in the page and run when the page is
displayed in a Web browser — and event scripts — scripts that run when trigger events from ActiveX controls 
and form fields occur. Use the Script dialog box or the Script Wizard to create event scripts; use the Script dialog 
box to create inline scripts.

When you use the Script Wizard, you can write only event scripts. The point-and-click interface allows you to 
select objects and associated events, then pick the an action that will be done when the event takes place. After 
you make your selections, the Script Wizard creates the VBScript or JavaScript for you. For more information 
about the Script Wizard, press the Help button in the Script Wizard's dialog boxes.

Dialog Box Options

Language
Use this section to choose the language in which you want to write your script. If you use the Script Wizard, you 
must set the scripting language in this dialog box. For example, if the language option is set to JavaScript and 
you open the Script Wizard to edit VBScript, the changes you make will be written in JavaScript.

VBScript

Select this option if you want to write your script in Microsoft Visual Basic Scripting Edition. When your script is 
completed and you close the dialog box, FrontPage inserts the VBScript icon  to indicate that VBScript has 
been placed in the page.

Run Script on Server

Select this check box if you want the VBScript to execute on an Internet Information Server. The page that 
contains the script may need to be named with an ASP filename extension.

If this check box is cleared, the VBScript will execute on the client computer when a user browses to the page.

JavaScript

Select this option if you want to write your script in JavaScript. When your script is completed and you close the 
dialog box, FrontPage inserts the JavaScript icon  to indicate that JavaScript has been placed in the page.

Other

To write script in a language other than VBScript or JavaScript, select this option and then type the name of that 
scripting language. Most Web browsers do not currently support scripting languages other than VBScript or 
JavaScript.

Script
Type your script in this field. FrontPage does not perform any syntax checking on script you type in this field, so 
you should verify that your script is correct before closing this dialog box.

Style
Click this button to edit the cascading style sheet properties for the script. Style-sheet formatting allows for 
precise control over spacing, alignment, fonts, and colors that is not possible with basic HTML attributes. 
Typically, cascading style-sheet formatting overrides attributes in HTML tags; however, the formatting displayed 
in a Web browser depends on the Web browser used to display the page.



Script Wizard
The Script Wizard is the recommended method for creating VBScript or JavaScript associated with events. Be 
sure to set the language for the script in the Language section of this dialog. For example, if the language option 
is set to JavaScript and you open the Script Wizard to edit a VBScript, the changes you make will be written in 
JavaScript.

Note      When you use the Script Wizard to add script to an existing form field or ActiveX control, the VBScript or 
JavaScript icon may not be added to your page.
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Shared Borders Command
Use the Shared Borders command to display the Shared Border dialog box, where you can enable, disable, or 
modify shared borders for the active page in the FrontPage Editor. The contents of a shared border, such as a 
navigation bar, appear consistently on all of the pages in your Web site that use that shared border.

For example, if you wanted a copyright disclaimer and your company's name and address to appear in the footer
of every page in your Web site, you would enable the bottom shared border for the current web. Once you open 
any page in the web that uses the bottom shared border, type the copyright and address in the bottom shared 
border, and save the page, the copyright and address would appear automatically on all of the pages in your 
Web site that use the bottom shared border.

You can specify that the active page use the default shared borders of the current FrontPage web, or you can 
customize the shared borders for the active page only.

· If shared borders are enabled in the current web, and you use the Shared Borders command to disable any or
all shared borders for the active page, any content in disabled shared borders will not appear when a user 
views the page in a Web browser.
For example, if the current web uses a left shared border that contains a navigation bar, and you disable the 
left shared border on this page only, the navigation bar will not be displayed when a user browses the page.

· If shared borders are disabled in the current web, you can enable them for the active page. However, any 
content you place in the shared borders for the active page won't appear on any other pages in the current 
web unless you enable the same shared borders for those pages, either on a page-by-page basis, or by using
the same command in the FrontPage Explorer to enable shared borders for the entire web.

· If the active page is a frames page, you should not enable shared borders.

Dialog Box Options

Borders to Include
Use the options in this section to enable or disable shared borders on the active page.

Use Web Default

Choose this option if you want the active page to use the default shared borders for the current FrontPage web.

· If shared borders are not enabled for the current Web, choosing this option will not enable them for the active 
page.

· If shared borders are enabled for the current Web, and you have previously enabled shared borders for this 
page only, choosing this option will cause the active page to use the default shared borders for the current 
Web, effectively overriding the previous shared borders for the page.

Set For This Page Only

Choose this option if you want the active page to use only shared borders that you specify using the check boxes
in this dialog box. If shared borders are enabled for the current Web, the active page will use only the shared 
borders that you specify using the check boxes in this dialog box, effectively overriding the default shared 
borders for the current Web.

Choose the shared borders that you want for this page by selecting the check boxes to the right of the preview 
pane. As you select or clear a check box, the preview pane displays a graphical representation of the shared 
borders that are enabled for the page.

Top

Select this check box to enable the top shared border on the active page or clear the check box to disable the top
shared border.

Left

Select this check box to enable the left shared border on the active page or clear the check box to disable the left
shared border.

Right

Select this check box to enable the right shared border on the active page or clear the check box to disable the 



right shared border.

Bottom

Select this check box to enable the bottom shared border on the active page or clear the check box to disable the
bottom shared border.
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Shared Borders Command
Use the Shared Borders command to display the Shared Border dialog box, where you can enable or disable 
shared borders for the current FrontPage web. The contents of a shared border, such as a navigation bar, appear
consistently on all of the pages in your Web site that use that shared border.

For example, if you wanted a copyright disclaimer and your company's name and address to appear in the footer
of every page in your Web site, you would enable the bottom shared border for the current web. Once you open 
any page in the web that uses the bottom shared border, type the copyright and address in the bottom shared 
border, and save the page, the copyright and address would appear automatically on all of the pages in your 
Web site that use the bottom shared border.

· If the current web was created from one of the FrontPage templates or wizards (except for the Discussion 
Web Wizard), shared borders are automatically created and enabled for you. Use the Shared Borders dialog 
box to modify the layout of the shared borders, or to disable shared borders completely.

· If you created the web page-by-page by in the Navigation View, shared borders are enabled automatically for 
you. FrontPage automatically creates navigation bars for each page based on the organizational structure in 
the Navigation View, and then places the appropriate navigation bar in the shared border for each page.

· If you did not create the web using a template or wizard, or by creating a structure in the Navigation View, you 
can enable shared borders using the Shared Borders command on the Tools menu.

The changes you make in the Shared Borders dialog box apply to all of the pages in the current web that use the
web's default shared borders.

· To enable or disable the layout of shared borders for individual pages, open those pages in the FrontPage 
Editor, and then use the Shared Borders command on the Tools menu.

· To modify the contents of a shared border, open any page that uses that shared border in the FrontPage 
Editor and then edit the shared border's contents. When you save the page, any other pages using that 
shared border will be updated automatically with the modified shared border's contents.

Dialog Box Options

Borders to Include
Choose the shared borders that you want for this web by selecting the check boxes to the right of the preview 
pane. As you select or clear a check box, the preview pane displays a graphical representation of the shared 
borders that are enabled.

Top

Select this check box to enable the top shared border, or clear the check box to disable the top shared border.

Left

Select this check box to enable the left shared border, or clear the check box to disable the left shared border.

Right

Select this check box to enable the right shared border, or clear the check box to disable the right shared border.

Bottom

Select this check box to enable the bottom shared border, or clear the check box to disable the bottom shared 
border.
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Font Dialog Box
Use the Font dialog box to specify the font, color, and character formatting for the text on the hover button.

Dialog Box Options

Font
Select the font for the hover button from the drop-down list.

Color
Specify a text color for the font by selecting a color from the drop-down list. To specify a custom color, click 
Custom, then select the custom color in the Color dialog box.

Font Style
Select the character style from the drop-down list.

Size
Enter the font size for text on the button. 
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Custom Dialog Box
Use the Custom dialog box to associate a sound with a hover button and select an image to be used as the 
hover button.

Dialog Box Options

Play Sound
The options in this section are for associating sounds with a hover button. You can associate a sound to play 
when the button is clicked and when a mouse pointer moves over it. 

On Click

Enter the URL of the sound you want associated with the hover button when the button is clicked.

Browse

Click Browse to select the sound to include from the current FrontPage web, your local network, the World Wide 
Web, or from the Microsoft Clip Gallery.

On Hover

Enter the URL of the sound you want associated with the hover button when a mouse pointer moves over the 
button.

Browse

Click Browse to select the sound to include from the current FrontPage web, your local network, the World Wide 
Web, or from the Microsoft Clip Gallery.

Custom Image
The options in this section are for selecting an image for the hover button and an image to display when a mouse
pointer moves over the button.

Button

Enter the URL of the image you want for the hover button.

Browse

Click Browse to select the image to include from the current FrontPage web, your local network, the World Wide 
Web, or from the Microsoft Clip Gallery.

On Hover

Enter the URL of the image you want to display when a mouse pointer moves over the button.

Browse

Click Browse to select the image to include from the current FrontPage web, your local network, the World Wide 
Web, or from the Microsoft Clip Gallery.
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FrontPage Advanced Components
Overview

Inserting Advanced Components
To insert a Java applet

To insert a plug-in

To insert an ActiveX control

To insert an event script

To insert an inline script

Setting the Scripting Language
To set the default script language for the Script Wizard

To set the script language



To create a hover button
1 In the FrontPage Editor, click the page where you want to insert the hover button.
2 On the Insert menu, point to Active Elements and then click Hover Button.
3 If you want the button to display text, enter the text in the Button Text field. Leave this field blank if you want to

insert an image that includes text.
4 To create a hyperlink from the button, type a URL in the Link To field, or click Browse and select a hyperlink 

target in the Select Hover Button Hyperlink dialog box.
5 Select a Button Color, Effect, Background Color, and Effect Color.
6 To play a sound file when a user clicks the hover button, click Custom and in the Play Sound section, enter 

the URL of a sound file in the On Click field. To play a sound file when a user moves the mouse pointer over 
the hover button, enter the URL of a sound file in the On Hover field. Click OK to close the Custom dialog box.

7 To display a custom image, click Custom and, in the Custom Image section, enter the URL of an image in the 
Button field. To display an image when a user moves the mouse pointer over the hover button, enter the URL 
of an image in the On Hover field. Click OK to close the Custom dialog box.

8 Click OK.
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To create a banner ad
1 In the FrontPage Editor, on the Insert menu, point to Active Elements and then click Banner Ad Manager.
2 In the Banner Ad Manager dialog box, for each image in the series, click Add and, in the Add Image for 

Banner Ad dialog box, select the image from the current FrontPage web your file system, or the World Wide 
Web.

3 To change the position of an image in the banner ad, select the image and click Move Up or Move Down.
4 In the Effect field, select the transition effect.

The best way to select the right transition effect for a banner ad is to create one and preview it, trying various 
effects until one matches your needs. To preview a banner ad, use the FrontPage Editor’s Preview tab (if you 
have Microsoft Internet Explorer, version 3.0 or higher, installed) or choose Preview in Browser on the 
FrontPage Editor’s File menu.

5 To create a hyperlink from the Banner Ad, enter a URL in the Link To field, or click Browse and select a 
hyperlink target in the Select Banner Ad Hyperlink dialog box.

6 Adjust the Banner Ad’s width, height, and the amount of time to display each image.
7 Click OK.
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To insert a hit counter
1 In the FrontPage Editor, place the insertion point where you want to create the Hit Counter.
2 On the Insert menu, point to Active Elements and then click Hit Counter.
3 In the Hit Counter Properties dialog box, in the Counter Style field, select a counter style.

This is a GIF image containing the digits zero through nine.
4 To reset the hit counter click Reset Counter To and enter the number to reset the counter to.
5 To supply a GIF image containing a customized set of the digits zero through nine, enter the relative URL of 

the image in the Custom Image field. Be sure to space these digits evenly in the custom image.
6 Click OK.
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To animate one or more page elements
1 In the FrontPage Editor, select the text, graphics, or other page elements to animate.
2 On the Format menu, choose Animation and then click the effect you want, such as Zoom In or Fly From 

Top.
Animation is displayed in Microsoft Internet Explorer 4.0 or other Web browsers that support Dynamic HTML.
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To create a page transition effect
You can apply a page transition effect to the active page.

1 In the FrontPage Editor, on the Format menu, choose Page Transition.
2 In the Event field in the Page Transitions dialog box, select the event, such as entering your Web site, that will

trigger the effect.
3 In the Transition Effect field, select the transition effect you want to apply.
4 in the Duration field, select the amount of time, in seconds, that you want the effect to last.
5 Click OK.
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To create a collapsible outline
1 In the FrontPage Editor, select any item in a list and choose List Properties from the shortcut menu.
2 In any tab of the List Properties dialog box, click Enable Collapsible Outlines.

When collapsible outlining is applied to a list level, it will affect all list items at that level and all sub-levels 
below.
Collapsible outlines are displayed in Microsoft Internet Explorer 4.0 or other Web browsers that support 
Dynamic HTML.
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To create a search form
A Search Form is a one-line text box in which users type words to find in a FrontPage web. When the user 
submits the form, it creates a list of hyperlinks to pages containing one or more of the words.

1 In the FrontPage Editor, click where you want to create the search form.
2 On the Insert Menu, point to Active Elements and then click Search Form.

The Search Form Properties dialog box opens.
3 In the Label for Input field in the Search Form Properties tab, enter the label for the one-line text box field or 

accept the default.
4 In the Width in Characters field, enter the width in characters of the one-line text box field or accept the 

default.
5 In the Label for “Start Search” Button field, enter the label for the push button that starts the search or accept 

the default.
6 In the Label for “Clear” Button field, enter the label for the push button that clears the form or accept the 

default.
7 In the Word List to Search field in the Search Results tab, you can indicate that the entire FrontPage web 

should be searched for the word or that a single discussion group directory should be searched. (Discussion 
group directories are defined in the Directory field of the Discussion tab in the Settings for Discussion Form 
Handler dialog box.)
· Specify All to search all of the FrontPage web except discussion group directories.
· Specify a single discussion group directory, such as _internet to limit the search to that directory.

8 Choose any of the following fields to include additional information in the search results:
· Score indicates the quality of the match.
· File Date indicates the date and time the document containing the match was most recently modified.
· File Size indicates the size of the document containing the match, in kilobytes.

9 Click OK.
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Image Command
Use the Image command to insert an image at the insertion point. You can insert an image from the current 
FrontPage web, your local intranet, the World Wide Web, the Microsoft Clip Gallery, or a TWAIN-compatible 
camera, scanner, or other device installed on your computer.

You can insert images in the following formats: GIF, JPEG, BMP, (Windows and OS/2) TIFF, RAS, EPS, PCX, 
WMF, and TGA.

When you insert an image that is not in the GIF or JPEG format, it is first converted to the GIF format (for images
with 256 or fewer colors) or the JPEG format (for images with more than 256 colors).

{button Dialog Box,AL(`insert images DB tabs',0,`',`main')}
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Stylesheet Command
Use the Stylesheet command to create or edit an embedded style sheet on the active page in the FrontPage 
Editor.

Note      Not all Web browsers support cascading style sheets. If you specify selectors or properties that are not 
supported by a given Web browser, the page may not display as you intended.
The Format Stylesheet dialog box lets you create an embedded style sheet within HTML <STYLE> tags. If you 
are creating a new style sheet, the dialog box contains only the beginning and ending <STYLE> tags. FrontPage
automatically saves these tags within the page's <HEAD> tags, which is according to HTML syntax for cascading
style sheets.

Dialog Box Options

Editor Window
In the Format Stylesheet dialog box, you create an embedded style sheet by typing style information in the editor 
window.

Between the <STYLE> tags, FrontPage also places SGML comment tags (<!-- comment -->). You create 
styles (sometimes called style rules) by defining selectors, and properties for those selectors, within these 
comment tags; otherwise, the style rules would appear as document content in older browsers that do not 
support cascading style sheets. The following is an example of a very simple embedded style sheet:

<style>
<!--
H1 { font-size: x-large; color: green }
H2 { font-size: large; color: blue }
.note { font-size: small }
#footer { font-family: serif }
-->
</style>
In the example, H1 is a selector. The selector's properties and values are contained within the curly braces { }. 
font-size is a property, and x-large is the value of the font-size property. You can specify multiple 
properties for a selector by separating each with a semi-colon ( ; ). .note is a class selector, and #footer is 
an ID selector. For detailed information on the structure and rules for defining a cascading style sheet, and for 
valid properties and values, refer to the World Wide Web Consortium (W3C) specifications on cascading style 
sheets at http://www.htmlhelp.com/reference/css/

Style
You can use the Style button to assist you in defining the properties and values for a selector. First, in the editor 
window, type a name for the selector, followed by a space. Then click the Style button to display the Style dialog 
box. Use the different tabs on the Style dialog box to define the properties and values for the style. When you 
click OK to close the Style dialog box, FrontPage inserts the specified properties and values after the selector. 
Similarly, you can edit properties and values for a given selector by positioning the cursor anywhere within the 
curly braces, and then clicking the Style button.

OK
When you click OK to close the Format Stylesheet dialog box, the embedded style sheet is saved back to the 
page. To edit the style sheet, use the Stylesheet command to open the style sheet in the Format Stylesheet 
dialog box.

If the active page is linked to an external style sheet, any embedded styles that you specify in the Format 
Stylesheet dialog box will either extend or override properties specified in the external style sheet.
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Alignment Tab
Style Dialog Box
Use the Alignment tab of the Style dialog box to specify cascading style sheet margins, padding, and text wrap 
properties. You can apply these properties as inline styles to the selected element — such as a paragraph, 
image, or ActiveX control — on the active page in the FrontPage Editor.

Note      Not all Web browsers support cascading style sheets. If you specify properties that are not supported by 
a given Web browser, the page may not display as you intended.
If the active page is linked to an external style sheet or contains an embedded style sheet, the inline style 
properties that you specify will either extend or override properties specified in the external or embedded style 
sheet.

You can also use this dialog box to specify properties and values if you are using the Format Stylesheet dialog 
box to create an embedded style sheet for the page.

Dialog Box Options

Margins
Use the options in this section to specify the distance between the borders of the containing element (such as the
page body, current frame, or current table) and the edges of the element. If you have nested elements, the 
margins are relative to the containing nested element.

You can specify each margin either by a relative or absolute length, or as a percentage of the parent element's 
width. You can type negative values to create negative margins.

To specify length, type the value immediately followed by the unit of measurement, such as 3em (three ems) or 
4cm (four centimeters). Relative length units specify the length relative to another length property; valid relative 
length units are:

· em specifies the height in ems (that is, the height of the element's font)
· ex specifies the x-height (that is, the height of the letter "x")
· px specifies pixels, relative to the screen resolution

Valid absolute length units are:

· in specifies the height in inches
· cm specifies the height in centimeters
· mm specifies the height in millimeters
· pt specifies the height in points
· pc specifies the height in picas

To specify a percentage, type the value followed by the percent symbol, such as 50%.

Left

Specify the distance between the left border of the containing element and the left edge of the selected element.

Right

Specify the distance between the right border of the containing element and the right edge of the selected 
element.

Top

Specify the distance between the top border of the containing element and the top edge of the selected element.

Bottom

Specify the distance between the bottom border of the containing element and the bottom edge of the selected 
element.

Padding



Use the options in this section to specify the space between the borders of the selected element and the content 
of the element. You can specify padding by a relative or absolute length, or as a percentage of the element's 
width. Refer to the Margins section above for a description of valid units of measurement. You cannot type 
negative values for padding.

Left

Specify the distance between the left border of the element and the content of the element.

Right

Specify the distance between the right border of the element and the content of the element.

Top

Specify the distance between the top border of the element and the content of the element.

Bottom

Specify the distance between the bottom border of the element and the content of the element.

Float
The Float property specifies how surrounding text wraps around the selected element. Valid values are:

· None turns off text wrap. Surrounding text will overlap the selected element.
· Left wraps surrounding text down the left side of the selected element.
· Right wraps surrounding text down the right side of the selected element.
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Borders Tab
Style Dialog Box
Use the Borders tab of the Style dialog box to specify cascading style sheet border properties. You can apply 
these properties as inline styles to the selected element — such as a paragraph, image, or ActiveX control — on 
the active page in the FrontPage Editor.

Note      Not all Web browsers support cascading style sheets. If you specify properties that are not supported by 
a given Web browser, the page may not display as you intended.
If the active page is linked to an external style sheet or contains an embedded style sheet, the inline style 
properties that you specify will either extend or override properties specified in the external or embedded style 
sheet.

You can also use this dialog box to specify properties and values if you are using the Format Stylesheet dialog 
box to create an embedded style sheet for the page.

Dialog Box Options
For each border listed on the tab — left, right, top, and bottom — you can specify the border style, color, and 
width. If you specify None for a given border, that border will not be enabled. To enable a given border, select a 
style for the border, and then specify a width (and optionally, a color).

Style
For each border (left, right, top, and bottom), specify the border style. If your browser supports cascading style 
sheets, you can view a given border style by selecting it, closing the Style dialog box and the element's 
Properties dialog box, saving the page in the FrontPage Editor, and then previewing the page in your browser.

Color
For each border (left, right, top, and bottom), specify the border color by choosing a color from the list. To specify 
a custom color, select Custom at the bottom of the list, and then specify the custom color in the Color dialog box.

Width
For each border (left, right, top, and bottom), specify the width of that border. If you selected a border style of 
None, setting a width will have no effect. You can specify the border width using a keyword, or as a relative width 
value.

Valid keywords are:

· thin
· medium
· thick

To specify a relative width, type the value immediately followed by the unit of measurement, such as 3em (three 
ems) or 4px (four pixels). Relative width units specify the width relative to another length property; valid relative 
width units are:

· em specifies the border width in ems (that is, the height of the element's font)
· ex specifies the border width in x-height (that is, the height of the letter "x")
· px specifies the border width in pixels, relative to the screen resolution

You cannot specify a negative width value.
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Font Tab
Style Dialog Box
Use the Font tab of the Style dialog box to specify cascading style sheet font-family properties. You can apply 
these properties as inline styles to the selected element — such as a paragraph, table, or ActiveX control — on 
the active page in the FrontPage Editor.

Note      Not all Web browsers support cascading style sheets. If you specify properties that are not supported by 
a given Web browser, the page may not display as you intended.
If the active page is linked to an external style sheet or contains an embedded style sheet, the inline style 
properties that you specify will either extend or override properties specified in the external or embedded style 
sheet.

You can also use this dialog box to specify properties and values if you are using the Format Stylesheet dialog 
box to create an embedded style sheet for the page.

Dialog Box Options

Primary Font
Specify the primary font in which to display the selected element when viewed in a Web browser. You can select 
a specific font, such as Arial, or a generic font family, such as sans serif. If a specific primary font is not available 
in the user's browser, the specified secondary font will be used instead.

Tip      If you select a specific font, such as Arial, for the primary font, you should select a generic font family, such
as sans-serif, for the secondary font. It is much more likely that a given browser will support a generic font family 
than a specific font.

Secondary Font
Specify the secondary font in which to display the selected element when viewed in a Web browser. You can 
select a specific font, such as Arial, or a generic font family, such as sans serif. If a specific primary font is not 
available in the user's browser, the specified secondary font will be used instead. In general, you should select a 
generic font family for the secondary font to ensure that the selected element can be correctly displayed in most 
browsers.

Font
This box lists the selections you made in the Primary Font and Secondary Font boxes. You can type or edit font 
assignments directly in this box as an alternative to making selections in the Primary Font and Secondary Font 
boxes; to specify more than two font assignments; or to specify fonts or font families not listed in the Primary 
Font and Secondary Font choices. If you type or edit font assignments in this box, separate each with a comma, 
followed by a space.

For example, you might want to display the selected element in the Verdana font. If you do not have the Verdana 
font installed on your computer, it will not appear in the Primary Font and Secondary Font lists. You could still 
specify Verdana as the primary font, Arial as the secondary font, and the sans-serif font family as the third font 
assignment, by typing the following in this box:

Verdana, Arial, sans-serif

Font Size
Specify the font size in which to display the selected element when viewed in a Web browser. You can choose a 
size from the drop-down list or enter a number for the size.
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Colors Tab
Style Dialog Box
Use the Colors tab of the Style dialog box to specify cascading style sheet background color, foreground color, 
and background image properties. You can apply these properties as inline styles to the selected element — 
such as a paragraph, table, or image — on the active page in the FrontPage Editor.

Note      Not all Web browsers support cascading style sheets. If you specify properties that are not supported by 
a given Web browser, the page may not display as you intended.
If the active page is linked to an external style sheet or contains an embedded style sheet, the inline style 
properties that you specify will either extend or override properties specified in the external or embedded style 
sheet.

You can also use this dialog box to specify properties and values if you are using the Format Stylesheet dialog 
box to create an embedded style sheet for the page.

Dialog Box Options

Background Color
Specify the background color for the selected element. To specify a custom background color, select Custom at 
the bottom of the list, and then specify the custom color in the Color dialog box.

Foreground Color
Specify the foreground color for the selected element (this corresponds to the cascading style sheet {color} 
property). For an element that uses text in the foreground, such as a table, this setting specifies the text color. To 
specify a custom foreground color, select Custom at the bottom of the list, and then specify the custom color in 
the Color dialog box.

Background Image
If you want to use a background image for the selected element, type the URL of the image you want to use, or 
click Browse to choose an image from the current FrontPage web, from your file system, from the World Wide 
Web, or from the Microsoft Clip Gallery.

Tip      If you decide to use a background image, you should specify a similar background color to produce a 
similar appearance for users who have disabled downloading images in their browsers.

Browse
Click Browse to choose a background image for the selected image. You can choose an image from the current 
FrontPage web, from your file system, from the World Wide Web, or from the Microsoft Clip Gallery.

Attachment
Use this box to specify whether to attach the specified background image to the selected element:

· Scroll attaches the background image to the selected element. The image and element will move together 
when the page is scrolled horizontally or vertically in the user's browser.

· Fixed attaches the background image to the page. The image will not move with the element when the page 
is scrolled in the user's browser.

Repeat
Use this box to specify whether to tile the background image horizontally or vertically across the selected 
element, if the image is smaller than the selected element:

· Repeat tiles the background image both horizontally and vertically across the selected element.
· Repeat-X tiles the background image horizontally only.
· Repeat-Y tiles the background image vertically only.
· No Repeat specifies no tiling of the background image.

Vertical Position



Use this box to specify the initial vertical position of the background image in relation to the selected element, if 
the Attachment for the background image is set to Scroll. If the Attachment is set to Fixed, this box specifies the 
vertical position of the background image in relation to the page.

· Top aligns the top of the background image with the top of the selected element or page.
· Center centers the background image vertically in relation to the selected element or page.
· Bottom aligns the bottom of the background image with the bottom of the selected element or page.

Horizontal Position
Use this box to specify the initial horizontal position of the background image in relation to the selected element, 
if the Attachment for the background image is set to Scroll. If the Attachment is set to Fixed, this box specifies the
horizontal position of the background image in relation to the page, rather than the selected image.

· Left aligns the left edge of the background image with the left edge of the selected element or page.
· Center centers the background image horizontally in relation to the selected element or page.
· Right aligns the right edge of the background image with the right edge of the selected element or page.
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Text Tab
Style Dialog Box
Use the Text tab of the Style dialog box to specify cascading style sheet font and text properties. You can apply 
these properties as inline styles to the selected element — such as a paragraph, table, or ActiveX control — on 
the active page in the FrontPage Editor.

Note      Not all Web browsers support cascading style sheets. If you specify properties that are not supported by 
a given Web browser, the page may not display as you intended.
If the active page is linked to an external style sheet or contains an embedded style sheet, the inline style 
properties that you specify will either extend or override properties specified in the external or embedded style 
sheet.

You can also use this dialog box to specify properties and values if you are using the Format Stylesheet dialog 
box to create an embedded style sheet for the page.

Dialog Box Options

Weight
Use this box to specify the weight of the font used in the selected element:

· Normal specifies that the font in the selected element is the same weight as the default inherited font.
· Bold, bolder, and lighter make the font in the selected element bolder or lighter relative to the default 

inherited font weight.
· 100 - 900 specify absolute values; the greater the value, the heavier the weight of the font in the selected 

element, without regard to the inherited font weight.

Style
Use this box to specify whether the font in the selected element is displayed normally, italicized, or oblique 
(slanted).

Variant
Select small-caps to display the text in the selected element in small, uppercase characters.

Transform
Select one of the following options to specify the case of text displayed in the selected element:

· Capitalize displays the initial character of each word in the text using a capital letter.
· Uppercase displays all of the text in capital letters.
· Lowercase displays all of the text in lowercase letters.
· None displays the text in the case in which it was typed.

Decoration
Select an option if you want to apply decoration, such as underlining or blinking, to the text displayed in the 
selected element.

Indent
Use this option to indent the first line of text in the selected element. You can specify the indentation either by a 
relative or absolute length, or as a percentage of the parent element's width. You can type a negative value to 
create a negative indentation.

To specify length, type the value immediately followed by the unit of measurement, such as 3em (three ems) or 
4cm (four centimeters). Relative length units specify the length relative to another length property; valid relative 
length units are:

· em specifies the indent in ems (that is, the height of the element's font)
· ex specifies the indent in x-height (that is, the height of the letter "x")
· px specifies the indent in pixels, relative to the screen resolution



Valid absolute length units are:

· in specifies the indent in inches
· cm specifies the indent in centimeters
· mm specifies the indent in millimeters
· pt specifies the indent in points
· pc specifies the indent in picas

To specify a percentage, type the value followed by the percent symbol, such as 50%.

Line Height
Use this option to specify the spacing between text baselines in the selected element. You can specify the line 
height as a number, a relative or absolute length, or as a percentage of the element's font size. You cannot 
specify a negative line height.

If you specify the line height as a number, the user's browser will multiply that number by the element's font size 
to determine the line height.

To specify the line height as a relative or absolute length, refer to the preceding discussion of the Indent option 
for valid values and length units.

Letter Spacing
Use this option to specify the amount of space between text characters in the selected element. You can specify 
the letter spacing as a relative or absolute length. Refer to the preceding discussion of the Indent option for valid 
values and length units. You cannot specify negative letter spacing. If you want to turn off justification, type 0.

Alignment
Use this option to specify the horizontal alignment of text in the selected element: left-aligned, right-aligned, 
centered, or justified.

Vertical Alignment
Use this option to specify the vertical alignment of text in the selected element, relative to the element or the 
element's line.

To raise or lower the element's baseline relative to the parent element's baseline, specify the vertical alignment 
as a percentage relative to the line height of the element. You can specify a negative value to lower the element's
baseline.

You can also specify vertical alignment using one of the following options:

· Baseline aligns the text baselines of the selected element and the parent element.
· Sub produces text that is subscripted, relative to the parent element's baseline.
· Super produces text that is superscripted, relative to the parent element's baseline.
· Top aligns the top of text with the tallest element on the line.
· Text-top aligns the top of text relative to the top of the parent element's font.
· Middle aligns the middle of text with the selected element's baseline, plus half the x-height of the parent 

element's baseline.
· Bottom aligns the bottom of text with the lowest element on the line.
· Text-bottom aligns the bottom of text relative to the bottom of the parent element's font.
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Class Tab
Style Dialog Box
Use the Class tab of the Style dialog box to specify cascading style sheet class selectors and ID selectors. These
selectors are applied as inline styles to the selected element — such as a paragraph, table, or image — on the 
active page in the FrontPage Editor.

If the active page is linked to an external style sheet or contains an embedded style sheet, you can use this 
dialog box to select a class or ID selector defined in the style sheet. Class selectors defined in the external or 
embedded style sheet appear as choices in the Class list.

You can edit the properties of the selector using the other tabs in this dialog box; however, the changed 
properties will not be saved to the external or embedded style sheet. You can also use this dialog box to define 
new class and ID selectors. However, new class or ID selectors that you create here will not be saved to the 
external or embedded style sheet. The properties of the class or ID selector that you specify and apply as inline 
styles will either extend or override properties specified in any external or embedded style sheet.

Note      Not all Web browsers support cascading style sheets. If the class or ID selector use properties that are 
not supported by a given Web browser, the page may not display as you intended.

Dialog Box Options

Class
Click Class to apply a class selector defined in an external or embedded style sheet. Type its name in this box or 
select one from the list. The class selector will be applied as an inline style to the selected element on the active 
page. If you want to edit the properties of the class selector for this occurrence only, use the other tabs on the 
Style dialog box to specify the properties you want.

Tip      The name of a class selector should reflect its function on the page, not its appearance. For example, if 
you define a class selector that uses a small font indented from the left border, you might name it "Tip" instead of 
"Small indent."

ID
Click ID to apply an ID selector defined in an external or embedded style sheet, and then type its name in this 
box. The ID selector will be applied as an inline style to the selected element on the active page. If you want to 
edit the properties of the ID selector for this occurrence only, use the other tabs on the Style dialog box to specify
the properties you want.

To define a new ID selector, type a name for it in this box, and then use the other tabs on the Style dialog box to 
specify the properties of the new selector.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Style_Sheets')}



About Style Sheets

Cascading style sheets allow Web site authors more control over the appearance and presentation of their pages
and extend the ability to precisely specify the location and appearance of elements on a page and create special 
effects. By defining style information in one location — the style sheet — an author can then link the style sheet 
to all of the pages in a Web site to create a consistent, uniform appearance across the entire site. Cascading 
style sheets are an evolving standard being developed by the World Wide Web Consortium (commonly called the
"W3C") for the next generation of Web browsers.

The Contents of a Style Sheet

A cascading style sheet defines the styles that can be applied to pages or page elements. Each style definition, 
or style rule, consists of a selector followed by the properties and values for that selector. The following are 
simple examples of style rules defined in a style sheet:

H1 { font-size: x-large; color: green }
H2 { font-size: large; color: blue }
.note { font-size: small }
#footer { font-family: serif }
In the example, H1 and H2 are selectors, which correspond to style names. The selector's properties and values 
are contained within the curly braces { }. font-size is a property, and x-large is the value of the font-
size property. You can specify multiple properties for a selector by separating each with a semi-colon ( ; ).
.note is a class selector, and #footer is an ID selector. For detailed information on the structure and rules 
for defining a cascading style sheet, and for valid properties and values, refer to the World Wide Web Consortium
(W3C) specifications on cascading style sheets at http://www.htmlhelp.com/reference/css/

Linking a Style Sheet to a Page

There are three primary methods of implementing style sheets on pages in your FrontPage web:

· By linking a page to an external style sheet.
· By creating an embedded style sheet on a page.
· By applying inline styles to individual elements on a page.

Each method has advantages and disadvantages:

· Use an external style sheet when you want to apply the same styles consistently across some or all pages in 
your Web site. By defining styles in one or more external style sheets and linking them to pages in your web, 
you ensure consistency of appearance throughout those pages. If you decide to change a style, you need 
only make one change — in the external style sheet — and the change will be reflected in all of the pages 
linked to that style sheet. Typically, an external style sheet uses the .css file extension, such as mystyles.css.

· Use an embedded style sheet when you want to define styles only for the active page in the FrontPage Editor.
· Use inline styles to apply cascading style sheet properties to individual elements on a page.
If a page is linked to an external style sheet, the embedded or inline styles that you create for that page will either
extend or override properties specified in the external style sheet.

Note      If a theme has been applied to a page, you should avoid or minimize the use of embedded style sheets 
or inline styles, or that page may not display properly. You should never edit a theme's .css files, or you may 
render the theme unusable.
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Creating and Using Style Sheets
Overview

Creating Style Sheets
To create an external style sheet

To edit an external style sheet

To link a page to an external style sheet

To create or edit an embedded style sheet

Using Style Sheets
To apply a style from an external or embedded style sheet

To apply an inline style to a page element

To create or apply a class or ID selector to a page element



To create an external style sheet
Use this procedure to create an external style sheet that you can link to all of the pages in the current FrontPage 
web to provide a consistent, uniform appearance.

1 Open Windows Notepad, the default text editor for .CSS files.
2 Type the style rules you want to define.

· For an overview of how to create style rules, see the topic, About Style Sheets.
· For detailed information on the structure and rules for defining a cascading style sheet, and for valid 

properties and values, refer to the World Wide Web Consortium (W3C) specifications on cascading style 
sheets at http://www.htmlhelp.com/reference/css/

3 When you are finished, save the file with a .CSS file extension, such as    "mystyles.css", and exit Notepad.
4 Import the file into the FrontPage web.
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To edit an external style sheet
Use this procedure to edit an external style sheet that you can link to all of the pages in the current FrontPage 
web to provide a consistent, uniform appearance.

1 In the FrontPage Explorer's Folders View, navigate to the folder containing the .css file you want to edit. 
Usually .css files are located in the top-level folder in your web.

2 Double-click the .css file to open it in Windows Notepad, the default text editor for .css files.
3 Edit the style rules you want to redefine.

· For an overview of the proper syntax for style rules, see the topic, About Style Sheets.
· For detailed information on the structure and rules for defining a cascading style sheet, and for valid 

properties and values, refer to the World Wide Web Consortium (W3C) specifications on cascading style 
sheets at http://www.htmlhelp.com/reference/css/

4 When you are finished, save the file and exit Notepad.
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To link a page to an external style sheet
Use this procedure to link the active page in the FrontPage Editor to an external style sheet. By linking pages in 
the current FrontPage web to an external style sheet, you can apply a uniform, consistent appearance to those 
pages.

Note      If the active page is linked to an external style sheet, any embedded style sheet or inline styles that you 
create for the page will either extend or override properties specified in the external style sheet.
· If the page does not contain an embedded style sheet, switch to the HTML View, and then type an HTML 
<LINK> tag between the beginning and ending <HEAD> tags, similar to the following example:

<HEAD>
<LINK REL=stylesheet HREF="mystyles.css" TYPE="text/css">
</HEAD>
Substitute the name or URL of your external style sheet for "mystyles.css".

· If the page contains an embedded style sheet, on the Format menu, choose Stylesheet. In the Format 
Stylesheet dialog box, type an @IMPORT tag at the beginning of the SGML comment tag (<!-- comment 
-->) that contains the style rules, similar to the following example:

<style>
<!--
  @import URL(/mystyles.css) ;
  H1 { font-size: x-large; color: green }
  H2 { font-size: large; color: blue }
  .note { font-size: small }
  #footer { font-family: serif }
-->
</style>
Substitute the absolute URL or relative URL of the external style sheet for "/mystyles.css".

Notes
· For an overview of the proper syntax for style rules, see the topic, About Style Sheets.
· For detailed information on the structure and rules for defining a cascading style sheet, and for valid 

properties and values, refer to the World Wide Web Consortium (W3C) specifications on cascading style 
sheets at http://www.htmlhelp.com/reference/css/
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To create or edit an embedded style sheet
Use this procedure to create an embedded style sheet on the active page in the FrontPage Editor.

Note      If the active page is linked to an external style sheet, any embedded style sheet or inline styles that you 
create for the page will either extend or override properties specified in the external style sheet.
1 On the Format menu, choose Stylesheet to display the Format Stylesheet dialog box.
2 Type the style rules you want to define or edit within the SGML comment tag (<!-- comment -->). For 

general information on creating style rules, click the Help button on the Format Stylesheet dialog box.
· For detailed information on the structure and rules for defining a style sheet, and for valid properties and 

values, refer to the World Wide Web Consortium (W3C) specifications on cascading style sheets at 
http://www.htmlhelp.com/reference/css/

3 Click OK.
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To apply a style from an external or embedded style sheet
Use this procedure to apply a style from an external style sheet or an embedded style sheet to the selected 
element on the active page in the FrontPage Editor.

Note      If a theme has been applied to the active page, you should avoid or minimize the use of embedded style 
sheets or inline styles, or the page may not display properly.
1 Select the element — such as a paragraph, table, or image — to which you want to apply the style.
2 In the Change Style box on the format toolbar, select the style that you want to apply from the external or 

embedded style sheet. Any custom styles are displayed in the drop-down list along with the standard HTML 
styles, such as Defined Term.
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To apply an inline style to a page element
Use this procedure to apply an inline style to the selected element on the active page in the FrontPage Editor.

Note      If the active page is linked to an external style sheet, any embedded style sheet or inline styles that you 
apply will either extend or override properties specified in the external style sheet.
1 Select the element — such as a paragraph, table, or image — to which you want to apply the style.
2 Right-click to display the shortcut menu for the selected element, and then open that element's properties 

dialog box.
3 In the properties dialog box, click the Style button to display the Style dialog box. If the dialog box does not 

contain a Style button, then you cannot apply inline styles to the selected element.
4 In the Style dialog box, use the different tabs to specify the properties and values you want to apply to the 

selected element, and then click OK.
Note      Not all Web browsers support cascading style sheets. If you specify selectors or properties that are not 
supported by a given Web browser, the page may not display as you intended.
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To create or apply a class or ID selector to a page element
Use this procedure to create or apply a cascading style sheet class selector or ID selector to the selected 
element on the active page in the FrontPage Editor.

Note      If the active page is linked to an external style sheet, or contains an embedded style sheet, any inline 
styles that you apply will either extend or override properties specified in the external or embedded style sheet.
1 Select the element — such as a paragraph, table, or image — for which you want to create or apply a class or

ID selector.
2 Right-click to display the shortcut menu for the selected element, and then open that element's properties 

dialog box.
3 In the properties dialog box, click the Style button to display the Style dialog box. If the dialog box does not 

contain a Style button, then you cannot apply inline styles to the selected element.
4 In the Style dialog box, click the Class tab, and then create or apply a class or ID selector:

· To apply an existing class or ID selector, type the name of that selector in the Class box or the ID box, or, 
for class selectors, choose an existing class selector from the list.
If you want to edit the properties of the class selector for this occurrence only, use the other tabs on the 
Style dialog box to specify the properties you want.

· To create a new class or ID selector, type its name in the Class box or the ID box, and then use the other 
tabs on the Style dialog box to define the properties and values for that selector. However, new class or ID 
selectors that you create here will not be written back to the external or embedded style sheet.

5 Click OK to close the Style dialog box and apply the inline style to the selected element.
Note      Not all Web browsers support cascading style sheets. If you specify selectors or properties that are not 
supported by a given Web browser, the page may not display as you intended.
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Add Task Command
Use the Add Task command to add a new task linked to the active page in the FrontPage Editor. The FrontPage 
Explorer becomes the active window and displays the New Task dialog box, where you can name the task, 
assign it to an author, and indicate the task's priority. When you click OK to close the dialog box, the new task is 
added to the Tasks View of the FrontPage Explorer.
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Add/Edit Browser Dialog Box
Use the Add/Edit Browser dialog box to add a Web browser to the list of Web browsers available for previewing 
FrontPage pages, or to edit a currently listed Web browser.

Dialog Box Options 

Name
Type the name of the Web browser.

Command
Type the full path to the Web browser’s executable file, or click Browse to browse your file system for the file.
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Page Banner Properties Dialog Box
Use the Page Banner Properties dialog box to insert or edit a page banner on the active page in the FrontPage 
Editor.

· If the page does not use a theme or shared borders, use this dialog box to insert a page banner at the 
insertion point. The page banner inserts only the page title as large, bolded text. Choosing Image has no 
effect.

· If the page uses a theme but does not use shared borders, use this dialog box to insert a page banner at the 
insertion point. Choose Image to insert the page banner using the font and banner image from that theme; 
choose Text to insert only the page title as large, bolded text using the theme font, but without a banner 
image.

· If the page uses a top shared border, a page banner is automatically created in the top shared border; you do 
not need to insert it. If the page does not use a theme, the page banner displays the page title in the top 
shared border as large, bolded text without a banner image. If the page uses a theme, the page banner 
displays in the top shared border using the font and banner image from that theme.

Dialog Box Options

Image
Select this option to display the page banner using the font and banner image from the applied theme. If the 
page does not use a theme, this option is the same as selecting Text; the page banner displays only the page 
title as large, bolded text without a banner image.

Text
Select this option to insert a page banner that displays the page title in a large, bolded font with no banner image.
If the page uses a theme, the page title displays in the theme's font, but without a banner image.
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Set Attribute Value Dialog Box
Use the Set Attribute Value dialog box to set and modify an extended attribute value. Typically, you use this 
dialog box to specify name-value pairs for advanced page elements that utilize extended attributes, such as Java
applets.

Dialog Box Options

Name
Type the name of the extended attribute for which you want to specify a value. For example, for a Java applet, 
type the name of a legal parameter for the specified applet.

Specify Value (Specifying a value is not always an available option.)
Select this check box to associate a value with the specified attribute name. If you do not select this check box, 
only the name will be generated.

Value
Type the attribute's value. For example, for a Java applet, type a legal value for the parameter specified in the 
Name box.

If you leave the Value box empty, FrontPage associates the name with an empty string, such as SAMPLE = " ".
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Name/Value Pair Dialog Box
Use this dialog box to add or edit a name-value pair. For example, you might use this dialog box to add 
name/value pairs for hidden fields to a form's properties, or to specify additional parameters and values for 
advanced page elements such as Java applets.

Dialog Box Options

Name
Type the name of the extended attribute or parameter for which you want to specify a value. Typically, this would 
be the name of a legal property for an advanced page element, or the name of a hidden field to be used by a 
custom form handler.

For example, if you have multiple forms that use the same custom form handler, you might use this dialog box to 
add a hidden field to each form identifying the form by a unique number or name. The hidden fields in the form 
results would then indicate from which form the results came. In this example, you would type the name of the 
hidden field in the Name box, such as "formname."

Value
Type the value to associate with the specified name. Typically, this would be a legal value for the property 
specified in the Name box, or the value for a hidden field. Continuing the example of hidden fields cited above, 
you would type the name of the form, such as "userinfo." When the custom form handler receives the results of 
the form, the hidden field would identify the results from "formname=userinfo."
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Background Command
Use the Background command to view and set the properties of the active page. You can specify properties such
as a background image or color, text colors, and hyperlink colors.
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Properties Command
Use the Properties command to open the appropriate properties dialog box for the selected object on the active 
page in the FrontPage Editor.
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Bulleted List Command
Use the Bulleted List command to format the paragraph containing the insertion point as a bulleted list 
paragraph. If a theme has been applied to the active page, this command formats the paragraph using the image
bullet from that theme.

You can also format a bulleted list by clicking the Bulleted List button on the format toolbar:

Bulleted List 
button
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Insert HTML Command
Use the Insert HTML command in the FrontPage Editor's Normal view to insert text at the insertion point that will 
be saved directly as HTML. FrontPage does not verify that the text you are inserting is valid HTML. Use this 
command to supplement the HTML that FrontPage generates.

Alternatively, you can click the HTML tab to switch to    HTML View. In HTML View, you can edit HTML directly 
using the color-coded HTML editor, which checks HTML syntax automatically as you type.

You can also insert HTML in normal view using the Insert HTML button on the advanced toolbar:

Insert HTML button

Dialog Box Options

HTML Markup to Insert
Type the text that that you want inserted on the page when the page is saved to the server as HTML.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Pages')}



New Normal Page Command
Use the New Normal Page command to create a new blank page based on the default Normal Page template. 
The New Normal Page command creates the new page in a new FrontPage Editor window. This command is the
same as choosing the New command on the File menu, and then selecting the Normal Page template on the 
Page tab of the New dialog box.

Once you have created a new page, you can add it to the current FrontPage web by choosing the Save 
command on the File menu.

You can also create a new page based on the Normal Page template by clicking the New Normal Page button on
the standard toolbar.

New Normal
Page button
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Clipart Command
Use the Clipart command to insert an image, sound, or video clip from the Microsoft Clip Gallery on the active 
page in the FrontPage Editor.
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Hit Counter Command
Use the Hit Counter command to insert a hit counter on the active page in the FrontPage Editor. A hit counter is a
numeric counter which displays the number of users who have visited your Web site.
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To insert an ActiveX control
Use this procedure to insert an ActiveX control on the active page in the FrontPage Editor.

1 On the Insert menu, point to Advanced, then choose ActiveX Control, or on the Advanced toolbar, click the 
Insert ActiveX Control button:

2 In the ActiveX Control Properties dialog box, select an ActiveX control from the Pick a Control field, which lists 
the ActiveX controls installed on your computer. To specify an ActiveX control that has not yet been installed 
on your computer, type the control’s class ID number.

3 If you want to specify parameter values for the ActiveX control, click Properties.
· If the ActiveX control is loaded on your computer and supports local editing of properties, clicking 

Properties opens a table editor that you use to configure the ActiveX control. The table editor lists all of the 
ActiveX control’s properties and the current values of each property.

· If the ActiveX control is not loaded on your computer, or if the control does not support local editing of 
properties, clicking Properties opens the Object Parameters dialog box. To use the Object Parameters 
dialog box, you must know the names of each of the control’s properties along with valid data values for 
each property. To add a parameter, click Add and supply a parameter name, value, and type.

4 If you want to use a name to refer to the ActiveX control within scripts on the current page, in the Name box, 
type the name.

5 Use the Layout section of the ActiveX Control Properties dialog box if you want to specify alignment, border 
thickness, horizontal and vertical spacing, and width and height values for the ActiveX control.

6 In the HTML field under Alternative Representation, you can type HTML to display in place of the ActiveX 
control on Web browsers that do not support ActiveX.

7 In the Data Source field under Network Location, you can specify the URL of a file containing runtime 
parameters. Click Browse to browse for this file in the current FrontPage web, the World Wide Web, or your 
file system.

8 In the Code Source field under Network Location, you can specify the URL that Web browsers should use to 
download the ActiveX control when the page is loaded, if the control is not on the Web browser computer.

9 If you want to specify cascading style sheet properties as an inline style for the ActiveX control, click the Style 
button.

10 Click OK to close the ActiveX Control Properties dialog box and insert the control on your page.
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To insert a Java applet
Use this procedure to insert a Java applet on the active page in the FrontPage Editor.

1 On the Insert menu, point to Advanced, and then choose Java Applet, or on the Advanced toolbar, click the 
Insert Java Applet button:

2 In the Java Applet Properties dialog box, type the name of the Java applet source file in the Applet Source 
box. Java applet source files usually have a CLASS filename extension.

3 In the Applet Base URL box, type the URL of the folder containing the Java applet source file.
4 In the Message For Browsers Without Java Support box, you can type HTML to display in place of the Java 

applet on Web browsers that do not support Java applets.
5 In the Applet Parameters section, for each parameter that you want to pass to the Java applet, click Add and 

type the parameter’s name and, if required, value in the Set Attribute Value dialog box.
Since Java does not provide a mechanism for displaying the valid properties and values for a given applet, 
consult the documentation that comes with the Java applet, and then specify the correct parameter names 
and legal values for each parameter.

6 In the Size and Layout sections of the Java Applet Properties dialog box, you can specify the alignment, 
border thickness, horizontal and vertical spacing, and width and height values for the Java applet.

7 If you want to specify cascading style sheet properties as an inline style for the Java applet, click the Style 
button.

8 Click OK to close the Java Applet Properties dialog box and insert the applet on your page.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Advanced_Components')}



To insert a plug-in
Use this procedure to insert a plug-in on the active page in the FrontPage Editor.

1 On the Insert menu, point to Advanced, and then choose Plug-In, or on the Advanced toolbar, click the Insert
Plug-In button:

2 In the Data Source box, type the URL or file location of the plug-in, or click Browse to locate the plug-in in the 
current FrontPage web, the World Wide Web, or your file system.

3 In the Message For Browsers Without Plug-In Support field, you can type HTML to display in place of the 
plug-in on Web browsers that do not support plug-ins.

4 In the Size section, specify the plug-in’s width and height.
5 If you want the plug-in to be hidden when the page is viewed in a Web browser, select the Hide Plug-In check 

box.
6 In the Layout section, you can specify the alignment, border thickness, horizontal and vertical spacing values 

for the plug-in.
7 If you want to specify cascading style sheet properties as an inline style for the plug-in, click the Style button.
8 Click OK to close the Plug-In Properties dialog box and insert the plug-in on your page.
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To insert an inline script
Use this procedure to insert an inline script on the active page in the FrontPage Editor. An inline script is 
embedded in the page and run when the page is displayed in a Web browser.

1 On the Insert menu, point to Advanced, and then choose Script, or on the Advanced toolbar, click the Insert 
Script button:

2 In the Language section, select the language for the script, either VBScript (Microsoft® Visual Basic® Scripting
Edition) or JavaScript.

3 For VBScript, select the Run Script on Server check box if you want the VBScript to execute on an Internet 
Information Server. The page that contains the script may need to be named with an ASP filename extension.
If this check box is cleared, the VBScript will execute on the client computer when a user browses to the page.

4 In the Script field, type the script. FrontPage does not perform any syntax checking on script you type in this 
field, so you should verify that your script is correct before closing this dialog box.

5 If you want to specify cascading style sheet properties as an inline style for the script, click the Style button.
6 Click OK.
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To insert an event script
Use this procedure to insert an event script on the active page in the FrontPage Editor. An event script runs when
trigger events from ActiveX controls and form fields occur. You can use either the Script dialog box or the Script 
Wizard to create event scripts.

To insert an event script using the Script Wizard

1 On the Insert menu, point to Advanced, and then choose Script, or on the Advanced toolbar, click the Insert 
Script button:

2 In the Language section, select the language for the event script, either VBScript (Microsoft® Visual Basic® 
Scripting Edition) or JavaScript.

3 For VBScript, select the Run Script on Server check box if you want the VBScript to execute on an Internet 
Information Server. The page that contains the script may need to be named with an ASP filename extension.
If this check box is cleared, the VBScript will execute on the client computer when a user browses to the page.

4 Click the Script Wizard button.
When you use the Script Wizard, the point-and-click interface allows you to select objects and associated 
events, and then pick an action that will be done when the event takes place. After you make your selections, 
the Script Wizard creates the VBScript or JavaScript for you. For more information about the Script Wizard, 
press the Help button in the Script Wizard's dialog boxes.

To insert an event script using the Script dialog box

1 On the Insert menu, point to Advanced, and then choose Script, or on the Advanced toolbar, click the Insert 
Script button:

2 In the Language section, select the language for the event script, either VBScript or JavaScript.
3 For VBScript, select the Run Script on Server check box if you want the VBScript to execute on an Internet 

Information Server. The page that contains the script may need to be named with an ASP filename extension.
If this check box is cleared, the VBScript will execute on the client computer when a user browses to the page.

4 In the Script field, type the event script. FrontPage does not perform any syntax checking on script you type in
this field, so you should verify that your script is correct before closing this dialog box.

5 If you want to specify cascading style sheet properties as an inline style for the event script, click the Style 
button.

6 Click OK in the Script dialog box.
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To assign a form's handler
Use this procedure to assign a form handler to the selected form on the active page in the FrontPage Editor. You 
can send the form results to a file in the current FrontPage web, the root web, or your file system. You can also 
send the results to an e-mail address, a FrontPage form handler, or a custom form handler that you create.

Note      All of the forms results options except Custom ISAPI, NSAPI, CGI or ASP Script require a server running 
the FrontPage Server Extensions.
1 Right-click on the form to display the shortcut menu, then select Form Properties.

This displays the Form Properties dialog box.
2 If you want to use the default FrontPage form handler for the form, select the Send To option, then specify the 

file or e-mail address to which to send the form results.
If you want to use the Discussion Form Handler, Registration Form Handler, or a custom form handler that you
have created, select the Send To Other option, then select the form handler you want to use.

3 To configure the form handler, click Options, edit the tabs on the appropriate settings dialog box, then click 
OK.

4 If you want to use a form name to refer to the form from a custom form handler, type that form name in the 
Form Name box.

5 The Target Frame field lists the frame in which to display the form results, such as a confirmation page. If a 
frame is supplied and no frames page is loaded, a Web browser may create a new window in which to display
the form results.
Type the name of the frame or click the Target Frame button:

6 Click the Advanced button to display the Advanced Form Properties dialog box, where you can create and 
modify optional hidden fields.
For example, if you have multiple forms that use the same custom form handler, you might add a hidden field 
to each form identifying the form by a unique number or name. The hidden fields in the form results would 
then indicate from which form the results came.

7 Click OK to close the Form Properties dialog box.
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To collect data from a form
In the FrontPage Editor, you collect data from a form by creating a Save Results Form Handler.

To quickly create a form that collects data, on the File menu, choose New, and in the Page tab of the New dialog
box, select the Feedback Form template. This template creates a generic feedback form that you can modify to 
fit your needs.

To create a general data-collecting form:

1 Right-click on the form to display the shortcut menu, and then select Form Properties.
This displays the Form Properties dialog box.

2 Select the Send To option, then specify the file or e-mail address to which to send the form results.
3 To configure the form handler, click Options.

This displays the Options for Saving Results of Form dialog box.
4 Use the tabs on the dialog box to configure the form handler. Click the Help button on each tab for guidelines 

on using the options on that tab.
5 Click OK to close the Options for Saving Results of Form dialog box.
6 If you want to use a form name to refer to the form, type that form name in the Form Name box.
7 The Target Frame field lists the frame in which to display the form results, such as a confirmation page. Note 

that if a frame is supplied and no frames page is loaded, the Web browser may create a new window in which 
to display the form results.
Type the name of the frame or click the Target Frame button:

8 Click the Advanced button to display the Advanced Form Properties dialog box, where you can create and 
modify optional hidden fields.
For example, if you have multiple forms that use the same custom form handler, you might add a hidden field 
to each form identifying the form by a unique number or name. The hidden fields in the form results would 
then indicate from which form the results came.

9 Click OK to close the Form Properties dialog box.
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To assign a custom form handler
You can apply an ISAPI, NSAPI, or CGI script to the selected form in the FrontPage Editor.

1 Right-click on the form to display the shortcut menu, and then select Form Properties.
This displays the Form Properties dialog box.

2 Select the Send To Other option, then select the Custom ISAPI, NSAPI, CGI or ASP Script option.
3 To configure the custom form handler, click Options.

This displays the Options for Custom Form Handler dialog box.
5 In the Action box, type the absolute URL of the form handler.
5 In the Method box, select the method of submitting information to the form handler:

· The Get method encodes the form's name-value pairs and assigns the information to a server variable 
called QUERY_STRING.

· The Post method passes the name-value pair directly to the form handler as input.
6 Leave the Encoding Type field blank to use the default encoding method: application/x-www-form-urlencoded.
7 Click OK to close the Settings for Custom Form Handler dialog box.
8 If you want to specify cascading style sheet properties as an inline style for the form handler, click the Style 

button.
9 Click OK to close the Settings for Custom Form Handler dialog box.

10 If you want to use a form name to refer to the form, type that form name in the Form Name box.
11 The Target Frame field lists the frame in which to display the form results, such as a confirmation page. Note 

that if a frame is supplied and no frames page is loaded, the Web browser may create a new window in which 
to display the form results.
Type the name of the frame or click the Target Frame button:

10 Click the Advanced button to display the Advanced Form Properties dialog box, where you can create and 
modify optional hidden fields.
For example, if you have multiple forms that use the same custom form handler, you might add a hidden field 
to each form identifying the form by a unique number or name. The hidden fields in the form results would 
then indicate from which form the results came.

10 Click OK to close the Form Properties dialog box.
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To e-mail form results
Use this procedure to send the results of the selected form on the active page in the FrontPage Editor to an e-
mail address.

Note      Sending form results to an e-mail address requires a server running the FrontPage Server Extensions.
1 Right-click on the form to display the shortcut menu, and then select Form Properties.

This displays the Form Properties dialog box.
2 Select the Send To option, then specify the e-mail address to which to send the form results.
3 If you want to specify advanced options for the e-mail results, click Options.

This displays the Options for Saving Results of Form dialog box.
4 Select the E-mail Results tab, then specify the custom e-mail options you want to use. Click the Help button 

on this tab for information on each field.
5 Click OK to close the Options for Saving Results of Form dialog box.
6 Click OK to close the Form Properties dialog box.
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To display a confirmation field
You display a confirmation field by inserting it on the confirmation page of a form that is handled by a Save 
Results Form Handler, Discussion Form Handler, or Registration Form Handler.

1 In the FrontPage Editor, open the confirmation page.
2 On the Insert menu, choose FrontPage Component.
3 In the Insert FrontPage Component dialog box, choose Confirmation Field and click OK.

This displays the Confirmation Field Properties dialog box.
4 In the Name of Form Field To Confirm box, type the name of the form field.

For all form fields except radio buttons, use the name in the Name field of the Form Field Properties dialog 
box. For radio button fields, use the name in the Group Name field.

5 Click OK.
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Page Transition Command
Use the Page Transition command to specify a transition effect for the active page in the FrontPage Editor. A 
page transition is a movie-like effect that occurs when a user surfs to the page or away from it. You can limit a 
transition effect to happen only when the user enters or leaves your Web site.

Dialog Box Options

Event
Select the event that causes the page transition:

· Page Enter displays the selected transition effect when a user visits or follows a hyperlink to the active page.
· Page Exit displays the selected transition effect when a user exits the active page or follows a hyperlink to 

another page.
· Site Enter displays the selected transition effect when a user initially enters your Web site by visiting the 

active page.
· Site Exit displays the selected transition effect when a user exits your Web site from the active page.

Duration (Seconds)
Type the length, in seconds, that you want the selected transition effect to display.

Transition Effect
Select the type of transition effect that you want to occur between pages.

To help you decide which type of transition effect to use, create one and preview it. You can preview a transition 
effect in the FrontPage Editor’s Preview tab (if you have Microsoft Internet Explorer, version 4.0 installed) or by 
choosing Preview in Browser on the FrontPage Editor’s File menu (if you have Microsoft Internet Explorer, 
version 4.0 or another Web browser that supports Dynamic HTML installed).
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Getting Started Dialog Box
Use the Getting Started dialog box to create a new FrontPage web or to open an existing FrontPage web.

You must be authorized as an administrator or author to open a FrontPage web. If you have not yet entered your 
name and password, the Name and Password Required Dialog Box opens.

Note      If end-user access has been restricted in the root web, a name and password are required to list and 
open FrontPage webs.
You can also open a FrontPage web by clicking the Open FrontPage Web button on the toolbar.

Open 
FrontPage 
Web button

Dialog Box Options

Open an Existing FrontPage Web
Select this option to open an existing FrontPage Web. The list below shows the FrontPage webs that are stored 
on your Web server; the URL of that server is displayed beneath the list.

To delete the name of a FrontPage web from this list, select the web's name, click the right mouse button and 
choose Remove From List.

More Webs
Click the More Webs button to display the Open FrontPage Web dialog box, where you can list FrontPage webs 
on other servers to which you have access.

Create a New FrontPage Web
Select this option to create a new FrontPage web. You can create a new one page web, a new web from a 
template or Web Wizard, or you can import the contents of an existing web.

Always Open Last Web
Select this check box if you want to open the last web you worked on whenever you start the FrontPage Explorer.
When you select this option, the Getting Started dialog box no longer appears. If you select this option and later 
want the Getting Started dialog box to appear, on the Tools menu in the FrontPage Explorer, choose Options. In
the General tab, select the Show Getting Started dialog option.
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Stop Command
Use the Stop command to cancel a request that has been sent to a Web server. Typically, you would use the 
Stop command in the FrontPage Explorer to interrupt the Verify Hyperlinks command, if verifying an external 
hyperlink was taking too much time (for example, if the server for that site was not responding).

To cancel a request quickly, click the Stop button on the toolbar.

Stop 
button
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Recalculate Hyperlinks Command
Use the Recalculate Hyperlinks command to recalculate internal hyperlinks in the current FrontPage web, if you 
suspect that they are broken. Usually you would not need to use this command, because FrontPage 
automatically recalculates and repairs internal hyperlinks — including pages that use the Include Page 
component or text indices created by a Search Form — whenever you move, delete, or rename a page or folder 
in the FrontPage Explorer.

This command does not verify the status of external hyperlinks. To verify external hyperlinks, use the Verify 
Hyperlinks command on the Tools menu.

Recalculating hyperlinks for a large FrontPage web might take several minutes.
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Define Channel Command
Use the Define Channel command to start the Channel Definition Wizard, which assists you in creating a 
Channel Definition File (CDF). A Channel Definition File allows users to subscribe to your Web site as a channel 
or a desktop component. When a user subscribes to your FrontPage web as a channel, they can browse your 
web offline, automatically display updates to your web on their screen saver, and download or receive 
notifications when pages in your FrontPage web are modified. This feature is available only in browsers that 
support channel definitions, such as Microsoft Internet Explorer version 4.0.
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Design-time Control Command
Use the Design-time Control command to insert a Design-time control on the active page in the FrontPage Editor.
This displays the Insert Design-time Control dialog box, where you can choose from the Design-time controls 
installed on your computer. After you select a control and click OK, FrontPage opens a properties editor that you 
use to configure the Design-time control. The properties editor lists all of the Design-time control’s properties and
the current values of each property.

After you close the properties editor, the FrontPage Editor inserts a placeholder icon for the Design-time control 
at the insertion point on the active page. To edit the properties of the control, double-click the placeholder icon.

Note      Depending on the type of Design-time control you are inserting, and on where you are inserting it — for 
example, in a table or an HTML list — the control may not appear correctly positioned when the page is viewed 
in a Web browser. For example, if you insert a control that uses a table into a table on your page, the tables may 
not nest properly. Consult the documentation for the Design-time control.
If you click the HTML tab to switch to the FrontPage Editor's HTML View, you will see that the Design-time control
inserts <!--METADATA> comment tags identifying the control. Within the comment tags are an <OBJECT> 
tag representing the control, followed by the parameters and values for the control and any script that the control 
might generate. 

Note      Design-time controls that rely on data bindings may not function properly, or may have limited 
functionality, in FrontPage 98. Consult the documentation for the Design-time control to determine if you can use 
it properly in FrontPage.

Dialog Box Options

Choose Control
The list displays all of the Design-time controls installed on your computer. Select the control you want to insert, 
then click OK.
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Getting Started with Frames
Frames and frames pages are methods that World Wide Web authors use to organize their Web sites. Frames 
pages divide a Web browser's window into separate regions called frames. Each frame displays a page.

Note      When you use frames pages and frames to organize your Web site, you should not use shared borders 
and navigation bars. These are alternate ways to organize the navigation structure of your FrontPage web. Using
shared borders and navigation bars along with frames will make your Web site confusing to navigate.
In the simplest frames page there are two frames: one frame displays a page listing a set of hyperlinks, and the 
other frame displays the pages to which the hyperlinks point. Each time a user clicks a hyperlink in the first 
frame, the page pointed to by that hyperlink is displayed in the second frame. The frames page itself does not 
actually contain any content or pages; it contains only hyperlinks to existing pages that are displayed in the 
frames.

You create a new frames page by selecting a frames page template from the Frames tab of the New dialog box. 
FrontPage creates the frames page in a new window in the FrontPage Editor. All you need to do is set the initial 
page you want displayed in each frame on the frames page. You can select and edit existing pages, or you can 
create and edit new pages directly in each frame.

Tip      You can resize frames by dragging the frame borders or split a frame by clicking CTRL while dragging a 
border.
To customize how the frames and the frames page will display in a user's Web browser, use the Frame and 
Frames Page Properties dialog boxes to specify such options as scrollbars, borders, and margins. Once you 
have created the new frames page, you can save it to the current FrontPage web, using the Save command on 
the File menu.

Tip      In a frames page, a highlighted border indicates the active page, which is either the page displayed in the 
active frame, or the frames page itself. To select the frames page, click any frame border. If the frames page is 
selected, you can undo or redo actions such as splitting a frame, resizing a frame, setting an initial page, or 
creating a new page.

Set Initial Page
Click Set Initial Page to select the first page that will be displayed in the frame when the frames page is viewed in
a user's browser. You can choose a page from the current FrontPage web, your file system, or the World Wide 
Web.

When a user clicks a hyperlink on the initial page, the page to which the hyperlink points will be displayed in the 
designated target frame based on the frames page template you selected.

If you decide later to display a different initial page in the active frame, specify that page in the Initial Page field of
the Frame Properties dialog box.

New Page
Click New Page to create a new page in the active frame. The new page will be the initial page displayed in the 
active frame when the frames page is viewed in a user's browser.
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Off Command
Use the Off command to turn off animation that has been applied to selected text on a page. When the Off 
command has a check mark next to it, any animation that has been applied to the selection is turned off.
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Fly From Bottom Command
Use the Fly From Bottom command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to "fly" from the bottom of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Left Command
Use the Fly From Left command to animate selected text when a user initially views the page in a Web browser. 
The selection will appear to "fly" from the left of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Right Command
Use the Fly From Right command to animate selected text when a user initially views the page in a Web browser.
The selection will appear to "fly" from the right of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Top Command
Use the Fly From Top command to animate selected text when a user initially views the page in a Web browser. 
The selection will appear to "fly" from the top of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Bottom-Left Command
Use the Fly From Bottom-Left command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to "fly" from the bottom-left of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Bottom-Right Command
Use the Fly From Bottom-Right command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to "fly" from the bottom-right of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Top-Left Command
Use the Fly From Top-Left command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to "fly" from the top-left of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Top-Right Command
Use the Fly From Top-Right command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to "fly" from the top-right of the web browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Pages')}



Fly From Top-Right By Word Command
Use the Fly From Top-Right By Word command to animate selected words when a user initially views the page in
a Web browser. The selection will appear to "fly" one word at a time from the top-right of the web browser window
to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Fly From Bottom-Right By Word Command
Use the Fly From Bottom-Right By Word command to animate selected words when a user initially views the 
page in a Web browser. The selection will appear to "fly" one word at a time from the bottom-right of the web 
browser window to its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Drop In By Word Command
Use the Drop In By Word command to animate selected text when a user initially views the page in a Web 
browser. The selection will appear to drop, one word at a time, from the top of the web browser window to its final
location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Spiral Command
Use the Spiral command to animate selected text when a user initially views the page in a Web browser. The 
selection will appear to spiral into its final location.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Zoom In Command
Use the Zoom In command to animate selected text when a user initially views the page in a Web browser. The 
selection will appear in a reduced size and then grow to its final size.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Zoom Out Command
Use the Zoom Out command to animate selected text when a user initially views the page in a Web browser. The
selection will appear in an enlarged size and then shrink to its final size.

Note      Only Microsoft Internet Explorer 4.0 or later supports this feature. Any animation will be ignored by earlier
versions of Internet Explorer and other Web browsers.
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Settings Tab
Permissions Dialog Box
Use the Settings tab to set up permissions for the current FrontPage web.

Dialog Box Options

Use same permissions as root web
Select this option to use the permissions that were established with the root web.

Use unique permissions for this web
Select this option to set up new permissions that will be unique to the current FrontPage web.

Apply
Click Apply to activate the changes you have made.
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Users Tab
Permissions Dialog Box
Use the Users tab of the Permissions dialog box to add or remove authorized users from the current FrontPage 
web. Only authorized administrators can restrict end users from a FrontPage web.

Dialog Box Options

Name
This field lists the names of all authorized users.

Access Rights
This field lists the access rights associated with each user name.

Add
Click Add to open the Add Users dialog box, where you can add new users and specify their access rights.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Edit
Click Edit to open the Edit Users dialog box, where you can change the access rights for the selected user.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Remove
Click Remove to delete the selected user from the permissions list.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Everyone has browse access
Select this option to grant browse access to anyone.

Only registered users have browse access
Select this option to grant browse access to authorized users only.

Apply
Click Apply to activate the changes you have made.
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Groups Tab
Permissions Dialog Box
Use the Groups tab of the Permissions dialog to add or remove authorized groups from the current FrontPage 
web. Only authorized administrators can restrict groups from a FrontPage web.

Dialog Box Options

Name
This field lists the names of all authorized groups.

Access Rights
This field lists the access rights associated with each group name.

Add
Click Add to open the Add Groups dialog box, where you can add new groups and specify their access rights.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Edit
Click Edit to open the Edit Groups dialog box, where you can change the access rights for the selected group.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Remove
Click Remove to delete the selected group from the permissions list.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Apply
Click Apply to activate the changes you have made.
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Add Computer Dialog Box
Use the Add Computer dialog box to add permissions for new computers for the current FrontPage web.

Dialog Box Options

IP Mask
Enter the IP address for the computer you want to add to the permissions list. To add a group of computers, enter
an IP mask with the asterisk (*) character in place of specific address groups.

Computer Can
Choose one of the three options in this field to assign the new computer's appropriate access rights.

Browse This Web

Specify this option to grant the computer browse access to the current FrontPage web.

Author And Browse This Web

Specify this option to grant the computer authoring and browse access to the current FrontPage web.

Administer, Author, and Browse This Web

Specify this option to grant the computer administrative, authoring, and browse access to the current FrontPage 
web.
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Edit Computer Dialog Box
Use the Edit Computer dialog box to change a computer's access rights to a FrontPage web.

Dialog Box Options

IP Mask
Displays the IP address for the computer you want to edit.

Computer Can
Choose one of the three options in this field to assign the computer's new access rights.

Browse This Web

Specify this option to grant the computer browse access to the current FrontPage web.

Author And Browse This Web

Specify this option to grant the computer authoring and browse access to the current FrontPage web.

Administer, Author, and Browse This Web

Specify this option to grant the computer administrative, authoring, and browse access to the current FrontPage 
web.
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Computers Tab
Permissions Dialog Box
Use the Computers tab of the Permissions dialog box to specify which computers have access to the current 
FrontPage web. Only computers with IP addresses listed in the permissions list in the Computers tab can access
the current FrontPage web.

Dialog Box Options

Name
This field lists the IP addresses of all authorized computers.

Access Rights
This field lists the access rights associated with each computer IP address.

Add
Click Add to open the Add Computers dialog box, where you can add new computers by specifying their IP 
addresses.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Edit
Click Edit to open the Edit Computer dialog box, where you can change the access rights for the selected 
computer.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Remove
Click Remove to delete the selected computer from the permissions list.

Note      If this button is dimmed, this web uses the same permissions as the root web. To enable this button, on 
the Settings tab, choose Use Unique Permissions for This Web.

Apply
Click Apply to activate the changes you have made. 
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Add Users Dialog Box
Add Groups Dialog Box
Use this dialog box to add new users or groups to the permissions lists for the current FrontPage web.

Dialog Box Options

Obtain List From
This box lists the domains that are known to the Web server. Select the domains that contain the users or groups
for whom you want to add permissions.

Names
This box lists the users or groups in the selected domain.

Add
Click Add to add one or more users or groups selected in the Names list to the Add Names list.

Add Names
Lists the users or groups that will be added. You can add names by selecting users or groups from the Names list
and then clicking Add, or you can type the names of users or groups directly in this field.

User Can
Choose one of the three options in this field to assign the user's or group's access rights.

Browse This Web

Specify this option to grant the user or group browse access to the current FrontPage web.

Author And Browse This Web

Specify this option to grant the user or group authoring and browse access to the current FrontPage web.

Administer, Author, and Browse This Web

Specify this option to grant the user or group administrative, authoring, and browse access to the current 
FrontPage web.
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Edit Users Dialog Box
Edit Groups Dialog Box
Use the Edit Users dialog box to change a user's or group's access rights to the current FrontPage web.

Dialog Box Options

Name
Displays the name of the user or group whose access rights you want to change.

User Can
Choose one of the three options in this field to assign the user's or group's new access rights.

Browse This Web

Specify this option to grant the user or group browse access to the current FrontPage web.

Author And Browse This Web

Specify this option to grant the user or group authoring and browse access to the current FrontPage web.

Administer, Author, and Browse This Web

Specify this option to grant the user or group administrative, authoring, and browse access to the current 
FrontPage web.
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Add Users Dialog Box
Use this dialog box to add new users or groups to the permissions lists for the current FrontPage web.

Dialog Box Options

Name
Type the name the end user will use to access the FrontPage web. Names can be a maximum of 128 characters.

Password
Type the new user's password. You can use alphanumeric characters and punctuation, but you cannot use 
spaces. FrontPage passwords are case-sensitive.

Confirm Password
Verify the new password by typing it again. If the confirmation field matches the entry in the Password field, the 
new user's password will be successfully registered.

User Can
Choose one of the three options in this field to assign the new user's appropriate access rights.

Browse This Web

Specify this option to grant the user browse access to the current FrontPage web.

Author And Browse This Web

Specify this option to grant the user authoring and browse access to the current FrontPage web.

Administer, Author, and Browse This Web

Specify this option to grant the user administrative, authoring, and browse access to the current FrontPage web.
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Object Parameters Dialog Box
The Object Parameters dialog box is a name/value editor for OCX controls and ActiveX controls that are not 
loaded on your computer at authoring time. To use the Object Parameters dialog box, you must know the names 
of each of the control's properties along with valid data values for each property.

Dialog Box Options

Attribute Name
A list of the parameters currently assigned values. For ActiveX controls, the attribute name corresponds to a valid
control property.

Value
A list showing the value of each parameter.

Type
A list showing the type of each parameter's value: Data, Page, or Object.

Add
Click Add to add a new parameter to the parameter list using the Edit Object Parameter dialog box.

Modify
Click Modify to change the selected parameter using the Edit Object Parameter dialog box.

Remove
Click Remove to delete the selected parameter from the parameter list.
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Edit Object Parameter Dialog Box
The Edit Object Parameter dialog box let you add or edit a parameter for an OCX control or ActiveX control.

Dialog Box Options

Name
Type the name of the parameter. For an ActiveX control, type a valid property for the control.

Value
This section contains fields that define the parameter's type and value.

Data

Select Data to specify that the value should be interpreted as data, then type the data in the Data field.

Page

Select Page to specify that the value should be interpreted as the URL of a file. Type the relative or absolute URL
of the file in the Page field, or click Browse to locate the file in the current FrontPage web, the World Wide Web, 
or your file system.

Object

Select Object to specify that the value should be interpreted as the name of another ActiveX control on the active
page, and then type the name of that control in the Object field.

Media Type

In some cases, you may need to specify the MIME type of the parameter. You can specify a media type only if 
the parameter type is Page.
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To authorize a FrontPage web administrator
Root web administrators can create and delete FrontPage webs and pages, designate administrators and 
authors, and restrict end users from accessing a FrontPage web. Use this procedure to authorize an 
administrator for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Users tab, click Add.
4 In the Add Users dialog box, type the new administrator's name in the Name field.
5 Have the new administrator type his or her password in the Password and Confirm Password fields.
6 In the User Can area, choose the Administer, Author, And Browse This Web option.
7 Click OK.
8 To add the new administrator and continue working in the Permissions dialog box, click Apply. To add the new 

administrator and close the dialog box, click OK.
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To authorize a FrontPage web author
Authors can create, modify, and delete pages in a FrontPage web, and they can make other changes to the 
web’s content. Use this procedure to authorize an author for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Users tab, click Add.
4 In the Add Users dialog box, type the new author's name in the Name field.
5 Enter the new author's password in the Password and Confirm Password fields.
6 In the User Can area, choose the Author And Browse This Web option.
7 Click OK.
8 To add the new author and continue working in the Permissions dialog box, click Apply. To add the new author

and close the dialog box, click OK.
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To remove a FrontPage web administrator
Use this procedure to remove an administrator from the permissions for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Users tab, select the administrator to be removed.
3 Click Remove.
4 To remove the administrator and continue working in the Permissions dialog box, click Apply. To remove the 

administrator and close the dialog box, click OK.
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To remove a FrontPage web author
Use this procedure to remove an author from the permissions for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Users tab, select the author to be removed.
3 Click Remove.
4 To remove the author and continue working in the Permissions dialog box, click Apply. To remove the author 

and close the dialog box, click OK.
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To restrict a FrontPage web administrator's IP addresses
You can restrict the range of IP addresses from which administrators can open the current FrontPage web by 
adding one or more IP address masks. Some Web servers do not support restricting access by IP address. If the 
Computers tab is not present in the Permissions dialog box, IP address restriction is not supported by the Web 
server.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Computers tab, click Add.
This displays the Add Computer dialog box.

4 In each of the four IP Mask field sections, enter an integer in the range 1 - 255 or the wild card character (*).
The wild card character means that any integer will be accepted at that position in the IP address.

5 In the Computer Can area, choose the Administer, Author, And Browse This Web option.
6 Click OK.
7 To add the IP address mask and continue working in the Permissions dialog box, click Apply. To add the IP 

address mask and close the dialog box, click OK.
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To restrict a FrontPage web user's IP addresses
You can restrict the range of IP addresses from which users can open the current FrontPage web by adding one 
or more IP address masks. Some Web servers do not support restricting access by IP address. If the Computers 
tab is not present in the Permissions dialog box, IP address restriction is not supported by the Web server.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Computers tab, click Add.
This displays the Add Computer dialog box.

4 In each of the four IP Mask field sections, enter an integer in the range 1 - 255 or the wild card character (*).
The wild card character means that any integer will be accepted at that position in the IP address.

5 In the Computer Can area, choose the Browse This Web option.
6 Click OK.
7 To add the IP address mask and continue working in the Permissions dialog box, click Apply. To add the IP 

address mask and close the dialog box, click OK.
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To remove a FrontPage web administrator's IP address mask
Use this procedure to remove an IP address mask from an administrator's permissions for the current FrontPage 
web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Computers tab, select the IP address mask to be removed, then click Remove.
3 To remove the IP address mask and continue working in the Permissions dialog box, click Apply. To remove 

the IP address mask and close the dialog box, click OK.
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To remove a FrontPage web author's IP address mask
Use this procedure to remove an IP address mask from an author's permissions for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Computers tab, select the IP address mask to be removed, then click Remove.
3 To remove the IP address mask and continue working in the Permissions dialog box, click Apply. To remove 

the IP address mask and close the dialog box, click OK.
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To remove a FrontPage web user's IP address mask
Use this procedure to remove an IP address mask from a user's permissions for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Computers tab, select the IP address mask to be removed, then click Remove.
3 To remove the IP address mask and continue working in the Permissions dialog box, click Apply. To remove 

the IP address mask and close the dialog box, click OK.
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Search Form Command
Use the Search Form command to insert a Search Form on the active page in the FrontPage Editor. A search 
form lets users search for text in all or specified pages in the current FrontPage web.
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Target Frame Dialog Box
Use the Target Frame dialog box to select a unique target frame on a frames page in which to display the page 
pointed to by a hyperlink.

Note      If you create frames pages using FrontPage frames page templates, the default target frames are 
already set in each template. You do not need to use this dialog box unless you want to specify different target 
frames.

Dialog Box Options

Current Frames Page
If the active page in the FrontPage Editor is a frames page, this area displays a "map" of the frames page. To 
assign a target frame for the hyperlink, click a frame in this map. The name of that frame is then displayed in the 
Target Setting field.

Common Targets
Common targets are predefined frame settings that are understood by all Web browsers. You can choose from 
the following common target frames:

· Page Default specifies that the page pointed to by the hyperlink should be displayed in the default target 
frame for the active page. This is the recommended method of specifying target frames for hyperlinks.

· Same Frame sets the target frame of the hyperlink to the same frame that contains the hyperlink. Use this 
setting to override the page's default target frame.

· Whole Page sets the target frame of the hyperlink to the entire Web browser window.
· New Window specifies that a new instance of the Web browser should be launched on the user's desktop, 

and the page that is the target of the hyperlink should be displayed in the new instance of the Web browser.
· Parent Frame specifies to display the page that is the target of the hyperlink in the frame that contains the 

current frameset tag. This is an advanced feature.

Target Setting
If you select a target frame in the Current Frames Page or Common Targets areas, this field displays the name of
the selected target frame or common target. Alternatively, you can type the name of the target frame or common 
target directly in this field.

Make Default for Hyperlinks on the Page
Select this check box if you want to make the selected target frame the default for all hyperlinks on the active 
page. This is the same as specifying a default target frame for the page in the Page Properties dialog box.
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To display a page in a frame
You can display a page in a frame on a frames page in a user's Web browser. If a frames page is not loaded, the 
browser may open a new window to display the page.

· If you are editing a frames page in the FrontPage Editor, click the Set Initial Page button in the frame, then 
select the page you want to display in that frame.

· If you are editing a standard HTML (non-frames) page in the FrontPage Editor, click the Create or Edit 

Hyperlink button  to create a hyperlink to the page you want to display in a frame. The Target Frame field 
lists the default target frame in which to display pages pointed to by hyperlinks on the active page.

To specify a different target frame, click the Target Frame button , then choose a frame in the Target 
Frame dialog box.
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To display form results in a frame
You can configure forms to direct their output to a frame on a frames page in a user's Web browser. If a frames 
page is not loaded, the browser may open a new window to display the page.

1 On the active page in the FrontPage Editor, select the form, right-click to display the shortcut menu, and then 
choose Form Properties.

2 In the Target Frame field of the Form Properties dialog box, type the name of the target frame in which to 

display the form results, or click the Target Frame button  to select one in the Target Frame dialog box.
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To use a frames page as your home page
Use this procedure to use an existing frames page as the home page for the current FrontPage web.

Note      If your web uses shared borders or navigation bars, or if you have already designed a navigation 
structure in the FrontPage Explorer's Navigation View, you should not use a frames page as your home page. 
Otherwise your Web site may be difficult to navigate, and pages may not display properly.
1 In the FrontPage Explorer's All Files View or Folders View, right-click on your current home page — usually, 

index.htm or default.htm — and on the shortcut menu, choose Rename and type a different name.
2 Right-click on the frames page that you want to use as your home page, and on the shortcut menu, choose 

Rename and type a different name — usually index.htm or default.htm.
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To open a frames page
Use this procedure to open an existing frames page in the current FrontPage web in the FrontPage Editor.

· In the FrontPage Editor, click the Open button , then browse to the frames page that you want to open.
· In any FrontPage Explorer view except Themes View or Tasks View, double-click the frames page to open it 
in the FrontPage Editor.
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Navigation Bar Command
Use the Navigation Bar command to insert a page element that contains hyperlinks to other pages in the 
FrontPage web’s structure. To navigate the structure of a FrontPage web, users follow hyperlinks from one page 
to another. FrontPage manages these hyperlinks with navigation bars.

To change the hyperlinks or button labels on a navigation bar, use the Navigation View in the FrontPage Explorer
and rename the page title you want to change.

Dialog Box Options
The graphical "tree" diagram in the Navigation Bar Properties dialog box is updated to show where in the 
FrontPage web’s structure the hyperlinks point to.

Hyperlinks to include

Parent Level

Choose this option to include hyperlinks to the other page(s) on the same level as the parent page.

Same Level

Choose this option to include hyperlinks to the other page(s) on the same level as the active page.

Back and Next

Choose this option to include hyperlinks to the adjacent page(s) on the same level as the active page.

Child Level

Choose this option to include hyperlinks to the page(s) below the level of the active page.

Top Level

Choose this option to include hyperlinks to the page(s) on the same level as the home page.

Additional Pages

Home Page

Select this option to include a hyperlink to the home page.

Parent Page

Select this option to include a hyperlink to the parent page

Orientation and Appearance

Horizontal

Choose this option to align the navigation bar horizontally on the active page.

Vertical

Choose this option to align the navigation bar vertically on the active page.

Buttons

Choose this option to display the navigation bar as graphical buttons.

Text

Choose this option to display the navigation bar as text.

Note      When a page is deleted from a FrontPage web’s structure, hyperlinks to the page from all navigation 
bars are also deleted. When all the hyperlinks on a navigation bar have been removed, the navigation bar 
remains on your page, but it is not visible in Web browsers.
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Theme Command
Use the Theme command to display the Choose Theme dialog box, where you can apply, remove, or override a 
FrontPage web’s theme association for the active page.

Dialog Box Options

This Page Does Not Use Themes
Choose this option to remove the current web theme from the active page.

Use Themes From Current Web
Choose this option to apply the current web theme to the active page.

Use Selected Theme
Choose this option to override the current web theme and apply a new theme to the active page.

Vivid Colors
Select this option to apply bright colors to theme elements on the active page.

Active Graphics
Select this option to animate theme elements on the active page.

Background Image
Select this option to apply the theme’s background image to the active page.

Note      To apply a theme to the entire FrontPage web, use the FrontPage Explorer’s Themes View.
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Open File As Dialog Box
The Open File As dialog box lets you indicate the type of file you are opening or inserting. It is displayed by the 
FrontPage Editor’s Open and File commands when:

· You are opening or inserting a file with a file name extension that FrontPage does not recognize.
· You are opening or inserting a file and the contents of the file do not appear to match the type indicated by 

the file name extension.

Dialog Box Options

HTML
Indicates that the file is an HTML file.

RTF
Indicates that the file is a Rich Text Format (RTF) file.

TXT
Indicates that the file is a text file.

If the dialog box indicates that binary data is detected in the file, you may be trying to open an image file. This is 
not supported using the Open command. Use the Image command on the FrontPage Editor’s Insert menu to 
open image files.
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Apply Changes Command
Use the Apply Changes command on the Navigation view’s shortcut menu to manually apply any changes you 
made to the FrontPage web structure. 

When you make changes to the FrontPage web structure in the FrontPage Explorer’s Navigation View, the 
changes are not actually applied until you take one of several actions, including:

· Switching views in the FrontPage Explorer
· Switching to another Windows application
· Opening a page in the FrontPage Editor
· Exiting Microsoft FrontPage
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Database Region Wizard Command
Use the Database Region Wizard command to insert or edit a database query on a page.

With this command, you can submit SQL queries to any ODBC-compliant database accessible from the Web 
server computer. When a user submits search criteria in a Web browser, the query runs based on the values of 
SQL parameter fields. The results are then combined with an Active Server Page (ASP), which acts as a custom 
form handler, and returned to the Web browser for display.

Within the database region, the results of a database query will be displayed as a table, with one query result per
table row.

Note      You must configure your Web server and workstation properly before you can use database features in 
FrontPage. For more information, see “FrontPage Database Integration” in the Getting Started with Microsoft 
FrontPage 98 book.
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Database Column Value Command
Use the Database Column Value command to insert a placeholder that displays the value of a column from a 
database region. This command is available only after you have placed the cursor into an existing database 
region on the active page.

You can choose a field name from the list, or type an arbitrary value if the column you want to use was not 
previously    added with the Database Region Wizard.
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Database Region Wizard
Using the FrontPage Database Region Wizard, you can submit SQL queries to an ODBC-compliant database 
accessible from the Web server computer. When a user visits your Web site and submits search criteria, the 
query runs based on the values of SQL parameter fields. The results are then combined with an Active Server 
Page, which acts as a custom form handler, and returned to the Web browser for display.

An Active Server Page is an HTML document that contains embedded server-side scripting. Web servers 
compatible with ASP can execute these server-side scripts. On the client side, an ASP is a standard HTML 
document, viewable on any platform using any Web browser.

Before you can integrate a database into a FrontPage web, you must follow a series of steps that take place 
outside of FrontPage. These include configuring your Web server and workstation, and building (and modifying) 
Structured Query Language (SQL) queries in a database management tool such as Microsoft Access. You can 
use any database with an available Open Data Base Connectivity (ODBC) compliant driver to publish data on a 
Web site.

Please see the Getting Started with Microsoft FrontPage 98 book for more information on FrontPage 98 
Database Integration.
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To edit an IDC file
1 In the FrontPage Explorer, double-click the .idc file in your current FrontPage web.

The Internet Database Connector Wizard is displayed.
2 In the Internet Database Connectivity Wizard, edit the appropriate fields to change the contents of your IDC 

file.
3 Click Finish to save your changes.

Note      FrontPage 98 database integration is based on Active Server Pages (ASP). An Active Server Page is an 
HTML document that contains embedded server-side scripting. Web servers compatible with ASP can execute 
these server-side scripts. To integrate a database with FrontPage 98, use the Database Region Wizard which 
you can choose with the Database Region Wizard command in the FrontPage Editor.
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To create a database region
1 On the FrontPage Editor’s Insert menu, point to Database, then choose Database Region Wizard.

The Database Region Wizard is displayed. Use this tool to configure SQL queries to an ODBC-compliant 
database accessible from the Web server computer.

2 In the Database Region Wizard, edit the settings you want to configure or change.
3 Click Finish to save your changes.

Note      Before you can integrate a database into a FrontPage 98 web, you must follow a series of steps that take
place outside of FrontPage. These include configuring your Web server and workstation, and building (and 
modifying) Structured Query Language (SQL) queries in a database management tool such as Microsoft Access.
Please see the Getting Started with Microsoft FrontPage 98 book for more information on FrontPage 98 
Database Integration.
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Dialog Box Options for Choosing a Page or File
You use this dialog box to:

· Open a page or file from the current FrontPage web, World Wide Web, or your file system.
· Insert a file such as an image, background sound, or ActiveX control, from the current FrontPage web, 

World Wide Web, or your file system.
· Save a page or file to the current FrontPage web, your file system, or the World Wide Web if you have 

authoring permissions to the web to which you want to save.
· Create a hyperlink to a page or file in the current FrontPage web or your file system, a page on the World 

Wide Web, or an e-mail address. You can also create a hyperlink to a bookmark, image, video, or scanned 
image.

Dialog Box Options
Some fields or buttons described below may not be displayed, depending on the command you are using.

Look In
This box initially lists the URL of the current FrontPage web. The area below this box lists all of the folders and 
files in that web. If you double-click a folder to explore it, the Look In box lists the name of the current folder. 
When you click a file, the URL of that file is displayed in the URL field.

URL
The URL of a page or file. You select a page or file to open or insert it, save it to a page or file, or identify it as the
target of a hyperlink. When creating a hyperlink, you can enter any protocol in this field, such as mailto or FTP.

World Wide Web Button

Click this button to specify a page or resource on your corporate intranet or the World Wide Web.

FrontPage starts your Web browser. Browse to the URL of the page or other resource, then without closing the 
Web browser, return to the FrontPage Editor. FrontPage fills in the URL field with the URL to which you just 
browsed.

File Button

Click this button to specify a file in another folder on your computer or on your local network.

Title
(Save As command only) Specify a page title for the page you are saving. FrontPage will modify the URL to 
match this title.

As Template
(Save As command only) Click As Template to save the current page as a page template.

E-mail Button

(Hyperlink command only) Click this button to create a hyperlink that creates a new e-mail message. When a 
user visiting your Web site clicks an e-mail hyperlink, the Web browser will prompt the user for a message and 
will send the message to the e-mail address specified here.

Note      Not all Web browsers support hyperlinks to e-mail addresses.

New Page Button

(Hyperlink command only) Click New Page to create a new page and select that page. This displays the New 



dialog box, where you choose a template or Wizard page. FrontPage creates and opens the new page in the 
FrontPage Editor and assigns it a temporary URL. When you save the new page, FrontPage updates the 
hyperlink to it. 

Bookmark
(Hyperlink command only) This drop-down list contains the bookmarks in the open page selected in the list 
above. Select the bookmark to which the hyperlink should point. 

If the page selected in the list is not open in the FrontPage Editor, the bookmark entry is <None>. Enter the 
bookmark to which the hyperlink should point.

Target Frame

(Hyperlink command only) The Target Frame field indicates the frame in which to display the page to which the 
hyperlink points. If you specify a frame that does not exist, a Web browser may create a new window in which to 
display the page to which a hyperlink points.

Style
(Hyperlink command only) Click Style to open the Style dialog box where you can edit the cascading style-sheet 
properties for the selection. Style-sheet formatting allows for precise control over spacing, alignment, fonts, and 
colors that is not possible with basic HTML attributes. Typically, cascading style-sheet formatting overrides 
attributes in HTML tags; however, the formatting displayed in a Web browser depends on the Web browser used 
to display the page.

Clip Art
(Image command only) Click Clip Art to open the Microsoft Clip Gallery, then choose an image, picture, video 
clip, or background sound to insert.

Scan
(Image command only) Click Scan to acquire an image from a TWAIN-compatible digital camera, scanner, or 
other TWAIN-compatible image capturing device installed on your computer.
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What's New in This Release
FrontPage 98 includes the following new features, listed alphabetically:

All Files View Optimized for Webmasters 

Auto Thumbnail 

Banner Ad Manager 

Cascading Style Sheet Support 

Channel Definition Format (CDF) Channel Wizard 

Clip Gallery Live 

Clip Art Gallery 

Database Region Wizard 

Design Time ActiveX Control Support 

Dynamic HTML Support 

Dynamic Outlining (Dynamic HTML) 

Easier Hyperlinks 

Easy Web Publishing 

Editor Integrated with Internet Explorer 

Editor Views Tabs 

Enhanced Form Creation 

Enhanced Support for "Hand Coded" HTML 

Form Field Extensions (Dynamic HTML)

Form Save Results to E-Mail

FrontPage Themes 

Getting Started — Most Recently Used List 

Graphical Bullets 

Hit Counter 

Hover Buttons 

Image Preview 

Improved Active Server Page Interoperability 

Improved Getting Started Dialog 

Improved Image Editing Tools 

Improved Import Wizard 

Improved Table Editing 

In-place HTML Editing 

In-place Page Preview 

Integration with Netscape Communicator 

Manage Orphan Files 

Microsoft Commercial Internet Services Membership Integration

Modify Navigation View "Site Maps" 

Navigation View 



Navigation View and Navigation Bars 

New Templates 

New Views Bar 

Page Transitions (Dynamic HTML) 

Paste Plain Text 

Performance Improvements 

Print Navigation View "Site Maps" 

Scalability Improvements 

Server Extensions Improvements 

Shared Borders 

Simplified Form Save Results Component 

Table Drawing Tools 

Text Animations (Dynamic HTML) 

Text Overlays on Images 

TWAIN Support / Image Acquisition 

Web Publishing Wizard version 1.5 

WYSIWYG Frames Page Editing 



All Files View Optimized
The FrontPage 98 Explorer All Files view also features a way to easily arrange and sort "orphan" files (files 
without any links pointing to them) so you can more easily manage these files and keep the size of your web to a 
minimum.



Auto Thumbnail
Automatically creates a small thumbnail image of a graphic and links it to the larger original image from which it 
was created. Great for quickly creating "picture gallery" type web sites.



Banner Ad Manager
Makes it easy to display a series of graphics with transition effects between them as you rotate through the 
different images. This component makes it easy to create lightweight banner advertisements for your web site 
that catch users' eyes.



Cascading Style Sheet Support
Cascading Style Sheets (CSS) are an open specification endorsed by the World Wide Web gives web authors 
tremendous power in formatting web pages. CSS support gives web authors word processor-like control over the
text in HTML documents so you can define complex styles for things like paragraphs, documents, and collections
of documents so you can create extensive and dramatic page layout settings. FrontPage 98 can do 100% round 
tripping of all CSS attributes as well as provides an interface for setting CSS properties. Popular web browsers 
supporting CSS include Microsoft Internet Explorer 3.0 and higher, and Netscape Navigator 4.0. No longer do 
you have to be a programmer to tap into the power of CSS!



Channel Definition Format (CDF) Channel Wizard
Users of FrontPage can take advantage of the exciting new world of Push technology. With the CDF Channel 
Definition Wizard, users can quickly turn their web site into a "channel" that users can "subscribe" to for 
automatic delivery to any desktop running Internet Explorer 4.0.



Clip Gallery Live
Want even more clip art? From within the Clip Gallery dialog you can download thousands of clip art images 
directly from the Microsoft web site. These images are automatically added to the Clip Gallery for easy access 
next time you need it.



Clip Art Gallery
FrontPage 98 sports the same Clip Gallery interface as Microsoft Office and Microsoft Publisher so you can 
easily preview and insert clip art through the familiar Clip Gallery interface. FrontPage 98 will ship with over 1000 
clip art images.



Database Region Wizard
The new Database Region Wizard lets you leverage the Active Server Pages functionality of Microsoft Internet 
Information Server to include dynamic database content directly into your web pages.



Design Time ActiveX Control Support
Design Time ActiveX Controls are a new type of component that lets third parties extend the web authoring 
capabilities of FrontPage 98.



Dynamic HTML Support
Dynamic HTML is a new web page object model specification developed by Microsoft and submitted to the World
Wide Web Consortium that allows programmers to manipulate web pages and their elements in exciting and 
powerful ways. Since the mission of FrontPage is to create "professional quality web sites without programming,"
FrontPage 98 has a range of features that let you take advantage of the benefits of Dynamic HTML without 
having to program the Dynamic HTML object model.



Dynamic Outlining (Dynamic HTML)
Create expanding and collapsing outlines in your web pages with no programming required. What used to 
require sophisticated scripting, ActiveX™ controls, or Java™ programming can now be done within a simple-to-
use FrontPage dialog. Best of all, you get this new functionality while still having the easy to use editing 
environment of FrontPage.



Easier Hyperlinks
The Insert Hyperlinks dialog has been completely redesigned in FrontPage 98 for dramatically enhanced ease of 
use and web author productivity. With the help of extensive usability tests, the new hyperlinks dialog makes it 
even easier to link to new pages, existing pages in the web, pages on the Internet, or directly to e-mail 
addresses. We've also simplified linking to bookmarks and specifying link targets when using frames pages.



Easy Web Publishing
FrontPage 98 offers one-button web publishing! The web publishing interface has been dramatically simplified 
from FrontPage 97.FrontPage intelligently only publishes files that have changed since you last published, and 
will automatically detect changes made by others in a multi-user environment, giving you the ability to resolve 
conflicting changes among different users. And if you don't already host your web with a FrontPage Web 
Presence Provider (WPP) you're invited to click one button to visit a list of registered FrontPage WPP's that 
Microsoft maintains on its web site.



Editor Integrated with Internet Explorer
Microsoft FrontPage 98 Editor will seamless integrate with Internet Explorer 4.0 so that when you browse to a 
page you've published you can press the Edit button in Internet Explorer to edit it in the FrontPage 98 Editor then
save the changes back to the server -- all while browsing with Internet Explorer 4.0! This increased integration 
between your web browser and web editor makes updates fast and easy. FrontPage also includes a new Go 
menu with commands to activate other members of the Internet Explorer 4.0 suite of tools, such as mail or news.



Editor Views Tabs
Easy to discover and easy to use, the FrontPage 98 Editor features new tabs at the bottom of the screen so you 
can quickly toggle between several views of your web page such as the improved and editable HTML code view, 
the Preview view, and the Normal view. When a frames page is loaded in the editor two additional tabs give you 
easy access to your frames page HTML code and the alternate "No Frames" web page that users with frames-
incompatible browsers will see when visiting your page.



Enhanced Form Creation
Creating a form has never been simpler! When you add your first form field to your web page FrontPage 98 will 
automatically insert "Submit" and "Reset" buttons so you don't have to! These buttons are needed for most 
forms, and FrontPage 98 takes the guess work out of forms creation by creating these for you automatically.



Enhanced Support for "Hand Coded" HTML
If your web authoring style is to work directly with HTML source code FrontPage 98 makes it dramatically easier 
to edit your raw HTML. FrontPage will preserve more of your hand-formatting of HTML source, and includes 
better auto-formatting algorithms to make the generated HTML code easier to read.



Form Field Extensions (Dynamic HTML)
An Accessibility feature this gives all users the ability to quickly access web page form fields via the keyboard by 
letting you define the tab order and "ALT+" key shortcuts for all your form fields.



Form Save Results to E-Mail
Ever forget to check your database or web server text file for newly submitted forms from your web? Ever wanted
the form results to simply be sent directly to your e-mail inbox? Well, with this FrontPage 98 feature you can do 
exactly that! With the new simplified Form Save Results component you simply tell FrontPage that when users 
fill-out and submit a form on your web site send it directly to your e-mail address. What used to require 
programming a custom script is now conveniently available in FrontPage 98 so you don't have to be a 
programmer to get this powerful functionality.



FrontPage Themes
Create a great looking web quickly with over 50 professionally designed themes you can apply to your entire web
or to separate pages. Backgrounds, bullets, banners, hyperlinks and navigation bars will have a great looking 
and consistent appearance — all without your having to be a graphic designer.



Getting Started — Most Recently Used List
Similar to the "Most Recently Used" list in other Microsoft applications such as Microsoft Office with FrontPage 
98 you can easily open any of your most recently used web sites, without ever having to type in a URL!



Graphical Bullets
FrontPage lets you specify custom images to use in place of the plain old bullets you normally find on web 
pages. The FrontPage Editor is smart enough to let you edit these graphical bulleted lists just as easily as a plain
list. When you apply a theme, matching graphical bullets are automatically applied to existing or newly created 
bulleted lists.



Hit Counter
No programming is required to keep track of how many hits your web page receives. Insert the Hit Counter 
component with a simple menu command, and easily change the number display style and the visual display for 
the number of visits to your page.



Hover Buttons
Hover buttons add life to your web page so when a user "hovers" over the button or clicks on it, it will change 
colors or shape, or animate any way you choose. This automatic feature of FrontPage 98 essentially creates a 
small Java™ applet without your having to know Java and helps deliver on the promise of making professional 
quality web sites without programming and without a graphic designer.



Image Preview
Save time with this new feature in FrontPage 98 that let's you preview your images before you actually insert 
them into your web page, making it easy to pick just the right images for your site.



Improved Active Server Page Interoperability
FrontPage 98 manages hyperlinks found within Active Server Page (ASP) script code. And web pages containing
ASP code can now be edited with greater fidelity using the FrontPage 98 Editor.



Improved Getting Started Dialog
A simpler Getting Started dialog makes it easier to get results. We also include a default web that provides a 
starting point for beginning users to get up and running on the web quickly.



Improved Image Editing Tools
New image editing tools in the FrontPage Editor make it easy for users to bevel, crop, flip, rotate or automatically 
washout images. Especially great for those images scanned in directly from digital cameras or scanners with 
FrontPage 98's TWAIN support. FrontPage 98 also lets you resample an image to shrink the physical image to a 
scaled down size to reduce the download time of large images.



Improved Import Wizard
The improved Import Wizard supports importing from a URL, in addition to a file directory. You can also limit how 
much data to import by the # of link levels, K of data, or limit it to just text and images.



Improved Table Editing
FrontPage 98 gives you visual control over the structure and layout of your table and its rows and columns. Use 
Drag & Drop to move or copy your table rows and columns. Resizing rows and columns is as easy as selecting a
border with your mouse and moving it where you want. Finally, the new "Distribute Rows Evenly" and "Distribute 
Columns Evenly" commands evenly spaces your rows and columns with just a click of the mouse.



In-place HTML Editing
The improved editable HTML view has moved from a dialog box into the FrontPage 98 Editor editing window 
making it easier for those wanting to manually edit the HTML to do so just as they would in any code or text 
editor.



In-place Page Preview
Preview your web page, even those including animations and active elements, right within the FrontPage 98 
Editor just by clicking on a tab at the bottom of the screen! Makes previewing web pages quicker and simpler 
than ever before.



Integration with Netscape Communicator
Using Netscape Communicator? No problem. The FrontPage 98 Editor will seamlessly integrate with 
Communicator, replacing the limited function Composer editor, and become the default HTML editor if you wish, 
giving you all the powerful functionality of FrontPage right from within Communicator!



Manage Orphan Files
The FrontPage 98 Explorer All Files view also features a way to easily arrange and sort "orphan" files (files 
without any links pointing to them) so you can more easily manage these files and keep the size of your web to a 
minimum.



Microsoft Commercial Internet Services Membership Integration
Membership is a feature of the Microsoft Commercial Internet System (MCIS) used by Internet Service Providers.
Many Web Presence Providers offering FrontPage-hosted web services also offer Membership Services, and 
now with support for this in FrontPage 98, web authors and their ISP's gain the benefit of one user log on to all of
the ISP's services.



Modify Navigation View "Site Maps"
Easily modify the structure of your web site with the Navigation View where you can add pages and rearrange 
links via drag and drop. Expanding and collapsing your view of the Navigation structure to make it easier for you 
to work with it is as simple as a few mouse clicks. And you can even "shrink to fit" the view using the resize 
command.



Navigation View
Navigation View is an innovative site creation and management feature that lets you create and manage the 
navigational structure of your web site within seconds. It's easy to connect new pages and move pages around in
your structure and as you make these changes FrontPage will automatically generate the appropriate navigation 
bars on each web page. You can rotate, size to fit on the screen, and even print a "site map" from the new 
Navigation View.



Navigation View and Navigation Bars
Include automatically generated Navigation Bars on your web pages with just a few simple clicks of the mouse. 
FrontPage 98 lets you specify the levels and hyperlink styles you wish to include for defining a consistent 
navigational structure for your site. And using the new Navigation View in the FrontPage Explorer, the Navigation 
Bars are regenerated for you automatically any time you change the structure of your web.



New Templates
Get a jumpstart on your page layout design by using one of over 17 new web page templates. These new 
templates contain professionally designed page layouts you can use to quickly create great looking pages — just
add content!



New Views Bar
FrontPage 98 Explorer features a new Views bar along the left side that gives you one-click access to all of the 
FrontPage views, including the new Navigation, All Files, and Themes views. Similar in style to the Outlook™ Bar
found in the Microsoft Outlook desktop information manager, the FrontPage Views Bar contains other views such
as Folders, Hyperlinks, Hyperlink Status (formerly Verify Hyperlinks), and Tasks (formerly To Do List).



Page Transitions (Dynamic HTML)
Choose from a variety of different page transitions so people browsing your web with Internet Explorer 4.0 can 
experience stunning visual effects when navigating between pages, similar to what's available in presentation 
packages like Microsoft PowerPoint.



Paste Plain Text
The new Paste Special command matches the functionality of other Microsoft Office applications and allows you 
to paste text from other applications either as plain text or as formatted text.



Performance Improvements
In FrontPage 98 the Explorer and Editor boot speed, page save speed, and time to open a web have all been 
improved.



Print Navigation View "Site Maps'
At last! FrontPage 98 lets you print out the graphical structure of your web site directly from the FrontPage 
Explorer.



Scalability Improvements
The FrontPage ability to handle large webs has also been improved.



Server Extensions Improvements
Making it easier for Web Presence Providers and web administrators to host multiple FrontPage web sites is a 
major focus of FrontPage 98. For more information about improvements in remote administration, multi-hosting, 
or improved Apache or IIS support please refer to the FrontPage 98 Server Extensions Resource Kit on the CD 
or online at http://www.microsoft.com/frontpage.



Shared Borders
The new Shared Borders feature allows you to specify shared headers or footers (horizontal or vertical) across 
the pages in your web site. This provides you a great deal of design flexibility in creating a great looking, but 
consistently designed web site.



Simplified Form Save Results Components
Setting up how your web handles the results of forms is now easy with the improved Save Results component. 
An intuitive and streamlined user interface gives you more power and control than ever in an easy to use manner
so you can set up how your forms are handled.



Table Drawing Tools
Design the layout of your web page more quickly and easily than ever before with the pixel-level precision of the 
new Table drawing tools. Create tables using the equivalent of a pencil and an eraser to draw tables of any size 
or shape directly on your web page. With the table drawing tools you have the flexibility to precisely design the 
layout of a page by fitting a table to your content. Include in your table any information you'd like, including 
images, text, multimedia files, and even tables nested within your table. Sophisticated web page layout without 
manually coding HTML is now a reality.



Text Animations (Dynamic HTML)
Easily create text animations like text flying in from off screen, or words that are revealed letter by letter. With this
type of Dynamic HTML support you can easily create animation effects for your web page that you'd usually 
expect to find only in presentation applications like the Microsoft PowerPoint® presentation graphics program.



Text Overlays on Images
Add text directly onto your images so now creating page elements like graphical buttons is a snap!



TWAIN Support / Image Acquisition
Built-in TWAIN support means you can scan images directly into FrontPage from your scanner or digital camera 
making it easy and fun to add your personal or company photographs and other "just-in-time" images to your 
web!



Web Publishing Wizard version 1.5
The new version of this wizard is designed for users publishing their webs to servers that do not contain the 
FrontPage Server Extensions. Web Publishing Wizard version 1.5 takes advantage of the FrontPage 98 one-
button-publishing feature and is smart enough to forestall the most common errors that can occur when 
publishing your web to the world using alternate publishing methods like FTP or via the America Online service.



WYSIWYG Frames Page Editing
Create and modify frames pages directly within the Editor in a truly WYSYWIG fashion. Choose to create frames 
from templates provided or create a custom frames grid with a few clicks of the mouse, then edit the pages and 
frames page directly on the screen. Creating and editing frames just as they'll appear in the browser is now 
remarkably simple.



Hit Counter Properties Dialog Box
Use the Hit Counter Properties dialog box to insert a hit counter on the active page in the FrontPage Editor. A hit 
counter is a numeric counter which displays the number of users who have visited your Web site.

Dialog Box Options

Counter Style
Select one of the predefined styles for the visual appearance of the hit counter or select Custom Image to use an
image as the hit counter. If you select Custom Image, type the absolute URL or relative URL of the image you 
want to use.

Reset Counter To
Select this check box to restart the hit counter at a specific number, then type the new starting number in the box.

For example, if you want the hit counter to begin at 1,000, select this check box and then type 1000 in the box. 
The hit counter would begin at 1,000 and increment one for each user who visits your site.

Fixed Number of Digits
Select this check box to limit the hit counter to a specific number of digits, then type that number in the box.

For example, if you want the hit counter to display five digits for the tens of thousands of users who have visited 
your web site, select this check box and then type 5 in the box. The hit counter would begin at 00000 and reset to
zero after 99999.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Pages')}



About Fields
Fields are the building blocks of forms. Using fields, a user provides information or input to your FrontPage web. 
This input is processed by a form handler on your Web server when the user submits the form.

You create fields in the FrontPage Editor using the Form Field command on the Insert menu, or by clicking 
buttons on the forms toolbar. You can create the following fields using FrontPage:

· A one-line text box is a labeled, single line form field into which users can type text.
· A scrolling text box is a labeled, multi-line form field into which users can type multiple lines of text.
· A radio button presents the user with a selection that can be chosen by clicking a button. Radio buttons are 

presented in a list, one of which is selected by default. Selecting a new member of the list clears the currently 
selected item.

· A check box presents the user with a selection that can be chosen by clicking a box. When the check box is 
selected, it is usually displayed with a check mark or X. Check boxes can represent a set of non-exclusive 
choices.

· A drop-down menu presents a list of selections in drop-down menu style. A set of drop-down menu form fields 
can be configured to allow either one item to be selected or many items to be selected at a time.

· A push button lets the user submit the form, or resets the form to its initial state.
· An image field displays an image in a form. By clicking the image, the user submits the form.

Form fields are created in line with text on the active page in the FrontPage Editor. Once a field is inserted on the
page, the FrontPage Editor treats it like a character. For example, if you click to the left of a field and start typing 
a field's label, the field moves right to make room for the text, and if you press ENTER to the left of a field, the 
field drops to the beginning of the new line. You can cut and copy fields to the clipboard and paste them into a 
form.
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Dialog Box Options for Web Results

Check Spelling Dialog Box
This dialog box lists the results of the spelling check of the current FrontPage web.

Status
Indicates the action taken for each misspelled word.

Page
Lists the page title and file name of the page containing the misspelled word.

Count
Indicates how many misspelled words were found per page.

Misspelled Words
Lists the misspelled words; an ellipsis indicates that all words are not listed.

Note      Misspelled words are listed without punctuation between them.

Stop/Done
Click Stop to halt the command before it has checked spelling in all or selected pages.

When all pages have been checked, the button changes to Done and is dimmed.

Edit Page
Select a page from the list, and then click Edit Page to open the page in the FrontPage Editor and scroll to the 
first misspelled word.

Add Task
Select a page from the list, and then click Add Task to add a task for correcting the misspelled word to the Tasks 
View.

Find Occurrences Dialog Box
This dialog box lists the results of the find or replace command for the current FrontPage web.

Status
Indicates the action taken for each word that was found.

Page
Lists the page title and file name of the page containing the found word.

Count
Indicates how many words were found per page.

Stop/Done
Click Stop to halt the command before it has checked all or selected pages.

When all pages have been checked, the button changes to Done and is dimmed.

Edit Page
Select a page from the list, and then click Edit Page to open the page in the FrontPage Editor and scroll to the 
first found word.

Add Task



Select a page from the list, and then click Add Task to add a task for the found word to the Tasks View.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Text')}



Errors Tab, Properties Dialog Box
Use the Errors tab to learn why a page in the FrontPage Explorer's Hyperlinks View has been flagged with the 
Error icon:

Error icon

Dialog Box Option

Description
A description of the error or errors on that page.
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New Top Page Command
Use the New Top Page command on the FrontPage Explorer's Navigation View shortcut menu to add a new 
page to the top level of the FrontPage web structure.

The page is added at the same level as your home page. Typically, top pages are special-purpose pages that are
not a part of the navigation structure, but that you want to be available throughout your site — such as a guest 
book page or a Search Form.
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To create an e-mail hyperlink
Use this procedure to create an e-mail    hyperlink. When a user visiting your Web site clicks an e-mail hyperlink, 
the Web browser will prompt the user for a message and will send the message to the specified e-mail address.

Note      Not all Web browsers support hyperlinks to e-mail addresses.
1 In the FrontPage Editor, select text that will identify the hyperlink.

If you do not select text, the URL will be inserted on the page when you create the hyperlink.
2 On the Insert menu, choose Hyperlink, or click the Create or Edit Hyperlink button.

3 In the Create Hyperlink dialog box, click the E-mail button.

4 In the Create E-mail Hyperlink dialog box, type the e-mail address you want users to send e-mail to, then click
OK.

5 Click OK to close the Create Hyperlink dialog box.
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To restrict a FrontPage web author's IP addresses
You can restrict the range of IP addresses from which authors can open the current FrontPage web by adding 
one or more IP address masks.Some Web servers do not support restricting access by IP address. If the 
Computers tab is not present in the Permissions dialog box, IP address restriction is not supported by the Web 
server.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Computers tab, click Add.
This displays the Add Computer dialog box.

4 In each of the four IP Mask field sections, enter an integer in the range 1 - 255 or the wild card character (*).
The wild card character means that any integer will be accepted at that position in the IP address.

5 In the Computer Can area, choose the Author And Browse This Web option.
6 Click OK.
7 To add the IP address mask and continue working in the Permissions dialog box, click Apply. To add the IP 

address mask and close the dialog box, click OK.
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To remove a registered user from a restricted-access FrontPage web
1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 In the Users tab, select the user to be removed.
3 Click Remove.
4 To remove the user and continue working in the Permissions dialog box, click Apply. To remove the user and 

close the dialog box, click OK.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Security')}



To register a user of a restricted-access FrontPage web
A FrontPage web administrator can restrict general end-user access to a FrontPage web and then register 
specific users that are authorized to access the FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root FrontPage 
web.

3 In the Users tab, choose Only Registered Users Have Browse Access, then click Add.
4 In the Name field, enter the name of the user who will have access to the FrontPage web.
5 Enter the user's password in the Password and Confirm Password fields.
6 In the User Can field, choose the Browse This Web option.
7 Click OK.
8 To add the user and continue working in the Permissions dialog box, click Apply. To add the user and close 

the dialog box, click OK.
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To apply a theme to a FrontPage web
Use this procedure to apply a theme to all of the pages in the current FrontPage web.

1 In the FrontPage Explorer, click the Themes button on the Views bar to switch to Themes View.
2 In the Use Selected Theme list, click the theme that you want to use. A preview of the theme displays in the 

Theme Preview area.
3 Select any of the following options:

· Select the Vivid Colors check box to specify a bright set of colors for the theme.
· Select the Active Graphics check box for a lively set of banners, buttons, bullets, and other graphical 

elements.
· Select the Background Image check box for a textured page background. If this is not selected, the page 

background will be a basic color.
4 When you have selected the theme and options that you want to apply to the current FrontPage web, click 

Apply.
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To change the theme applied to a FrontPage web
Use this procedure to change the theme that has been applied to all of the pages in the current FrontPage web.

1 In the FrontPage Explorer, click the Themes button on the Views bar to switch to Themes View.
2 In the Use Selected Theme list, click a different theme from the one previously applied. A preview of the 

theme displays in the Theme Preview area.
3 Select any of the following options:

· Select the Vivid Colors check box to specify a bright set of colors for the theme.
· Select the Active Graphics check box for a lively set of banners, buttons, bullets, and other graphical 

elements.
· Select the Background Image check box for a textured page background. If this is not selected, the page 

background will be a basic color.
4 When you have selected the other theme and the options that you want to apply to the current FrontPage 

web, click Apply.
FrontPage removes the previously-applied theme and then applies the selected theme and options.
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To change the theme applied to a page
Use this procedure to change the theme that has been applied to the active page in the FrontPage Editor.

1 On the FrontPage Editor's Format menu, choose Theme.
2 In the Choose Theme dialog box, click Use Selected Theme, and In the Use Selected Theme list, click a 

different theme from the one previously applied. A preview of the theme displays in the Theme Preview area.
3 Select any of the following options:

· Click Vivid Colors to specify a bright set of colors for the theme.
· Click Active Graphics for a lively set of banners, buttons, bullets, and other graphical elements.
· Click Background Image for a textured page background. If this is not selected, the page background will 

be a basic color.
4 When you have selected the other theme and the options that you want to apply to the active page, click OK.

FrontPage removes the previously-applied theme and then applies the selected theme and options.
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To remove the theme applied to a FrontPage web
Use this procedure to remove the theme that has been applied to all of the pages in the current FrontPage web.

Note      This procedure removes only the theme elements that have been applied to the current FrontPage web. 
It does not remove the theme itself from the choices in Themes View, so that the theme can be reapplied or used
on other webs in the future.
1 In the FrontPage Explorer, click the Themes button on the Views bar to switch to Themes View.
2 In the Use Selected Theme list, select the This Web Does Not Use Themes option, and then click Apply.
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To remove the theme applied to a page
Use this procedure to remove the theme that has been applied to the active page in the FrontPage Editor.

Note      This procedure removes only the theme elements that have been applied to the active page. It does not 
remove the theme itself from the list of available themes, so that the theme can be reapplied or used on other 
pages in the future.
1 On the FrontPage Editor's Format menu, choose Theme.
2 In the Choose Theme dialog box, select the This Page Does Not Use Themes option, and then click OK.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Themes')}



Frames Page Properties Command
Use the Frames Page Properties command to display the Frames tab of the Page Properties dialog box, where 
you can specify the spacing and borders between frames on the active frames page.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Frames')}



Print Command
Use the Print command to print the active page in the FrontPage Editor. Form fields do not appear on the printed 
page.

You can also print the active page by clicking the Print button on the standard toolbar:

Print button

{button Related Procedures,JI(`frontpg.HLP',`Content_Workplace')}



Label Command
Use the Label command to make the label of a form field "clickable." For example, if you use this command to 
make the label of a check box field clickable, a user can select the check box by clicking either the check box or 
the label.

Before using this command, type a label for the form field, and then select both the label and the form field.

You can also create an underlined "access key" for the label, which lets a user press ALT plus another key 
instead of clicking the label or form field. For example, the access key for the FrontPage Editor's File menu is the
letter 'F'; instead of clicking to display the File menu, a user can press ALT+F.

If you also want to create an access key, select the label letter that you want to enable as the access key, and 
then click the Underline button on the standard toolbar:

Underline button

Note      These features will only be enabled in Web browsers that support Dynamic HTML, such as Microsoft 
Internet Explorer 4.0.

{button Related Procedures,AL(`field form procedures',0,`',`main')}



Remove Label Command
Use the Remove Label command to remove Dynamic HTML formatting that has been previously applied to a 
form field label to make the label "clickable" or to set an access key.

Before using this command, select both the label and the form field.

After using this command, if the label contained an underlined letter for the access key, remove the underlining 
by selecting that letter and then clicking the Underline button on the standard toolbar:

Underline button

{button Related Procedures,AL(`field form procedures',0,`',`main')}



About Fields
Fields are the building blocks of forms. Using fields, a user provides information or input to your FrontPage web. 
This input is processed by a form handler on your Web server when the user submits the form.

You create fields in the FrontPage Editor using the Form Field command on the Insert menu, or by clicking 
buttons on the forms toolbar. You can create the following fields using FrontPage:

· A one-line text box is a labeled, single line form field into which users can type text.
· A scrolling text box is a labeled, multi-line form field into which users can type multiple lines of text.
· A radio button presents the user with a selection that can be chosen by clicking a button. Radio buttons are 

presented in a list, one of which is selected by default. Selecting a new member of the list clears the currently 
selected item.

· A check box presents the user with a selection that can be chosen by clicking a box. When the check box is 
selected, it is usually displayed with a check mark or X. Check boxes can represent a set of non-exclusive 
choices.

· A drop-down menu presents a list of selections in drop-down menu style. A set of drop-down menu form fields 
can be configured to allow either one item to be selected or many items to be selected at a time.

· A push button lets the user submit the form, or resets the form to its initial state.
· An image field displays an image in a form. By clicking the image, the user submits the form.

Form fields are created in line with text on the active page in the FrontPage Editor. Once a field is inserted on the
page, the FrontPage Editor treats it like a character. For example, if you click to the left of a field and start typing 
a field's label, the field moves right to make room for the text, and if you press ENTER to the left of a field, the 
field drops to the beginning of the new line. You can cut and copy fields to the clipboard and paste them into a 
form.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Fields')}



Next Page Command
Use this to display the next page.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



Prev Page Command
Use this to display the previous page.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



Two Page/One Page Command
Changes between previewing a single page and two pages.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



Zoom In Command
Magnifies the display.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



Zoom Out Command
Decreases the display magnification.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



Close Command
Closes the Print Preview window.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



About Frames and Frames Pages
Frames divide a Web browser's window into separate regions, each of which can display a separate, scrollable 
page. A group of frames is called a frames page. A frames page is a special Web page that defines the size and 
location of each frame it contains.

In the simplest frames page there are two frames: one frame displays a page listing a set of hyperlinks, and the 
other frame displays the pages to which the hyperlinks point. Each time a user clicks a hyperlink in the first 
frame, the page pointed to by that hyperlink is displayed in the second frame. The frames page itself does not 
actually contain any content or pages; it contains only hyperlinks to existing pages that are displayed in the 
frames.

You create a new frames page by selecting a frames page template from the Frames tab of the New dialog box. 
FrontPage creates the frames page in a new window in the FrontPage Editor. You then set the initial page you 
want displayed in each frame on the frames page.

When a user clicks a hyperlink to the frames page, the Web browser will load the frames page and then load the 
initial page specified for each frame. Typically, each page displayed in a frame is a Web page. However, a frame 
can also contain display another frames page, in which case that frame is the parent frame of all the frames in 
the new "nested" frames page.

When a user clicks a hyperlink on the initial page in a frame, the page to which the hyperlink points will be 
displayed in the designated target frame based on the frames page template you selected.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Frames')}



About Hyperlinks
A hyperlink is a connection from a World Wide Web page to another location on the World Wide Web. The 
destination of the hyperlink is most often another Web page, but it can also be an image, an e-mail address, a 
multimedia file, or even a program.

Hyperlinks are embedded directly in text or images on a page, and they give textual or graphical cues about 
where they lead. For example, a text hyperlink from the phrase "Microsoft FrontPage" and an image hyperlink 
from the Microsoft FrontPage logo both would indicate that the hyperlink goes to a page describing Microsoft 
FrontPage.

Web browsers usually underline text hyperlinks and display them in a specific color. Hyperlinks in images are 
invisible. However, users can tell when the pointer is over a hyperlink because it changes appearance, usually to 
a pointing hand.

When a user clicks on a hyperlink to a page, the Web browser gets the page from the correct server and displays
it. When a user clicks a hyperlink to another type of file, the Web browser gets the file from the server and opens 
it in an associated program. For example, most browsers open WAV files in a sound-playback application.

When a hyperlink is inserted on a page, the destination of the hyperlink is encoded as a Uniform Resource 
Locator (URL). A URL gives the address of a file on the World Wide Web and also identifies the Internet service, 
such as FTP or the World Wide Web, that will handle the file.

Any URL can be absolute or relative. An absolute URL is the full Internet address of a page or file, including the 
protocol, network location, and optional path and file name. For example, http:// www.microsoft.com/news.htm is 
an absolute URL.

A relative URL is a URL with one or more of its parts missing. Browsers take the missing information from the 
page containing the URL. For example, if the protocol is missing, the browser uses the protocol of the current 
page, and if the network location is missing, the browser uses the current page's network location.

The most common type of relative URL has only a partial path and a file name, but no network location. If a page
uses this type of relative URL to hyperlink to another page and both pages are moved to another server, the 
hyperlink will still work if the relative positions of the pages remains the same on the new server. For example, 
the relative URL products.htm points to a page in the same folder as the page containing the hyperlink. If 
both pages are moved to the same folder on a different server, the URL will still be correct.

FrontPage makes it easy to create, edit, and verify hyperlinks. In the FrontPage Editor, you create a hyperlink to 
a target page or file in your current FrontPage web by selecting the target from a list of your web's contents. You 
create hyperlinks to any page on the World Wide Web by typing in the target page's URL or by browsing the 
World Wide Web for the page.

You can also create hyperlinks to e-mail addresses. When a user visiting your Web site clicks an e-mail 
hyperlink, the Web browser will prompt the user for a message and will send the message to the specified e-mail 
address.

Using FrontPage, you can create hyperlinks without needing to know the URL of the target page or file. You can 
just browse the current FrontPage web or the World Wide Web, point to the page or file, and the FrontPage 
Editor fills in the correct URL.

FrontPage generates relative URLs when you create hyperlinks between pages in your FrontPage web. If you 
rename or move a page, FrontPage updates all the relative URLs in your FrontPage web that point to that page. 
By generating all relative URLs, FrontPage saves you time and ensures that your Web site will be portable.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Link_Bookmark')}



About the FrontPage Workplace
The FrontPage workplace includes what you see on the screens of the two components of FrontPage, the 
FrontPage Explorer and the FrontPage Editor. On both screens you see menu bars, toolbars, status bars, 
menus, title bars and dialog boxes.

The FrontPage Explorer shows you seven different views of the current FrontPage web:

· Folders View
· All Files View
· Navigation View
· Hyperlinks View
· Hyperlink Status View
· Themes View
· Tasks View

You switch between these views by clicking buttons on the Views bar. You use the FrontPage Explorer to create 
and open FrontPage webs, set permissions, create a navigation structure, manage folders and files, view and 
repair hyperlinks, use themes, and create and manage tasks.

The FrontPage Editor has a text area where you create the pages of your FrontPage web. In the FrontPage 
Explorer and FrontPage Editor you can display or hide some screen elements, such as the status bar.

Microsoft Office documents can be opened and edited while in FrontPage. FrontPage uses the power of the text 
import converters from Microsoft Word to import a wide variety of file formats into FrontPage, increasing your 
ability to use existing content for your web site. This feature is integrated into the File command options on the 
Insert menu, and any new converters are automatically shared with other Microsoft Office applications.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Workplace')}



About Themes
A FrontPage theme consists of unified design elements and color schemes for bullets, fonts, images, navigation 
bars, and other page elements. When applied, a theme gives the pages and navigation bars in your FrontPage 
web an attractive and consistent appearance.

You apply a theme to all pages in the current FrontPage web in the FrontPage Explorer's Themes View. Once a 
theme has been applied, you can change to a different theme, or remove the theme.

You also apply, change, or remove themes page-by-page in the FrontPage Editor using the Theme command on 
the Format menu.

In both the FrontPage Explorer and the FrontPage Editor, the Theme Preview pane lets you preview sample 
page elements as they will appear on your Web pages. You can preview a theme before applying it by selecting it
from the list of available themes. FrontPage includes over 50 themes.

Before applying a theme, you can select options that change the appearance of the theme's components. For 
example, selecting Vivid Colors will apply brighter colors to text and graphics, selecting Active Graphics will 
animate certain theme components, and selecting Textured Background will apply a textured background image 
to the pages in your FrontPage web.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Themes')}



What's New in This Release
FrontPage 98 includes the following new features, listed alphabetically:

All Files View Optimized for Webmasters 

Auto Thumbnail 

Banner Ad Manager 

Cascading Style Sheet Support 

Channel Definition Format (CDF) Channel Wizard 

Clip Gallery Live 

Clip Art Gallery 

Database Region Wizard 

Design Time ActiveX Control Support 

Dynamic HTML Support 

Dynamic Outlining (Dynamic HTML) 

Easier Hyperlinks 

Easy Web Publishing 

Editor Integrated with Internet Explorer 

Editor Views Tabs 

Enhanced Form Creation 

Enhanced Support for "Hand Coded" HTML 

Form Field Extensions (Dynamic HTML)

Form Save Results to E-Mail

FrontPage Themes 

Getting Started — Most Recently Used List 

Graphical Bullets 

Hit Counter 

Hover Buttons 

Image Preview 

Improved Active Server Page Interoperability 

Improved Getting Started Dialog 

Improved Image Editing Tools 

Improved Import Wizard 

Improved Table Editing 

In-place HTML Editing 

In-place Page Preview 

Integration with Netscape Communicator 

Manage Orphan Files 

Microsoft Commercial Internet Services Membership Integration

Modify Navigation View "Site Maps" 

Navigation View 



Navigation View and Navigation Bars 

New Templates 

New Views Bar 

Page Transitions (Dynamic HTML) 

Paste Plain Text 

Performance Improvements 

Print Navigation View "Site Maps" 

Scalability Improvements 

Server Extensions Improvements 

Shared Borders 

Simplified Form Save Results Component 

Table Drawing Tools 

Text Animations (Dynamic HTML) 

Text Overlays on Images 

TWAIN Support / Image Acquisition 

Web Publishing Wizard version 1.5 

WYSIWYG Frames Page Editing 



All Files View Optimized
The FrontPage 98 Explorer All Files view also features a way to easily arrange and sort "orphan" files (files 
without any links pointing to them) so you can more easily manage these files and keep the size of your web to a 
minimum.



Auto Thumbnail
Automatically creates a small thumbnail image of a graphic and links it to the larger original image from which it 
was created. Great for quickly creating "picture gallery" type web sites.



Banner Ad Manager
Makes it easy to display a series of graphics with transition effects between them as you rotate through the 
different images. This component makes it easy to create lightweight banner advertisements for your web site 
that catch users' eyes.



Cascading Style Sheet Support
Cascading Style Sheets (CSS) are an open specification endorsed by the World Wide Web gives web authors 
tremendous power in formatting web pages. CSS support gives web authors word processor-like control over the
text in HTML documents so you can define complex styles for things like paragraphs, documents, and collections
of documents so you can create extensive and dramatic page layout settings. FrontPage 98 can do 100% round 
tripping of all CSS attributes as well as provides an interface for setting CSS properties. Popular web browsers 
supporting CSS include Microsoft Internet Explorer 3.0 and higher, and Netscape Navigator 4.0. No longer do 
you have to be a programmer to tap into the power of CSS!



Channel Definition Format (CDF) Channel Wizard
Users of FrontPage can take advantage of the exciting new world of Push technology. With the CDF Channel 
Definition Wizard, users can quickly turn their web site into a "channel" that users can "subscribe" to for 
automatic delivery to any desktop running Internet Explorer 4.0.



Clip Gallery Live
Want even more clip art? From within the Clip Gallery dialog you can download thousands of clip art images 
directly from the Microsoft web site. These images are automatically added to the Clip Gallery for easy access 
next time you need it.



Clip Art Gallery
FrontPage 98 sports the same Clip Gallery interface as Microsoft Office and Microsoft Publisher so you can 
easily preview and insert clip art through the familiar Clip Gallery interface. FrontPage 98 will ship with over 1000 
clip art images.



Database Region Wizard
The new Database Region Wizard lets you leverage the Active Server Pages functionality of Microsoft Internet 
Information Server to include dynamic database content directly into your web pages.



Design Time ActiveX Control Support
Design Time ActiveX Controls are a new type of component that lets third parties extend the web authoring 
capabilities of FrontPage 98.



Dynamic HTML Support
Dynamic HTML is a new web page object model specification developed by Microsoft and submitted to the World
Wide Web Consortium that allows programmers to manipulate web pages and their elements in exciting and 
powerful ways. Since the mission of FrontPage is to create "professional quality web sites without programming,"
FrontPage 98 has a range of features that let you take advantage of the benefits of Dynamic HTML without 
having to program the Dynamic HTML object model.



Dynamic Outlining (Dynamic HTML)
Create expanding and collapsing outlines in your web pages with no programming required. What used to 
require sophisticated scripting, ActiveX™ controls, or Java™ programming can now be done within a simple-to-
use FrontPage dialog. Best of all, you get this new functionality while still having the easy to use editing 
environment of FrontPage.



Easier Hyperlinks
The Insert Hyperlinks dialog has been completely redesigned in FrontPage 98 for dramatically enhanced ease of 
use and web author productivity. With the help of extensive usability tests, the new hyperlinks dialog makes it 
even easier to link to new pages, existing pages in the web, pages on the Internet, or directly to e-mail 
addresses. We've also simplified linking to bookmarks and specifying link targets when using frames pages.



Easy Web Publishing
FrontPage 98 offers one-button web publishing! The web publishing interface has been dramatically simplified 
from FrontPage 97.FrontPage intelligently only publishes files that have changed since you last published, and 
will automatically detect changes made by others in a multi-user environment, giving you the ability to resolve 
conflicting changes among different users. And if you don't already host your web with a FrontPage Web 
Presence Provider (WPP) you're invited to click one button to visit a list of registered FrontPage WPP's that 
Microsoft maintains on its web site.



Editor Integrated with Internet Explorer
Microsoft FrontPage 98 Editor will seamless integrate with Internet Explorer 4.0 so that when you browse to a 
page you've published you can press the Edit button in Internet Explorer to edit it in the FrontPage 98 Editor then
save the changes back to the server -- all while browsing with Internet Explorer 4.0! This increased integration 
between your web browser and web editor makes updates fast and easy. FrontPage also includes a new Go 
menu with commands to activate other members of the Internet Explorer 4.0 suite of tools, such as mail or news.



Editor Views Tabs
Easy to discover and easy to use, the FrontPage 98 Editor features new tabs at the bottom of the screen so you 
can quickly toggle between several views of your web page such as the improved and editable HTML code view, 
the Preview view, and the Normal view. When a frames page is loaded in the editor two additional tabs give you 
easy access to your frames page HTML code and the alternate "No Frames" web page that users with frames-
incompatible browsers will see when visiting your page.



Enhanced Form Creation
Creating a form has never been simpler! When you add your first form field to your web page FrontPage 98 will 
automatically insert "Submit" and "Reset" buttons so you don't have to! These buttons are needed for most 
forms, and FrontPage 98 takes the guess work out of forms creation by creating these for you automatically.



Enhanced Support for "Hand Coded" HTML
If your web authoring style is to work directly with HTML source code FrontPage 98 makes it dramatically easier 
to edit your raw HTML. FrontPage will preserve more of your hand-formatting of HTML source, and includes 
better auto-formatting algorithms to make the generated HTML code easier to read.



Form Field Extensions (Dynamic HTML)
An Accessibility feature this gives all users the ability to quickly access web page form fields via the keyboard by 
letting you define the tab order and "ALT+" key shortcuts for all your form fields.



Form Save Results to E-Mail
Ever forget to check your database or web server text file for newly submitted forms from your web? Ever wanted
the form results to simply be sent directly to your e-mail inbox? Well, with this FrontPage 98 feature you can do 
exactly that! With the new simplified Form Save Results component you simply tell FrontPage that when users 
fill-out and submit a form on your web site send it directly to your e-mail address. What used to require 
programming a custom script is now conveniently available in FrontPage 98 so you don't have to be a 
programmer to get this powerful functionality.



FrontPage Themes
Create a great looking web quickly with over 50 professionally designed themes you can apply to your entire web
or to separate pages. Backgrounds, bullets, banners, hyperlinks and navigation bars will have a great looking 
and consistent appearance — all without your having to be a graphic designer.



Getting Started — Most Recently Used List
Similar to the "Most Recently Used" list in other Microsoft applications such as Microsoft Office with FrontPage 
98 you can easily open any of your most recently used web sites, without ever having to type in a URL!



Graphical Bullets
FrontPage lets you specify custom images to use in place of the plain old bullets you normally find on web 
pages. The FrontPage Editor is smart enough to let you edit these graphical bulleted lists just as easily as a plain
list. When you apply a theme, matching graphical bullets are automatically applied to existing or newly created 
bulleted lists.



Hit Counter
No programming is required to keep track of how many hits your web page receives. Insert the Hit Counter 
component with a simple menu command, and easily change the number display style and the visual display for 
the number of visits to your page.



Hover Buttons
Hover buttons add life to your web page so when a user "hovers" over the button or clicks on it, it will change 
colors or shape, or animate any way you choose. This automatic feature of FrontPage 98 essentially creates a 
small Java™ applet without your having to know Java and helps deliver on the promise of making professional 
quality web sites without programming and without a graphic designer.



Image Preview
Save time with this new feature in FrontPage 98 that let's you preview your images before you actually insert 
them into your web page, making it easy to pick just the right images for your site.



Improved Active Server Page Interoperability
FrontPage 98 manages hyperlinks found within Active Server Page (ASP) script code. And web pages containing
ASP code can now be edited with greater fidelity using the FrontPage 98 Editor.



Improved Getting Started Dialog
A simpler Getting Started dialog makes it easier to get results. We also include a default web that provides a 
starting point for beginning users to get up and running on the web quickly.



Improved Image Editing Tools
New image editing tools in the FrontPage Editor make it easy for users to bevel, crop, flip, rotate or automatically 
washout images. Especially great for those images scanned in directly from digital cameras or scanners with 
FrontPage 98's TWAIN support. FrontPage 98 also lets you resample an image to shrink the physical image to a 
scaled down size to reduce the download time of large images.



Improved Import Wizard
The improved Import Wizard supports importing from a URL, in addition to a file directory. You can also limit how 
much data to import by the # of link levels, K of data, or limit it to just text and images.



Improved Table Editing
FrontPage 98 gives you visual control over the structure and layout of your table and its rows and columns. Use 
Drag & Drop to move or copy your table rows and columns. Resizing rows and columns is as easy as selecting a
border with your mouse and moving it where you want. Finally, the new "Distribute Rows Evenly" and "Distribute 
Columns Evenly" commands evenly spaces your rows and columns with just a click of the mouse.



In-place HTML Editing
The improved editable HTML view has moved from a dialog box into the FrontPage 98 Editor editing window 
making it easier for those wanting to manually edit the HTML to do so just as they would in any code or text 
editor.



In-place Page Preview
Preview your web page, even those including animations and active elements, right within the FrontPage 98 
Editor just by clicking on a tab at the bottom of the screen! Makes previewing web pages quicker and simpler 
than ever before.



Integration with Netscape Communicator
Using Netscape Communicator? No problem. The FrontPage 98 Editor will seamlessly integrate with 
Communicator, replacing the limited function Composer editor, and become the default HTML editor if you wish, 
giving you all the powerful functionality of FrontPage right from within Communicator!



Manage Orphan Files
The FrontPage 98 Explorer All Files view also features a way to easily arrange and sort "orphan" files (files 
without any links pointing to them) so you can more easily manage these files and keep the size of your web to a 
minimum.



Microsoft Commercial Internet Services Membership Integration
Membership is a feature of the Microsoft Commercial Internet System (MCIS) used by Internet Service Providers.
Many Web Presence Providers offering FrontPage-hosted web services also offer Membership Services, and 
now with support for this in FrontPage 98, web authors and their ISP's gain the benefit of one user log on to all of
the ISP's services.



Modify Navigation View "Site Maps"
Easily modify the structure of your web site with the Navigation View where you can add pages and rearrange 
links via drag and drop. Expanding and collapsing your view of the Navigation structure to make it easier for you 
to work with it is as simple as a few mouse clicks. And you can even "shrink to fit" the view using the resize 
command.



Navigation View
Navigation View is an innovative site creation and management feature that lets you create and manage the 
navigational structure of your web site within seconds. It's easy to connect new pages and move pages around in
your structure and as you make these changes FrontPage will automatically generate the appropriate navigation 
bars on each web page. You can rotate, size to fit on the screen, and even print a "site map" from the new 
Navigation View.



Navigation View and Navigation Bars
Include automatically generated Navigation Bars on your web pages with just a few simple clicks of the mouse. 
FrontPage 98 lets you specify the levels and hyperlink styles you wish to include for defining a consistent 
navigational structure for your site. And using the new Navigation View in the FrontPage Explorer, the Navigation 
Bars are regenerated for you automatically any time you change the structure of your web.



New Templates
Get a jumpstart on your page layout design by using one of over 17 new web page templates. These new 
templates contain professionally designed page layouts you can use to quickly create great looking pages — just
add content!



New Views Bar
FrontPage 98 Explorer features a new Views bar along the left side that gives you one-click access to all of the 
FrontPage views, including the new Navigation, All Files, and Themes views. Similar in style to the Outlook™ Bar
found in the Microsoft Outlook desktop information manager, the FrontPage Views Bar contains other views such
as Folders, Hyperlinks, Hyperlink Status (formerly Verify Hyperlinks), and Tasks (formerly To Do List).



Page Transitions (Dynamic HTML)
Choose from a variety of different page transitions so people browsing your web with Internet Explorer 4.0 can 
experience stunning visual effects when navigating between pages, similar to what's available in presentation 
packages like Microsoft PowerPoint.



Paste Plain Text
The new Paste Special command matches the functionality of other Microsoft Office applications and allows you 
to paste text from other applications either as plain text or as formatted text.



Performance Improvements
In FrontPage 98 the Explorer and Editor boot speed, page save speed, and time to open a web have all been 
improved.



Print Navigation View "Site Maps'
At last! FrontPage 98 lets you print out the graphical structure of your web site directly from the FrontPage 
Explorer.



Scalability Improvements
The FrontPage ability to handle large webs has also been improved.



Server Extensions Improvements
Making it easier for Web Presence Providers and web administrators to host multiple FrontPage web sites is a 
major focus of FrontPage 98. For more information about improvements in remote administration, multi-hosting, 
or improved Apache or IIS support please refer to the FrontPage 98 Server Extensions Resource Kit on the CD 
or online at http://www.microsoft.com/frontpage.



Shared Borders
The new Shared Borders feature allows you to specify shared headers or footers (horizontal or vertical) across 
the pages in your web site. This provides you a great deal of design flexibility in creating a great looking, but 
consistently designed web site.



Simplified Form Save Results Components
Setting up how your web handles the results of forms is now easy with the improved Save Results component. 
An intuitive and streamlined user interface gives you more power and control than ever in an easy to use manner
so you can set up how your forms are handled.



Table Drawing Tools
Design the layout of your web page more quickly and easily than ever before with the pixel-level precision of the 
new Table drawing tools. Create tables using the equivalent of a pencil and an eraser to draw tables of any size 
or shape directly on your web page. With the table drawing tools you have the flexibility to precisely design the 
layout of a page by fitting a table to your content. Include in your table any information you'd like, including 
images, text, multimedia files, and even tables nested within your table. Sophisticated web page layout without 
manually coding HTML is now a reality.



Text Animations (Dynamic HTML)
Easily create text animations like text flying in from off screen, or words that are revealed letter by letter. With this
type of Dynamic HTML support you can easily create animation effects for your web page that you'd usually 
expect to find only in presentation applications like the Microsoft PowerPoint® presentation graphics program.



Text Overlays on Images
Add text directly onto your images so now creating page elements like graphical buttons is a snap!



TWAIN Support / Image Acquisition
Built-in TWAIN support means you can scan images directly into FrontPage from your scanner or digital camera 
making it easy and fun to add your personal or company photographs and other "just-in-time" images to your 
web!



Web Publishing Wizard version 1.5
The new version of this wizard is designed for users publishing their webs to servers that do not contain the 
FrontPage Server Extensions. Web Publishing Wizard version 1.5 takes advantage of the FrontPage 98 one-
button-publishing feature and is smart enough to forestall the most common errors that can occur when 
publishing your web to the world using alternate publishing methods like FTP or via the America Online service.



WYSIWYG Frames Page Editing
Create and modify frames pages directly within the Editor in a truly WYSYWIG fashion. Choose to create frames 
from templates provided or create a custom frames grid with a few clicks of the mouse, then edit the pages and 
frames page directly on the screen. Creating and editing frames just as they'll appear in the browser is now 
remarkably simple.



To moderate a discussion group
1 In the FrontPage Explorer, on the Tools menu, choose Web Settings.
2 In the Advanced tab, select Show Documents in Hidden Directories.
3 Click OK.
4 On the View menu, choose Refresh.
5 Change to the Folders view to see the pages (named 0001.htm, 0002.htm, etc.) created by users.

Do not delete offending articles. Open them in the FrontPage Editor and type a standard message replacing 
the article body, such as "[Deleted Article]." This will protect forward and backward hyperlinks to other articles 
in the thread.

{button Related Procedures,AL(`field form procedures',0,`',`main')}



To add tab order to a form 
Adding tab order to a form lets a user move from field to field within a form using the TAB key. 

Only Internet Explorer 4.0 or later supports tab order. If you leave the tab order blank, Internet Explorer 4.0 will 
use the default order, like previous versions of Internet Explorer. The settings for tab order will be ignored by 
earlier versions of Internet Explorer and other Web browsers. If the tab order is set, it will not change the 
behavior of form fields in other Web browsers. 

1 In the FrontPage Editor, open the form field properties dialog box for the form field for which you want to set 
tab order.

2 In the Tab Order field, enter a number 1 through 999 to establish the order to use for navigating between fields
in a form. If two fields share the same number, the field defined earlier on the page will come first. Enter -1 to 
remove the control from the tab order.

3 Click OK.
4 Repeat Steps 1-3 for each form field for which you want to set tab order.
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To make a form field label "clickable"
Note      This feature will only be enabled in Web browsers that support Dynamic HTML, such as Microsoft 
Internet Explorer 4.0.
1 In the FrontPage Editor, move the insertion point next to the form field for which you want to create a 

"clickable" label.
2 Type the label you want — unless it already exists — then select the label and the form field.
3 On the Insert menu, choose Form Field, then click Label.

FrontPage makes the label clickable.
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To add an access key to a form field label
You can create an underlined "access key" for a form field label, which lets a user press ALT plus another key 
instead of clicking the label or form field. For example, the access key for the FrontPage Editor's File menu is the
letter 'F'; instead of clicking to display the File menu, a user can press ALT+F.

Note      This feature will only be enabled in Web browsers that support Dynamic HTML, such as Microsoft 
Internet Explorer 4.0.
1 In the FrontPage Editor, select the label letter that you want to make the access key.

2 Click the Underline button  on the standard toolbar.
FrontPage makes the access key.
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FrontPage Advanced Components
By using the advanced components that are built into the FrontPage Editor, you can take advantage of the latest 
developments in Web browser technology. In the FrontPage Editor, the following advanced components are 
available on the Insert menu: ActiveX control, Java applet, plug-in, script, and Design-Time control. 

ActiveX controls are software components that provide dynamic features on your pages. For example, a stock 
ticker control could be used to add a live stock ticker to a page, or an animation control could be used to add 
animation features. To insert a control, you must first have it installed on your machine. For more detailed 
information about ActiveX controls, and to see a gallery of free controls that are available on the World Wide 
Web, visit http://activex.microsoft.com/ 

When an author is using the FrontPage Editor, Design Time controls are a set of interfaces for ActiveX controls 
that allow design-time editing and manipulation of a control. 

Java applets are similar to ActiveX controls. They are software components written in the Java programming 
language called Java that provide dynamic features on your Web page. A software vendor might choose to 
create a product as a Java applet because its interpreted nature lets it run on several different hardware 
platforms. Inserting a Java applet is similar to inserting an ActiveX control. 

Plug-ins are platform-specific components for pages. Originally designed for Netscape Navigator 2.0, they are 
supported in Microsoft Internet Explorer 3.0 and higher versions as well.

Scripting is a method for writing that you can use to write custom code for your Web page. This is an advanced 
FrontPage feature that requires knowledge of programming. Scripting is useful for custom Web-based solutions 
development. It provides a full object model for the Web browser and the objects on the current page. This 
makes it easy to write code that manipulates elements on the page without knowing the details of the HTML or 
how the objects are implemented. You can also use the Script Wizard included in FrontPage 98 to create script 
code that is specifically designed to handle events that occur on objects (such as ActiveX controls) on your page.
The Script Wizard includes its own online Help system.
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About Files
Using the FrontPage Explorer, you can import files of any format into a FrontPage web. Once a file is in your 
FrontPage web, you can create hyperlinks to it from pages in the web. This is a powerful way to share any 
general data with users of your FrontPage web. When an end user follows a hyperlink to a file of some format, 
the Web browser will launch a helper application that understands the format, so that the user can view (or hear) 
the file correctly. You can also associate a filename extension with an editor on the FrontPage Explorer. This lets 
you launch editing sessions for any file in your FrontPage web from the FrontPage Explorer.

Microsoft Office 97 documents support hyperlinks in documents. When you import a Microsoft Office 97 
document into your FrontPage web, all hyperlinks are preserved and will appear in the FrontPage Explorer's 
views. If you rename or move any file in your FrontPage web, the FrontPage Explorer updates all hyperlink 
references to that file within the FrontPage web, including hyperlinks from Microsoft Office 97 documents. 

You can also insert or open a file in the FrontPage Editor, and the FrontPage Editor will convert it to HTML. You 
can insert many types of files, including Microsoft Word, Microsoft Excel, and WordPerfect. If you try to insert a 
file with a filename extension that FrontPage does not recognize, or if the contents of the file do not appear to 
match the type indicated by the filename extension, the FrontPage Editor displays the Open File As dialog box so
you can indicate whether the file should be inserted in HTML, RTF, or text format. If you change the contents of 
the file after inserting it, you must insert it again to update it.
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About Forms
A form is a collection of form fields on a page and a form handler, which is a method of collecting information 
from the form. Forms are a key to making your FrontPage web interactive. Users can "talk back" to your 
FrontPage web by filling in forms in your FrontPage web and submitting them. The layout of a form can include 
form fields, text in all paragraph styles, tables, images, and most other objects that can be inserted on a page. In 
FrontPage, you create forms and fields using an easy to use, point-and-click interface.

A user fills in a form by typing into text fields, clicking radio buttons and check boxes, and selecting options from 
drop-down menus. The user then submits the form by clicking a button, usually labeled "Submit." When this 
happens, FrontPage adds the contents of the form to a file in your FrontPage web. This is the file you will 
periodically open to gather the collected information from the form. You can also configure a form to send its data
to your e-mail address.

A form's handler is not visible to a user but is associated with a form by FrontPage. It starts its operation when a 
user submits the form. FrontPage automatically assigns a default form handler to each form that you create. You 
can also select from a set of FrontPage form handlers or add you own custom form handler to a form.

The uses of forms on the World Wide Web are always evolving. Some typical uses include collecting names, 
addresses, telephone numbers, e-mail addresses, and other information to register users for a service or event, 
collecting feedback about a Web site, or gather information for the purchase of an item or service. 
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Viewing and Editing HTML
The HTML view in the FrontPage Editor gives you access to the HTML that FrontPage generates. Select the 
HTML tab at the bottom-left corner of the FrontPage Editor's window to view or edit this HTML. HTML attributes 
and their values are color coded so that you can distinguish them more easily. When you enter HTML tags or a 
page's contents in this view, you can use standard word-processing commands such as cutting, pasting, finding, 
and replacing. Any changes you make in the HTML view are immediately incorporated into the FrontPage 
Editor's Normal view.
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Language and Character Encoding
With FrontPage, you can change the HTML character encodingwhen you save or load a page. You can save a 
page in a different character set from the default character set for the current FrontPage web or from the 
character set for your computer if no web is open. If the text on a page does not display correctly after opening 
the page, you can select a different character set for loading the page.

If no font is specified for displaying text in the FrontPage Editor, you can specify the language or character set in 
which to display text. FrontPage lists the available languages or character sets that are installed on your 
computer.
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About Pages
Pages are the basic documents of the World Wide Web. They are written in an evolving language called HTML 
(HyperText Markup Language). An HTML page contains text and HTML tags — embedded commands that 
supply information about the page's structure, appearance, and contents. 

Some HTML tags build a description of the structure of the elements on a page, such as tables and forms, which 
are made up of many elements. Web browsers (programs that display pages) use this information to determine 
how to display the page elements in relation to each other. For example, the HTML tags that describe a table 
specify the number of rows it has, the number of cells in a row, and so forth.

In addition to describing the structure of page elements, some HTML tags also contain attributes. Attributes 
provide details about a particular tag. For instance, the tag that inserts an image on a page has an attribute that 
supplies the name of the image to insert. Some attributes supply preferences about the layout of the page 
element. For example, a table has attributes that describe its border width and the padding between its cells.

The FrontPage Editor is the FrontPage tool for creating, editing, and testing World Wide Web pages. As you add 
text, images, tables, form fields, and other elements to your page, the FrontPage Editor displays them as they 
would appear in a Web browser.

You do not need to know HTML to use FrontPage. The FrontPage Editor creates the HTML in the background, 
adding tags and filling in attributes based on your choices. You create and edit pages using a familiar, word-
processor interface. In the FrontPage Editor, you can add text, images, tables, form fields, hover buttons, 
marquees and many other elements to a page. You can add HTML by hand using the FrontPage Editor's HTML 
view, but only if you want to.

Because a page can combine many elements, designing pages so that all the elements have a consistent, 
professional look can be time consuming. To help you create well-designed pages quickly, FrontPage has over 
50 professionally-designed themes that use coordinated designs for bullets, fonts, images, navigation bars, and 
other page elements. 

To see how the pages you are working on look in a Web browser, you can select the Preview tab in the bottom-
left corner of the FrontPage Editor window. To view or edit the HTML that FrontPage generates, click the HTML 
tab. 
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Tasks Overview
The Tasks view in the FrontPage Explorer is a list of tasks required to complete a FrontPage web. Each 
FrontPage web you have can have its own list of tasks in this view. When multiple authors are creating or editing 
a FrontPage web, the Tasks view can help them keep track of who is working on the web and what each author's
assignments are.

You can add tasks and modify their names, assignments, and descriptions. You can also remove tasks from the 
list at anytime. When a task has been completed, you can mark it completed then archive it or delete it from the 
Tasks view.

Some of the Wizards in the FrontPage Explorer and some FrontPage Editor commands add tasks to the Tasks 
view and link them to the appropriate web page or file. When a task is linked to a page or file, you can open that 
page or file in the FrontPage Editor (or editor you have associated with a page or file) from the Tasks view. 
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Adding Security on Your Web
If you create and edit FrontPage webs directly on a World Wide Web or intranet server, FrontPage offers a set of 
useful administrative tools for setting web permissions and limiting access to FrontPage webs from specified 
computers. FrontPage security is based on the security mechanism used by the Web server and on the 
operating system on which the Web server is running. 

 For each FrontPage web on your Web server, you can set the following types of permissions:

· Browsing permission gives a user, a group of users, or specific computers permission to view the FrontPage 
web after it has been published on the World Wide Web or your organization's intranet.

· Authoring permission gives a user, a group of users, or specific computers permission to open the FrontPage 
web in the FrontPage Explorer and create and edit pages and files in the FrontPage Editor.

· Administering permission gives a user, group of users, or specific computers permission to administer the 
current FrontPage web. An administrator of the root web can create new FrontPage webs and set permissions
for other users and computers.

The root web is the top-level web on your Web server. All other FrontPage webs on the Web server inherit their 
permissions from the root web by default. In the FrontPage Explorer, you can assign unique permissions for any 
FrontPage web in the Settings tab of the Permissions dialog box.

FrontPage web permissions are hierarchical. This means that a user with administrative permissions also has 
authoring and browsing permissions; a user with authoring permissions also has browsing permissions. When 
you set permissions for administering, authoring, or browsing a FrontPage web, the Web server requests a name
and password for any task that requires permissions; however you may not see the prompt because, with some 
Web servers, FrontPage will send the name and password you are currently logged in with.

On some Web servers, you can also set permissions for computers, based on their IP addresses. You can set 
permissions for a group of computers using the asterisk character (*) to create an IP address mask. For example,
the IP address mask 127.*.*.* applies to all computers with IP addresses beginning with 127. In this scenario, a 
user, author, or administrator must not only have sufficient permissions to access the FrontPage web, but must 
also be working on a computer that has the appropriate level of permissions. By default, all computers have 
permissions to browse to a FrontPage web.

Note      You should not use IP address restrictions on computer networks that do not support fixed IP addresses.
When using Microsoft Internet Information Server or Microsoft Personal Web Server 1.0 (in configurations that 
support security), you can only set permissions for users or groups of users that are known to the Web server. 
With these Web servers, you cannot use FrontPage to add new users or groups, or to set passwords. You must 
use the operating system's features to create and manage users and groups. With Microsoft Personal Web 
Server 4.0, you cannot set permissions for your webs. All users on the network can browse to your FrontPage 
webs, and authoring and administering webs is permitted only from the computer on which the Web server itself 
is installed.

If you use other Web servers, you can create users, assign names and passwords, and give these users 
administrative, authoring, or browsing permissions.
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About Text Editing
The FrontPage Editor supplies a full text-editing interface. Using menu commands, toolbar buttons, and keyboard
shortcuts, you format text, cut, copy, and paste it, merge paragraphs, create lists and sub-lists, and do other 
familiar word-processing tasks. The FrontPage Editor lays the page out in WYSIWYG fashion and also generates
the underlying HTML.

If a theme has been applied to the page, the properties of the paragraph styles — such as fonts, sizes, colors, 
bullet and numbered list styles, and alignment — are set by the theme. You apply paragraph styles, such as 
Heading 1 or Body Text, to selected text from the Change Style window.

If the page does not use a theme, you set a paragraph style when you create it. You can change a paragraph's 
style from the Change Style window or the Paragraph Properties dialog box.

Characters have default attributes based on the format of the paragraph containing them. You can override the 
defaults and set character attributes to control color, size, boldness, subscripting and superscripting, and other 
character properties.
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To change the text of a button in a navigation bar
1 In the Navigation pane of the FrontPage Explorer's Navigation view, select the page for which you want to 

change the text of the button.
2 Press F2, type in the new text, then press ENTER.
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To assign shared borders to a FrontPage web
1 On the FrontPage Explorer's Tools menu, choose Shared Borders.
2 In the Shared Borders dialog box, select one or more of the shared borders: Top, Bottom, Left, and Right.
3 Click OK.
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Navigation Tab, FrontPage Web Settings Dialog Box
Use the Navigation tab to change the text of labels on navigation bars. When you change a label, you are only 
changing the text of the label, you are not changing the target of the navigation bar's    hyperlinks.

Dialog Box Options

Home Page
The default label for the home page is Home.

Parent Page
The default label for the parent page is Up.

Previous Page
The default label for the previous page is Back.

Next Page
The default label for the next page is Next.

Default
If you have changed one or all of the navigation bar's labels, click Default to change all the labels to their default 
names.

Apply
Click Apply to apply any changes you have made.
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Navigation Button Properties Dialog Box
Use the Navigation Button Properties dialog box when you are editing a page that is part of a FrontPage web 
structure to specify the page to display when a user clicks the button and whether the button will be an image or 
text. 

When you use the Navigation view in the FrontPage Explorer to create a structure for your FrontPage web, 
FrontPage creates navigation bars that contain hyperlinks to pages within the structure. The names for some of 
those hyperlinks that appear on the navigation bar describe the relationship of those pages, such as Home, Up, 
Back, and Next.

Dialog Box Options

Page to Display
Use the options in this section to indicate what page will display when a user clicks the button. If you choose an 
relationship between a page that does not exist in the FrontPage web structure, FrontPage puts the word 
"button" in brackets, and when the page is saved, the hyperlink will not be created if the corresponding page 
does not exist.

Home

Select this option to create a hyperlink to the home page.

Up

Select this option to create a hyperlink to the page above in the FrontPage web structure.

Back

Select this option to create a hyperlink to the previous page in the FrontPage web structure.

Next

Select this option to create a hyperlink to the next page in the FrontPage web structure.

Appearance
Use the options in this section to indicate whether the button will be an image or text. If you are using a theme on
the page you are editing, the button will be an image.

Button

Select this option to have the button be an image.

Text

Select this option to have the button be text.
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About Microsoft FrontPage 98
Welcome to Microsoft FrontPage 98, the web creation and management tool that requires no programming 
knowledge but is robust enough for experienced Web site developers. FrontPage 98 has everything you need to 
design and build a great-looking, easy to navigate World Wide Web site.

FrontPage 98 includes the FrontPage Explorer, where you create, design, and manage your entire Web site, and
the FrontPage Editor, where you create and edit Web pages without needing to know HyperText Markup 
Language (HTML). FrontPage includes many features that make Web-site creation easy for any user, such as a 
gallery of professionally designed graphical themes, a full set of wizards and templates for creating pages and 
FrontPage webs, active page elements for providing complex functionality without programming, and a Tasks list 
for tracking tasks as you create your FrontPage web.

You use the FrontPage Explorer to create the structure or layout of your Web site, apply graphical themes to its 
pages, organize its files and folders, import and export files, test and repair hyperlinks, administer access 
privileges, track tasks, and launch the FrontPage Editor to design and edit the contents of your Web pages. 
When your FrontPage web is completed, you use the FrontPage Explorer to publish it on your computer, your 
organization’s intranet, or the World Wide Web.

You use the FrontPage Editor to create, design, and edit World Wide Web pages. As you add text, images, 
tables, form fields, and other elements to your page, the FrontPage Editor displays them as they would appear in
a Web browser. Although it is a powerful tool, the FrontPage Editor is easy to use because of its familiar, word-
processor interface. You do not need to learn hypertext markup language (HTML) to use the FrontPage Editor 
because it creates all the HTML code for you.

If you want to edit HTML code directly, you can using the FrontPage Editor’s HTML view. In this view, you can 
enter text, edit HTML tags or script code, and use standard word-processing commands such as cutting, pasting,
finding, and replacing.

FrontPage is a member of the Microsoft Office family of products, and shares many of the features of Microsoft 
Word and Microsoft Excel, such as the Microsoft Clip Gallery, global spell checking and thesaurus, and easy 
table-editing. FrontPage 98 also manages hyperlinks created in Microsoft Office 97 documents.

For more information, explore the following topics:

The FrontPage Explorer

The FrontPage Editor



The FrontPage Explorer
The Microsoft FrontPage Explorer is a tool for creating, organizing, administering, and publishing FrontPage 
webs. Using the FrontPage Explorer, you create the structure or layout of your Web site, arrange its files and 
folders, import and export pages and files, test and repair hyperlinks, administer access privileges, and launch 
the FrontPage Editor to design and edit the contents of your Web pages. You also use the FrontPage Explorer to 
publish completed FrontPage webs on your computer, your organization’s intranet, or the World Wide Web.

A FrontPage web is a collection of HTML pages, images, documents, and other files and folders that make up a 
Web site. Authors can create, delete, open, edit, and close FrontPage webs using the FrontPage Explorer and 
FrontPage Editor on a client computer. FrontPage webs can be stored on a remote Web server, a Web server 
running on the same computer as the client program, or in the client computer’s file system.

A FrontPage web also contains a number of support files that provide added functionality with sophisticated 
features such as navigation bars, hyperlink recalculation and repair, full text index generation, consistent design 
elements from themes, automatic table of contents generation, and built-in forms handling.

Here are some of the key features of the FrontPage Explorer:

· You can quickly create professional-looking Web sites using the built-in web templates and wizards. For 
example, you can create a corporate presence on the World Wide Web with the Corporate Presence Wizard; 
launch a Customer Support site with the Customer Support Web template; host a discussion group with the 
Discussion Web Wizard; or publish a project management web with the Project Web template.

· If you have an existing Web site, you can easily convert it to a full-featured FrontPage web with the FrontPage
Explorer’s Import Web Wizard. In a few steps, this wizard imports your pages, images, and files, while 
preserving the web’s structure as well as its hyperlinks.

· You can import files to your FrontPage web by specifying a folder in your file system to import its contents. 
You can also export files from your FrontPage web to your file system.

· You can display and maintain the files, folders, hyperlinks, and layout of a FrontPage web by selecting any of 
the FrontPage Explorer’s seven views. Each view gives you a different perspective of a FrontPage web, 
designed to assist you in maintaining FrontPage webs from their creation until their publication to a Web 
server.

· In the FrontPage Explorer, you can apply one or more shared borders — page regions that are reserved for 
content that you want to appear consistently throughout your pages. Shared borders usually contain 
navigation bars — hyperlinks to the other pages in the current FrontPage web. When you create a FrontPage 
web in the FrontPage Explorer’s Navigation view, FrontPage can create shared borders and navigation bars 
that are automatically updated whenever you add, move, or delete pages from the web’s structure.

· FrontPage includes a gallery of professionally designed graphics and color schemes — called themes — that 
can be applied to any FrontPage web. Themes enhance the appearance of list bullets, fonts, navigation bars, 
table borders, horizontal lines, and page backgrounds, and they lend an attractive and consistent appearance 
to any FrontPage web.

· You can double-click any HTML page in the FrontPage Explorer and it will open for editing in the FrontPage 
Editor. In the FrontPage Explorer, you can also associate other editors for other file types in your FrontPage 
web. When you double-click a file that has been associated with an editor, it will open in that editor.

· When your FrontPage web is ready to be published on the World Wide Web — or on your organization’s 
intranet — the FrontPage Explorer’s Publish command transfers the pages and files to the World Wide Web 
or a Web server while automatically verifying the addresses of pages and the paths to your files.

· If you use the FrontPage Explorer to rename or move a file in your FrontPage web, all hyperlink references to 
that file are automatically updated within the FrontPage web, including hyperlinks from Microsoft Office 97 
documents. You can also verify and repair broken hyperlinks, including hyperlinks to external World Wide Web
sites. In a multi-authoring environment, you can refresh hyperlinks to incorporate and view recent changes 
made to the FrontPage web by other authors.

· Using the Tasks view in the FrontPage Explorer, you can track and complete any unfinished FrontPage web 
tasks (such as spell-checking corrections) on all pages. Clicking a task can take you right to the page that 
needs work. Some tasks are generated automatically as you create and maintain a FrontPage web; you can 
add other tasks and assign them to other FrontPage authors.

· In multi-user environments, you can protect a FrontPage web from unauthorized access by requiring a logon 
username and password for browsing or authoring access.
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The FrontPage Editor
The Microsoft FrontPage Editor is a tool for creating, designing, and editing World Wide Web pages. As you add 
text, images, tables, form fields, and other elements to your page, the FrontPage Editor displays them as they 
would appear in a Web browser.

You do not need to learn HTML to use the FrontPage Editor because it creates all the HTML code for you. The 
FrontPage Editor generates all the popular HTML tags, including extensions such as cascading style sheets, 
frames, and ActiveX Controls.

If you want to edit the HTML code directly, you can use the FrontPage Editor’s HTML view. In this view, you can 
enter text, edit HTML tags, and use standard word-processing commands such as cutting, pasting, and find and 
replace.

Although it is a powerful tool, the FrontPage Editor is easy to use because of its familiar, word-processor 
interface.

Here are some of the key features of the FrontPage Editor:

· You can create new HTML pages based on page wizards and templates. The FrontPage Editor offers many 
choices of page formats, and you can create your own templates.

· You can apply one of the many FrontPage themes, created by professional designers, to give your pages a 
dynamic, colorful appearance. You can also add and design borders for your pages and insert navigation 
bars, which guide your users around your Web site.

· You can open any HTML file in the FrontPage Editor and all the HTML tags on the page are preserved. You 
can also open files of many popular types, and the FrontPage Editor converts them to HTML. Some of the file 
types you can open are Microsoft Word 2.0 and 6.0, Microsoft Word 6.0 for MS-DOS, Microsoft Word 95 and 
97, Microsoft Excel 4.0 and 5.0, Microsoft Excel 95 and 97, and WordPerfect 6.x. The FrontPage Editor 
preserves hyperlinks from Microsoft Office 97 documents.

· You can insert text in all HTML styles, create multilevel lists, change text size and color, and apply formatting 
such as centering a heading or making text italic. Using cascading style sheet support, you can control 
margins, line spacing, colors, fonts faces and sizes.

· Using a point-and-click interface, you can create hyperlinks to pages and files in your FrontPage web or to 
pages and files on the World Wide Web. Point to a page and FrontPage creates the correct hyperlink syntax 
for you automatically.

· You can insert an image of almost any type, and the FrontPage Editor converts it into GIF or JPEG format. 
Double-click an image and it opens for editing in your favorite image-editing program. Create an image map 
by adding hotspots, areas in an image containing hyperlinks. Using FrontPage image-editing commands, you 
can crop, rotate, and resize an image, make it black and white, give it beveled edges, and change its 
brightness and contrast. FrontPage includes the Microsoft Clip Gallery, a large library of clip art, stock photos, 
and video clips.

· You can create forms containing text fields, check boxes, radio buttons, drop-down lists, and push buttons. 
When you create a form, the default FrontPage form handler automatically saves form information to a file or 
sends it to an e-mail address. You can select from a set of FrontPage form handlers or add you own custom 
form handler to a form.

· Using the FrontPage table-editing commands, you can create a table, insert rows and columns, align them, 
and create background colors, using a point-and-click interface.

· You can add powerful functionality to your page by inserting FrontPage components. They add interactive 
features such as navigation bars, threaded discussion groups, full-text searches, and form handlers that 
would otherwise require complex programming. For example, the Table of Contents component automatically 
creates an HTML outline of your FrontPage web with hyperlinks to each page, and the Banner Ad Manager 
replays a sequence of images using effects similar to a rotating billboard.

· You can create new frames pages, edit the appearance of your frames, and assign initial pages to each 
frame, all using a point-and click interface. FrontPage displays your frames pages in WYSIWYG style and 
generates the HTML.

· You can insert ActiveX Controls, plug-ins, and Java applets in the FrontPage Editor. You can launch a script-
editing session and create and insert JavaScript scripts and Microsoft Visual Basic Scripting Edition scripts.
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FrontPage Advanced Components
Overview

Inserting Advanced Components
To insert a Java applet

To insert a plug-in

To insert an ActiveX control

To insert an event script

To insert an inline script

Setting the Scripting Language
To set the default script language for the Script Wizard

To set the script language



To set the default script language for the Script Wizard
The Script Wizard lets you create scripts in either VBScript or JavaScript. However, you can use only one script 
language per page, and you cannot change the script language for a page that already contains script.

1 On the Insert menu, choose Advanced, then click Script.
2 In the Script dialog box, select VBScript or JavaScript.
3 Click OK.
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To set the script language
You can create scripts in either VBScript or JavaScript. However, you can use only one script language per page,
and you cannot change the script language for a page that already contains script.

1 On the Insert menu, choose Advanced, then click Script.
2 In the Script dialog box, select VBScript or JavaScript.
3 Click OK.
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FrontPage 98 Database Integration
Overview

Creating Database Regions
To create a database region

Editing IDC Files
To change an IDC file



Working With Files
Overview

Opening Files
To open a file from the FrontPage Explorer

To open a text file from the FrontPage Editor

To open an HTML file from the FrontPage Editor

To open an RTF file from the FrontPage Editor

Inserting Files
To insert a text file

To insert an HTML file

To insert an RTF file

Associating Files With Editors
To associate a file type with an editor

To change the associated editor for a file type

To remove the association between an editor and a file type

Renaming Files
To move a file

To rename a file 



To customize a video clip
Use this procedure to customize how a video clip on the active page plays when viewed in a Web browser.

Note      To edit the content of the video, double-click to open it in the video editor installed on your computer. If no
video editor is installed on your computer, you cannot edit the video itself.
1 In the FrontPage Editor, select the video clip that you want to customize, and then on the Edit menu, choose 

Image Properties.
2 On the Image Properties dialog box, click the Video tab, and then specify the options for playing the video 

when it is viewed in a user's Web browser:
· If you want the video to play with VCR buttons that let the user control the playback, select the Show 

Controls in Browser check box.
· Specify the number of times you want the video to repeat by typing a number in the Loop field, or select the

Forever check box for continuous play.
· Select the event that starts the video playback: On File Open starts the video when the page is loaded in 

the user's Web browser; On Mouse Over starts the video when a user moves a mouse over the video.
Note      If you have Microsoft Internet Explorer installed, you can immediately preview the video clip on the active
page by selecting the Preview tab in the FrontPage Editor.
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Change Style drop-down
Use the Change Style drop-down to change the paragraph style of the selection in the FrontPage Editor. If the 
page uses a theme, contains an embedded style sheet, or is linked to an external style sheet, the paragraph 
styles listed in the drop-down are defined by the theme or style sheet.
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About Images
Authors use images on their World Wide Web pages to provide information or decoration, to communicate their 
personal style or that of their organization, to display graphic artwork or pictures of products, and to create image
maps, which are images containing one or more hyperlink areas called hotspots.

In general, images on Web pages must be in either Graphics Interchange Format (GIF) or in Joint Photographic 
Expert Group format (JPEG). FrontPage lets you import images in the following formats: GIF, JPEG (standard 
and progressive), BMP (Windows and OS/2), TIFF, TGA, RAS, EPS, PCX, and WMF. FrontPage then converts 
these imported images to GIF format (for images containing up to 256 colors) or JPEG format (for images 
containing over 256 colors) when the page is saved to the current FrontPage web.

FrontPage has a complete interface for using images in FrontPage webs. In FrontPage, you can easily import 
images to your FrontPage web and insert them on pages, align them with text, create and edit image maps, 
create thumbnails, and use images in page design. You can also scan images from TWAIN-compatible scanners,
cameras, and other devices directly onto a page.

Along with its comprehensive set of image commands, FrontPage includes a full library of clip art from the 
Microsoft Clip Gallery: commonly used buttons, icons, background patterns, video clips, and other images that 
you can use in your FrontPage Web pages.

Image maps are images containing hyperlinks. A well designed image map gives users visual cues about where 
each hyperlink will take them. For example, an image map for a tourism bureau could be an actual map of a 
geographical region. By clicking a place of interest on the map, a user could follow a hyperlink to a topic 
describing the hotels and tourist attractions in that place. A business could use an image map to display pictures 
of its products. By clicking a product, a potential customer could follow a hyperlink to a topic describing the 
product.

In the FrontPage Editor, you can easily create image maps. Just insert the image on the page, and then use the 
commands on the Image Toolbar to create your hotspots.
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About Tables
Tables are made up of rows and columns of cells that can contain anything you might put on a page, such as 
text, images, forms, ActiveX controls, or FrontPage components. You can use tables to arrange data 
systematically or to organize the layout of a page. A table allows you to display text in side-by-side paragraphs or
arrange text next to graphics. Use a table to simulate columns of text, or use a fixed-pixel-width column to 
provide a margin for text on a page.

You can create a table quickly with the Draw Table command, which lets you define a table just by drawing the 
borders of the table, columns, and rows. After you create a table, you can customize it by adding rows and 
columns, changing the size of cells, and adding a caption. You can also convert existing text to a table and vice-
versa.

When you type text in a cell or insert text, images, forms and so on, the cell expands horizontally and vertically to
accommodate the elements that are typed or inserted. You can edit, format, and specify properties for the text or 
inserted element, as well as for the table cell, row, column, or table itself. You can easily resize cells, columns, 
rows, or the entire table by dragging borders.
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Using Navigation Bars and Shared Borders
Shared borders are page regions usually reserved for content that you want to appear consistently throughout all
pages of the current FrontPage web. Shared borders typically contain navigation bars — sets of hyperlinks to the
other pages in the current FrontPage web that help users navigate your Web site. When you create a FrontPage 
web in the FrontPage Explorer’s Navigation View, FrontPage creates shared borders and navigation bars that 
are updated whenever you add, move, or delete pages from the web’s structure.

You can enable shared borders and navigation bars for your entire FrontPage web in the FrontPage Explorer, or 
you can enable or disable them page-by-page in the FrontPage Editor. If you enable shared borders for your 
web, FrontPage will automatically create navigation bars based on the structure you create in the Navigation 
View, and will then insert the navigation bars into the shared borders. If a theme has been applied to the web or 
page, the navigation bars will use the fonts, colors, and other style elements from that theme.

When you edit the contents of a shared border using the FrontPage Editor, the changes apply to all pages in the 
current FrontPage web that use that shared border. For example, adding your name (or the name of your 
organization) to the Top shared border on one page will cause all other pages in that FrontPage web that use the
Top shared border to display the same name, in the same location.

If your FrontPage web was not created in the Navigation View, you can still enable shared borders for the entire 
web or page-by-page, and insert your own content into them. However, FrontPage will not create and insert 
navigation bars.
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Edit Page Command
Use the Edit Page command on the FrontPage Explorer's Hyperlink Status View shortcut menu to edit the page 
that contains the selected hyperlink. This opens the page in the FrontPage Editor, where you can repair a broken
hyperlink, delete a hyperlink, or add a new one.
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To create a navigation structure
You can create a navigation structure for the current FrontPage web by creating and organizing pages in the 
FrontPage Explorer's Navigation View. FrontPage creates navigation bars based on the navigation structure and 
then inserts the navigation bars into the shared borders of these pages.

· In general, to add new pages to the structure, click the New Page button  on the toolbar, or choose New 
Page or New Top Page on the shortcut menu.

· To create a new child page, select the parent page beneath which you want to add the new child page, and 
then click the New Page button or press the INSERT key.
· To add existing pages to the structure, drag them from the Files Pane into the Navigation Pane.
· To reorganize a navigation structure, drag and drop pages in the Navigation Pane.

FrontPage labels navigation bar buttons based on the page titles displayed on the structure in the Navigation 
Pane. To change the label on a navigation bar button, edit the page title in the Navigation Pane.
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To print a navigation structure
Use this procedure to print the navigation structure of the current FrontPage web displayed in the Navigation 
Pane of the FrontPage Explorer's Navigation View.

Tip      You can preview how the navigation structure will appear when printed by choosing the Print Preview 
command on the File menu.
1 On the File menu, choose Print Navigation View.
2 In the Print dialog box, specify printing options such as the printer name and number of copies, and then click 

OK.
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About FrontPage Webs
A FrontPage web is a collection of HTML pages, images, documents, and other files and folders that make up a 
Web site. Authors can create, delete, open, edit, and close FrontPage webs using the FrontPage Explorer and 
FrontPage Editor on a client computer. FrontPage webs can be stored on a remote Web server, a Web server 
running on the same computer as the client program, or in the client computer’s file system.

A FrontPage web also contains a number of support files that provide added functionality with sophisticated 
features such as navigation bars, hyperlink recalculation and repair, full text index generation, consistent design 
elements from themes, automatic table of contents generation, and built-in forms handling. In order to fully 
benefit from certain FrontPage components, you should create and maintain FrontPage webs on a Web server 
that has the FrontPage Server Extensions installed. These are a set of programs and scripts that support 
FrontPage authoring and extend the functionality of your Web server.

When your FrontPage web is ready to be published on the World Wide Web — or on your organization’s intranet 
— the FrontPage Explorer’s Publish command will publish the pages and files to the Web server you specify, 
while verifying the addresses of your pages and the paths to your files. If the Web server to which you are 
publishing your FrontPage web has the FrontPage Server Extensions installed, then your FrontPage web will 
have full FrontPage functionality when it is published. If FrontPage detects that you are publishing to a Web 
server that does not have the FrontPage Server Extensions installed, some FrontPage Components, such as the
FrontPage Search Form, will not work.

If the FrontPage Server Extensions are not present on the target Web server, FrontPage launches the Microsoft 
Web Publishing Wizard, which will publish your FrontPage web using FTP, a file transfer protocol. All hyperlinks 
to pages and files will be retained.
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The Server Extensions Resource Kit
The Microsoft FrontPage Server Extensions Resource Kit is an HTML document describing how to install and 
administer the FrontPage Server Extensions on a Web server machine. It is written for Internet service providers 
and intranet administrators who are hosting multiple Web sites. If you are using the FrontPage Explorer and 
FrontPage Editor to create FrontPage webs, you do not need to know the material presented in this document. 
However, if you are interested in learning more about the FrontPage Server Extensions, you can read topics in 
this document.

The Server Extensions Resource Kit contains the following topics:

· An Overview of the FrontPage Server Extensions
· Security Considerations
· Installing the FrontPage Server Extensions
· Administering the FrontPage Server Extensions
· Troubleshooting Guide
The FrontPage Server Extensions Resource Kit also includes a set of appendices describing the Server 
Extensions configuration file, the full contents of a Server Extensions installation, and other topics.

The FrontPage Server Extensions Resource Kit is on the Microsoft FrontPage 98 CD-ROM in the \SERK folder.



To create a hyperlink to a Microsoft Word, Excel, or PowerPoint file

1 Import the Microsoft Word, Excel, or PowerPoint file into your FrontPage web, using the Import command on 
the FrontPage Explorer’s File menu.

2 In the FrontPage Editor, create a hyperlink to the file using the Hyperlink command on the Insert menu.
When a user follows the hyperlink to the Microsoft Word, Excel, or PowerPoint file, the Web browser will open 
the associated application or viewer and display the file. In some Web browsers, the file is displayed inside 
the browser window, and in other web browsers it is displayed in a separate window.

To incorporate a PowerPoint Animation (.PPZ) file into your FrontPage web, you must have the Microsoft 
PowerPoint Animation ActiveX control installed on your machine. Insert a Microsoft PowerPoint Animation 
ActiveX control onto a page by choosing the ActiveX Control command on the Advanced sub-menu of the 
Insert menu. After entering the name of the control in the Pick A Control field, click Properties, and then in the 
Object Parameters dialog box click Add. Add "file" in the Name field, select Page as the Value, and then enter the
name of the PowerPoint Animation file in the Page field or click Browse to select the PowerPoint Animation File.
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Creating and Editing Fields
Overview

Editing Fields
To copy a form field

To delete a form field

To display a confirmation field
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To create a one-line text box field

To create a password field

To customize a one-line text box

Scrolling Text Boxes
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Check Boxes
To create a check box field
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Radio Buttons
To create a radio button field

To customize radio-button fields
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Drop-Down Menus
To add a choice to a drop-down menu

To change the height of a drop-down menu 

To create a drop-down menu

To modify a choice in a drop-down menu 

To move a choice in a drop-down menu 

To remove a choice from a drop-down menu
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Push Buttons and Image Fields
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Hidden Form Fields
To change a hidden field



To add a hidden field

To remove a hidden field
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Creating and Configuring Forms
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To assign a custom form handler

Discussion Groups
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To moderate a discussion group

Search Forms
To create a search form

General Forms
To collect data from a form

User-Registration Forms
To create a user-registration form



Creating and Using Frames
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Creating and Editing Frames Pages
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To create a frames page
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To split a frame
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To create a hyperlink to display a page in another page

To delete a frame
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To open a page in a frame
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To display a page in a frame

To display form results in a frame



Using Images and Image Maps
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Inserting Images
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To insert an image from a file
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To insert an image from the World Wide Web

To insert clip art

Editing Images
To add a beveled edge to an image

To add text to an image
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To change the layout of an image

To convert an image to black and white

To create a thumbnail image

To crop an image

To customize a video clip

To flip an image vertically

To resample an image

To reset an image
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To rotate an image

To washout an image
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To create a text hotspot
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Converting Images
To convert an image to GIF format

To convert an image to JPEG format

Other Image Procedures
To select an image

To specify an image's alternate low-resolution image

To set an image's default hyperlink

To specify an image's alternate text



Setting Language and Character Encoding
Overview

Setting Language and Character Encoding
To change the HTML character encoding for saving or loading a page

To specify the default display font for a language or character set



To register a user of a restricted-access FrontPage web
(Internet Information Server (IIS) or Microsoft Personal Web Server)
A FrontPage web administrator can restrict general end-user access to a FrontPage web and then register 
specific users that are authorized to access the FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root FrontPage 
web.

3 In the Users tab, choose Only Registered Users Have Browse Access, and then click Add.
This displays the Add Users dialog box.

4 The Obtain List From box lists the domains that are known to the Web server. Select the domain that contains
the user for whom you want to add permissions.

5 In the Names list, select the name of the user who will have access to the FrontPage web, and then click Add.
6 In the User Can field, choose the Browse This Web option.
7 Click OK.
8 To add the user and continue working in the Permissions dialog box, click Apply. To add the user and close 

the dialog box, click OK.
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To authorize a FrontPage web administrator
(Internet Information Server (IIS) or Microsoft Personal Web Server)
Root web administrators can create and delete FrontPage webs and pages, designate administrators and 
authors, and restrict end users from accessing a FrontPage web. Use this procedure to authorize an 
administrator for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Users tab, choose Only Registered Users Have Browse Access, and then click Add.
This displays the Add Users dialog box.

4 The Obtain List From box lists the domains that are known and acceptable to the Web server. Select the 
domain that contains the administrator you want to authorize.

5 In the Names list, select the name of the administrator, and then click Add.
6 In the User Can area, choose the Administer, Author, And Browse This Web option.
7 Click OK.
8 To add the new administrator and continue working in the Permissions dialog box, click Apply. To add the new 

administrator and close the dialog box, click OK.
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To authorize a FrontPage web author
(Internet Information Server (IIS) or Microsoft Personal Web Server)
Authors can create, modify, and delete pages in a FrontPage web, and they can make other changes to the 
web’s content. Use this procedure to authorize an author for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Users tab, choose Only Registered Users Have Browse Access, and then click Add.
This displays the Add Users dialog box.

4 The Obtain List From box lists the domains that are known and acceptable to the Web server. Select the 
domain that contains the author you want to authorize.

5 In the Names list, select the name of the author, and then click Add.
6 In the User Can area, choose the Author And Browse This Web option.
7 Click OK.
8 To add the new author and continue working in the Permissions dialog box, click Apply. To add the new author

and close the dialog box, click OK.
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To register a group of users of a restricted-access FrontPage web
(Internet Information Server (IIS) or Microsoft Personal Web Server)
A FrontPage web administrator can restrict general end-user access to a FrontPage web and then register 
specific groups of users that are authorized to access the FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root FrontPage 
web.

3 In the Groups tab, click Add.
This displays the Add Groups dialog box.

4 The Obtain List From box lists the domains that are known to the Web server. Select the domain that contains
the group for whom you want to add permissions.

5 In the Names list, select the name of the group that will have access to the FrontPage web, and then click 
Add.

6 In the User Can field, choose the Browse This Web option.
7 Click OK.
8 To add the group and continue working in the Permissions dialog box, click Apply. To add the group and close 

the dialog box, click OK.
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To authorize a group of FrontPage web administrators
(Internet Information Server (IIS) or Microsoft Personal Web Server)
Root web administrators can create and delete FrontPage webs and pages, designate administrators and 
authors, and restrict end users from accessing a FrontPage web. Use this procedure to authorize a group of 
administrators for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Groups tab, click Add.
This displays the Add Groups dialog box.

4 The Obtain List From box lists the domains that are known and acceptable to the Web server. Select the 
domain that contains the group of administrators you want to authorize.

5 In the Names list, select the name of the administrator group, and then click Add.
6 In the User Can area, choose the Administer, Author, And Browse This Web option.
7 Click OK.
8 To add the new group of administrators and continue working in the Permissions dialog box, click Apply. To 

add the new administrator and close the dialog box, click OK.
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To authorize a group of FrontPage web authors
(Internet Information Server (IIS) or Microsoft Personal Web Server)
Authors can create, modify, and delete pages in a FrontPage web, and they can make other changes to the 
web’s content. Use this procedure to authorize a group of authors for the current FrontPage web.

1 In the FrontPage Explorer, on the Tools menu, choose Permissions.
2 If the current FrontPage web is not the root web, select Use Unique Permissions For This Web and click 

Apply.
This specifies that the current FrontPage web will not inherit its permissions settings from the root web.

3 In the Groups tab, click Add.
This displays the Add Groups dialog box.

4 The Obtain List From box lists the domains that are known and acceptable to the Web server. Select the 
domain that contains the group of authors you want to authorize.

5 In the Names list, select the name of the author group, and then click Add.
6 In the User Can area, choose the Author And Browse This Web option.
7 Click OK.
8 To add the new group of authors and continue working in the Permissions dialog box, click Apply. To add the 

new author and close the dialog box, click OK.
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To define a channel for the current FrontPage web
You can use the Channel Definition Wizard to create a Channel Definition Format (CDF) file that allows users to 
subscribe to the current FrontPage web as a channel or a desktop component.

Note      This feature is available only in Web browsers that support channel definitions, such as Microsoft Internet
Explorer version 4.0.
Before starting the Channel Definition Wizard, you should consider the following:

· If you do not want to include all the pages in the current FrontPage web in your channel, organize the pages 
that you want to include in one folder or group of subfolders. 
This is not required to use the wizard, but it simplifies the process of selecting pages for your channel.

· Create or select artwork to be used as the logo and icon images for your channel.
The logo image identifies your channel in a user's Web browser, and should be an 80x32-pixel GIF image. 
The icon image identifies the pages in your channel, and should be a 16x16-pixel GIF image.
This is not required when creating a channel, but using these images makes your channel look unique.

· If you plan to publish the current FrontPage web to a remote Web server at this time, you will need to supply 
the complete URL of the location on the World Wide Web (or the location of your organization's intranet Web 
server).

1 In the FrontPage Explorer, on the Tools menu, choose Define Channel.
This starts the Channel Definition Wizard. Complete each step of the wizard except the last.

2 In the final step of the wizard:
· Select the Place a Button on the Navigation Bar… check box if the current FrontPage web uses shared 

borders and navigation bars, and you want the wizard to add a Subscribe button to your home page.
· Select the Prepare for Publishing… check box if you plan to publish the current FrontPage web to a remote

Web server at this time, and then type the complete URL of the location on the World Wide Web (or the 
location of your organization's intranet Web server).

· Clear the Prepare for Publishing… check box if you plan to test your channel in its current location before 
publishing it.

3 To customize the text label of the Subscribe button, in the FrontPage Explorer's Navigation View, select the 
Subscribe node and then rename it using the Rename command on the shortcut menu.

4 On the File menu, choose Save.

You can change the definition of your channel at any time by re-running the Channel Definition Wizard. To do so, 
double-click the Subscribe node in the FrontPage Explorer's Navigation View, or double-click the CDF file in the 
All Files View or the Folders View. If you move or rename files included in your channel, you must re-run the 
Channel Definition Wizard to incorporate those changes into your channel.
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To change a channel definition
If you have defined a channel for the current FrontPage web, you can redefine it using the Channel Definition 
Wizard.

1 In the FrontPage Explorer's Navigation View, double-click the Subscribe button for your channel, or double-
click the CDF file in the All Files View or the Folders View.
This starts the Channel Definition Wizard. Complete the wizard, specifying the options that you want to 
change.

2 In the final step of the wizard:
· Select the Prepare for Publishing… check box if you plan to publish the current FrontPage web to a remote

Web server at this time, and then type the complete URL of the location on the World Wide Web (or the 
location of your organization's intranet Web server).

· Clear the Prepare for Publishing… check box if you plan to test your channel in its current location before 
publishing it.

3 In the FrontPage Explorer, on the File menu, choose Save.
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To rename a Subscribe button
Use this procedure if you defined a channel for the current FrontPage web, and you want to rename the 
Subscribe button on your home page. If you created multiple channels for the current Web, this procedure is 
useful for labeling each Subscribe button uniquely to differentiate between channels.

1 In the FrontPage Explorer's Navigation View, select the Subscribe node that you want to rename.
2 On the shortcut menu, click Rename, and then type the name you want to appear on the button.
3 On the File menu, choose Save.
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To create a hyperlink that subscribes users to a channel
Use this procedure if:

· You have defined a channel for the current FrontPage web. 
· The current FrontPage web does not use navigation bars created by FrontPage from the navigation structure 

in the FrontPage Explorer's Navigation View.
· You want to create a hyperlink that a user viewing your page in a Web browser can click to subscribe to your 

channel.

1 In the FrontPage Editor, open the page on which you want to place the hyperlink. Typically, this is the home 
page of your FrontPage web.

2 Type or select the text, or insert or select the image that you want to use as the hyperlink, and then:
· If you are creating a text hyperlink, click the Create or Edit Hyperlink button:

· If you are creating an image hyperlink, click the Rectangle button:

This opens the Create or Edit Hyperlink dialog box.
3 Select the Channel Definition Format (CDF) file, and then click OK.

Typically, this is a file with the .cdf file extension in the top-level folder of your Web, such as channel.cdf.
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To publish a channel
Use this procedure to publish the current FrontPage web as a channel on a remote Web server.

Note      Once you have published your channel to a remote Web server, your CDF file will only allow users to 
subscribe to your channel in its new location. To test your FrontPage web in its current location after you have 
published it, you must re-run the wizard and clear the Prepare to Publish… check box. You can then use the 
following procedure to re-publish the channel at a later time.
1 Create or modify a Channel Definition Format (CDF) file to define your channel using the Channel Definition 

Wizard. In the last step of the wizard, select the Prepare for Publishing… check box and specify the complete 
URL of the location on the World Wide Web (or the location of your organization's intranet Web server) to 
which you want to publish your channel.

2 In the FrontPage Explorer, on the File menu, choose Save.
3 Click the Publish button on the toolbar:

4 In the Publish FrontPage Web dialog box, specify the location on the World Wide Web (or the location of your 
organization's intranet Web server) to which you want to publish your channel.
You can choose from the drop-down list or enter a new location by typing directly into this field. To publish to a
folder on your local file system, type in the full path and name of the folder. If you specify a folder that does not
exist, FrontPage will offer to create it.

5 Click OK.
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About Channel Definitions
A Channel Definition Format (CDF) file allows users to subscribe to your FrontPage web as a channel or a 
desktop component. When a user subscribes to your FrontPage web as a channel, they can browse your web 
offline, display updates to your web on their screen saver, and download or receive e-mail notifications when 
pages in your FrontPage web are modified. This feature is available only in Web browsers that support channel 
definitions, such as Microsoft Internet Explorer version 4.0.

You create a CDF file for the current FrontPage web using the Channel Definition Wizard. The Channel Definition
Wizard leads you through the steps of defining your channel, and then creates the CDF file based on your input 
to the wizard. You start the Channel Definition Wizard using the Define Channel command on the FrontPage 
Explorer's Tools menu.

If the current FrontPage web uses shared borders and navigation bars, the wizard lets you add a Subscribe 
button to your home page. A user viewing your home page in a Web browser can then click the Subscribe button 
to subscribe to your channel.

The wizard also allows you to prepare your CDF file for publishing to a remote Web server on the World Wide 
Web (or on your organization's intranet). Once you have published your channel to a remote Web server, your 
CDF file will only allow users to subscribe to your channel in its new location on the remote server. If you want to 
test your channel locally before publishing it to a remote Web server, do not prepare the CDF file for publishing 
the first time you run the wizard.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Channels')}



Using Channel Definitions
Overview

Creating Channel Definitions
To define a channel for the current FrontPage web

Editing Channel Definitions
To change a channel definition

To rename a Subscribe button

Publishing Channel Definitions
To publish a channel

Other Channel Procedures
To create a hyperlink that subscribes users to a channel



Creating and Using Hyperlinks and Bookmarks
Overview 

Creating Text Hyperlinks
To create a text hyperlink from the FrontPage Explorer 

To create a text hyperlink to a new page

To create a text hyperlink to a page on the World Wide Web

To create a text hyperlink to a page or file in the current FrontPage web

Creating Image Hyperlinks
To create an image hyperlink to a new page

To create an image hyperlink to a page on the World Wide Web

To create an image hyperlink to a page or file in the current FrontPage web 

Following Hyperlinks
To follow a hyperlink backward

To follow a text hyperlink forward

To follow an image hyperlink forward

Deleting and Changing Hyperlinks
To change a text hyperlink

To change an image hyperlink

To delete a text hyperlink

To delete an image hyperlink

Creating and Using Bookmarks
To create a bookmark

To create a hyperlink to a bookmark

To delete a bookmark

To visit a bookmark

Verifying and Repairing Hyperlinks
To check the status of hyperlinks

To repair a broken hyperlink

To verify hyperlinks

To verify external hyperlinks

Other Hyperlink Procedures
To recalculate hyperlinks

To select a hyperlink

To select hyperlink color

To select active hyperlink color

To select visited hyperlink color



To create an e-mail hyperlink

To create a hyperlink to a Microsoft Word, Excel, or PowerPoint file



Creating and Editing Lists
Overview

Creating Lists
To create a bulleted list

To create a definition list

To create a directory list

To create a menu list

To create a nested list

To create a numbered list

To create a collapsible outline

Deleting List Items
To delete a list item

Other List Procedures
To end a list

To insert a list item

To select a list



Using Lists
FrontPage lets you format text into five kinds of lists:

· A bulleted list presents an unordered list of items. Generally, bulleted lists are rendered as paragraphs 
separated by white space and prefixed by bullets.

· A numbered list presents an ordered list of items, such as steps in a procedure. Generally, numbered lists are
rendered as paragraphs separated by white space and prefixed by numbers.

· A directory list presents a sequence of short terms.
· A menu list presents an unordered list of short entries.
· A definition list presents terms and their definitions. Generally, a term is rendered flush left, and its definition 

is indented.

The exact formatting of a list depends on the Web browser that will be used to view the list. Some Web browsers 
do not display the Directory List and Menu List styles as intended.

If a theme has been applied to the page, the list will appear in the font and paragraph formatting specified by the 
theme. You can use standard bullets, image bullets from the theme, or specify your own image bullet.

You can easily create nested lists by inserting a list within a list, or you can insert a paragraph in a list. To end 
any list, press the ENTER key twice or press CONTROL+ENTER.

{button Related Procedures,JI(`frontpg.HLP',`Content_Lists')}



Using Navigation Bars and Shared Borders
Overview

Using Navigation Bars
To insert a navigation bar on a page

To change the text of a button in a navigation bar

To modify a navigation bar

To change the position of navigation bar

To delete a navigation bar in the FrontPage Editor

Using Shared Borders
To assign shared borders to a FrontPage web

To assign shared borders to a page

To edit a shared border



Using Pages
Overview

Creating Pages
To create a new page

To create a template page

Opening Pages
To open a page from the FrontPage Explorer

To open a page in the FrontPage Editor

Saving Pages
To save a page to a file

To save a page to the current FrontPage web

Editing Pages
To add a system meta-variable to a page

To add a user-defined meta-variable to a page

To add a watermark to a page

To add comments to a page

To include a page in another page

To include a page in another page during a time period

To include an image in a page during a time period

To insert a variable

To timestamp a page

Previewing Pages
To add a Web browser to the preview list

To preview a page in a Web browser

To set the preview window size

Editing Horizontal Lines
To add a horizontal line

To change the appearance of a horizontal line

Inserting and Editing Marquees
To align a marquee with text

To change a marquee's background color

To change a marquee's behavior

To change a marquee's direction

To change a marquee's size

To change a marquee's speed

To change the number of times a marquee repeats



To insert a marquee

Setting Page Properties
To apply one page's background style and colors to another page

To set a background color for a page

To set a background image for a page

To specify the margins of a page

Associating Sounds
To associate a background sound with a page

To change the number of times a background sound repeats

Using Animation and Effects
To animate one or more page elements

To create a banner ad

To create a hover button

To create a page transition effect

To insert a hit counter

Editing Tables of Contents
To create a table of contents

Other Page Operations
To delete pages from the current FrontPage web

To hide a page from Web browsers

To send a copy of the active page through electronic mail

To view explanations of errors on pages



Working with Tables
Overview

Inserting Tables
To insert a table

To insert a table within a table

Selecting Parts of a Table
To select a table or its parts

Changing a Table
To add a background image to a cell

To add a background image to a table

To change the background color of one or more cells

To change the background color of a table

To change the color of cell borders

To change the color of table borders

To change the layout of a cell

To change the layout of a table

To insert a cell

To insert a row or column

To split cells

To merge cells

To change cell spanning

To resize a table

To resize a cell

Aligning a Table or Its Parts
To distribute rows and columns evenly

Deleting a Table or Its Parts
To delete a table or its parts

Other Table Procedures
To add a table caption

To edit a table caption

To add a header cell

To convert a table to text

To convert existing text to a table



Using Themes
Overview

Applying Themes
To apply a theme to a FrontPage web

To apply a theme to a page

Changing Themes
To change the theme applied to a FrontPage web

To change the theme applied to a page

Removing Themes
To remove the theme applied to a FrontPage web

To remove the theme applied to a page



Adding and Using Tasks
Overview

Adding and Deleting Tasks
To add a task from the FrontPage Editor

To add a task from the FrontPage Explorer

To delete a task

Other Task Procedures
To modify a task

To do a task

To mark a task completed

To show completed tasks

To view task history



Typing and Editing
Overview

Formatting Text
To format text

To indent text

To outdent text

Working with Paragraphs
To create a new line

To create a paragraph

To align a paragraph

To change a paragraph's style

Deleting Text
To cut or delete text

Finding and Replacing Text
To find text in a FrontPage web

To find text on a page

To replace text in a FrontPage web

To replace text on a page

Other Text Procedures
To check spelling in a FrontPage web

To check spelling on a page

To insert a line break

To insert a special character

To undo an edit



Using FrontPage Webs
Overview

Creating and Deleting FrontPage Webs
To create a new FrontPage web

To delete a FrontPage web

Opening FrontPage Webs
To open a FrontPage web

Adding Pages and Files To a FrontPage Web
To add pages to a FrontPage web

To copy a page to a FrontPage web

To import files to a FrontPage web 

Publishing FrontPage Webs
To publish the current FrontPage web

Using Variables
To add a variable to a FrontPage web

To delete a variable from a FrontPage web

To modify a variable in a FrontPage web

Other Web Procedures
To copy the current FrontPage web 

To change the title of a FrontPage web

To create a new folder in a FrontPage web

To export a page or file from a FrontPage web

To rename a FrontPage web



The FrontPage Workplace
Overview

Using the FrontPage Explorer
To create a new folder

To select pages

To print a navigation structure

To preview the printing of a web structure

Using the FrontPage Editor
To preview a printed page

To print a page

To redo an action

To undo an action

Other Workplace Operations
To show the Getting Started with Microsoft FrontPage Dialog Box

To test your network connection

To view the properties of page elements



Add Name and Value Dialog Box
Use the Add Name and Value Dialog Box to add a variable.

Dialog Box Options

Name
Type the name of the variable; the name can be any length. When entering a name, do not use a colon (:).

Value
Type the value you want associated with the name of variable; the value can be any length.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Webs')}



Modify Name and Value Dialog Box
Use the Modify Name and Value Dialog Box to modify a variable.

Dialog Box Options

Name
Change the name of the variable; the name can be any length. When entering a name, do not use a colon (:).

Value
Change the value you want associated with the name of variable; the value can be any length.
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You’re having other problems
You can find late-breaking updates and technical information in the readme file that came with your product disks
or compact disc.

If you still have a question, Microsoft offers technical support and services ranging from self-help tools to direct 
assistance with a Microsoft technical engineer. 

Note      The services and prices listed here are available in the United States and Canada only. Support services 
may vary outside the U.S. and Canada. For more information on support in other locations, contact your local 
Microsoft subsidiary.
Microsoft’s support services are subject to Microsoft’s then-current prices, terms, and conditions, which are 
subject to change without notice. 

{button ,JI(`',`MTSChoose')}    Choose the support option that’s right for you

Outside the U.S. and Canada, contact the local Microsoft subsidiary office in your area. For a list of worldwide 
Microsoft subsidiaries, click:

{button ,JI(`',`MTSWorld')}    Microsoft Technical Support Worldwide



Choose the support option that’s right for you
Here are the options you can choose from:

Self Help Tools 

{button ,JI(`',`MTSSelf')}    Self-Help Tools Online

Direct Assistance from a Microsoft Technical Support Engineer

{button ,JI(`',`DirectAssistance')}    Direct Assistance from a Microsoft Technical Support Engineer

Other Microsoft Services

Includes information on customer service and text telephone numbers for the deaf. For more information, click:

{button ,JI(`',`MTSOther')}    Other Microsoft Services

Microsoft Technical Support Worldwide

For information on how to obtain Microsoft Technical Support from Microsoft worldwide subsidiaries outside the 
U.S. and Canada, click:

{button ,JI(`',`MTSWorld')}    Microsoft Technical Support Worldwide



Self-Help Tools 

Microsoft Technical Support Online at http://www.microsoft.com/support/ 

This site uses the cutting-edge technology of Microsoft to help you access the most relevant technical 
information and resources to answer your support questions. Online support helps you find the answers you 
need quickly and easily through the following features:

· Troubleshooting Wizards: Microsoft Technical Support Online has built-in diagnostic technology to help you 
easily pinpoint problems and identify solutions. Just ask for help on a specific problem, and a Troubleshooting 
Wizard will walk you through, step by step, until your question is resolved. Troubleshooting Wizards are like 
electronic versions of our own engineers.

· Product-Specific Support Home Pages: Think of this as an electronic information synthesizer. It 
automatically pulls together the top technical articles, the most frequently asked questions, downloadable 
files, and more for your specific product. If you need an answer in a hurry, be sure to stop here first. Chances 
are the solution you are looking for is already waiting for you.

· Frequently Asked Questions (FAQs): FAQs are questions about Microsoft products that our engineers have
identified as those customers ask most often. Like the Product-Specific Support Home Pages, this invaluable 
feature extracts just the most critical, up-to-date questions and answers on your products to help you find 
solutions quickly. FAQs are updated continually.

· Knowledge Base: Here you'll find a collection of more than 75,000 detailed articles—updated daily—with 
technical information about products, bug and fix lists, and answers to commonly asked technical questions. 
The Knowledge Base also provides descriptions of product issues and workarounds, optimization tips, and 
compatibility issues for every product. A step-by-step process helps you build a query to search the database, 
making it easy for you to look for information on the product or technology of your choice.

· Help Files, Service Packs, & More: Keep your system current with access to thousands of files from our 
software library, all available for downloading. This includes free software add-ons (connect charges may 
apply), bug fixes, peripheral drivers, software updates, sample code, patches, application notes, sample files, 
and programming aids.

· Support Site Tour: The Support Site Tour uses a "Support Wizard" to help you easily get the information 
most relevant to your product and technical support needs. First, select your product. Next, indicate what you 
would like to do: find a technical article, troubleshoot a problem, or download a driver. Then just double-click 
and the Support Wizard takes you where you want to go.

· Newsgroups: This peer-to-peer communication forum links you to a worldwide community of other Microsoft 
customers and technical experts, including Microsoft's Most Valuable Professionals. Newsgroups offer a 
unique way to help you find answers, tips, and tricks by putting you in touch with other Microsoft product users
who have similar interests.

Additional Information

{button ,JI(`',`MTSChoose')}    Choose the support option that’s right for you

{button ,JI(`',`MTSSelfOther')}    Other Self-Help Tools

{button ,JI(`',`DirectAssistance')}    Direct Assistance with a Microsoft Technical Support Engineer

{button ,JI(`',`MTSOther')}    Other Microsoft Services

{button ,JI(`',`MTSWorld')}    Microsoft Technical Support Worldwide



Other Self-Help Tools
In addition to the Internet resources, Microsoft Technical Support provides the following additional technical 
information resources:

· Microsoft TechNet: If you are an information technology (IT) or Help desk professional responsible for 
administering your corporate network or supporting end users then you can stay on top of your organization's 
requirements with TechNet. TechNet is a comprehensive resource for evaluating, implementing, and 
supporting Microsoft business products. Every month, TechNet delivers two CDs packed with more than 
150,000 pages of the critical information you need to smoothly deploy mission-critical systems and minimize 
downtime–all while building your technical expertise. To subscribe, see your local authorized retailer, or call 
(800) 344-2121, Monday through Friday, excluding holidays, 6:30 A.M to 5:30 P.M. Pacific time.

· Microsoft Developer Network Library (MSDN): If you develop applications for the Internet or the Windows® 
operating system, or use Microsoft products for any other development purposes, you'll enhance your 
productivity with an MSDN subscription. MSDN is Microsoft's official source for technical programming 
information, SDKs, DDKs, Windows, BackOffice™, Microsoft Office, and Visual Tools for developers. For 
more information on MSDN subscription levels and benefits, visit MSDN online at: 
http://www.microsoft.com/msdn/. Or call (800) 759-5474, Monday through Friday, excluding holidays, 6:30 
A.M. to 5:30 P.M. Pacific time.

· Microsoft Download Service (MSDL): Provides direct modem access to Microsoft’s electronic technical 
library, which contains sample programs, device drivers, patches, software updates, and programming aids. 
The service is available 24 hours a day, 365 days a year. In the U.S. dial (425) 936-6735. Connect 
information: 1200, 2400, 9600, or 14400 baud, no parity, 8 data bits, and 1 stop bit. In Canada, dial (905) 507-
3022. Connect information: 1200 to 28800 baud, no parity, 8 data bits, and 1 stop bit.

· Microsoft FastTips: An automated toll-free telephone service for quick answers to common technical 
questions, as well as technical articles by telephone, fax, or mail. To access FastTips or to receive a catalog of
the articles available, call one of the following numbers on a touch-tone telephone:
· Desktop Applications: (800) 936-4100
· Desktop Systems: (800) 936-4200
· Development Tools: (800) 936-4300
· Business Systems: (800) 936-4400

You can use the following keys on your touch-tone telephone after you reach FastTips. 

To do this: Press this key:
    

Advance to the next message *
Repeat the current message 7
Return to the beginning of FastTips #

Additional Information

{button ,JI(`',`MTSChoose')}    Choose the support option that’s right for you

{button ,JI(`',`MTSSelf')}    Self-Help Tools:    Microsoft Technical Support Online
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Direct Assistance with a Microsoft Technical Support Engineer

Standard No-CHARGE Support

If you still need answers to your technical questions, Microsoft offers no-charge support for retail* versions of 
FrontPage 98 as follows:

· Unlimited no-charge support. 
To receive your Standard No-Charge Support, in the U.S., please call (425) 635-7088, 6 A.M. to 6 P.M. Pacific 
time, Monday through Friday, excluding holidays. In Canada, please call (905) 568-3503, 5:00 A.M. to 5:00 P.M. 
Pacific time, Monday through Friday, excluding holidays.

Note      Toll-charges may apply.
In the U.S. and Canada, you can also submit your support question via the Internet with Web Response. For 
more details, go to Microsoft Technical Support Online at http://www.microsoft.com/support/. 

*Note: If your Microsoft product was pre-installed or distributed with your personal, the personal computer 
manufacturer or ISP is responsible for providing your product support. For support, contact the manufacturer or 
source from which you obtained your Microsoft product.

When you contact us for support, you should be at your computer and have the appropriate product 
documentation at hand. Be prepared to give the following information:

· The version of the Microsoft product you use.
· The type of hardware you use.
· The operating system you use.
· The exact wording of any messages that appeared on your screen.
· A description of what happened and what you were doing when the problem occurred.
· A description of how you tried to solve the problem.

After-Hours Support

If you require support after normal business hours, you can purchase Pay-Per-Incident Support:

· In the U.S., for a fee of $15US per incident, please call (800) 936-5600 or (900) 555-2400, 24 hours a day, 
seven days a week, including holidays. 

· In Canada, for a fee of $45CDN plus tax per incident, please call (800) 668-7975, 5:00 A.M. to 9:00 P.M. 
Pacific time, seven days a week, excluding holidays. 

· In the U.S. and Canada, you can also submit your support question via the Internet with Web Response. For 
more details, go to Microsoft Technical Support Online at http://www.microsoft.com/support/.

Note: Support fees for the (800)# calls will be billed to your VISA, MasterCard, or American Express credit card. 
Support fees for the (900)# calls will appear on your telephone bill.

Priority Annual Support

If you anticipate a higher volume of support incidents, or need priority access to Microsoft Technical Support 
Engineers, you can purchase a Priority Annual Desktop Account as follows:    

· In the U.S., for more information or to purchase an annual account at a cost of $295US per 10 incidents, 
please call (800) 936-3500, 24 hours a day, seven days a week, including holidays. To submit an incident 
against an existing account, call (800) 936-4700, 24 hours a day, seven days a week, including holidays.

· In Canada, for more information, to purchase an annual account at a cost of $295CDN plus tax per 10 
incidents, or to submit and incident against an existing account, please call (800) 668-7975, Monday through 
Friday, excluding holidays, 5:00 A.M. to 9:00 P.M. Pacific time.

Additional Information
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Other Microsoft Services

Text telephone

Microsoft text telephone (TT/TTY) services are available for the deaf or hard-of-hearing. In the U.S., using a 
TT/TTY modem, dial (425) 635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, 
excluding holidays. In Canada, using a TT/TTY modem, dial (905) 568-9641 between 8:00 A.M. and 8:00 P.M. 
eastern time, Monday through Friday, excluding holidays.

Microsoft Customer Service

For customer service issues on Microsoft products, upgrades, and services, contact the Microsoft Sales 
Information Center. In the U.S., call (800) 426-9400. In Canada, call (800) 563-9048.

Note      Technical support is not available at these numbers.

Additional Information
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Microsoft Technical Support Worldwide
If you are outside the U.S. and have a question about a Microsoft product, first:

· Check the information in this Help file or product manual.
· Check the readme files that come with your product disks. These files provide general information that 

became available shortly before the product was released.
· Go to Microsoft Technical Support Online at http://www.microsoft.com/support/.
If you cannot find a solution, you can receive information on how to obtain product support by contacting the 
Microsoft subsidiary office in your area.

Calling a Microsoft subsidiary office

When you call your local Microsoft subsidiary, you should be at your computer and have the appropriate product 
documentation at hand. Be prepared to provide the following information:

· The version of the Microsoft product you use.
· The type of hardware you use, including network hardware, if applicable.
· The operating system you use.
· The exact wording of any messages that appeared on your screen.
· A description of what happened and what you were doing when the problem occurred.
· A description of how you tried to solve the problem.
Microsoft subsidiary offices and the countries they serve are listed below. If there is no Microsoft subsidiary office
in your country, please contact the establishment from which you obtained your Microsoft product.

Additional Information
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Microsoft Worldwide Subsidiaries
· Argentina

Microsoft de Argentina S.A. 
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support:
(Consumer, POS, and DAD): (54) (1) 314-0560
(BSD and DD, only for installation): (54) (1) 819-1900

· Australia
Microsoft Pty. Ltd.
Fax: (61) (02)805-0519
Sales Information Centre: (61) (02) 870-2100
Installation Support: (61) (02) 870-2132
Bulletin Board Service: (61) (02) 878-5200
Technical Support: (61) (02) 870-2131

· Austria
Microsoft Ges.m.b.H.
Phone: 0222-68 76 07
Fax: 0222-68 16 2710
Information: 0660-6520
Prices, updates, etc.: 0660-6520
CompuServe: GO MSEURO (Microsoft Central Europe)
Standard Support: Installation and Handling



Windows 95: 0660-6510
Microsoft Excel for Windows: 0660-6511
Microsoft Access: 0660-6761
TechNet, Developer Network, Bookshelf: 0660-6506

General information about Support Network in Central Europe:
FAX: 0049/2622/167006

· Belgium
Microsoft NV
Phone: +32-2-730 39 11
Fax: +32-2-726 96 09
Microsoft Information Center: +32-2-481 52 52
CompuServe: 02-2150530 (GO MSBEN)
Bulletin Board: +32-2-726 85 45 (14400/1200/2400/9600 bd, 8N1, ANSI)
Technical Support:
+32-2-513 32 74 (Dutch speaking)
+32-2-502 34 32 (English speaking)
+32-2-513 22 68 (French speaking)

· Bolivia
See Argentina

· Brazil
Microsoft Informatica Ltda.
Phone: (55) (11) 514 –7100
Fax: (55) (11) 514 - 7106/514-7107
Technical Support:
Phone: (55) (11) 871-0090
Fax: (55) (11) 262-8638
Technical Support Bulletin Board Service: (55) (11) 872-4106
Technical Support Help by Fax: (55) (11) 871-4701

· Canada
Microsoft Canada Inc.
Head Office Phone: 1 (905) 568-0434
Customer Support Centre: 1 (800) 563-9048
Technical Support:
Desktop Systems including Microsoft Windows 95: 1 (905) 568-4494
Microsoft Office and Office Components: 1 (905) 568-2294
Other Standard Technical Support: 1 (905) 568-3503
Priority Support Information: 1 (800) 668-7975
Text Telephone (TT/TDD) 1 (905) 568-9641
Technical Support Bulletin Board Service: 1 (905) 507-3022

· Caribbean
Microsoft Caribbean, Inc.
Phone: (809) 273-3600
Fax: (809) 273-3636
Technical Support: (214) 714-9100

· Central America
See Latin America

· Chile
Microsoft Chile S.A.
Phone: 56-2-330-6000
Fax: 56-2-330-6190
Customer Service: 56-2-800-213121
Personal Operating System and Applications:

Phone: 56-2-330-6222
Fax: 56-2-341-1439

· Colombia
Microsoft Colombia
Phone: (571) 618 2245
Fax: (571) 618 2269
Technical Support: (571) 618 2255

· Czech Republic



Microsoft s.r.o.
Phone (+42) (2) 611 97 111
Fax: (+42) (2) 611 97 100
Technical Support: 
(+42) (2) 2150 3222 or 53 52 56 (Windows 95 only)

· Denmark
Microsoft Denmark AS
Phone: (45) (44) 890 100
Fax: (45) (44) 685 510
Technical Support:

Phone: (45) (44) 89 01 11
Microsoft Sales Support: (45) (44) 89 01 90
Microsoft FaxSvar: (45) (44) 89 01 44
Microsoft BBS: (45) (44) 66 90 46
(Document 303030 in FaxSvar contains detailed instructions)
Microsoft MSDL: (45) (44) 66 90 46
Microsoft FastTips: (45) (44) 89 01 44

· Dubai
Microsoft Middle East
Phone: (971) 4 513 888
Fax: (971) 4 527 444

· Ecuador
Corporation Microsoft del Ecuador S.A.
Phone: (593) 2 460-447, (593) (2) 460-451
Customer Service: (593) (2) 460-453, (593) (2) 460-458
Technical Support: (593) (2) 463-094

· Egypt
Microsoft Egypt
Phone: +202-418-5571
Fax: +202-4174766

· England
See United Kingdom

· Finland
Microsoft OY
Phone: (358) (90) 525 501
Fax: (358) (90) 522 955
Product Support:

Phone: (358) (90) 525 502 500
Microsoft FaxSvar: (46) (0) 8-752 29 00
(Information in Swedish and English)
Microsoft BBS: (46) (0) 8-750 47 42
(Information in Swedish and English)
Microsoft MSDL: (358) (90) 455 03 66
Microsoft FastTips: (358) (90) 525 502 550

For Technical Support, please contact your local reseller.
· France

Microsoft France
Phone: (33) (1) 69-86-46-46
Fax: (33) (1) 64-46-06-60
Telex: MSPARIS 604322
Technical Support Phone: (33) (1) 59-85-96-33 (Province)/33 3 49 49 49 57(2)
Technical Support Fax: (33) (1) 69-28-00-28
Fax Information Service: (33) (1) 36-70-13-13

· French Polynesia
See France

· Germany
Microsoft GmbH
Phone: 089/3176-0
Fax: 089/3176-1000
Telex: (17) 89/83 28 MS GMBH D



Information: 089/3176 1199
Prices, updates, etc.: 089/3176 1199
CompuServe: GO MSEURO (Microsoft Central Europe)
Bulletin board, device drivers, tech notes: 
                Btx: *microsoft# or *610808000# 
Standard Support: Installation and Handling

Windows 95: 089/3176-1115
Microsoft Excel for Windows: 089/3176-1120
Microsoft Access: 089/3176-1180
TechNet, Developer Network: 089/3176-1810General information about Microsoft support in Central 

Europe:
Fax: 02622/167006

· Greece
Microsoft Hellas, S.A.
Phone: (30)(1) 6806-775 through (30)(1) 6806-779
Fax: (30)(1) 6806-780

· Hong Kong
Microsoft Hong Kong Limited
Fax: (852)2560-2217
Product support Faxback Service: (852)2535-9293
Microsoft Club Upgrade Centre: (852)2880-5085
Microsoft Club Member Hotline: (852)2516-5113
Technical Support: (852) 2804-4222

· Hungary
Microsoft Hungary
Phone: +36 (1) 268-1668
Fax: +36 (1) 268-1558
Technical Support: +36 (1) 267-4636 (2MSINFO)

· Iceland
See Denmark

· Ireland
See United Kingdom

· India
Microsoft India
Phone: (011) (91) (11) 646 0694, 646 0767, 646 0813
Fax: (011) (91) (11) 646-0813

· Indonesia (SP)
Microsoft Indonesia - Jakarta
Technical Support
Phone: 62 21 5721060
Fax: 62 21 5732077

· Israel
Microsoft Israel Ltd.
Phone: 972-3-613-0833
Fax: 972-3-613-0834

· Italy
Microsoft SpA
Phone: (39) (2) 7039-21
Fax: (39) (2) 7039-2020
Microsoft by Fax (Fax-on-demand service): 
(39) (2) 70-300-703
Customer Service (New product info, product literature): 
(39) (2) 70-398-398
Dealer Support (Customer Service for resellers only): 
(39) (2) 70-398-388
Bulletin Board: (39) (2) 7030-0102
Technical Support: (39) (2) 70-398-351
Microsoft Consulting Service: (39) (2) 7039-2400
Microsoft Rome Office: (39) (6) 5432-497



· Japan
Microsoft Company Ltd.
Technical Support: (81) (424) 41-8700
Fax Information Service: 
(81) (3) 5454-8100 (1#-0# for guidance)
Microsoft Support Sales: 
(Technical Support options/ Support Contract)

Phone: 0120-37-0196 (toll free domestic only)
Channel Marketing Information Center: 
(Presales Product Support)

Phone: (81) (3) 5454-2300
Fax: (81) (3) 5454-7951

Customer Service Phone :
(Version upgrade/Registration)

Phone: (81) (3) 5454-2305
Fax: (81) (3) 5454-7952

· Korea
Microsoft CH
Phone: (82) (2) 531-4500
Fax: (82) (2) 531-1724 
Office Technical Support: (82) (2) 508-0040
Windows Technical Support: (82) (2) 563-0054
Developer Technical Support: (82) (2) 566-0071
Technical Support Fax: (82) (2) 531-4600
Technical Support Bulletin Board Service: 
(82) (2) 538-3256

· Latin America
Microsoft
Latin American Headquarters (U.S.A.)
Phone: (305) 489-4800
Fax: (305) 491-1616
Customer Service: (425) 936-8661
Technical Support: (214) 714-9100

· Liechtenstein
See Switzerland (German speaking)

· Luxembourg
Microsoft NV
Phone: +32-2-730 39 11
Microsoft Information Center: +32-2-481 52 52
CompuServe: +32-2-215 05 30 (GO MSBEN)
Bulletin Board: +32-2-726 85 45 
(1200/2400/9600/14400 bd, 8N1, ANSI)
Technical Support:

+32-2-513 32 74 (Dutch speaking)
+32-2-502 34 32 (English speaking)
+32-2-513 22 68 (French speaking)

· Malaysia (SP)
Microsoft (Malaysia) Sdn Bhd:

Phone: (60-3) 793-9595
Fax: (60-3) 791-6080

· México
Microsoft México, S.A. de C.V.
Technical Support:
(Applications and Operating Systems)
(52)(5) 325-0912
Customer Service. (52)(5) 325-0911
Fast Tips: (52)(5) 237-4894 
(24 hours x 365 days service)
Bulletin Board Service:

(52)(5) 628-6200 



(2400s/14400k baud, 8 bits, No parity, 1 stop bit, ANSI
terminal emulation)
(52)(5) 628-6202
(14400k baud, 8 bits, No parity, 1 stop bit, ANSI terminal emulation)

User: MSMEXICO, NO Password
· Morocco

Microsoft Afrique Du Nord
Phone: (212) 2 47 10 72
Fax: (212) 2 47 10 86

· Netherlands
Microsoft BV
Phone: 023-5689189
Customer Service: 023-5677700
CompuServe: 020-6880085 (GO MSBEN)
Bulletin Board: 023-5634221 
(1200/2400/9600/14400bd, 8N1, ANSI)
Technical Support:

023-5677877 (Dutch speaking)
023-5677853 (English speaking)

· New Zealand
Microsoft New Zealand Ltd
Phone: 64 (9) 358-3724
Fax: 64 (9) 358-3726
Technical Support:

Phone: 64 (9) 357-5575
Fax: 64 (9) 307-0516 and 357-5577

· Northern Ireland
See United Kingdom

· Norway
Microsoft Norway AS
Phone: (47) (22) 02 25 00
Fax: (47) (22) 95 06 64
Product Support: (47) (22) 02 25 50
Microsoft Sales Support: (47) (22) 02 25 80
Microsoft BBS: (47) (22) 18 22 09
(Document 404040 in FaxSvar contains detailed instructions)
Microsoft FaxSvar: (47) (22) 02 25 70
Microsoft MSDL: (47) (22) 18 22 09
Microsoft FastTips: (47) (22) 02 25 70

· Papua New Guinea
See Australia

· Paraguay
See Argentina

· Peru
See Latin America

· Philippines (SP)
Microsoft Philippines 
Phone: 632 811 0062
Technical Support:

Phone : 632 892 2295/2495
Fax: 632 813 2493

· Poland
Microsoft Sp. z o.o.
Phone: (+48) (22) 661-5433
Fax: (+48) (22) 6615434
Information Service: (+48) (22) 6286924
Technical Support: 
(+48) (22) 6216793 or (+48) (71) 441357

· Portugal



Microsoft Portugal MSFT, Lda.
Phone: (351) 1 4409200
Fax: (351) 1 4412101
Technical Support:

Standard Support (All Clusters): 
              (351) 1 4409280/1/2/3

Fax : 351 1 4411655
· Republic of China

Microsoft Taiwan Corp.
Phone: (886) (2) 504-3122
Fax: (886) (2) 504-3121
Technical Support: (886) (2) 508-9501

· Republic of Ireland
See United Kingdom

· Russia
Microsoft A/O
Fax: (+7) (502) 224 50 45

· Scotland
See United Kingdom

· Saudi Arabia
Microsoft Saudi Arabia
Phone: +966-1-488-1165
Fax: +966-1-488-1576 ext 300
Technical Support (POS and DAD only):

Phone: 800 124 0500 
              (toll free within Saudi Arabia)

Fax: 966-1-4740576
· Singapore

Microsoft Singapore Pte Ltd
Phone: (65) 337-6088
Fax: (65) 337-6788
Customer Services:

Phone: (65) 433-5488
Fax: (65) 339-9958

Product Support Services:
Phone: (65) 337-9946
Fax: (65) 337-6700

· Slovenia/Slovenija
Microsoft d.o.o. (see Germany also)
Phone: +386 61 1881 133
Fax: +386 61 1881 137
Technical Support: 
+386 61 123 23 54 or +386 64 331 020

· Slovak Republic
Microsoft Slovakia s.r.o.
Phone (+42) (7) 37 63 02
Fax: (+42) (7) 37 66 71
Technical Support: (+42) (7) 31 20 83

· South Africa
Microsoft South Africa
Phone: (27) 11 445 0000
Fax: (27) 11 445 0343 or (27) 11 445 0046
Technical Support:

(Toll Free): 0 802 11 11 04
(Toll): (27) 11 445 0100

Customer Service Centre: (27) 11 445 0145
· Spain

Microsoft Iberica SRL
Phone: (34) 1-807-9999



Fax: (34) 1-803-8310
Technical Support: (34) 1-807-9960
Customer Service: (34) 1-804-0096
Fax Back telephone: (34) 1-804-0096

· Sweden
Microsoft AB
Phone: (46) (0) 8-752 56 00
Telex: 8126132 MICRAB AB
Fax: (46) (0) 8-750 51 58
Product Support: (46) (0) 8 -752 09 29
Sales Support: (46) (0) 8-752 56 30
Microsoft FaxSvar: (46) (0) 8-752 29 00
Microsoft BBS: (46) (0) 8-750 47 42
(Document 202020 in FaxSvar contains detailed instructions)
Information on Technical Support: (46) (0) 8-752 09 29
Microsoft MSDL: (46) (0) 8-750 47 42
Microsoft FastTips: (46) (0) 8-752 29 00

· Switzerland
Microsoft AG
Phone: 01-839 61 11
Fax: 01-831 08 69
Prices, updates, etc.: 01/839 61 11
CompuServe: GO MSEURO(Microsoft Central Europe)
Documentation:
Phone: 155 59 00
Fax: 064-224294, Microsoft Info-Service, Postfach, 8099 Zürich
Standard Support: Installation and Handling

Windows 95: 01/342-4085
Microsoft Mail Client: 01/831-1581
Microsoft Excel for Windows: 01/342-4082
Microsoft PowerPoint for Windows: 01/342-4082
Microsoft Word for Windows: 01/342-4087
Microsoft Access: 01/342-4121
Microsoft Software for Apple Macintosh: 01/342-4081
TechNet, Developer Network, Bookshelf: 01/342-1964

Technical support (French speaking): 022-738 96 88
General information about Microsoft Support in Central Europe:
FAX: 0049/2622/167006

· Thailand
Microsoft (Thailand) Limited
Phone: (662) 266-3300
Fax: (662) 266-3310
Product Support:
Phone: (662) 632-0360 through 3
Fax: (662) 632-0364

· Turkey
Microsoft Turkey
Phone: 90 (212) 258 59 98
Fax: 90 (212) 258 59 54
Support Hotline:
    Phone: 90 (212) 258 96 66
    Fax: 90 (212) 258 95 99
Bulletin Board Service: 90 (212) 227 93 90
Faxback Service: 90 (212) 227 93 80 ( 81, 82 or 83 )

· United Kingdom
Microsoft Limited
Fax: (01734) 270002
Phone: (01734) 270001
Microsoft KeyData: 
(Bulletin Board Service)
 (01734) 270065 (up to 14.4Kbaud, n, 8, 1)



Microsoft KeyFax: 
(Faxback Information Service)
 (01734) 270080
Telephone Support:
Consumer, Desktop Apps & 
Personal Operating Systems: (01734) 271000
Microsoft Connection, Pre-Sales Information: 
(0345) 00 2000

· Uruguay
Soporte Técnico: (598) (2) 77-4934

· Venezuela
Corporation MS 90 de Venezuela S.A.
Other information: (582)265-2250
Fax: (582)265-0863 / (582)265-2611
Technical Support: (582)264-1933

· Wales
See United Kingdom



Maintaining Web Security
Adding Security on Your Web

Internet Information Server (IIS) and Microsoft Personal Web Server Procedures
To authorize a FrontPage web author (IIS and Microsoft Personal Web Server)

To authorize a FrontPage web administrator (IIS and Microsoft Personal Web Server)

To register a user of a restricted-access FrontPage web (IIS and Microsoft Personal Web Server)

To authorize a group of FrontPage web authors (IIS and Microsoft Personal Web Server)

To authorize a group of FrontPage web administrators (IIS and Microsoft Personal Web Server)

To register a group of users of a restricted-access FrontPage web (IIS and Microsoft Personal Web Server)

To remove a FrontPage web author

To remove a FrontPage web administrator

To remove a registered user from a restricted-access FrontPage web

Procedures for Other Web Servers
To authorize a FrontPage web author

To authorize a FrontPage web administrator

To register a user of a restricted-access FrontPage web

To restrict a FrontPage web user’s IP addresses

To restrict a FrontPage web author's IP addresses

To restrict a FrontPage web administrator’s IP addresses

To remove a FrontPage web user’s IP address mask

To remove a FrontPage web author’s IP address mask

To remove a FrontPage web administrator’s IP address mask

To remove a FrontPage web author

To remove a FrontPage web administrator

To remove a registered user from a restricted-access FrontPage web



Permissions Command
Use the Permissions command to authorize administrators, authors, and end users of a FrontPage web. You 
must have administrator access to the FrontPage web in order to use this command.

The number of tabs that comprise the Permissions dialog box depends on whether the FrontPage web is a root 
web or sub-web and on which server the web is stored.

· Use the Settings tab to decide the type of permissions you want to set up for the current FrontPage web.
Note      When working with a root FrontPage web, the Settings tab is not shown.

· Use the Users tab to set up administrators, authors, and users of a FrontPage web. Administrators can create 
and delete FrontPage webs, create and delete pages, designate authors, and restrict end users from 
accessing a FrontPage web. Authors can create and delete pages.

· Use the Computers tab to restrict specific workstations from accessing a FrontPage web.
· Use the Groups tab to restrict specific groups from accessing a FrontPage web.

{button Dialog Box,AL(`web permissions DB tabs',0,`',`main')}

{button Related Procedures,JI(`frontpg.HLP',`Contents_Security')}



Publish FrontPage Web Dialog Box
Use the Publish FrontPage Web Dialog Box to publish a FrontPage web, which is the process of making your 
FrontPage web public on the World Wide Web or an intranet. 

Dialog Box Options

Click Here to Find An Internet Service Provider to Host Your FrontPage Web
When you click this button, the default Web browser installed on your computer opens and shows you the current
list of Web Presence Providers that have the FrontPage Server Extensions installed.

Please specify the location to which you want to publish your FrontPage web
Specify the location to which you want to publish the current FrontPage web. You can choose from the drop-
down list or enter a new location by typing directly into this field

To publish to a folder on your local file system, type in the full path and name of the folder. If you specify a folder 
that does not exist, FrontPage will offer to create it.

Secure connection required (SSL)
Secure Socket Layer (SSL) allows software to communicate with Web servers in a secure, encrypted manner. 
Many Web sites that conduct electronic commerce use SSL to securely transmit credit card numbers from a 
customer’s Web browser to the Web server. If you are publishing your FrontPage web on a Web server that 
supports SSL, select the Secure Connection Required (SSL) option to communicate securely between your 
computer and the Web server.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Webs')}



Publish Dialog Box
Use the Publish Dialog Box to publish a FrontPage web, which is the process of making your FrontPage web 
public on the World Wide Web or an intranet. 

Dialog Box Options

Publish FrontPage Web to
Specify the location to which you want to publish the current FrontPage web. You can choose from the drop-
down list.

To publish to a folder on your local file system, type in the full path and name of the folder. If you specify a folder 
that does not exist, FrontPage will offer to create it.

More Webs
Click More Webs for a list of FrontPage webs at the specified location.

Publish changed pages only
If you are publishing a FrontPage web that has been published at least once before, click this option to copy only 
those pages that have been edited since the last time you published or copied the FrontPage web.

Include child webs
If you are publishing the root web, select the Include Child Webs option to publish the other FrontPage webs on 
the same Web server or, if the root web is in a folder, to publish the other FrontPage webs in the same folder.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Webs')}



To apply an effect to a page’s background image
You can apply some of the effects on the image toolbar to a page’s background image.

1 If the image toolbar is hidden, choose Image Toolbar on the FrontPage Editor’s View menu.
3 On the active page, click anywhere on the page background or within a line of text.

No foreground image should be selected.
4 On the image toolbar, click the effect you want to apply to the background image.

Certain buttons on the image toolbar are dimmed because they will not work on background images (for 
example, the Resample tool).

Note      If all buttons on the image toolbar are dimmed, then the active page has a theme applied. In this case, 
you will not be able to apply image effects to the background image. You can override this setting by removing 
the theme associated with the page.

{button Related Procedures,JI(`frontpg.HLP>main',`Content_Images')}



Create E-mail Hyperlink Dialog Box
Use the Create E-mail Hyperlink dialog box to enter the e-mail address to which all messages will be sent when 
a user clicks an e-mail hyperlink in your Web site and enters a message.

Dialog Box Option

Type an E-mail Address
Enter the e-mail address to which all messages will be sent when a user clicks an e-mail hyperlink in your Web 
site and enters a message.

{button Related Procedures,JI(`frontpg.HLP>main',`Contents_Link_Bookmark')}



Viewing and Editing Frames Pages Within Frames
In the FrontPage Editor, to edit a frames page that is inside another frame, click the View Frames Page button 
inside the frame. FrontPage opens the frames page in a separate window. You cannot directly view or edit a 
frames page inside a frame.
To view a frames pages that contains other frames pages, use the FrontPage Editor’s Preview tab or the Preview
in Browser command.

{button Related Procedures,JI(`frontpg.HLP',`Contents_Frames')}



Internet Database Connector Wizard
Database Connection Panel
Use the Database Connection panel to configure the ODBC connection.

Dialog Box Options

Database Connection
Use the Database Connection section to specify the ODBC Data Source, username and password, and to set 
advanced ODBC options.

ODBC Data Source

The ODBC data source to which you want to connect. This field is required. 

Username

If the data base system requires a user name, enter it in this field.

Password

If the data base system requires a password, enter it in this field.

Advanced Options

Click Advanced Options to open the Advanced Options dialog box. Use this dialog box to set advanced options 
for the ODBC driver. Setting advanced options is not required.

Query Results Template
This is a required field.    Enter the name of the file that will format and display the query results data for the IDC 
file created by the Database Connector Wizard. This should be relative to the location of the IDC file. By 
convention, query results template files have an HTX filename extension. 

Browse

Click Browse to browse the current FrontPage web for a query results template file.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Advanced Options Dialog Box
Query Tab

Dialog Box Options

Do Not Scan For SQL Escape Sequences
If you do not select this option, the ODBC driver will scan SQL strings for escape clauses. If you select Do Not 
Scan For SQL Escape Sequences, the driver does not scan SQL strings for escape clauses; instead, the driver 
sends the statement directly to the data source. If your SQL statement does not contain any ODBC escape 
clauses, a special syntax enclosed by curly braces ( { } ), then selecting this option will provide a small 
performance gain by directing the driver to not scan the SQL string.

Cached Results Expiration Time
Click Cached Results Expiration Time to specify the number of seconds to wait before refreshing a cached output
page. If a subsequent request is identical, the cached page will be returned without ever accessing the database.
The Cached Results Expiration Time field is useful when you want to force a re-query of the database after a 
certain period of time. The IDC does not cache output pages by default. It caches them only when the Cached 
Results Expiration Time field is used.

Query Timeout
Click Query Timeout to set the number of seconds to wait for an SQL statement to execute before canceling the 
query. When not selected (the default) there is no query time out. If the specified time out value exceeds the 
maximum time out in the data source, or is smaller than the minimum time out, the driver substitutes the 
maximum or minimum value.

Transaction Isolation
Click this option to set the transaction isolation level. The Internet Database Connector does not support 
transactions that span more than the request in the IDC file. However, for some database management systems, 
setting the Transaction Isolation option to Read Uncommitted will result in higher concurrency and therefore 
better performance. However, with this setting, data that has not been committed to the database by other 
transactions may be retrieved .

Content Type
Click Content Type to specify the content type of the information supplied in the body of a POST request. By 
default, the content type is text/html.

HTML Translation File
Use this field if you are publishing a database in a language other than English. A translation file is a text file with 
each special character mapped in the following format: value=string<CR> where value is an international 
character and string is the HTML translation code. Enter the path to the file that maps non-English characters 
(such as à, ô, or é) so that Web browsers can display them properly in HTML format. If the translation file is not in
the same directory as the IDC file, you must type the full path to the translation file.

ODBC Translation DLL
Click this option to enter the name of a DLL containing the functions SQLDriverToDataSource and 
SQLDataSourceToDriver. The ODBC driver loads and uses these functions to perform tasks such as character-
set translation.

ODBC Translation Option
Click this option to specify a value controlling translation functionality, which is specific to the translation DLL 
being used. Consult the documentation for the ODBC driver and translation DLL for details.

 

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Advanced Options Dialog Box
Driver Specific Tab

Dialog Box Options
Use this tab to specify ODBC driver-specific options. Refer to your ODBC driver documentation for descriptions 
of available options.

ODBC Driver Specific Options
This field lists the number and value of each ODBC driver-specific option that you add.

Add
Click Add to open the Add Option dialog box. In this dialog box, specify the option number and value and click 
OK.

Modify
Click Modify to change the selected ODBC driver-specific option in the Modify Option dialog box. In this dialog 
box, specify a new option number or value and click OK.

Remove
Click Remove to delete the selected ODBC driver-specific option.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Internet Database Connector Wizard
SQL Query Panel
Use the SQL Query panel to define one or more SQL queries for the IDC file. If you define more than one query, 
the results of each query are displayed in a separate detail section of the HTX file. Queries are written to detail 
sections in numerical order. The first query is written to the first detail section, the second query to the second 
detail section, and so forth.

Dialog Box Options

SQL Query
Lists the SQL queries defined for the current IDC file. To define a new SQL query, select Create Additional Query 
from the list. You must create at least one query. 

To edit a query, select it from the list, and type directly into the text window.

Insert Parameter
Click Insert Parameter to insert an IDC parameter value in the SQL query.

Clear Query
Click Clear Query to clear the current SQL query.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Advanced Options Dialog Box
Limits Tab

Dialog Box Options

ODBC Driver Limits
Use this section to set optional ODBC limits.

Maximum Field Length

Click this option to specify the maximum amount of data that the ODBC driver should return from a character- or 
binary column. This option is intended to reduce network traffic and should only be used when the data source 
(as opposed to the driver) in a multiple-tier driver can implement it. 

Maximum Number of Data Rows Returned

Click this option to specify the maximum number of rows to return for a SELECT statement. If this option is not 
selected, the driver returns all rows. This option is intended to reduce network traffic when the data source itself 
can limit the returned rows, as opposed to the MaxRecords built-in variable in the Internet Database Connector, 
which limits the rows fetched. 

IDC Limits
Use this section to set optional fields in the IDC file. 

Maximum Displayed Field Length

Click this option to specify the maximum buffer space allocated by the IDC file, per field. Any characters beyond 
this will be truncated. The parameter applies only to fields returned from the database that exceed 8192 bytes. 
The default value is 8192 bytes.

Maximum Number of Data Rows Fetched

Click this option to specify the maximum number of records that the IDC file will return from one query. This value
is not set by default, so a query can return up to 4 billion records. Set this value to limit the records returned.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Internet Database Connector Wizard
Default Parameter Values Panel
Use the Default Parameter Values panel to specify IDC parameter values that will always be used when the SQL 
query is run. When the SQL query is run because the user submitted a form with the IDC file specified as the 
form’s handler, the default parameters will be combined with the parameters passed when the form is submitted. 
When the SQL query is run because the user followed a hyperlink to the IDC file, only the default parameters will 
be used. 

Dialog Box Options

Default Parameter Values
This field lists the default parameter names and values.

Add
Click Add to add a parameter and value.

Modify
Click Modify to change the currently selected parameter and value.

Remove
Click Remove to delete a parameter/value pair.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Advanced Options Dialog Box
Connection Tab

Dialog Box Options

Read Only Access
Click this option to prevent the IDC connection from modifying the data in the data source to which it is 
connecting. Read-only access can be used to optimize locking strategies, transaction management, or other 
areas as appropriate to the ODBC driver or data source. The behavior of the ODBC driver and the data source 
when asked to process SQL statements that are not read-only during a read-only connection is implementation-
defined.

Enable Logging of ODBC Calls
Click this option to log each function call made by the ODBC driver. If the file already exists, the ODBC appends 
to the file. Otherwise, it creates the file. If this option is selected, but no log file has been specified, ODBC writes 
to the file “Sql.log.” 

Log File

The name of the log file on the server to use if Enable Logging of ODBC Calls is selected.

ODBC Connection Pooling
Click this option and click On to keep the connection to the data source open between data source requests. Use
this option to improve the performance of the IDC file.

SQL Logon Timeout
Click this option to specify the number of seconds to wait for a logon request to complete before disconnecting. 
The default is ODBC driver-dependent. If the value is zero, the time out is disabled and a connection attempt will 
wait indefinitely. If the specified time out value exceeds the maximum logon time out in the data source, the driver
substitutes that value.

Network Packet Size
Click this option to specify the network packet size, in bytes, to be use to exchange information between the 
database management system (DBMS) and the Web server. 

Note Many data sources either do not support this option or can return only the network packet size. If the 
specified size exceeds the maximum packet size or is smaller than the minimum packet size, the driver 
substitutes that value. 

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



Current Web Dialog Box
Use the Current Web dialog box to select a name and location in the current FrontPage web for the IDC file 
created by the Internet Database Connector Wizard.

Dialog Box Options

Name
Lists the folders and files in the current folder. Browse the FrontPage web by clicking folders. Choose a folder in 
which executable scripts can be stored. 

To determine if a folder can hold executable scripts, return to the FrontPage Explorer, select the Folder View, 
choose a folder, and choose Edit: Properties. If the folder has Allow Scripts Or Programs To Be Run selected, it 
can hold executable scripts.

Save As
Type in the name of the IDC file or select a file from the FrontPage web. IDC files must have an IDC filename 
extension. If you do not supply a filename extension, the Internet Database Connector Wizard will add one.

{button Overview,JI(`HPIDCWIZ.HLP',`Overview_IDCWIZ')}



ODBC
(Open Database Connectivity). A standard for accessing different database systems.



Publish Command
Use the Publish command to publish your FrontPage web to a Web server on the World Wide Web or your 
organization’s intranet. If you want to publish a FrontPage web to multiple locations, use the Publish FrontPage 
Web command on the FrontPage Explorer’s File menu, where you will always be prompted for the target location
of the current FrontPage web you are publishing.

If you are going to publish your FrontPage web to the same location every time, you can use the Publish button 
on the FrontPage Explorer’s toolbar to publish to the specified target location quickly.

Publish 
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The first time you press the Publish button, the Publish FrontPage Web dialog box is displayed. Enter the 
location of the Web server to which you want to publish. Clicking the Publish button to publish the same 
FrontPage web to the same location in subsequent sessions will bypass the dialog box and the publishing 
process will begin immediately.

To change the default location for the Publish button, use the Publish FrontPage Web command on the 
FrontPage Explorer’s File menu.
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Page Setup Command 
Use the Page Setup command to set the options for printing, such as paper size, and orientation.
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Video Command
Use the Video command to insert a Video for Windows (AVI) file on the active page.

The video file will be inserted at the insertion point on the active page. The first frame of the video sequence will 
be shown as a placeholder image for the file. To view the full video sequence as it will appear when the page is 
browsed on the World Wide Web, choose Preview in Browser on the File menu in the FrontPage Editor.

To change the properties of the video clip, select the placeholder image and choose Image Properties on the 
Edit menu in the FrontPage Editor.
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